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1 How to learn Prism

Browse the Statistics and Regression guides

This Prism Guide is only one of three guides. Check out the other two.
Both do more than explain how to use Prism. They also explain the
concepts of data analysis. 

· GraphPad Statistics Guide

· GraphPad Curve Fitting Guide

·

Step by step tours

Read this one page tour , which will take about five minutes to follow.

Then follow longer detailed tours that walk you step by step through data
analyses and graphing.

Work with tutorial data sets

 Choose these from the Welcome dialog. Each sample data set comes with
brief instructions, and links to longer explanations. 
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The data table with sample data, also contains a floating note that
explains how the data are arranged and gives suggestions for graphing
and analyzing. 

Follow step-by-step examples, using sample data, for analyzing data with
Prism:

Descriptive statistics

Column statistics

Frequency distribution

Compare two groups

Unpaired t test from raw data

Paired t test

Mann-Whitney test

Wilcoxon matched pairs test

Categorical outcomes

Contingency table analysis

Survival analysis

Diagnostic lab tests

ROC curve

Bland-Altman plot

Nonlinear regression

Fitting an enzyme kinetics curve

Comparing two enzyme kinetics models

Automatic outlier elimination (exponential decay)

Global nonlinear regression (dose-response curves)

Ambiguous fit (dose-response)
 

Explore the graph portfolio
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Choose the Portfolio tab at the bottom of  the Welcome dialog to browse
dozens of polished graphs, each of which demonstrates several Prism
features. When you open a portfolio graph, you'll see a brief explanation
of how that graph was made, and can explore the details. Many of these
portfolio graphs are linked to step-by-step instructions. Others give brief
explanations. Exploring these files will help you master graphing with
Prism.

2 What's new in Prism 7?

Version 7 of GraphPad Prism introduces many

improvements in graphs , nonlinear regression ,

statistical analyses  and much more . 

13 24

28 36
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2.1 Highlights of what's new

Heat maps

Three-way ANOVA

FDR approach to multiple comparisons
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More accurate (asymmetrical, likelihood) confidence intervals from
nonlinear regression

Label subcolumns

Color code sheet names, and selected cells in tables
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Semitransparent colors
 so you can see overlap

Enter dates (or elapsed times) as X values

 

2.2 What's new: Graphs

Heat maps, semitransparent colors, dates and

more. 
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2.2.1 Heat maps

Heat maps are a new way to plot grouped data. The plotting area is
divided into squares. The columns corresponds to different data sets in
your table, and the rows in the graph correspond to different rows in the
data table. Each square in the graph is color coded to denote the value
entered into that cell of the table. Features:

· Reverse the direction of either axis, or transpose the X and Y axes.

· Color scales can encode continuous data with one scale, continuous data
with two scales (perhaps one for positive numbers and another for
negative numbers) or discrete categories (1=blue, 2=red, ...).
Monochrome or color.

· Specify special colors for values that are "off the map" or for excluded
values. Optionally put "X" through those cells.

· If you entered replicate values, base the heat map on the mean, median
or geometric mean of the replicates. Or base it on the SD, SEM or CV
among replicates to make a heat map of variation.

· Introduce more structure to the graph by inserting gaps to the right of
any column or below any row.  

2.2.2 Semitransparent colors to see overlapping points

When choosing any color, you can now specify that is be 
semitransparent  (or on a Mac, "semiopaque"). 

When symbols are semitransparent, this lets you see when several
symbols are superimposed (they get darker).

336
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Semitransparent colors are also useful when shading under a curve. 

 

2.2.3 Enter dates or elapsed time as X values

Until now, you could only enter numbers into the X column of XY tables.
Prism 7 now lets you enter   numbers (as always), elapsed time in
hh:mm:ss, or dates. Choose on the Welcome dialog: 
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If you choose elapsed time, enter time as hh:mm or hh:mm:ss. For
example, enter 1:12:30.2 to enter an elapsed time of 1 hour, 12 minutes,
30.2 seconds. 

If you chose to enter dates, you can enter dates in almost any format.
Prism will figure out what you meant and display the date on the table in
a standard format (that you cannot change).

XY graphs can now label the X axis with the dates or elapsed times you
entered. 
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When performing XY analyses (or making graphs with numerical X axis),
the dates or elapsed times you entered are converted to numbers using
units and a starting date that you choose in the Format Data Table dialog.

2.2.4 Three way grouped graphs

To go along with three-way ANOVA, Prism can also create three way
grouped graphs. 

Enter your data on a grouped table like this. 

Two of the factors must have only two levels (e.g. male/female; low
fat/high fat), but the the third factor (designated by different rows) can
have more levels (more than two rows). 

Here is the three way graph, with labels produced automatically.

http://www.graphpad.com/guides/prism/7/statistics/index.htm?stat_what_is_three-way_anova_used_f.htm
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2.2.5 Improvements with error bars

New error bar calculations

· When plotting medians, Prism offers a new choice of error bars: Median
with 95% CI 

· When plotting the geometric mean, Prism now offers to plot error bars
showing the geometric SD. It also shows the geometric SD factor on the
Column statistics results page. 

New warnings

· If any error bar is smaller than the symbol, Prism now places a floating
note on the graph explaining why the error bars are not shown.

· Prism will warn you if you mix SD and SEM error bars on the same
graph, as this is usually not intentional. 

New default

· Prism 6 always defaulted to SD error bars. A new preference lets you
choose whether you prefer to default to SD or SEM error bars.

2.2.6 Other improvements in graphing

New graphing options

· Add major grid lines on the categorical axis of Column and Grouped
graphs.

http://www.graphpad.com/guides/prism/7/statistics/index.htm?stat_the_geometric_mean_and_geometr.htm
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· Some box-and-whisker graphs plot individual points for large and small
values. Prism 6 always plotted these points using solid circles. Prism 7
lets you choose any type of symbol.

· Prism lets you plot replicates on an XY graph as box-and-whiskers.
Prism 6 always plotted these with the whiskers extending down to the
minimum and up to the maximum value. Prism 7 now offers five choices
for defining the whiskers (same choices that Prism 6 offered for Column
box-and-whisker graphs).

· When plotting individual replicates on a XY plot, in addition to
connecting the means, you can now draw lines that connect the median
or geometric means.

· On grouped graphs, specify how large a gap you would like to see when
a data table row is blank, and specify gaps before the first data set and
after the last.

· On column graphs, specify how large a gap you would like to see before
the first data set and after the last.

· When you make one graph per data set, Prism uses the column title of
each data set as the graph title. Now this is a live link, so if you change
the column title, the corresponding graph title will update.

· For bar graphs, the choice to use (or not use) a fill pattern is now more
obvious in the Format Graph dialog. With prior versions you had to
choose a solid fill pattern to get no fill pattern. Now just uncheck the
option if you don't want a fill pattern.

Exporting

· Prism 7 Windows uses a superior library for exporting and importing
bitmap (tiff, jpeg, png) images creates better image files compatible
with more applications.

· When exporting color graphs in tiff or jpg format, Prism Windows now
lets you choose grayscale, where colors are converted to various shades
of gray (Prism Mac already offered this choice).
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Axes

· Use a comma as decimal separator in axis numbering.

· Discontinuities in the X or Y axis can now be shown with either
perpendicular or angled gaps. 

More versatility when drawing lines, boxes, etc. 

· Rotate any line, rectangle, text object or imported image. 

· When moving lines, arrows or objects, Prism shows more information in
the tool tip (length, angle, position...).

· Set a default for the line width of lines and arrows you draw.

Legends

· Choose square (new) or rectangular legends for bar graphs.

· New command on the Change menu reverses the order of a set of
legends.

Text

· You can now use flush justification.

Add information to graphs

New file constants let you add file name, and dates to graphs or layouts. 
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2.3 What's new: Nonlinear regression

More accurate asymmetrical confidence intervals,

test for homoscedasticity and more. 

2.3.1 More accurate (asymmetrcial) confidence intervals from nonlinear
regression

With all prior versions of Prism, the confidence intervals for parameters fit
by nonlinear regression were always symmetrical around the best-fit
value. These are called asymptotic intervals or approximate intervals.
These are are what most nonlinear regression programs report. But the
true uncertainty in a parameter's value, in many cases, is asymmetrical.
In these cases, the symmetrical confidence intervals do not really express
the precision of a parameter's estimate very well. 

Prism 7 lets you choose to create asymmetrical confidence intervals
instead. Based on the method used to compute these intervals, they are
sometimes called profile likelihood intervals. These almost always do a



What's new in Prism 7? 25

© 1995-2016 GraphPad Software, Inc.

better job of expressing the precision of the parameter estimate, and in
some cases a much better job. 

The initial default is to show the asymmetrical intervals, but you can
change this default (in the Confidence tab of the nonlinear regression
dialog). Since the only purpose of the standard errors of the parameters
is to compute the approximate confidence intervals, we suggest that you
stop showing these once you get used to the new asymmetrical intervals. 

The only disadvantage of this new way of computing the confidence
interval is that the calculations are slower. But with modest data sets
(few dozen data points), standard models, and reasonably fast
computers, you won't notice. Prism 7 computes nonlinear regression
more quickly than prior versions (about ten times faster if you choose a
built-in equation), so you are unlikely to notice the slow down.

The availability of these new asymmetrical confidence intervals let us add 
new dose-response equations  where X is dose or concentration, rather
than the logarithm of dose or concentration. 

27
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2.3.2 Test for homoscedasticity

Nonlinear regression assumes that the average distance of points from
the curve is the same for all parts of the curve (homoscedasticity) or that
you have chosen an appropriate option on the weights tab to correct for
this problem. 

Prism 7 can test for homoscedasticity or appropriate weighting. To do
this, Prism 7 computes nonparametric correlation between the absolute
values of the weighted residuals and the Y value of the curve. A low P
value from this test means that the weighted residual is correlated with
the Y value of the curve, and this suggests  the weighting choice was not
ideal.

2.3.3 Flag bad fits

Some scientists run many fits, perhaps using a script, or review many fits
run by others. Prism 7 provides a way to flag poor fits, so you you know
which data sets and results to inspect more carefully. 

· Define "poor" fits on the new Flags tab on the parameters dialog of
nonlinear regression. Flag a fit because the R2 is too low (you define
how low that is), when the number of outliers is too high (you define
how high that is), when a dependency is too high, or when the residuals
fail a normality test, or the runs or residual test.  

http://www.graphpad.com/guides/prism/7/curve-fitting/index.htm?reg_test_for_homoscedasticity.htm
http://www.graphpad.com/guides/prism/7/curve-fitting/index.htm?reg_flags_tab.htm
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· When running Monte Carlo simulations choose to skip any results from
fits that were flagged as being poor.

· When comparing two models, you can tell Prism to skip formal
comparisons when one fit is flagged as being poor, and always choose
the other fit in that case.  

2.3.4 More choices for user-defined equations

· When editing an equation, the innermost parentheses around the
insertion point are always highlighted to help you avoid mistakes that
can occur when you are lost in a sea of parentheses.

· New choices for rules rules for initial values. You can now compute the
initial value as a constant value multiplied or divided by the initial slope,
the final slope, or the slope at the middle of the graph.

· When defining an equation, you can enter equations to report values
calculated from the parameters. Enter "Y[logEC50]" to report the Y
value when X=logEC50, or "X[B]" to report the X value when Y=B. 

· Three improvements when fitting a model defined by a differential
equation:  

o Set X0 to any value (Prism 6 always set it to 0.0).

oUse the <A> or <B> notation to define different equations for different

data sets.

o Choose to share or not share the value of Y0 among data sets. 

2.3.5 Improved built-in equatons

· A new set of dose response equations fit data where X is dose or
concentration, to complement the existing set of equations where X is
the logarithm of dose or concentration.
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· Faster. When you choose a built-in equation, nonlinear regression is
more than ten times faster than it was with Prism 6, with improved
precision. This is because the derivatives (and second derivatives) are
now evaluated analytically rather than numerically. This will even work
when you clone a built-in equation and change parameter names.  This
extra speed is noticeable when you have lots of data, do Monte Carlo
simulations, ask for Hougaard's measure of asymmetry, or ask for
asymmetric likelihood confidence intervals (which require more
computation). 

· The rules for initial values have been improved for the parameter Width
in the log(Gaussian) distribution, for all three parameters in the
equation for enzyme substrate inhibition, and for the Amplitude of a sine
wave.

· New equation for sine wave with nonzero baseline.

· Renamed "One-site --- specific binding with Hill slope" equation to
"Specific binding with Hill slope", because with a Hill Slope that doesn't
equal 1.0, this equation really necessarily describe binding to one site. 

2.4 What's new: Statistical analyses

Three way ANOVA, analyze a stack of P values,

control the FDR and more. 

2.4.1 Three way ANOVA

Prism has been able to perform one- and two-way ANOVA for many
versions, and now can also perform three-way ANOVA. 

Enter your data on a grouped table like this. 

http://www.graphpad.com/guides/prism/7/curve-fitting/index.htm?reg_sine_wave_nonzero_baseline.htm
http://www.graphpad.com/guides/prism/7/statistics/index.htm?stat_what_is_three-way_anova_used_f.htm
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Two of the factors must have only two levels (e.g. male/female; low
fat/high fat), but the the third factor (designated by different rows) can
have more levels (more than two rows). 

The three-way ANOVA dialog is similar to the dialog for one- and two-way
ANOVA, but the choices for multiple comparison goal are a bit different:

Here is a portion of the results table, showing all seven P values. Yes,
seven! Three-way ANOVA is complicated.  

Prism 7  provides a new kind of three-way graph to display data entered
into three-way ANOVA:
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2.4.2 Analyze a stack of P values

Enter a stack of P values that were computed elsewhere into a column A
of a Prism Column table, and choose this new analysis to determine which
of those P values are small enough for the corresponding comparison to
be worth investigating further. Use the approach of statistical significance
with multiple comparisons or the method of controlling the false-discovery
rate. 

This analysis also lets you plot the rank of each P value vs. the actual P
value, a common way to visualize the distribution of a set of P values. 

http://www.graphpad.com/guides/prism/7/statistics/index.htm?stat_key_concepts_analyzing_a_stack.htm
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2.4.3 Control the false discovery rate (FDR)

Correct for multiple comparisons by controlling the False Discovery Rate

Controlling the False Discovery Rate (FDR) is a great method for coping
with multiple comparisons. Prism 6 offered this as part of the multiple t
test analysis. Prism 7 offers it in three places. 

As a followup to ANOVA

Prism has long offered multiple comparisons tests after ANOVA to control
the Type I error rate for the family of comparisons. Now Prism 7 lets you
use an alternative strategy for multiple comparisons following ANOVA
(one-, two- or three-way): controlling the False Discovery Rate (FDR). 

Multiple comparisons for P values computed elsewhere

Prism has always helped you deal with multiple comparisons after
analysis of variance. Prism 7 offers a new analysis to analyze a stack of P
values computed elsewhere. You enter a set of P values into a column and
choose this analysis. Prism graphs the rank of each P value vs. the P
value itself. This is a standard way to visualize the distribution of a set of
P values.

Which P values are small enough so the corresponding finding should be
flagged as "statistically significant"? Choose to control the False Discovery
Rate or the familywise Type I error rate using the method of Bonferroni,
Sidak or Holm. 

http://www.graphpad.com/guides/prism/7/statistics/index.htm?stat_the_false_discovery_rate_appro.htm
http://www.graphpad.com/guides/prism/7/statistics/index.htm?stat_false_discovery_rate_from_mult.htm
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Multiple t tests, one per row

Prism 6 introduced an analysis to run multiple t tests, one per row. If you
choose the method that controls the  Prism 7 now also reports q values
(also called adjusted P values) for each comparison.

Three algorithms for using the FDR method

Whenever you choose to use the FDR approach to decide which P values
are small enough to be a "discovery", Prism lets you choose one of three
methods for controlling the FDR.

http://www.graphpad.com/guides/prism/7/statistics/index.htm?stat_pros_and_cons_of_the_three_met.htm
http://www.graphpad.com/guides/prism/7/statistics/index.htm?stat_pros_and_cons_of_the_three_met.htm
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2.4.4 New analysis to transform concentrations

Prism has always had a versatile transform analysis. Prism 7 adds a new
analysis to simplify transforming concentrations  entered into the X
column of an XY table. 

This analysis can do any or all of these tree things:

· Handle zero concentrations differently. Zero concentrations are
sometimes a problem because the  logarithm of zero is not defined, so
zero concentrations are lost in a log transform. With this analysis, you
can specify that zero be substituted with a low value (say 10-9) before
taking the logarithm.

· Change units, for example from molar to nanomolar. Simply tell Prism
what constant to multiply or divide by.

· Transform to logarithms, often needed prior to fitting a curve. 

2.4.5 Choose how to report P values

Most of Prism's analyses report P values, and now all these analyses let
you choose how to report P values. 

Prism 7 gives you four choices:

296
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· The APA (American Psychological Association) style, which shows three
digits but omits the leading zero (.123). P values less than 0.001 shown
as "< .001". All P values less than 0.001 are summarized with three
asterisks, with no possibility of four asterisks.

· The NEJM (New England Journal of Medicine) style, which shows three
digits and includes the leading zero (0.123). P values less than 0.001
shown as "< .001". All P values less than 0.001 are summarized with
three asterisks, with no possibility of four asterisks.

· The now classic GraphPad method which reports four digits after the
decimal point with a leading zero (0.1234). P values less than 0.0001
shown as "< .0001". P values less than 0.001 are summarized with
three asterisks, and P values less than 0.0001 are summarized with four
asterisks.

· Choose how many digits you want to see after the decimal point, up to
15. P values less than 0.001 are given three asterisks, and P values less
than 0.0001 are given four asterisks.

2.4.6 Improved analyses of 2x2 contingency tables

More complete analyses 

Prism now reports the reciprocal of the relative risk and odds ratio, and
their confidence interval. Depending on the meaning of the rows and
columns, the reciprocal may be more meaningful to you. 

When you choose to report the difference between proportions, its
reciprocal called the Number Needed to Treat (NNT) is also computed
along with  its confidence interval.

Choice of algorithms

Prism offers new algorithms when computing the confidence interval of a 
proportion, the difference between two proportions, the relative risk, or
the odds ratios. 

http://www.graphpad.com/guides/prism/7/statistics/index.htm?stat_three_methods_for_computing_th.htm
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The methods used by prior versions were simple approximations, and the
improved methods Prism now offers produce narrower intervals that still
provide the desired confidence level. We suggest you use them routinely.

2.4.7 Other improvements in statistical analyses

· The Row Statistics analysis can now report means only without SD or
SEM.

· One-way ANOVA now works even if any of the data set columns has only
a single value.

· Two-way ANOVA can now do multiple comparisons comparing every cell
with every other cell if the data are repeated measures in both factors.

· The Normalize analysis can now normalize each subcolumn separately,
using its own definition of 100% and 0%. 

· The correlation matrix analysis now reports a third page of results
showing number of XY pairs for each pair of variables (missing values
can lead to different n for different variable pairs). 

· Enter starting and ending dates for each subject in a survival analysis
instead of entering number of days (or weeks..). 

· If you enter data with replicates (or enter mean, n and SD or SEM), the
Area under the curve (AUC) analysis will now report the AUC with a
standard error and 95% confidence interval. 

· The multiple t test analysis now reports multiplicity adjusted P values. 

· The Shapiro-Wilk normality test now works with a sample as small as
n=3. 

· The Remove Baseline & Column Math analysis now gives you choices for
reporting the column titles. If the column titles in your data table are
"Control" and "Treated" and you ask the analysis to subtract one from
the other, you can have the second results column labeled as "B-A" or
"Treated-Control" or just "Treated". 

http://www.graphpad.com/guides/prism/7/statistics/index.htm?stat_area_under_the_curve.htm
http://www.graphpad.com/guides/prism/7/statistics/index.htm?stat_area_under_the_curve.htm
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2.5 What's new: General

Color code sheet names or cells, label subcolumns,

and more. 

2.5.1 Label subcolumns

In Prism 6, subcolumns were labeled Y1, Y2, Y3, etc. and you couldn't
change these labels. With Prism 7, you can enter your own subcolumn
titles. 

Apply one set of subcolumn titles  to all data sets, or label each
subcolumn in each data set uniquely.

2.5.2 Color code selected cells in tables

With Prism 6, it was not possible to highlight certain cells in data or
results tables. With Prism 7, you can  highlight selected cells  of data or
results tables with a choice of colors. 

194
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Use one color to mark values that you want to double check, and color for
cells you want to discuss with a colleague, another for key results you
want to find again. Or color code different parts of an experiment.

2.5.3 Color code sheet names

With Prism 6, you could highlight sheet names, but only in yellow. With
Prism 7, choose from nine color when highlighting a sheet name . 

You might want to choose one color to highlight the most important
results, another color to mark sheets you need to discuss with a colleague
or mentor, and yet another color to mark the graphs that were included in
a paper.   

2.5.4 New Family menu

Working with families of linked sheets is an important method for working
efficiently in Prism, but the commands that worked with families of sheets
have been scattered around the program, and many people never
discovered them. 

A new Family menu  in Prism 7 consolidates all these commands,
making it easier to view, delete, duplicate, highlight, save or print all
related sheets in a family. It also offers a new command to highlight all
sheet names in the family. 

151
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2.5.5 New shortcuts to work more efficiently

We know that some people use Prism almost every day, so we work hard
to provide time savers for frequent users. Improvements in Prism 7:

· Create a new data table without a linked graph.

· When creating a layout , assign a series of graphs so you don't have
to add them one at a time.

479
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· Set a preference to make bar graphs without bar borders.

· Reverse the order of legends instantly.

· With parts-of-whole graphs you can now choose which data set to graph
(these graphs can only plot one data set). Prism 6 only plotted data set
A.

· The script editor shows line numbers, making it easier to edit long
scripts.

· New script command to save all graphs or all layouts in a single pdf file. 

· The Wand  graphs data on a new table just like you have already
graphed another table (even if that table was not analyzed).

· When editing an equation, the innermost parentheses around the
insertion point are always highlighted to help you avoid mistakes that
occur when you are lost in a sea of parentheses.

2.5.6 Uses OS X Versions and Resume (Mac only)

Prism 7 uses the Versions and Resume features of OS X to make it easier

136
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to get your work done without thinking about saving files. Your work is
saved as you go, with no need to ever click the Save button (although
you can). Automatic backup is handled by the Mac Versions and Resume
feature, and is no longer handled by code we wrote. 

This is a change Apple introduced a few years ago. If you use iWork
(Pages, Numbers, Keynote), you already know about Versions and
Resume. If you don't use iWork, spend a minute reading about these
features  to avoid frustration. 

2.5.7 Enter data with more digits

Prism 7 lets you enter data with 13-14 digits for each value (double
precision). In contrast, Prism 6 allowed to to enter only 6-7 digits (single
precision). 

Allowing more digits prevents round off errors when importing or pasting
data with more than 6 or 7 digits of precision. 

Additionally, all calculations now use doubles instead of integers. This
allows Prism to avoid integer overflow and as a results work better with
large data sets (large N). Prism already use double-precision floating
point math. 

2.5.8 Looks better on high resolution displays

Many people now use computer displays with high resolution. Apple calls
these retina displays. 

Prism 7 Windows works much better on high resolution displays. 

Prism 6 Mac already worked well on retina displays, but Prism 7 looks
even better with high resolution icons. 

2.5.9 Work with larger files

We improved how Prism manages computer memory, so it can now work
with larger files than before.

2.6 What was new in Prism 6?

When creating Prism 6, our goals were ambitious:

111
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· To simplify Prism so it is easier to learn and even more
efficient to use.

· To greatly improve its statistical clout and graphical
versatility. 

· To make Prism 6  appeal to a wider group of scientists
and students.

· To make the transition from Prism 5 (or earlier) to Prism 6
be graceful,  and for people who make the switch to
rapidly discover that Prism 6  simply works better.

Links to the full lists of new features:

Highlights
Statistics
Multiple comparisons
Regression
Data tables
Working with other programs
Parts-of-whole data
Column graphs
XY Graphs 
Grouped graphs
Layouts
Time savers

2.6.1 What's new? Highlights

Prism 6 is a big upgrade with many
improvements. It has more statistical
clout, can make more kinds of graphs, and
is even more efficient to use. But Prism is
still Prism. The basic interface and
organization of the program has not
changed, so you can switch to Prism 6 with
almost no learning curve. And you can try
the Prism 6 demo without removing Prism
5. 

Statistics

· Two-way ANOVA with repeated measures
in both factors

Zig-zag and elbow lines
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· Detect outliers in a column of data using
Grubbs' test

· Calculate and graph 95% CI of median
with Wilcoxon test 

· Calculate and graph 95% CI of difference
between medians with Mann-Whitney
test 

· Greenhouse-Geisser correction in one-way
repeated measures ANOVA

· Ratio t test
· Kolmogorov-Smirnov test (alternative to

Mann-Whitney)
· Multiple tests (one-per row) with optional

correction for multiple comparisons
· Monte-Carlo analyses

Multiple comparisons

· Exact (multiplicity adjusted) P values with
Bonferroni, Tukey and Dunnett's tests.

· Graph 95% CI of difference between
means

· New approach: Fisher’s unprotected Least
Significant Difference (LSD)  

· New multiple comparisons test: Holm-
Sidak

· Test main or simple effects after two-way
ANOVA

· Dunnett's test now can handle up to 256
groups (up from 20)

Nonlinear regression
· Fit to models defined by implicit and

differential equations.
· Write more complex models
· Weight your fit by 1/YK

· Much easier interpolation

Bigger data tables
· Enter data in up to 256 data set columns

(up from 52 in Prism 5)
· Create data sets with up to 256

subcolumns (up from 52) to allow

Pie charts and more

Superimpose individual data points with
bars 

Superimpose individual data points with
box-whiskers 

Separate columns with lines

Label both sides of an axis
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repeated measures 2 way ANOVA with
more subjects

Row and column titles
· Write two or three line titles
· Use bold and italics 
· Make titles as long as necessary
· View and edit all of your column titles at

once

Work more efficiently
· Faster in many ways: saving, graphing,

exporting and closing
· Nonparametric calculations are way way

faster!
· Format several data sets at once. Want to

plot alternating columns as dotted lines?
Now you can do it in one step.

· Paste link data or results copied from
Prism, and those values will be hot linked

· Choose the size, shape and color of
selected data points right from the data
table

· More choices when exporting
· Set defaults as you work. Many dialogs

now a have checkbox to make your
choices on that dialog (or tab) become the
defaults when you use that dialog in the
future.

· Much easier to create the graph you want
since you don't pick the graph type until
after entering data. Preview how different
graphs look with your data before
deciding.

· Search a large project to find pages that
include specified text
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2.6.2 What's new? Statistics

Repeated measures ANOVA

· Two-way ANOVA with repeated measures in both factors. Prism 5 could
only compute two-way ANOVA with repeated measures in one of the
factors. Prism 6 can handle repeated measures in both factors. 

· More subjects . Prism 6 now allows up to 256 subcolumns, so can
perform repeated measures two-way ANVOA with up to 256 subjects
per treatment.

· The Greenhouse-Geisser correction allows repeated measures one-way
ANOVA to work, even when the assumption of sphericity is violated
because the repeated measurements are made in too short a time
interval, so that random factors that cause a particular value to be high
(or low) don't wash away or dissipate before the next measurement. In
this case, multiple comparisons are also computed so as to not assume
sphericity.  

Survival analylsis

· Prism now computes the hazard ratio (HR) by two methods: The logrank
method and the Mantel-Haenszel method. 

· If people in group A die at twice the rate of people in group B (HR=2.0),
then people in group B die at half the rate of people in group A
(HR=0.5). Prism now reports the hazard ratio, and its confidence
interval, both ways so you can report the one that makes most sense in
your clinical context.

· If people in group A have a median survival time three times people in
group B, then people in group B have one third the median survival of
people in group A. Prism now reports the ratio of median survival times,
and its confidence interval, both ways so you can choose which to
report.

Analyses of column data (t tests etc.)

· Mann-Whitney tests reports 95% CI of difference between medians. The
Mann-Whitney test is often described as comparing the median of the
two groups. That is not precisely correct, as it is possible for two groups
to have the same median, but for the Mann-Whitney test to find that the
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difference between the distribution of ranks among the two groups is
statistically significant. However, if you assume that the two
distributions have roughly the same shape, then it is fair to think of the
Mann-Whitney test as comparing two medians. Accordingly, Prism 6 can
now report the confidence interval for the difference of two medians. 

· The Wilcoxon test computes the 95% CI of the median. The Wilcoxon
matched-pairs test (nonparametric test of two paired or matched
groups) reports the confidence interval of the median of the paired
differences, and the Wilcoxon signed rank sum test (nonparametric test
to compare a median with a hypothetical median) now reports the
confidence interval of the difference between the actual sample median
and the hypothetical median.

· Ratio t test. The paired t test works by analyzing the difference between
each pair of values, testing the null hypothesis that the average
difference is zero. With some kinds of data, the difference between
before and after is not a consistent measure of effect. The differences
might be larger when the "before" values are larger, and smaller when
the "before" values are smaller. The ratio (after/before) may be a much
more consistent way to quantify the effect of the treatment. Actually, it
turns out that analyzing the logarithm of ratios works much better. 

· Kolmogorov-Smirnov test.   Like the Mann-Whitney (MW) test, the
Kolmogorov-Smirnov (KS) test, is a nonparametric method to compare
two groups. The KS test works by comparing the two cumulative
frequency distributions, and so has more power to detect subtle
differences in the two distributions. In contrast, the  MW test is better
at detecting changes in the median. The use of the KS test has become
standard in some scientific fields. Don't confuse this test with the the
other version of the KS test used for normality testing.

· Faster nonparametric tests. To avoid slow calculations, Prism reports an
approximate P value for nonparametric tests with large data sets. Prism
5 also reported approximate P values when several values were identical
and so tied for the same rank. Prism 6  performs the exact calculations
much faster (hundreds of times faster!), and so does exact calculations
even for fairly large data sets and even when several values are
identical and so tie for the same rank.

· Identify outliers. One of our free QuickCalc web calculators identifies
outliers from a stack of values using Grubbs' method. Because this is
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one of our most popular calculators, we created a new analysis in Prism
6 to identify outliers in a column of data. 

· Perform many t tests simultaneously. Computing multiple t tests can be
useful, so long as you correct for multiple comparisons. Prism 6 has a
new  analysis to perform one t test per row of a data table (with
replicates placed side-by-side). It corrects for multiple comparisons
either by using either a more stringent definition of statistical
significance or controlling the False Discovery Rate (FDR). You can also
choose not to correct for multiple comparisons.

· More graphing choices. Prism 6 offers options to automatically graph
ranks of nonparametric tests, and differences for paired t test and
repeated measures ANOVA.

· Browne and Forsythe test. To test equality of variances in one-way
ANOVA, Prism 6 computes both the Browne and Forsythe test as well as
the Bartlett test (which previous versions computed). 

· Method of Pratt. There are two ways to compute the Wilcoxon matched-
pairs test when some of the pairs are identical, so the difference is zero.
Prism 6 offers both choices. The new choice is the method of Pratt for
tied rows.

Simulations and Monte-Carlo analyses

Simulations can be useful even when you just simulate one data set, and
view the graph and analysis.Prism 5 let you simulate XY data. Prism 6
now let's you also simulate column data and 2x2 contingency tables. For
XY and Column data, Prism 6 can include not only Gaussian random
scatter, but also scatter computed from a Poisson or binomial
distribution. 

Simulations are even more useful when you repeat the simulation many
times, and tabulate the results. Prism 6 makes this possible with a new 
Monte Carlo simulation analysis that makes it easy to tabulate the results
of many simulations. First simulate a data table and run an analysis to
analyze that table. Then run the new Monte Carlo analysis. Specify how
many simulations you want to run, and which analysis parameters to
tabulate. You can also define a “hit”, as perhaps a P value less than 0.05,
or a confidence interval including a theoretical value. The results of the
Monte-Carlo analysis include a table with all the tabulated data (that you
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can analyze further), and a table of the number of simulations that were
hits.

2.6.3 What's new? Multiple comparisons

· Multiplicity adjusted (“exact”) P values can be reported with Bonferroni,
Tukey, Dunnett, Dunn, or Holm-Sidak multiple comparisons testing
following one- or two-way ANOVA.  An adjusted P value is an “exact P
value” reported for each comparison, but its value depends on the
number of comparisons. 

· Fisher’s unprotected Least Significant Difference (LSD) comparisons are
a second approach to report "exact P values" following ANOVA. This
method does not correct for multiple comparisons.

· New multiple comparisons test. Holm-Sidak has more power than the
Tukey or Dunnett methods, but cannot provide confidence intervals.  

· Dunnett's test can now can be computed with 256 groups. Prism 5 was
limited to 20 groups.

· For all multiple comparisons that create confidence intervals, check an
option and Prism will create a new graph with those multiple
comparisons confidence intervals. 
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· Multiple comparisons after one-way repeated measures ANOVA, without
assuming sphericity. Prism 6 can compute confidence intervals from
repeated measures one-way ANOVA using two different methods. The
new method does not assume sphericity. Instead of using the pooled
variation from all the groups (which depends on the sphericity
assumption), the multiple comparisons are computed using only the
data in the two treatments being compared. The calculations still
account for the total number of comparisons, but don’t pool the
variation in all groups. 

· When performing multiple comparisons testing, it can make sense to
use a  overall (familywise) significance threshold higher than 0.05.
Prism 6 lets you set it to 0.1.  

·  Main and simple effects for multiple comparisons after two-way ANOVA.

2.6.4 What's new? Regression

Simpler
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· Much easier interpolating. Many people use nonlinear regression for the
purpose of interpolating values from standard curves. If that is your
goal, most of the options provided in the nonlinear regression dialog are
neither required or helpful. Prism 6 offers a new analysis just for
interpolating curves. It offers only essential  options, so is super easy to
use.

· Plot functions to understand them. Before using an equation as a model
to fit to data, it is wise to first understand it. A great way to do this is to
plot the function and see how it changes when you alter the parameters.
Prism plot functions using an analysis called Generate a family of
curves. It addition to (or instead of) plotting the function itself, Prism 6
can now also plot the first and second derivative of the function, and its
integral.

Fit more kinds of models with nonlinear regression

· Implicit and differential equations. It is no fun to struggle with algebra
and calculus to express a model as an equation that defines Y as a
function of X and parameters. It can even be impossible. Instead
express your model as a differential equation (enter the equation that
defines dY/dX) as or an implicit equation (an equation where Y appears
on both sides of the equals sign). 

· Write more complex models. Prism 5 let’s you define different models
for different data sets by designating certain lines in the equation to
only apply to a certain data set. For example, a line in the equation
preceded with <B> applies only to data set B. Prism 6 extends this
syntax  to allow more complex equations. Precede a line with <A:D> for
it to apply only to columns A-D, or with <A:K,2> to make it apply to
every second data set between A and K (A, C, E, G, I, K). 

· New weighting choice. When fitting a model to data with nonlinear
regression, it is important to weight the data appropriately. This choice
is often ignored, but it can affect the regression results. Prism always
offered several choices for weighting. Prism 6 offers a new weighting
choice, weighting by 1/YK. where K is a constant you enter on the
weighting tab of the nonlinear regression dialog. 

Additional results with nonlinear regression

· Hougaard's skewness. When you write a user-defined equation to fit to
data with nonlinear regression, you can choose to express the
parameters in multiple ways. For example, choose between fitting a rate
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constant or a half life. Hougaard's measure of skewness can help you
choose the parameterization where the uncertainty is closer to
symmetrical so the confidence intervals will be more accurate.

· Adjusted R2. Prism reports the adjusted R2 which takes into account the
number of degrees of freedom, and so can be compared between
models with different numbers of parameters.

Linear regression

· Convert from linear to nonlinear regression with one click. Linear
regression can be viewed a special case of nonlinear regression. Prism’s
nonlinear regression analysis can be used to fit a straight line, and there
are more than a dozen reasons why you might want to do so. But few
people think of using the nonlinear regression analysis to fit a straight
line.  Prism 6 makes it easier to switch – simply click the “More choices”
button on the linear regression dialog.

· Copy the linear regression equation. Prism always reported the best-fit
values for the slope and intercept, but not in the form of an equation.
Prism 6 now reports the equation for the line, ready to copy and paste
onto a graph or into a manuscript.

2.6.5 What's new? Time savers

General time savers

· Wand to analyze data.  After entering data onto an empty data table,
you may wish to analyze these new data exactly as you have analyzed
another data table. Prism has always provided a tool to do this, but you
probably never found it (it used to be called Applying a Method). Prism
6 introduces the Wand (Wizard to ANalyze Data ) button. Click it to
analyze (and graph) a new data table just like you already analyzed
(and graphed) an existing table. 

136
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· Choose your own defaults. Many dialogs now a have checkbox to
make your choices on that dialog (or tab) become the defaults when you
use the dialog in the future.

· Rename while duplicating a family. A commonly used time saver is
to duplicate a sheet with a family, and then change the data in the new
copy. Prism 5 let you specify a prefix, which then preceded all the newly
created sheet names. When the family only has one data table, Prism 6
lets you entirely rename  that data table.

· Faster saving. Prism 6 Windows saves to a networked drive many
times faster than did Prism 5. Prism 6 Mac saves over a SMB connection
much more quickly.

· Faster closing. Prism 6 Windows can close a large file much more
quickly than did Prism 5.

Make graphs faster

· Easier to choose the right type of graph.  Prism 6 no longer asks
you to pick the graph type on the Welcome dialog, which leaves the
Welcome dialog less cluttered and easier to understand. Instead, you
choose the graph type the first time you view a new graph. Choose a
graph type by choosing among a set of icons, and preview how that kind
of graph looks with your data.

· Format several data sets at once. The Format Graph dialog in Prism
5 always let you either change one data set at a time, or click the “all”
button to change all data sets at once. Prism 6  also  lets you choose a
defined subset of data sets at once. For example, you could select data
sets A, C, E, and G and change all of those data sets to use a dotted
line. Then choose B, D, F and H, and make those lines solid. 

· Click the apply button to see changes without closing the Format
Graph or Format Axes dialog. The Format Graph and Format Axes
dialogs are very powerful, and give you a huge number of options to
change the appearance of your graph. To avoid the need to click OK,
then go back to the dialog to make more changes, simply click the new
Apply button and you’ll see the effect of the changes you made without
closing the dialog.

· View graphs faster. An XY graph with many points appear on screen
faster when you switch to it, and is regraphed much faster after you
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make any changes in the Format Axes or Format Graph dialogs or if you
move the graph on a page or stretch its axes. 

· Instantly switch between black and white, colors, and shades of
gray. You can bring up the color scheme dialog if you want to choose
among many color schemes. But Prism 6 makes it super fast to switch
between color and black and white (includes shades of gray). 

Easier to navigate around Prism

· Search for sheets. Prism lets you organize projects the way you want
to, with no limit to the number of sheets that a project can contain. But
if you put hundreds of sheets into one file, you may have trouble finding
the sheet you need. Prism 6 lets you search  within a project to find all
sheets that include the specified text.

· More galleries. Prism 5 lets you view all graphs at once on a gallery.
Ditto for data tables, info tables, analysis results and layouts. Prism 6
also lets you view an entire family of linked sheets in the gallery, or to
see the entire set of search results (see above) as a gallery.

· Crisper on screen graphics. We’ve revamped how Prism Windows
handles onscreen graphics. It won’t affect how your graphs look when
exported or printed, but graphs look much crisper on screen in Prism 6.

New choices in the Welcome dialog

· Graph Portfolio to help you master Prism. Click the Portfolio tab on
the Welcome dialog to browse a portfolio of polished graphs. Open any
of these graphs to explore how it was made.

154
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· Open files you forgot to save! When you exit Prism (as with any
program), it asks you whether you want to save changes to every open
file. Have you ever clicked No by accident and lost your work? Not with
Prism 6! You can open "unsaved" files from the Welcome dialog (unless
you tell Prism not to keep them, or unless you waited more than three
days).

· Launch two instances of Prism. When you open Prism Windows, it is
limited to use on one display. If you open several projects, each project
is a window within the larger overall Prism window. With Prism 6, you
can launch a second copy of Prism with its own windows. You can’t
launch the second instance from within Prism. Instead, double-click on
the program icon.

· Open files directly from LabArchives. From the Welcome dialog of
Prism 6, you can open a file directly from LabArchives, so don't need to
first go to labarchives.com to download the file you want.With Prism 6,
you can  upload files directly to LabArchives  (introduced in Prism 5.04
and 5.0d). Prism 6 (but not Prism 5) also sends LabArchives a list of all
words used in notes, titles, text boxes, etc, so you can search within
LabArchives to find the file you need. 

· Easier to find the sample data sets. Prism 5 introduced sample data
sets as a way to learn Prism. Prism 6 makes these more obvious on the
Welcome dialog, so more people will try them.

2.6.6 What's new? Data tables

· More columns . Prism 6 allows you to enter data in up to 256 data set
columns. Prism 5 allowed only 104.

· More subcolumns.  When creating an XY or grouped table,  Prism 6
allows up to 256 subcolumns per data set (compared to only 52
subcolumns with Prism 5). This lets Prism compute repeated measures
two-way ANOVA with more subjects. 

· Paste link data or results from Prism.  You’ve probably encountered
situations where you need to copy values from a results table, and then
paste onto a data table, perhaps using options in the Paste Special
dialog to transpose or rearrange the values. Prism 5 could paste the
values, but there was no link, so it was not possible to trace where the
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values were pasted from, and the pasted values did not update when
the original data were edited or replaced. Prism 6 lets you paste link so
values pasted onto the data table are linked to their source, and will
automatically update.

· Reformat a select set of points.   Select any block of data in a data
table, right click, and choose Format Points to change the color (or size
or shape...) used to graph that subset of points.

· Long column titles . With Prism 6, the length of column titles has no
real limit. Prism 5 limited the length of column titles, and many people
bumped into that limit. 

· Multiple line titles.  Each row or column title can now have two or
more lines of text. 

· Bold, italics and underline. You may also now bold, italicize and
underline text in row and column titles (you could always use
superscript, subscripts and Greek).

· View all column titles at once . A new tab in the Format Data Table
dialog of Prism 6 lets you see and edit all the column titles. This saves
you from the  scrolling back and forth to edit titles, which was especially
tedious with XY or Grouped tables with many subcolumns. 

2.6.7 What's new? Working with other programs

· LabsArchives. Prism 6 integrates better with LabArchives. As in Prism
5, click “LabArchive it” to upload files directly to LabArchives. Now,  ,
Prism also sends LabArchives a list of all words used in notes, titles,
text boxes, etc. That mean you can search within LabArchives to find
the file you need. From the Welcome dialog of Prism 6, you can open a
file directly from LabArchives. There is no longer a need to first go to
labarchives.com to download the file you want.

· Faster TIFF. Exporting TIFF files at 1200 dpi from Prism Windows is
much faster and more reliable (doesn't lead to out of memory
messages). 
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· Smaller TIFF. Prism Windows can now compress TIFF files at 600 or
1200 dpi, and compress even when you choose the CMYK color model
(not allowed in Prism 5 Windows)

· More exporting choices. When compressing TIF files, choose between
the LZW or packbits scheme. Choose either a RGB or CMYK color model
for PNG files. Choose higher resolution output (up to 1200 dpi) with
JPG. 

· No popup dialog after exporting. After exporting a graph, layout or
table, Prism 5 would always pop up a dialog offering to open the folder
to which the file was exported. When it is done exporting, Prism 6
doesn’t show that extra dialog. Instead, Prism 6 lets you choose, in the
export dialog, whether to open the folder after exporting. You can make
that choice a default for the future. 

· More importing choices. Prism 6 Windows can import more kinds of
images onto a graph or layout. Here is the complete list:

Windows Enhanced Metafile (*.emf)
Windows Metafile (*.wmf)
TIFF (*.tif;*.tiff)
JPEG (*.jpg;*.jp2;*.j2k;*.jpx)
Portable Network Graphics (*.png;*.mng)
Windows Bitmap (*.bmp)
Graphics Interchange Format (*.gif)
Scalable Vector Graphics Format (*.svg)
PC PaintBrush (*.pcx)
TruvisionTarga Format (*.tga)
Microsoft Paint Format (*.msp)
PhotoShop 3.0 Format (*.psd)
Windows Icon and Cursor Formats (*.ico)
Macintosh Pict (*.pct;*.pict)

· Choices when copying excluded values. Prism lets you exclude
values on the data table, where they appear in blue italics. These values
are ignored when Prism makes graphs and analyzes data. Prism 6 offers
three choices for how excluded values should be copied or exported. 1.
Like other values, ignoring the fact that they are excluded. 2.Followed
by an asterisk. 3. As a blank space instead of the value. When
exporting, this choice is set in the export dialog. When copying to the
clipboard, the choice is set in the File & Printer tab of Preferences.

· Choose whether to use period or comma as the decimal
separator. When you copy data to the clipboard, Prism 5 used the
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Windows or Mac control panel settings to decide whether to use a
comma or period (point) as the decimal separator. Prism 6 lets you
choose in the Preferences dialog. This lets scientists who live in
countries where a comma is commonly used still use a period when
copying data out of Prism for pasting into a manuscript that will be read
in other countries. 

· LinkBack support. When you paste a graph or layout created with
Prism 6 Mac into  some other programs, LinkBack let's you double-click
on the embedded graph to return to Prism for editing. This works
similarly to OLE on Windows. But while OLE is part of Windows and
supported by Microsoft, LinkBack is not part of OS X and is not
supported by Apple. It only works with selected Mac apps, and does not
work with Word, PowerPoint or Keynote.

2.6.8 What's new? Parts-of-whole data

· Parts of whole tables.  Prism has always created structured data
tables, and Prism 6 adds a sixth kind of table: Parts of Whole. As the
name suggests, this  table is used for the kind of data where it makes
sense to sum all the values in a data set column, and divide each value
in the table into this total. 

· Pie charts and more.  Each data set column in the parts of whole table
can become its own pie chart, and each value represents one slice of the
pie. Prism will graph column A automatically. To graph the other
columns, use New...Graph of existing data.  Prism can also plot these
kind of data as a donut plot, stacked bar plot, or a percentage dot plot.

· A new fraction of total analysis  computes each value in a table as a
fraction or percent of its column total. In a parts of whole table, each
value represents one slice in a pie chart defined by the sum of all the
values in that column, so this analysis computes the fraction (or
percentage) of the pie represented by each slice. It can also be used
with contingency (or Column,  XY or Grouped, if needed and if there are
no subcolumns) tables to compute each value as a fraction of its column
total, its row total, or the grand total. 

· Compare an observed categorical distribution with an expected
distribution using either the chi-square test (any number of categories)
or the binomial test (works only with two categories).
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2.6.9 What's new? Column graphs

Superimpose individual data points with bars 

Superimpose individual points on a box-and-whiskers plot

Separate groups of columns with a line
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Control the length of the mean or median line in a scatter plot

Connect column means with lines
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2.6.10 What's new? XY Graphs

· Depth charts.  When you assign a graph to a layout, you can specify
that it be rotated 90 degrees. This essentially creates an XY graph
where the independent (X) variable is shown on the vertical axis. As the
graph's name suggests, this kind of graph is used in fields where the
independent variable is depth, which is naturally shown on the vertical
axis.

485
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· Label both sides of the axis.  Place additional ticks and labels across

the axis from the regular numbering. This is helpful, for example, when
X is time, but you also want to label particular times when an
experimental intervention was performed.

· Faster graphing.  Regenerating graphs with tens or hundreds of
thousands of points can be slow. If you are impatient, Prism 6 lets you
specify that a graph only show one out of every K points (you specify
K), to speed up graphing on screen. It also lets you work on the graph
(move things around, add text or drawings, change axis properties,
etc.) as the data points are plotted on screen. 

· Create a graphs with only a right Y axis.  Prism has always made it
easy to add a right Y axis as a second axis. But it has been difficult to
create a graph with a single Y axis positioned on the right side. To do
this with Prism 5 can requires positioning the "left" (only) Y axis in on
the right side of the graph, and then assigning data sets to the “left”
axis, even though it is on the right side of the graph. Confusing! Prism 6
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makes this more straightforward. Turn off the left Y axis, and create a
right Y axis to which you assign data sets. 

· More subcolumns. Prism 6 allows up to 256 subcolumns for replicates.
Prism 5 allowed only 52.

2.6.11 What's new? Grouped graphs

· Draw lines between groups .

· More easily create grouped low-high, box-whiskers, and scatter
graphs.
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· More subcolumns. Prism 6 allows up to 256 subcolumns for replicates.
Prism 5 allowed only 52.

2.6.12 What's new? Layouts

· Unlinked graphs.  Prism 6 lets you assign a graph to a layout as an
unlinked picture, that won't update if the data are edited or replaced, or
if the graph is altered. One use for this is if you want to make several
versions of a graph sequentially, and place each on a layout.

· Resize graph to match length of X axis . The resize graph dialog in
Prism 5 lets you change the graph size to make the entire graph object
have a specified width. But sometimes your goal is to match the length
of axes, rather than the size of the entire graph object (including
labels). Prism 6 now lets you specify the desired length of the X axis,
and the rest of the graph changes size to meet that goal.

· Control the scaling factor on a layout . When you place a graph on a
layout, its size usually changes. For example, the total length of a graph
might be half as long on the layout as it is on the graph. We now term
this value (50%) the scaling factor . If you then add a legend, drawing
or image to the graph, Prism  6 will maintain the scaling factor, so the
graph itself won't change size on the layout (but the graph plus its
legend, drawings, etc will get larger). In contrast, Prism 5 maintained
the size of the graph placeholder, so the graph itself would get smaller
on the layout when you added a legend or text box or image to a graph.

· Enlarge or shrink an entire layout.  Enlarge or shrink an entire layout.
Prism 6 has a new tool to  as well as enlarging or shrinking an entire
graph (which you could do in Prism 5).

· Easier to place a graph from one project into the layout of another.
Prism 5 allowed you to link a graph from one project into a layout of
another. This lets you keep each project compact, and avoids the need
to put all the data and results for one layout in one file. But that feature
has been hard to discover, and used an extra popup dialog. Prism 6
makes it easier to discover and use by placing the choice on the first tab
of the layout dialog.
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· Draw elbow and zig-zag lines.

· Place borders around graphs in layouts . After assigning a graph to a
layout, you can crop it and/or define a border. 

· Thinner lines. We’ve added a new choice to make lines and curves ¼ of
a point thick.  With Prism 5, the thinnest choice was ½ point. You won’t
notice the difference on screen, but you may notice the difference on
printouts or high resolution exported files. 

2.7 What was new in Prism 5?

In case you are upgrading from Prism 4, the pictures below show the
biggest improvements in Prism 5. For details, read this 16 page pdf
document.
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3 How Prism is unique

GraphPad Prism is very different than other
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scientific graphing programs. As you start to use

Prism, be sure to notice these four unique aspects

of Prism. 

· Organized data tables

· Everything is hot linked

· A complete record of your work

· Helps you learn data analysis

3.1 Organized data tables

Formatted data tables simplify graphing

Unlike spreadsheet
programs, and other
scientific graphing
programs, Prism's data
tables are structured or
formatted. Whenever you
create a new data table,
choose one of six table
types. This makes it much
easier to create appropriate
graphs and to choose
suitable analyses.

Enter SD or SEM values computed elsewhere

If you computed error values
elsewhere, enter them onto
labeled (SD or SEM)
subcolumns. Prism’s
analyses (i.e. t test, ANOVA,
regression) will take into

68

72

72

70



How Prism is unique 69

© 1995-2016 GraphPad Software, Inc.

account the SD (or SEM)
and sample size.

Create error bars from raw data

Enter the raw data (i.e.
triplicates), and Prism will
automatically compute and
plot the error bars. You can
instantly switch between
plotting the raw data, or
plotting mean with SD, SEM,
confidence interval or range.

Fit a family of curves at once

Place data for multiple data
sets side-by-side on an
organized data table, and fit
them all at once. You can fit
the same model separately
to each data set, use global
nonlinear regression to
share parameter values
among data sets, or fit
different models to different
data sets.

Easily handle missing and excluded values

Using a command on the
View menu (or via right
clicking, or a toolbar button)
exclude selected values.
Excluded values show on the
data table in blue italics but
are omitted from analyses
and graphs. You can also
leave a cell blank to show
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that its value is missing.
Prism treats missing and
excluded values identically,
and never treats a missing
or excluded value as if you
entered zero.

Computed values are kept separate from raw data

Prism includes built-in
analyses to transform or
normalize your data, or to
subtract (or divide by) a
baseline. Prism leaves your
raw data alone, and places
the calculated values on
results tables. Raw data
tables have a black grid.
Results tables have either
Green grids (when they can
be analyzed further or
graphed) or red grids.

You’ll never confuse raw
data with calculated results.
You'll never wonder how
values were computed.

3.2 Data analysis for scientists, not statisticians

Understandable analysis dialogs  
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Prism presents analysis choices in clear
language, and avoids statistical jargon.

Statistical help when you need it

Consult Prism’s
comprehensive online help
to review the basic
principles of data analysis,
and to understand your
analysis choices.

Review analysis check lists

Once you’ve completed the
analysis, review the
accompanying analysis
checklist to confirm you
made the right choices.
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3.3 Everything is hot linked

Prism links data to results,  graphs and layouts. It also lets you paste link
data from one part of Prism onto a data table.  This has three
advantages. 

· When you fix a mistake in data entry, the results and graphs are
automatically updated. 

· When you open a Prism file, you can retrace every step of every
analysis, and review (or change) any of the choices. You’ll never see a
curve or a P value and wonder how it got there.

· After you’ve polished the analysis and graphing steps with data from
one experiment, you don’t have to repeat all those steps for a repeat
experiment. Prism provides several ways to instantly analyze and graph
a repeat experiment, without repeating any tedious steps and without
requiring any scripting or programming.  

3.4 A complete record of your work

Annotate your experiments with floating notes

Add floating notes to data tables, results and graphs. These notes can be
color coded.
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Record experimental details in Info tables

Use Info tables to record dates, lot numbers, concentrations, etc. These
values can be used as constants when transforming or analyzing data.

Highlight sheets you want to return to

Highlight the pages that you want to review, or want a colleague to look
at. Choose a different color highlight for different purposes.

Change the background color of selected data values or results

Select any cell or range of cells in data tables or results and apply a
background color. 
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Save to the cloud with LabArchives

LabArchives.com enables researchers to store, organize, and publish their
research data. Upload your Prism files directly to LabArchives, and open
them (even from a different computer) directly from Prism’s Welcome
dialog.

Anyone can view a Prism file using the viewer

You can send Prism files even to colleagues who don't own Prism. They
can use the Prism viewer for Windows, Mac or iPad to view all parts of
your file. Details. 

4 Getting started with GraphPad Prism
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Prism is designed so you can just plunge in and

use it. But you'll master Prism more quickly if you

check out the tips listed here, and the guided

examples of data analysis.
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4.1 A brief tour of Prism

This five-minute tutorial will show you a bit about how Prism is organized.

1. When you start Prism, you'll see the Welcome dialog. You'll see six tabs
representing the six kinds of data tables. Click on the Column tab. Then
choose to use tutorial data for an unpaired t test.

Notes:

· To use Prism effectively, you need to learn how to choose which of the 
six types of data table  to select.  

· Note the distinction between choosing sample data or creating an empty
table into which you can enter or import data.

161
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· Choosing the tutorial data for the unpaired t test only fills the table with
data. You'll choose an analysis in the next step.

2. Note that the tutorial data comes with a floating yellow note that briefly
explains the data format, and links to more detailed online help. 

3. From the data table, click Analyze and then choose the t test analysis.
Alternatively, click the t test shortcut button above the Analyze button.
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4. On the first tab of the t test dialog, confirm that the experimental
design in unpaired and that you want to assume a Gaussian distribution
and to perform an unpaired t test. For now, you can accept all the
defaults on the second tab. Click the Learn button to read explanations
of all the choices..
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5. View the results. Click the analysis checklist button to help interpret
the results. Click the Results button in the upper left corner to open the
Analysis Parameters dialog to perhaps change to a paired or
nonparametric test. 
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6. In the navigator on the left, click on "Unpaired t test data" in the
graphs section. The Change Graph Type dialog will pop up. Choose the
kind of graph you want, and see how that choice will look. We suggest
choosing a Scatter plot, and plotting a line at the mean. 
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4.2 Essential concepts

To use Prism effectively, you need to understand these essential
concepts:

Prism data tables are organized. It is essential to choose the right kind of
data table.

Unlike Excel or most statistics programs, Prism's data tables are
organized with a structure or format. To use Prism effectively, therefore,
you must learn the distinction between the six types of data tables .
Don't try to choose the kind of table based on the kind of graph to make.
That approach doesn't always work. Choose a table based on the
organization of your data and the analyses you wish to perform. 
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A Prism project can contain many data tables and graphs

A Prism project (another term for a Prism file) is not limited to a single
graph or data table, but rather can contain up to 500 data tables, graphs,
analyses, and page layouts.

Prism can automatically plot error bars from raw data

One of Prism's strengths is its ability to handle replicates and error bars.
For XY and Grouped tables, replicates are placed in side-by-side
subcolumns. For Column tables, replicates are stacked in each column.If
you enter replicate values, Prism can plot either individual replicates or
error bars. It can plot error bars from the replicates you entered
automatically. You don't have to specify any calculations.

When you edit or replace data, analyses and graphs are automatically
updated

Prism remembers the logical links between data tables, info sheets,
results tables, graphs and layouts. When you edit or replace data, Prism
automatically recomputes linked analyses and redraws linked graphs.

Analyses can be chained

Results tables can be analyzed further. From any results table with green
grid lines, click the Analyze button. This lets you, say, first transform
your data, and then fit a curve (nonlinear regression) to the results. 

By default, Prism creates one graph for each data table you create, but
this should not limit you. You can plot a table on multiple graphs. And you
can plot data from multiple data tables on one graph. 

Recycle your work

Once you've analyzed and graphed one data table, it is easy to repeat
your work with new data by duplicating a family  or cloning a graph .134 135
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4.3 Welcome dialog

When you launch Prism, or use File..New to begin a new
project, you'll see the Welcome dialog. 

New table & graph

Most of the time, especially when new to Prism, you'll use
one of the six tabs on top to create a new table  and
graph. Within each of these tabs, you have the choice of
beginning with a new empty data table or beginning with
tutorial data (with instructions).

Open a file

Click on a folder or file to open it. Or click on "Desktop and
other folders" to browse all your files.

After you have used Prism a bit, you may see files listed
under the heading Unsaved Files. How can you open a file
that wasn't saved? When you exit Prism (as with any
program), it asks you whether you want to save changes to
every open file. If you click No, Prism still saves the file in a
special location for four days, and shows it in the list of
unsaved files. 

LabArchives 

LabArchives is an innovative web-based product that
enables researchers to store, organize, and publish their
research data. Far more than an "ELN" (Electronic
Laboratory Notebook), LabArchives stores and catalogs all
of your research for easy retrieval and publication. You can
save files to LabArchives from Prism. And you can open
Prism files saved on LabArchives from the Welcome dialog,
without going to www.labarchives.com.

Clone a graph

Cloning a graph is making a copy of it, along with the data
table and any linked analyses. At the time you clone a
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graph, Prism will give you the option of deleting the data.
Add your own data, and your done. From the Welcome
dialog, you can clone from any file (project) that is open,
from one you've used recently, or from projects you've save
as examples.

Portfolio

Open an example Prism file, containing a polished graph,
simple or complex. Explore these portfolio graphs to learn
how to get started with Prism and to learn some of its
advanced features. People who have already learned the
basics of Prism will appreciate these portfolio files more
than beginners.

.

4.4 Graph Portfolio

From the Welcome dialog, click on the Graph Portfolio tab to browse
dozens of polished graphs. Open any of them to see how they were made.
Most come with explanations on floating notes.
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4.5 Tutorial Data Sets

When you choose to create a new data table from the Welcome dialog, you
can start with a blank table or with tutorial data. The tutorial data comes
with explanations and is a great way to learn how to use Prism.

4.6 The five sections of a Prism project

A Prism project can contain a lot more than a single graph or data table.
A  Prism project (file) has five sections. Each can contain up to 500
pages (also called sheets): 

Data tables

Enter and organize your data for analyses or graphs. Learn
more.  159
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Info tables

Keep a record of experimental details, or of constants you want to
use in analyses. Learn more .

Results

These sheets show the results of your analyses. You can copy from
here and paste parts of your results onto graphs. Learn more.

Graphs

147
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Once you enter your data in a data table, Prism automatically
creates a graph. You can customize any part of a graph. Learn
more.  

Layouts

Combine several graphs or other sheets in a layout for printing or
publishing. You also can send layouts directly to PowerPoint and
Word. Learn more.
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4.7 Adding new sheets to your project

Click the New button on the Sheet toolbar and choose what kind of sheet
you want to create. The first choice is used the most. It adds a new
empty data table and linked graph  to your project. 

You can also add a New Data Table (No Automatic Graph), a new Info
sheet , a new graph of an existing data table , or a new layout . To
be complete, this menu also lets you add a new analysis, but you'll find it
easier to start at a data table or graph and click the Analyze button .

Don't overuse this New button. You can also add to your project by 
duplicating a family of sheets  or by cloning a graph . 

4.8 Tips for using Prism

 Expand all tips
      

Collapse all tips

Getting started tips

Before using Prism for the first time... 

If you are new to Prism, start by reading this one page list  of
essential concepts.

Also consider arranging on-site training .

 Pay attention to the distinctions between the six kinds of data tables

When you create a new data table, choose between a XY ,
Column , Grouped , Contingency , Survival  and Parts of a
Whole  table. Understanding how these tables are used will make it
much easier to use Prism effectively.
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 Learn about the various approaches to making bar graphs

Spending a few minutes reading about the various approaches to
making bar graphs  will prevent some aggravation later. Bar 
graphs can be created from Colum, Grouped, XY or Contingency
tables.

Recycle your work

Once you've analyzed data and made some graphs with Prism, you'll
probably want to do similar analyses and make similar graphs with
new data. Don't start again from scratch.  Prism offers four ways to
recycle your work, without programming. You can duplicate a
family , clone a graph , use the Wand to repeat analyses , or
save and recycle templates . 

Navigation tips

View all sheets in the gallery

Click on the Data Table, Info, Results, Graphs or Layouts folder name
in the Navigator to open the Gallery. Or click the Gallery button on
the bottom toolbar.

The gallery  shows all sheets in a section. Double click on the one
you want to go to. Or select several sheets to work on at once .
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Jump between related sheets using the Family folder

Open the Family  folder to see all sheets linked to the current one.
Or click the Link button in the bottom toolbar to jump to one of those
linked sheets.

    

Trace an analysis chain using the Data with Results folder

Open the Data with Results folder  to trace an analysis chain (when
the result of one analysis is the input to another).

Ping pong (flip back and forth) between two sheets

Click the ping-pong button in the bottom toolbar to go to the
previously viewed sheet. Click again to return.

100
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Highlight or annotate sheets you want to return to

Click the highlight  button, and the sheet name will appear
highlighted in the navigator and gallery.

Annotate any sheet with a floating note , then find all annotated
sheets in a  special folder at the bottom of the Navigator .

Search for sheets

If your project is large, click the search button  on the bottom
toolbar to find all sheets that include specified text.

Graphing Tips

Change the color (or size..) of just one symbol or bar

Right click  on any symbol or bar, and you can change its
appearance, apart from other symbols or bars in the same data
set. Or select a range of values in the data table, and change the
appearance of all symbols or bars plotting those  data .

Use Prism Magic to make graphs consistent

Select one (or several graphs), click the Magic  (Make Graphs
Consistent) button, choose an example graph, and all your graphs
will be changed at once.
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Change colors by picking a color scheme

Rather than change colors of every graph element separately, use 
color schemes . You can use ones we provide, or create your own.

Prism can plot error bars directly from raw data

Prism can plot error bars directly from raw data. Prism lets you enter
SD or SEM if you have calculated them elsewhere, but there is no
need to do so. Enter your raw data, and let Prism do the rest. Prism
offers analyses that perform row and column descriptive statistics, but
these are only to help you understand the data. You do not need to
run these analyses to plot error bars.

To add data to a graph, drag a table from the Navigator and drop onto the graph

After you drop the data or results table onto the graph, a dialog will
pop up where you can choose which data sets to include and which
axis to plot those data on (right or left).

Data analysis tips

Don't run the analysis again -- change the analysis choices

If you made a mistake, or want to try different analysis choices, you
can always return to the analysis parameter dialogs. Don't repeat the
analysis unless you want two copies of the results. To open the
analysis parameters dialog, click the analysis parameters in the
upper left corner of any results sheet or in the toolbar.

Use the 'Learn' and 'Analysis checklist' buttons

Click Learn from any Analyze dialog to learn more about the analysis.
Our help goes beyond program help, and explains the principles
behind the analysis.

Once you've finished any analysis, click the Analysis Checklist button
in the toolbar to make sure you are interpreting the results correctly.

330
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Paste results onto your graph

Select any block of tabular results, copy to the clipboard, and paste
onto any graph or layout. This will be a live link. If you change the
data, or the analysis choices, the embedded results table  will
update.

Create chains of analyses, without copying and pasting

Many analyses (i. e. Transform) create results tables that can be
used as a data table. These results tables have green grids, unlike
tables with red grids that contain tabulations of results that cannot
be graphed. From any results table with a green grid, click Analyze
to analyze the results. You can make the analysis chain as long as
you want. For example, you could Transform, then Normalize, then
fit with Nonlinear regression, then transform the residuals from the
regression.

Exporting tips

Use the Send-to-Word and Send-to-PowerPoint buttons

Click one button  and you are done. No need to copy and paste,
or export and import.

Experiment with copying graphs in EMF or WMF format (Windows only)

Prism Windows can copy graphs to the clipboard in one of three
formats. You can tell Prism to only copy one format (File & Printer
tab of the preferences dialog ). If graphs pasted into other
programs don't look right, try all these settings.

Choose export formats carefully

Prism offers a variety of formats . When possible, choose formats
that include information about vectors and fonts (WMF, EMF, EPS,
PDF) over formats that only describe bitmaps (TIF, JPG, PNG).

Send your colleagues complete Prism files rather than exported images
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Anyone can view the complete Prism file, including analysis choices,
using the  Prism Viewer for Windows, Mac or iPad.

Organizing tips

Rename, reorder and delete sheets

You aren't stuck with the sheet names that Prism assigns, or their
order. Rename or reorder  your data tables (and graphs...). When
you rename data tables, linked analyses and graphs are
automatically renamed. Delete sheets  you no longer need.

Highlight sheets you want to return to

You'll see the yellow highlighting  in both the navigator and gallery.

Use floating notes to communicate with coworkers

Click the push-pin icon to add a color-coded floating note  to any
sheet.

     

Record experimental details on info sheets

Info sheets contain both structured information (lot numbers, page
numbers,....) and unstructured notes. Each info sheet can be linked
to a particular data table.

Don't make projects too small or too large

Some people make the mistake of starting a new project for every
data table, not realizing that a Prism project (file) can have up to 500
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data tables, analyses and graphs. You can keep an entire project in
one file.

Don't define 'project' too broadly, because a huge project can be
hard to navigate. You can always merge  projects later, or
include  a graph from one project in a layout of another.

Common mistakes

Mistake: Repeating an analysis rather than fixing it.

If you want to change your mind about analysis choices, you can do
so . You can change the parameters (options) for the analysis. Or
you can change which data table and which data sets are analyzed.
There is no need to start the analysis again, which leaves an obsolete
copy of the results in your project.

Mistake: Duplicating a table in order to make a second graph of those values.

Prism automatically makes a graph of each data table. So when you
want to make a second graph of that same data, people commonly
copy the data and paste onto a new table which is automatically
graphed. No need for that. You can make any number of graphs from
the same table. Just click the New button, and then choose Graph of
Existing Data.

Mistake: Repeatedly formatting a series of related graphs.

No need to change the fonts, colors, line thickness, etc. etc. for each
graph in a series. Instead, format one graph, and use Magic  (Make
Graphs Consistent ) to instantly fix the others. 

Mistake: Making a project too large.

We call a Prism file a "project", but you can decide how large to
make it. Huge files can be hard to navigate. So it often makes sense
to keep files of reasonable size. You can always merge  projects later,
or include  a graph from one project in a layout of another.

Mistake: Going through many steps to make the same graph from a new data set.

There is no need to repeat yourself. Once you have a graph you like,
Prism offers several ways to make that graph again with different
data.  Start by learning to clone a graph . 

Mistake: Not saving milestone backups while working on a large project.

123

480

263

317

317

123

480

135



Getting started with GraphPad Prism 97

© 1995-2016 GraphPad Software, Inc.

When working on a large project, do more than backup the current
version. What happens if you mistakenly delete key data? What
happens if the file someone gets corrupted? Use Prism's Backup
command  to save interim versions as you work. 

 Expand all tips
      

Collapse all tips

4.9 Differences between Windows and Mac versions

We work hard to keep the Windows and Mac versions of Prism very
similar. You can switch back and forth between platforms easily, and files
created on one platform can be opened on the other. But there are a few
differences.

Features in Windows but not Mac:

· Object linking and embedding . This means you can paste a Prism
graph into another program and double-click to edit in Prism. We wish
we could allow this to work on Prism Mac, but Apple and Microsoft
simply do not provide the "hooks" Prism would need.

· Excel linking and embedding . This means you can paste Excel data
into Prism, and double click to edit within Excel. We also wish this were
possible with the Mac. 

· Import and export EMF and WMF images. These formats are only used
on Windows computers.

· Send to Word with a single click .

· One click to post a graph or layout on a web site .

· High contrast printing, with no grays and no colors (choice on
Preferences dialog).

· Visual Basic for Applications (VBA) commands  to launch Prism and
start a script.

· Find Prism files using Google Desktop Search.

· Export in the older PCX format.
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 Features in Mac but not Windows:

· Automatic saving. Prism Mac uses the OS X features Resume and
Versions , which may seem strange at first. 

· Spell checking of text anywhere in the project

· Quick Look lets you preview graphs within Finder.

· Color eyedropper. While setting any color, click the magnifying glass
tool, then click on any color on any window to select that color.

· Use an Automator action  to launch Prism and run a Prism Script;

· Choice of color model ( RGB, CMYK, or Grayscale) when exporting in
JPEG format.

File compatibility

Files saved on one platform can be opened on the other. In almost all
respects, this just works and you don't have to think about it. But there
are two exceptions:

· If you use Prism Mac and copy a graph from one project and paste it
onto a layout on another project, Prism can handle this in two ways. By
default it pastes in a form that works only with Prism Mac. If you open
the project in Windows, that graph will be missing from the layout. Use
an option in the Files tab of Prism Preferences to save in a compatible
format. On the Mac, you will notice that the files will be larger and
pasting graphs from other projects noticeably slower (but still only a few
seconds). Now the file will open fine in Windows.

· Tabs within titles or text objects are handled differently on Windows and
Mac. If you include tabs within text objects, the spacing of that text may
change a lot when you open it on the other platform.

5 Getting around in Prism
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Prism is easy to use. Use the Navigator tree to

move between parts of a project, and toolbars to

perform tasks.
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5.1 Navigator -- See all sheets in your project

Each section of a Prism project  (Data tables, Info Sheets, Analysis
Results, Graphs, and Layouts). can contain up to 500 sheets (pages).

The most versatile way to jump from sheet to sheet is by using the Prism
Navigator tree on the left side of the Prism screen.

The names of all sheets related to the current sheet are shown in bold.
Click on any sheet name to go there.

If you need more room to work, click the button in the lower left corner of
the Prism window to hide the Navigator. Click it again to bring the
Navigator back.

See also:

Tips for navigating large project
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5.2 Gallery - View all the sheets of one type

The gallery shows you thumbnails (small images) of all the sheets in a
section at once.

To view the gallery, click on the folder name in the navigator. Click on
"Family, Data Table", "Info", "Results", "Graphs" or "Layouts".  

Another way to view the Gallery is to click its button on bottom toolbar.

Notes:

· Don't confuse the Gallery, which shows you all the sheets in your
project, with the Portfolio which shows you a set of polished graphs
you can use as examples.View the Portfolio from the Welcome dialog.

· From the gallery, double-click on any thumbnail to leave the gallery
and go to that sheet. This is the main purpose of the gallery -- to help
you quickly find a particular sheet and go to it. Alternatively, you can
leave the gallery by clicking on the gallery button in the lower toolbar
shown above.
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· Drag and drop sheets to change their order.

· Click on option boxes in front of the sheet names to select multiple
sheets. Once you've selected a set of sheets, you can delete, use 
Magic , and much more . 

 

5.3 Graph and layout tool tips

Some of the tool tips in Prism do more than provide information. They
also provide links to take you to other parts of the project.

Hover your mouse over a symbol on a graph to see the value, and
location of the data point. Click on the name of the data (or results)
table to go right to the correct spot on the data table.

Hover your mouse over any graph on a Layout. A tool tip will appear
with a link to the graph. Click on the link to go to the graph.

317 144
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5.4 Changing the zoom

Zoom buttons

Use the Zoom buttons located on the lower right side of the Prism screen
to enlarge or shrink the view of the current sheet. You can also use the
Zoom tools to make thumbnails in the Gallery  larger or smaller.

On graph and layout sheets, Zooming lets you see more or less of the
sheet, but doesn't change the size of the graph or layout when printed.
Click here to find out how to actually resize graphs  and layouts.

On data tables and analysis results sheets, the Zoom buttons not only
change what you see, but they also actually change the size of the font
Prism uses when you print. If you want to get more of your data table on
a printed page, Zoom Out to make the font smaller.

Keyboard shortcuts
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Shortcut: Hold the Ctrl key and press M to zoom larger or J to zoom
smaller.

Mac gestures

Starting with release 6.0c (and if you use Lion or later), you can zoom
Prism Mac by pinching with two fingers, but only if that gesture is turned
on in the Trackpad control panel. You can also smart zoom by double
tapping with two fingers. Depending on where you tap, that will zoom you
in to see the entire page, the graph plus all other objects on the page, or
just the graph. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5.5 What if the toolbar or navigator is missing?

It is possible to use Prism without the Toolbar (top) and Navigator (left),

http://www.graphpad.com/faq/viewfaq.cfm?faq=1528
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and this can be useful on computers with  tiny screens. But it is easier to
learn Prism with both the Toolbar and Navigator showing. If someone else
using the computer has turned off either, it is easy to bring it back:

· If the toolbar is not showing on your computer, drop the View menu and
choose Main Toolbar.

· If the Navigator is not showing on your computer, drop the View menu
and choose Navigator.

· If the bottom toolbar is missing, choose Bottom Toolbar on the View
menu.

5.6 Opening multiple Prism files

Distinguish multiple sheets in one project file from multiple files

A Prism project can have multiple pages or sheets , divided into five
sections . These are all saved in one Prism .PZF or .PZFX file. Of course,
you can export individual data tables or graphs, but this is not the same
as saving the entire project as one Prism file. 

People new to Prism often make the mistake of thinking that each Prism
file can only have one data table and one graph. Not so. Each file can
contain up to 500 data tables, info sheets, analysis results, graphs and
page layouts.

Prism lets you open more than file at a time

While working with Prism, you can open multiple Prism files. The details
are slightly different for Windows and Mac. 

Prism Windows. Multiple open projects in one overall Prism window.

There are two ways to work on a second Prism project. 

If you use the File..New or File..Open commands (or the corresponding
toolbar buttons), you'll open a second project within the overall Prism
window. You can then open (or create) a third, fourth... project. All are
contained within a master (parent) Prism window. This means that even if
you use two (or more) displays, all these projects must be shown on one
computer display. All open projects share the same toolbar.

100
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Use the Window menu to move from one project to another. Use the
Navigator or bottom toolbar to move between sheets in one project file.

Prism Windows. Two open projects in distinct Prism windows.

If you want to open a second Prism window, simply launch Prism again.
To do so, you must double-click on the program icon. Double-clicking on a
Prism file when Prism is running will always open that file in the instance
of Prism already running. To launch a second instance of Prism, double-
click on the program icon. It is not possible to launch more than two
instances of Prism. (Opening two distinct Prism windows is new to Prism
6.)

Once you have a second copy of Prism running, you can open any file
within it. If you open a file that is already open in the other copy
(instance) of Prism, then you won't be able to save any changes unless 
you use File..Save As and choose a new file name. Any changes you make
in one instance of Prism will not be seen in the other. Use the second
launch of Prism to view one sheet (say a page of results) while you edit
another sheet (the graph) in the original launch of Prism. 

The Windows menu of each instance of Prism will only show files open in
that instance. 

Prism Mac before Sierra

There is no concept of a parent or overall Prism window when you use
Prism Mac. Each project file you open or create is in its own window. You
can move each project to whatever display you want. The Windows menu
lists all open Prism projects.

Prism Mac after Sierra

MacOS Sierra introduces the possibiltiy of putting multiple Prism files into
a single tabbed window. The files are distinct (not merged) but they all
will be in one window, with a row of tabs that let you choose which file
you want to view. This can make it easier to be organized, especially if
you work with a small display. Details . 

5.7 Tabbed window with MacOS Sierra

A new feature in MacOS Sierra lets you put several files into one window
and navigate between them using tabs.  This is a great way to work on
multiple files at once, especially on a small screen. Apple calls this feature
"Tabbed Windows".

106
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When you create or open multiple files with Prism Mac, it looks like this.
Each project file is in its own window with its own toolbar. 

Until Apple released MacOS Sierra, this was the only way to work with
multiple files in Prism Mac. But Sierra lets you put them all into one
Window. Drop the Window menu on any of the Prism files, and choose
"Merge All Windows". 

Now there is only one Prism Window, with a set of tabs just below the
toolbar that let you choose which project file you are working on:
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Notes:

· To work on another window, click the + button to the right of the file
selection tabs which will bring up the Welcome dialog.

· There are three ways to move a file into its own window and away from
the tabbed window:  Control-click on the tab and choose Move Tab to
New Window; grab the tab and drag it away from the joint window; or
drop the Window menu and choose Move Tab to New Window.

· There is no way to have one window with one set of files, and another
window with another set of files. Each file is either in its own window, or
in the single tabbed window.

· Keyboard shortcut: Hold Control and click Tab to move to the next
project file in the tabbed window. Hold shift and control and click tab to
go to the prior project file. 

· Putting multiple files in one tabbed window is simply a convenience to
make it a bit easier to move between files. The files are still all distinct,
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saved in different names. Putting multiple files into one tabbed window
does not merge the files. 

5.8 Tips for working in a small window

Working on a small screen can be difficult. To free up space to have more
working space: 

· With Prism Mac, you can click the green circle the top left of the toolbar
to run full screen. When you use the View menu to view or hide the top
toolbar, the navigator or the bottom toolbar, those choices will apply
only to the full screen view. You can make different choices for when the
Prism window does not fill the screen. 

· Hide the Prism Navigator tree. To hide the navigator, use a command in
the View menu or the leftmost button in the bottom toolbar.

· Hide the main (top) toolbar, and use the menu commands instead. To
hide the toolbar, use a command in the View menu. 

· You can also hide the bottom toolbar, but  we suggest you don't. If you
hide the navigator, you'll want to use the bottom toolbar to navigate
from sheet to sheet and section to section. 

· With MacOS Sierra, you can put multiple Prism files into a single tabbed
window . 

 

6 Prism files
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A Prism project file (or PZF file) contains all the

pieces of a project.

6.1 Overview: Resume and Versions in Prism Mac

Versions and Autosave have been part of OS X since 2011, but are new to
GraphPad Prism 7. Apple thinks these features are so intuitive they don't
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need explanation. For those who disagree, we created a lengthy
explanation .

Here are the big ideas:

· As you work, your file is automatically saved. You don't have to think
about saving. Close a project file when you are done working with it.
Open it when you want to work on it again.

· When you quit Prism, it remembers the files that were open. When you
next launch Prism, those files will open again. This means you won't see
Prism's Welcome dialog unless you closed all open files before quitting.

· If you need to, you can revert a file back to how it was an hour (or a
day...) ago.

· The File..Save command has a new purpose after its first use to specify
a file name and location. After that, use the Save command to save a
milestone you can revert to.

· The File..Save As command is gone, replaced with three new
commands: Rename, Duplicate and Move. 

· Two settings in the General tab of Systems preferences affect how your
work flows: whether to keep changes when closing a document, and
whether to open the documents you were working on when you start an
application. These apply to all applications that use the new way of
working, not just Prism. We suggest you keep both options checked.

6.2 Details: Resume and Versions in Prism Mac

Note that this page only applies to Prism Mac, not Prism Windows. 

Versions and Autosave have been part of OS X since 2011, but are new to
GraphPad Prism. If you use iWork (Pages, Numbers and Keynote), you
are already familiar with these features. Since we know that many Prism
users will have not encountered this new way of working before, we detail
how these features work below. But note that we simply implemented the
framework that Apple created, so have no ability to fine-tune how it
works. 
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Important settings in the General tab of System Preferences

Two setting in the General tab of System Preferences have a huge impact
on how Prism acts when you close a file or exit Prism.

By default, both are unchecked. Both options apply to all applications that
use Autosave and Versions, not just Prism. Most of this page assumes
that you have left both options unchecked (the default), and we urge you
to use Prism for a while this way to get used to the new approach. What
happens when you check these options is explained at the bottom of this
page. 

A new mindset

When working with previous versions of Prism, as with Microsoft Office
and many other programs, you had to always remember that you were
editing a transient document in computer memory. If your computer
crashed (or lost power for a fraction of a second), your work was gone
unless you had saved it. Prism had an automatic backup feature to
recover your work when this happened. So you had to remember to
frequently save work in progress. This made sense in the days of floppy
disks, but those days are long gone. 

Prism 7 now conforms to the new paradigm that Apple created for
working with files. There are three new big ideas:
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·  As you work, your file is automatically saved. You don't have to think
about it. Close a project file when you are done working with it. Open it
when you want to work on it again. You'll always be working on the
latest version and don't have to think about saving. 

· When you quit Prism, it remembers the files that were open. When you
next launch Prism, those files will open again. This means you won't see
Prism's Welcome dialog unless you closed all open files before quitting.  

· If you need to, you can revert a file back to how it was an hour (or a
day...) ago. 

 A new way to work

Once you get used to it, this is a much better way to work.  

The Save command has a new purpose

The File..Save command still exists, but its purpose has changed. When
creating a new project, use this command to specify its name and
location. After that, use this command when you have completed a chunk
of work, and want to save a milestone you can revert to (see below).

No File..Save as command

The File.. Save As was always annoying because it rarely did exactly what
you wanted. So Apple removed it and replaced it with three new
commands on the File menu:

· File..Duplicate. Make a copy of the file (which you can name), and then
edit the copy while leaving the original alone.

· File..Rename. Rename the file you are working on. You'll enter the new
name at the very top of the Prism window.

· File..Move. Move the file you are working on to a different folder or
drive. 

If you really want to use the old File..Save As command, there are two
ways you can:

· Hold down the Option key while dropping the File menu. Now the Save
as... command appears (instead of Duplicate).
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· Click the Save button on the toolbar that drops a menu. That menu
includes Save As.

There is one purpose of Save As that is not available with the other
commands. If you have saved the file in .pzf format and want to switch to
.pzfx. Or the other way around. 

Reverting files

A version of your file is saved when you open a file, when you choose the
save command, and occasionally while  you work on it. The File.. Revert
To command lets you revert your file back to how it was when you opened
it, to how it was the last time you explicitly saved it, or to browse all
versions to find the one you want to restore.

 When you ask to browse all versions, the Revert screen fills your display.

The left side shows the current document. 

The right side shows a stack of older versions.. Use the buttons near the
bottom right to step through the versions. There is a bug (by Apple) so
sometimes these buttons appear gray/unavailable. Click them anyway --
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they work. If you have lots of saved versions, use the time line on the
right side of the window to fast forward to the version you want. 

Click on a version to temporarily open it and view all of its contents. If
you don't want to revert to any older version, click Done to keep working
with the most recent version. If you do find a version you want, click
Revert to go back to that version. The current version won't be entirely
deleted, and you can fast-forward back to it, in the version browser.

Notes on reverting files:

· You are only able to browse prior versions so long as you work on a
single computer, as the information about prior versions is not saved in
the file itself, but rather is saved in hidden files on your computer. 

· To delete a version or all old versions: Select that version on the right
side of the revert screen, move the cursor to the top of the screen to
see a menu, drop the File menu, choose Revert to, and you'll see the
new command "Delete this version". Hold Option and that command
changes to "Delete old versions" to delete all  versions (except the
current one, of course). 

· While in the revert screen, you cannot switch to other applications. To
leave the Revert screen you need to click Done (to make no changes) or
Revert.

· To save an older version while also saving the current version: Click on
the version you want, move the cursor to the top of the screen to see a
menu, drop the File menu, and choose Restore a copy. If you have
selected the current version (on the left), this command changes to
Duplicate. 

· Instead of reverting, you can select data or text (but not graphs or
layouts) from an old version, copy to the clipboard, and then paste into
the current version. In some situations, this is more useful than
restoring an old version entirely.

Rename, tag and move from the top of the Prism Window

Hold the mouse cursor over the file name at the top of the Prism window,
and you'll see a downward pointing arrow. Click that arrow, and you can
rename the file, add tags, move it to a different folder, or lock it. 
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Notes:

· The full file name is shown, including the extension .pzf or .pzfx. You
cannot change the extension from here. You'd need to use the File..
Save as command (see above; you need to hold down the Option key).

· Locking is not secure. There is no password, so anyone can unlock. Its
purpose is to prevent accidental changes. No, it is not very useful!

· When you click in the Tags field, a list of current tags (including color
codes) will drop down. You can also tag files in Finder, and search there
for files by tags. A file can have more than one tag. You can also enter a
new tag. Tagging is an OS X feature, not a GraphPad feature.

· The list of locations is limited to top-level folders, or folders you have
used recently. The last entry in the file list is Other. Double click "Other"
to open a Finder-like window that lets you choose any drive or folder. 

Settings in the System Preference dialog

As mentioned at the top of this page (with screen shot), two settings in
the General tab of the System Preferences dialog affect how Prism saves
files. 

Ask to keep changes when closing documents

With the new way of working,  Prism doesn't prompt you when you close
a named project with unsaved changes because the changes are
automatically saved. When you open that file again, you'll see the latest
version. If the project is new, and not yet named, Prism will prompt you
to name it or delete it when you close its window.
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If you check the setting in General tab of System Preferences, "Ask to
keep changes when closing documents", Prism asks you what to do when
you close a document with unsaved changes:

If you click Save, Prism saves your latest work before it closes the
document. 

If you click Revert Changes, Prism reverts any automatic saves so the
document that gets saved is the same as it was the last time you
explicitly saved it. 

Since this option is in system preferences, it applies to all applications
that use the modern way of working, not just to Prism. 

It reminds you of the old way of working, but it doesn't reset things all
the way back. We recommend not using this option, as it isn't really
helpful.

 Close windows when quitting an app

With the new way of working, when you launch Prism the projects that
were open when you exited Prism open automatically. You won't see the
Welcome dialog if any project windows were open when you exited Prism.
The idea is that you open a document when you want to work on it, and
close it when you are done (for now). Launching and quitting Prism has
nothing to do with with when project files are open. 

If you check the  setting in General tab of System Preferences (see top of
this page) "Close windows when quitting an app", then Prism will save
and close all the projects when you quit. If a project file is not yet named,
Prism will ask you to name it. When you next open Prism, you'll see the
Welcome dialog and no projects will open automatically. 

This seems like a useful personal preference. Check this option if you
want to start fresh with the Welcome dialog each time you launch Prism.
Don't check it if you like the idea of that when you launch Prism, it opens
the files you left open the last time you used Prism. 
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Since this option is in system preferences, it applies to all applications
that use the modern way of working, not just to Prism.

Automatic backup

Prism has had automatic backup since version 3. You won't notice any
difference in Prism 7, but now Prism uses the built in automatic backup
feature provided by Apple, instead of using our homegrown method. In
the File tab of Preferences, choose how often you want to save automatic
backups and whether you also want a backup made whenever you view a
different sheet. We suggest saving backups every few minutes and
whenever you view a new sheet. 

The purpose of automatic backups is to restore your work if your
computer (or Prism) freezes or crashes, so you want frequent backups.
These automatic backups do not all appear in the Revert screen (which
would be overwhelming).

6.3 PZF vs. PZFX files

Two formats

When you save a Prism file, you save the entire project into one file. You
have a choice of two file formats:

· PZF format: This is a binary format that can be opened by Prism 4 or
later, but not by other applications.  

· PZFX format: This is a format that can be opened only by Prism 5 or
later. The first part of the file contains all the data tables and info sheets
in a plain-text XML format that can be viewed by other programs. After
that comes information about results, graphs and layouts in a format
that is incomprehensible to any program but Prism.

Advantages of PZFX compared to PZF
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· The PZFX format is a bit more secure for long-term backing up. Even
without access to Prism, the data in the file are in plain text that can
readily be viewed.

· The PZFX format is very useful for data interchange. With a bit of work,
someone could write a program to replace the data in a .PZFX file with
new data. When you open that file, you'll see the new data analyzed and
graphed.

· Files saved in PZFX format tend to be much smaller (about 10% the
size) than the same file saved as PZF. We recommend that you use
PZFX files routinely.

· The data (and info and scripts) are in a plain text format at the
beginning of the file. It is possible to create a program that swaps out
the saved data with new data. Open that altered file, and the new data
will instantly be analyzed and graphed.

Disadvantages of PZFX compared to PZF

· Prism 5 was the first version that understand the PZFX format, so these
files cannot be opened by Prism 4.

· Avoid the .PZFX format if you plan to post the file on a web site. Web
browsers sometimes detect the XML format, and try to open the file
with some program that understands XML rather than opening with
Prism. In contrast, .PZF files generally just open in Prism, as they
should.

· The PZFX format never contains analysis results, so Prism needs to
recompute the results when it opens the file (or when you view those
results pages or graphs that depend on them). If your analyses are very
slow to recalculate, choose the PZF format with the Compact option
turned off (see below). These files will contain analysis results, so Prism
will not need to recalculate anything when you open the file. 

Compact PZF format

Prism has an option to save PZF files in compact format. All the compact
format does is leave out analysis results. Files with lots of complicated
analyses will be smaller if saved in compact form, but all those analyses
will need to be recomputed when the file is opened, which can take time.
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Choose to use, or not use, the compact format in the File tab of
Preferences. PZFX files are always saved in the compact format. 

Zipping the file with standard zipping software can do a much better job
of compression. To really make a PZF file as small as possible, save it
compact and then zip it.

Check the box in the Preferences  menu if you want to save in compact
format as a default.

6.4 File compatibility between Prism versions

Upward compatibility

Prism 7  can open all files created by earlier versions of Prism, including
.PZM files created by Prism versions 1 to 3. 

Downward compatibility

We have done extensive testing to make sure that Prism 6 can open
Prism 7 files. When Prism 6 lacks a Prism 7 feature, the result is
sensible. 

We have not tested opening Prism 7 files in Prism 5 and earlier. It will
probably work ok for many files, but this is not something we have
tested.  

The location of analysis results may change between versions

When you open a Prism file on a version different than the version it was
created on, results also may appear on different rows of the results
tables. This means that results tables embedded on graphs may no longer
show the results you care about, and scripts may export the wrong
values. You may have to do a bit of clean up to make the files work as
intended.

153
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File compatibility between Windows and Mac Prism files

The Windows and Mac versions of Prism use the same file format, and you
can go back and forth without any special conversion.

Compatibility of Prism objects saved within other documents

On Windows (but not Mac), when you paste a Prism graph or layout
within Word or PowerPoint (or some other programs), you can paste just
a picture, paste a link, or embed a Prism object. If you paste a link or
embed an object , you can then double click on that image to edit within
Prism. This works only if the correct version of Prism (or the GraphPad
Prism Viewer) is installed or a newer one is installed on your computer.

6.5 Backing up Prism files

Automatic backups

Choose automatic backups on the File & Printer tab of the Preferences
dialog and Prism will automatically save your work. Choose to save based
on a timer (every few minutes) and/or whenever you switch from one
sheet to another. The backup files are also saved whenever you save your
work, so the backup files can never be older than your project files.  

When you quit Prism normally, the timed backup files are deleted. In case
of computer disaster, the backup files will remain on your hard drive.
When you restart Prism, these files will automatically load so you can
continue your work. Note a potential problem: After a crash, the
automatic backup system works fine if you launch Prism as an application.
But if you double-click on the file you were working on, then you open
that saved file, not the backup that Prism saved elsewhere. 

If you need to find these files, which have the extension .PZB, their
location depends on which operating system you use:

Windows XP C:\Documents and Settings\[username]\Local
Settings\Temp\

Windows Vista,
or Windows 7-
10

C:\Users\[username]\AppData\Local\Temp\

523
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Mac OS ~/Library/Application Support/GraphPad/prism/7/Prism
Backups

Manual backups of Prism files

Prism provides an unusual way to save backup copies of your projects.
Click on the Save Special button in the File section of the Prism toolbar,
and choose Save a Backup. Prism will save a copy of your project to the
location and name you specify, perhaps to a network or CD drive.

Note the difference between Save As and Save a Backup. When you use
the Save a Backup command, Prism doesn't rename the file you are
working on -- it simply saves a copy of that project with a new name.

We recommend that you backup to the .PZFX format (rather than .PZF)
because it provides a more secure backup. It is possible (with some
difficulty) to extract your data from these files without Prism, even if the
file is damaged or truncated.

Recovering files you forgot to save!

When you exit Prism Windows (as with any program), it asks you whether
you want to save changes to every open file. Have you ever clicked No by
accident and lost your work? Prism 6 saves the file anyway, in a special
location, and keeps it for four days. You can open those “unsaved” files
from the Welcome dialog of Prism Windows. If you delete the file, Prism
will automatically delete the backup file, and not offer to recover it. 

If you share a computer with others and don't want your unsaved work to
be recoverable, you can turn this feature off on the File & Printer tab of
the Preferences dialog.

Manual backups of Prism data tables

You can backup individual data tables using the File Export command. You
can export to plain text tables (delimited with tabs or commas) or to an
XML format. We recommend using XML format, even though it is harder
to view, because it contains more information. XML format includes
details omitted from the plain text formats, including about subcolumns,
excluded values, and floating notes.
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6.6 Merging and splitting projects

Merging

Prism offers two approaches to merging two Prism projects.

To merge an entire Prism project into another, drop the File menu and
choose Merge. Pick a file (which must not be open), and all sheets from
that file will be appended to your current project. Prism places an asterisk
(*) in front of the name of each merged sheet.

It is also possible to merge just one graph and its related sheets into
another Prism project. To do this, do not use the Merge command.
Instead, copy a graph from one Prism project and then paste it into a 
Layout  in another project.  The Place Graph on Layout dialog lets you
choose to merge the graph and data into the new file. The alternatives
are to maintain a link to the original Prism file so that changes in the
original will update in the current file, or to paste just a picture of the
graph.

Splitting

Prism offers two approaches to splitting apart a Prism project.

To save one family of sheets into a new file, choose Save Special from the
File section of the Prism toolbar, and then Save Family As. This will save
the current sheet along with all linked sheets. 

To save the entire project with a new name, drop the File menu and
choose Save As.

Once you've saved a copy of the file, or part of it, you'll want to delete
unwanted sheets from the original project. The easiest way to delete
several sheets is to go to the Gallery for a section and click the checkbox
on several sheets. Then press Delete. When you delete a data table, you
have the option to delete all info, results, and graph sheets linked to the
selected data tables at the same time.

478
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6.7 Emailing Prism files to colleagues

Click on the Send by Email button in the Send section of the Prism
toolbar. You can choose to send a Sheet, Family, or Project. Your email
program will open and create a new message with the Prism file attached.
The format of the file depends on what you choose:

· If you choose to send a data table or results sheet, it will be sent as a
text file. 

· If you send a graph or layout, Prism will send it as a .PDF file.

· If you choose to send a family or project, Prism creates a temporary
copy of the project, and attaches that to the email. Changes you make
after choosing the Send Mail command will not be included in the email,
even if you delay sending it. 

These commands probably won't work if you use a web-based email
system or a nonstandard email program. If the command doesn't work, or
isn't available, you can still attach Prism files to email. Simply save the
file, and then attach it to an email from your email program. If you only
want to send a subset of your project, save the current sheet and all
related sheets using the Save Family As command. Choose Save Special
from the File section of the Prism toolbar.

You can send a Prism file even to someone who doesn't own Prism. The
recipient can view the file using a free Prism trial. After the trial expires in
30 days) it becomes a Viewer that doesn't expire. It lets anyone view and
print all contents of a Prism file, including analysis choices, but does not
allow any editing or exporting.

http://www.graphpad.com/demos
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6.8 LabArchives

 Far more than an "ELN" (Electronic Laboratory Notebook), LabArchives
stores and catalogs all of your research for easy retrieval and publication. 

Free LabArchives account for Prism users

Registered users of Prism can obtain a free account on LabArchives.  To
set up this account, go to a graph in Prism, click the LabArchives button
to drop a menu, and choose to "LabArchives it". You will be prompted for
your email address, which is all you need to start an account. You do not
need to enter a credit card number!

Prism integrates well with LabArchives:

· Click “LabArchive it” to upload files directly to LabArchives.

· When it uploads a file to LabArchives, Prism also sends LabArchives a
list of all words used in notes, titles, text boxes, etc. That mean you can
search within LabArchives to find the file you need.

· From the Welcome dialog of Prism 6, you can open a file directly from
LabArchives. There is no need to first go to labarchives.com to download
the file you want.

Logging on to an existing  LabArchives account

If you have a LabArchives username and password, Prism will prompt you
to enter it.

But what if you log in to your institutional server, and the logging into
LabArchives is done behind the scenes using an authorization system like
Shibboleth? In this case, you don't have a username and password
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specific to LabArchives. But you can get one. After logging into the
LabArchives web browser interface, click on your name in the upper right-
hand corner of the screen and click “LA App authentication". The next
screen will show you a username (email) and password for LabArchives.
Use these when Prism asks you to log in to LabArchives. Prism will
remember this information, so you should only need to do this once. 

LabArchives usually uses a server maintained by LabArchives. If you want
to use a local server to host LabArchives files, you can do so. Details
here. 

6.9 Saving vs. exporting

Saving and exporting are different. When you Save your Prism file you
save it in Prism's file format. This type of file can only be opened with
Prism and it contains data, analyses and graphs.

Use Export to save a graph or layout in an image format that can be
imported to another application. If you export a graph  or layout, you
are simply creating a picture of it. You won't export the original data or
any analysis results. You won't be able to open the exported file or edit it,
except as a picture. If you export a data table  as a text file, you are
just exporting the values.

6.10 Template, method and example files

Prism can save your work in three special kind of files designed to let you
save time by not repeating steps with future data. 

· A template is a Prism file that you recycle. Choose a template, add new
data, and all the analyses and graphs will be created automatically. 
Templates  are an older feature, and we recommend you use example
files or method files instead. 

· Example files are files saved in a special location to later be cloned.
Choose to clone an example file  on the Welcome dialog, enter new
data, and all the analyses and graphs will be remade. 

· Method files are files saved in a special location to later be applied
(using the Wand ) to new data you have entered. When you apply a
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method, you apply the analyses and graphs in the method file to the
data table you have already entered. 

Save your work as a template, example or method from commands in the
File... Save special menu. To save an example, you must be looking at a
graph when you save the example. To save a method, you must be
looking at a data table. Templates can be saved from anywhere.

6.11 Closing a Prism file without exiting Prism

There are two ways to close a Prism file without exiting Prism:

·  Use the File..Close menu command. Or File..Close all command to close
all open files but still leave Prism running. 

· Close the file by clicking on an icon. 

Using Windows, distinguish the icon to close a file from the one that
exits Prism. 

 

Using Mac, each open file is in its own window. Close it by clicking the
red circle in the upper left.

 

Why close Prism files without exiting Prism? Because the next file will
open more quickly if you don't also need to initialize Prism by relaunching
it. 
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With either platform, if you close the last open file, Prism still remains
open. On the Mac, you'll see it in the dock and its menu will still be active
so you can open another project or create one. On Windows, the Prism
window will remain open.
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7 Work efficiently. Repeat analyses and graphing

Once you've analyzed data and made some graphs

with Prism, you'll probably want to do similar

analyses and make similar graphs with new data.

Don't start again from scratch. Prism offers four

ways to recycle -- to quickly analyze and graph
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new data using the same steps and format that you

used earlier.

7.1 Working with families of sheets

What is a family?

Prism remembers the links between data tables, info sheets, analyses,
graphs and layouts. Replace or edit the data, and linked analyses and
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graphs will update. We call the current sheet with all linked sheets, a 
family of sheets.

Prism automatically determines which sheets are in a family. You cannot
assign sheets to a particular family.

The Family menu

From anywhere in the program, drop the Family menu to see all the
commands that work with the entire family of sheets related to the sheet
you are now looking at.

Viewing a family of sheets in the navigator

The navigator  shows you which sheets are linked to the current sheet.
Their names are bold. If you have a large project, you may have to scroll
to see all the linked sheets. Prism, therefore, lets you see them all at
once. 

Click the plus sign in front of the Family  folder to see a list of all sheets
linked to the current one. Alternatively, click on the word "family"  itself,
to see all linked sheets displayed in a gallery . When you move to
another sheet, the definition of family will change.
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Working with families of sheets

To navigate a family using the bottom toolbar:

Click the Link button in the bottom toolbar to jump to any linked sheet.

To save a family of sheets:

Drop the File menu, and choose Save Special, and then Save Family
As. Choose a location and file name, and Prism saves just the current
family of sheets into that file. The current full file will remain open, and
Prism will open the new, smaller, file in a smaller Window. Be careful
not to mix these up.

To delete a family of sheets:

Click on the plus sign in front of the Family folder to open it. While
pointing at that folder, right click (control click for macs) and choose
Delete Entire Family from the shortcut menu. 

 To duplicate a family of sheets:

From any sheet, click the New button on the toolbar, and choose
Duplicate Family. Alternatively, right click on any sheet in the
navigator, and choose Duplicate Family.

Starting from a new data table, create an entire family of sheets with the new
data analyzed and graphed:

From a data table (not linked to any graphs or analyses), click the 
Wand  (Wizard to ANalyze Data) button. Choose the table you want
to use as an example, and Prism will analyze and graph the current
data exactly as it analyzed the example data.

Merge a graph and its family into a different project:

Copy the graph, go to a layout of the other project, and paste. You'll
get a choice of pasting just the picture, a picture with a link to the first
project, or to merge in that family of sheets into the project that
contains the layout.
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 The details of how a family is defined

 A family is the sheet you are looking at and all sheets directly related to
that sheet. So if you are looking at a graph, the family includes the data
table(s) plotted on that graph, any analyses included on that graph as
curves or embedded results tables, and any layout(s) that include that
graph. 

Possible ambiguities:

· A graph can contain data from two more more data tables. If you start
from the graph (and save or duplicate its family), both (all) those tables
are part of the family. If you start from only one of those tables, the
other table(s) are not part of the family. 

· A layout can contain many graphs. If you start at the layout, the family
contains all those graphs and all the data and results on those graphs. If
you start from a data table, the family includes the layout, but not the
other graphs (and related sheets) that are also on that layout.

· If you start from a data table, all analyses are part of the family.  But if
you go to a graph that includes that table, only analyses plotted on that
graph (directly, by pasting a table, or by using analysis constants) are
part of the family. Other analyses that are not actually on that graph are
not part of the family defined when you start on a graph.

· Info sheets can either be declared to be linked to a particular data table
or to be global to the entire project. Prism includes an info table when
you first create a new project file, and this info table belongs to the
project  and is not linked to the first data table. To choose, go to the
table, drop the Change menu and choose "Link to data table". If an info
table is linked to a data table, then it is part of any family that includes
that table. If the info table is not linked to a particular data table, then it
will not be part of any sheet's family -- with one exception. The
exception is that when the project contains only a single info table, and
all the other sheets in that project are linked to be part of a single
family, then that info table is defined to be part of that family too.

· Don't confuse two uses of the word family. The term is also used when
Prism does multiple comparisons after one- or two-way ANOVA. The
multiple comparisons calculations are done so the probability alpha
applies to the entire family of comparisons. This use of the word family
in multiple comparisons has nothing to do with a family of sheets.
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7.2 Duplicate a family of sheets

A family  is defined to be a selected sheet and all linked sheets. 

To duplicate a family of sheets, do one of the following:

· Click the New button and choose Duplicate Family.

· Drop the Family menu and choose Duplicate Family.

· Right click (or Control-click if using a Mac) on any sheet in the
Navigator, and choose Duplicate Family

If you are starting from a data table, Prism will ask you to assign a name
to the new (duplicated) data table. If the table name is a subset of the
results and graph sheet names, these will be substituted. Suppose that
the data table is "October data", and is linked to "Nonlin fit of October
data" and "Graph of October data". If you start from the data table and
choose to duplicate family, you can enter "November data" as the name
of the new data table. Prism will then rename the linked sheets to "Nonlin
fit of November data" and "Graph of November data". It can only do this
because the exact name of the data table is part of the sheet names.

 If you are starting from another kind of sheet, Prism will ask you to enter
a prefix that will be prepended to the names of all the duplicated sheets.
In the example above, you could choose to preface all the newly created
sheets with "* ". These new sheets will be "* October data", "* Nonlin fit
of October data" and "* Graph of October data". Of course, you can
rename the sheet titles however you want. 

Prism will duplicate the current sheet and  all linked sheets. Replace the
data on the new data table, and all analyses and graphs will update.

Note the distinction between duplicating a sheet, and duplicating a family
of sheets. When you duplicate a sheet, only that one sheet is duplicated.
If you duplicate a data table, it will not be linked to any graphs. If you
duplicate a graph, the copy will link to the same data table as the
original. This is useful if you want to make two graphs of the same data.
But if you want to make two similar graphs of different data, you'll want
to duplicate the family (or clone the graph ).
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7.3 Clone a graph

Cloning means to duplicate a graph along with data tables and results
included on that graph. Enter a new data set, and it will instantly be
graphed the same way. Clone a graph when starting a new project from
the Welcome dialog. Or drop the New button and choose Data Table (+
Graph).

 

Choose to Clone from an open project, a recently-used project, or a Prism
project that you have saved as an example or has been saved as a shared
example . At the bottom of the dialog is a control where you can choose
the size of the thumbnails. 

Once you choose the graph to clone,  Prism will show a dialog where you
can choose which data and titles to delete. By default, Y values are
deleted, but X values and titles are kept.
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Q&A:

· Are analyses also cloned? It depends. Cloning duplicates regression
lines and curves,and results tables that are included on embedded
tables. Other analyses that are linked to the original data table, but are
not included on the graph, are not cloned. For example, say you have a
data table, analyzed with a t test, and graphed. If you clone the graph,
the t test analysis will only be included if you have pasted a portion of
the results onto that graph.

· To save the current graph as an example to clone in the future, drop the
File menu  and choose Save Special ...Save as Example. Start from a
completed graph. Don't erase the data before saving the example, as
you can ask Prism to remove the data when you clone the example.

· Can you clone layouts? No. But you can go to any layout, and duplicate
that sheet with its family . 

· How is cloning a graph different than duplicating a family of sheets?
When you start from a graph, and duplicate its family, the results are
identical to cloning that graph. To clone a graph, go to the Welcome
dialog. To duplicate a family, go to the selected sheet.

7.4 Use Wand to analyze and graph just like another table

If you've already entered data onto an empty data table, it is too late to
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clone, too late to duplicate a family, and too late to open a template -- at
least without copy and pasting data. 

Prism provides a great tool to solve this problem: the Wand (Wizard to
ANalyze Data). Use it to analyze (and graph) the new table just like you
already analyzed (and graphed) an existing table. 

Follow these steps:

1. Start from the data table (with data) you wish to analyze (and graph).

2. Click the magic wand button on the toolbar, to bring up the Analyze
Data dialog.

3. Choose the existing data table (in the current project) you want to use
as an example. 

4. At the bottom of the dialog, optionally enter the prefix you wish to
appear in front of the new sheet names.

That's it. The new table (where you started from) will be graphed and
analyzed the same as the example table. 

Notes:

· The name Wand is new to Prism 6. This feature used to be called
Applying a Method.

· You can also choose to use the Wand to apply a stored method file. To
save a method file, go to the data table that has been analyzed and
graphed, drop the File menu  and select Save Special… Save Method. 
Where is it saved?  To apply that saved method file, click the Wand
button (or the Analyze button), and then choose Use Saved Method at
the top left of the Analyze Data dialog.

· The same icon is used for both the Magic  and Wand features. Magic
(Make Graphs Consistent) changes the appearance of selected graphs
so they look like an example graph. You can only use Magic when you
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start from a graph, or a set of graphs selected in the gallery. The Wand
analyzes and graphs a new table the way you have already analyzed
and graphed another table.  You can only use the Wand when you start
from a data table with data.

7.5 Templates

What is a template?

A template is a Prism file that you recycle. Choose a template, add new
data, and all the analyses and graphs will be created automatically.
Templates are an older feature, and we recommend you clone a graph ,
or use the Wand , instead.

A Prism template is a regular Prism file, with three differences:

· A template has the extension .pzt. When Prism opens such a file, it will
"forget" the file name and open the file without a name. Then it will
prompt for a file name when you save. This prevents accidentally
overwriting the template.

· When you save a template, you can enter some brief instructions that
will appear when the template is opened. This can be useful when you
are creating a template for others to use.

· A list of templates will appear on the Open a File tab of the Welcome
dialog.

Creating a template

Follow these steps to create a template:

1. Create a Prism project with only the sheets you want to see when a
template is opened. 

2. (Optional) Delete the portions of the data that will change with each
experiment (for example, delete the Y values but leave the X values
and the column titles). Don't delete entire columns, just the values in
those columns by selecting and then using the Delete key. 

3. Go to the data table you want to see when the template is opened,
drop the File menu, choose Save Special, and finally choose Save
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Template. You'll also find this command if you drop the Save menu
from the toolbar.

4. On the Save Template dialog, choose (or create) a category (folder), 
enter a name for the new template, and optionally enter a description
and/or instructions for using the template. If it will be used by others,
you can write a help file for it and install the files onto other
computers.

To use a template

You'll see a list of templates on the Open a File tab of the Welcome dialog.
When you open a template, any description of instructions you entered
will appear in a popup dialog.

Templates on your own

The instructions above assume that you save the template from Prism,
and open it via a link on the Welcome dialog. But you can rename any
Prism file to have a .pzt extension, and open it from Windows Explorer or
Mac Finder by double-clicking on it. The difference is that when Prism
opens a .pzt file, it instantly forgets the file name so will prompt you for a
file name when you first save it.

7.6 Template or method (wand)?

When you want to analyze and graphs a set of experiments the same
way, you can save your example as either a template or method. In
either case, start from the data table, drop the File menu, choose Save
Special..., and then choose Save Template or Save Method. 

The difference is in when you choose to use these files.

· Open the template from the Welcome dialog, enter or import data, and
then look at (and fine-tune) the results and graphs.
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· Methods are different. First create a data table and enter or import
data. Only then do you click the Wand button  to apply the method to
your data.  

Perhaps this distinction will help: A template is a noun - a place you start
from. A method is a verb - something you apply to data you have already
entered

. 

8 Organizing Prism projects
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A Prism project file (or PZF file) contains all the

pieces of a project. Each Prism project has basic

five sections: Data tables , Info sheets ,

Results , Graphs , and Layouts . Each section

can have up to 500 sheets. The term 'sheet' refers

159 147
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to an individual data table, info page, set of

results, graph or page layout.
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8.1 Renaming, sorting, and deleting sheets

Changing the order of sheets in a section

Simply drag-and-drop within the Navigator  or Gallery , or pull down
the Edit menu and choose Reorder

Renaming a sheet

Prism initially assigns each data table a generic name such as “Table 1.”
It is easier to manage large projects if you give the sheets more
descriptive names.

Click on the name of the sheet in the Navigator, and press F2 (or wait for
a second and then click again) to rename the sheet. Or right-click on the
sheet name and choose Rename sheet.

You can also rename using the bottom toolbar. Click on the sheet name in
the bar at the bottom of the Prism window and edit it. Don’t try to delete
the current sheet name from the drop down in the bottom toolbar. If you
delete the name, Prism replaces it with a default name. Instead, double-
click on the sheet name in the bottom toolbar to select it, and then begin
typing to replace it.

 Deleting sheets

Select a sheet in the Navigator  and click the Delete Sheet(s) button 
on the Sheet toolbar. You can select one or more sheets in the current
section to delete.
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To delete several sheets,go to the Gallery  and select several sheets.
Then click the Delete Sheet(s) button or press the Delete key.

Because sheets are linked, remember that deleting one sheet may affect
others. When you delete a data table or results sheet, you also remove
those data and results from all graphs. The graphs themselves remain;
they just have fewer (or no) data plotted on them. Any results sheets
based on the deleted data become orphaned (you can still view and graph
orphaned results but can’t change the calculation parameters). When you
delete a graph sheet, you also delete that graph from all page layouts,
but you will not delete the page layout sheets themselves.

8.2 Working with multiple sheets at once

View all sheets in the gallery

Click a section title in the Navigator (Data tables, Info sheets, Results,
Graphs, or Layouts) to view thumbnails of all the sheets in that section.
We call this the Gallery.
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Use the Zoom buttons on the bottom toolbar  to make the Gallery
thumbnails larger or smaller.

The gallery is useful for navigation and organization. Double-click on any
sheet to go to it. Drag and drop thumbnails in the Gallery to rearrange
sheets in a section.

Selecting multiple sheets

Check this option box below each sheet to select it. Alternatively, hold the
Control key while clicking on several sheets.

Working with several sheets at once

Many commands are available that work on all selected sheets at once.
Right click on the gallery to see a list of all available commands.

· Print  each selected sheet separately, or print a combined gallery
page.
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· Export .

· Send  to Microsoft Word or PowerPoint.

· Magic . Make graphs consistent.

· Apply a color scheme

· Change the background color or plotting area color

· Rename. Add a prefix or suffix to their existing names, or give all
selected sheets the same name (followed by 1,2,3...).
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8.3 Freezing a sheet to prevent changes

When you edit data, Prism automatically recalculates the analyses and
updates the graphs.

Freeze a results or graph sheet if you don't want it to update. For
example, you might want to freeze results and a graph before excluding
some outliers from the data. You can then repeat the analysis, and have
both copies of the results and graphs in the project. Note that Prism
doesn't let you freeze data tables, info sheets, or layouts.

Click the Freeze button in the Sheet section of the Prism toolbar to freeze
a results sheet or graph. The Prism bottom toolbar will indicate that the
sheet has been frozen and won't update with any changes to the data.
Click again to unfreeze.

         

8.4 Using Info sheets to organize your projects

Key concepts: Info sheets

· Use Info sheets to record experimental details and constants you want
to use in analyses.

· The left side of an info sheet is a table of structured information. The
right side is for unstructured notes

· Each project can have up to 500 info sheets. Each Info sheet can be
linked to a particular data table, but doesn't have to be. 

· The info constants can be used (hooked) in analyses. 

Create and edit an Info sheet
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To create an info sheet, click the New button on the toolbar, or drop the
Insert menu. Choose New Info. Select whether the new sheet should be
linked to a particular data table, or a global Info sheet for the project.

 How to use Info Sheets

To embed all or part of an Info table onto a graph or layout:

Select all or part of the Info table, and copy to the clipboard. Then go to a
graph or layout and paste. This will be a live link, updated if you edit the
info table. Double-click on the embedded table to adjust its properties.

To insert an Info constant into a graph title, legend, or text object:

While entering text, use the right-click menu or click on the Inset Info
Constant button in the Write section of the Prism toolbar. Prism will
maintain a link to the constant, updating the text when you edit the info
table.

To change the order of the rows on an Info sheet, or to delete a row:



Organizing Prism projects 149

© 1995-2016 GraphPad Software, Inc.

Click on a row, then click the right mouse button. From the shortcut
menu, choose to move the selected row up or down, or choose to delete
that row. Or use the buttons on the Change toolbar.

To link a global Info sheet to a specific data table:

Click this button in the Change toolbar to bring up a dialog to select which
data table the Info Sheet is linked to.

To change which info constants appear by default on new Info sheets:

Use the Info Sheet tab of the Preferences  dialog. You can also choose
whether or not Prism will automatically create a linked Info sheet to
accompany every new data table you create

To import info constants into an Info sheet at the same time you import data:

     See here for the details.   

To hook info constants into an analysis or graphing dialog.

You can "hook " Info sheet constants as constraints in nonlinear
regression or as constants when transforming.

You can also Hook to Info sheet constants to create custom ticks ,  set
axis limits , etc.

You'll know when it’s possible to insert ("hook") an info constant, because
you'll see the fishhook icon next to the number entry field.

  

When you see this button in a dialog, click on it to bring up a list of all
Info and Analysis constants that can be hooked.

To insert a text file into the notes portion of an Info sheet:

Drop the File menu and choose Import.
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8.5 Annotating your work with floating notes

Floating notes will show on the sheet but not when a sheet is printed, or
exported or copied to another application, such as Word or PowerPoint.
Use different color notes for different things. For example, have one
colleague review all yellow notes, and another one review all the blue
notes.

To add a floating note to a Prism sheet:

Click on the button on the Sheet toolbar.

To minimize a floating note:

 - Click the Minimize button on a Floating Note to collapse the note. Or just double-
click on the top border of the note.

To add a link to a web site:

 - Drop the Note menu using the button in the upper left corner of a note and use
the Create Link to add a hyperlink to a website or other document.

To change the color or delete a floating note:

Drop the Note menu using the button in the upper left corner of a note, and select
Note Color.
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8.6 Color code selected cells in data or results tables

It is easy to color code selected cells in data or results tables. This would
be useful to highlight the key results, to mark surprising results you wish
to review further, or to mark suspicious data entries that you wish to
double check. To do so:

1. Place the insertion point in the single cell you wish to color code. Or
drag to select a range of cells. 

2. Click the paint bucket icon in the Change area and choose a color. Or
drop the Change menu and choose "Cell Background Color".

 

Note the distinction between two related features. You can highlight
(color code) sheet names in the navigator, and you can also color code
the background of selected cells in data and results tables. 

8.7 Highlighting sheets in the Navigator tree

Highlight a sheet name to remind yourself to go back to it, or to flag
sheets you want a co-worker to view. You can choose among seven
colors.

Select a sheet in the Navigator, or several sheets in the Gallery , and
click on the Highlight button on the Sheet toolbar. Click on the highlight
button itself to use the same color as last time, or click the arrow to
choose a color.
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8.8 Grouping related sheets

Prism offers no way to create subfolders or to group sheets within a
section (except by color coding  them). But one of our customers came
up with a clever workaround. He creates extra data tables or graphs
(which can be ignored) and renames the sheet title to "-------". This has
the effect of dividing a long list of sheets into sections.
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8.9 Preferences

Overview

Use the Preferences dialog to set Prism's defaults for various settings.

Note that some preference settings are made elsewhere in Prism. The 
import  (paste special) dialog, the export graph , and the diagnostics
tab of nonlinear regression, for example, all have check-boxes to make
the current settings default for the future.

Also note that on Macs, there are two settings in the General tab of the
System preferences  dialog that have a big effect on how Prism works. 

To open the Preferences dialog, drop the Edit menu (Windows) or Prism
menu (Mac) and choose Preferences.

Most of the settings are self explanatory. The rest of this page discusses
the settings that are not entirely self-explanatory.

 File and Printer tab

· PZF vs. PZFX files
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· Compact format for PZF files. All this format does is leave out analysis
results (and instead recomputes them when you open the file).  IT
makes the file a bit smaller, but PZFX files are way smaller. 

· Do not read page size when opening files. Prism tries to track the page
size of your printer, so the margins are realistic on screen. With some
printers, Prism gets confused and you can check this option, which is
rarely needed. 

· How to copy graphs and layouts to clipboard (Windows). Prism gives
you a choice of three formats: WMF, EMF (old) and EMF+. In theory,
EMF+ is the best because it is newest. But it all depends on which
application you are pasting into. You may need to experiment. 

· How to paste a graph from another project (Mac). Choose whether the
pasted image needs to be Windows compatible (which increases file
size, and on slow computers may noticeably delay pasting). 

New Graphs tab

Set defaults for axes, error bars, symbols and lines, color schemes, and
graph and data table fonts. These defaults apply to newly created graphs,
but don't change existing graphs. 

Internet tab (Windows only)

Most of the tab is a relic from old versions. It sets up a feature that lets
you send a graph to a web server via FTP. We can't imagine why anyone
still uses this. If you do, please let us know!

The bottom part is an option for Prism to automatically check for updates
and let you know if there is one.

8.10 Tips for navigating large projects

A Prism project file can have up to 500 data tables, info tables, analyses,
graphs and layouts. Lump lots of data into one file? Or split into many

http://www.graphpad.com/support/faqid/955/
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files? The choice is yours. If you prefer to create large projects, use these
tools to navigate:

Use the bottom toolbar

Browse the sheets sequentially.

Ping pong between any two sheets. Click once to go back to the previous sheet. Click
again to return.

Pick from a menu of sheets linked to the current sheet, or use the five tabs to jump
between sections.

Navigate within sheets in a family

At the top of the Navigator tree, there is a section that organizes related
sheets as Families . When you select a sheet in any section of the
Navigator, all the related sheets -- data tables, graphs, info sheets,
results, and layouts will be grouped and shown in the Family section.

The screenshot is for Windows. If you use a Mac, you'll see triangles (pointing up or down) rather
than + and - signs. 

This folder is especially useful when working with a project with lots of
sheets. It lets you move between related sheets without scrolling the
Navigator. The keyboard shortcut to open the Families folder is Ctrl-L.
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Use the link button on the bottom toolbar to move between sheets in a
family. Note below that each type of sheet is marked either (D) for data
table, (R) for results, and (G) for Graph.

Working with chained analyses

Prism lets you chain analyses. For example, you can first transform data,
then normalize the transformed data, then fit a curve to the normalized
results, and finally run a normality test on the residuals from the curve
fit. To make it easier to view analysis chains, Prism can show an additional folder in

the Navigator  labeled Data with Results.

The default is to show the Data with Results folder whenever a results
sheet is analyzed. To change this default, click on the Prism section of the
Toolbar and select Preferences, and then click this option in the View tab.

100
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Use the Search tool

Click Find from the Edit menu (or click on the binoculars icon in the
bottom toolbar, or use the control-F shortcut key) to search for sheets in
a project containing specific words or text. The results will appear in the
Search Results folder which you'll see in the Navigator. Prism searches for
the text you entered in titles, floating notes, sheet names, and more. It
only searches within the current file, and does not search within other
files that might include the search text.

         

There is no way to empty the search results folder. Just use the Search
command (or button) again to search for something else. 

Navigator tool tips

If you've got lots of sheets in a project, and you're not sure which one
you are looking for, hover your mouse over any sheet name in the Prism
Navigator  to display a thumbnail of the sheet.100
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Highlight or move selected sheets

If you identify certain sheets that you want to go back to frequently:

· Highlight  the sheet name in a color you choose. Use the highlight
button in the toolbar, or right click on the sheet in the navigator and
highlight from there. 

· Move  them to the top of the list in the navigator. Just drag and drop. 

8.11 Tips to avoid the need for large projects

Delete sheets you don't need

As you work on a project, you might accumulate graphs and analyses
which you don't need. Keeping them in the project adds clutter and
makes it harder to find the sheets you want. Delete them . 

Save families of sheets

If a file is large, consider breaking it into smaller projects. You can save
any family of sheets as a new project. Find the command "Save Family
As" on the File  menu. 

Merge Prism files 

If you later want to merge two files, that is straightforward. Use the
Merge command on the File menu. 
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Place a graph from one project on a layout of another

You can  place a graph from one project onto a layout of another project.
There are two ways to do this:

· Double click on a placeholder in the layout, and choose a graph from
another open project. 

· Copy the graph from one project, go to the layout of another project,
make sure no placeholders are selected, and paste. Prism will give you
three choices:to paste a picture, paste a hot link, or to paste merge, so
the entire family of the pasted graph is merged in. 

9 Data tables
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Unlike Excel or most other graphics programs,

Prism's data tables are formatted. In most cases,

the first column is for X. The rest of the columns

are for Y values, and these can be divided into

subcolumns for entry of error bars.
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9.1 Distinguishing the six kinds of data tables

Unlike the data tables of most programs, the data

tables in Prism have a format or structure. There

are six different kinds of tables, and it is essential

that you pick the right one for your data and

experimental design.
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9.1.1 Key concept -- data tables

Choosing among the six kinds of data tables is important

The format of a Prism data table determines what kinds of graphs you can
make and what kind of analyses you can perform. Choosing the right kind
of table for your data is really important. Take the time to get this right. 

Don't try to choose the right kind of table for your data by thinking about
the kind of graph you want to make. That approach will end up confusing
you because there isn't a one to one match between table and graph
types. For example,  you can make a bar graph from four kinds of
tables , and a graph showing points (a scatter graph) from three kinds
of tables . You need to choose a table based on the organization of the
data and the analyses you wish to perform. 

Prism projects can have many data tables

You are not limited to one data table per file. Store an entire project in
one file, creating as many data tables as you need.

Prism can compute error bars

Prism can plot error bars from raw data. You don’t have to enter SD or
SEM values, although you can.  

9.1.2 Prism's six data table formats

The format of a Prism data table  determines what kinds of graphs you
can make and what kind of analyses you can perform. Choosing a data
table format lets Prism create a data table that fits your data and makes
it easy to create the kind of graph you want and perform the appropriate
analyses. You can always change  the format of a data table.

The six kinds of data tables

XY tables  - An XY table is a graph where every point is defined by both
an X and a Y value. This kind of data are often fit with linear or nonlinear
regression.
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Column tables  - Use column tables if your groups are defined by one
scheme, perhaps control vs. treated, or placebo vs. low-dose vs. high-
dose. Each column defines one group.

Grouped tables  - The idea of two-way variables is best understood by
example. One grouping variable (male vs. female in the example below)
is defined by rows; the other grouping variable (control vs. treated) is
defined by columns.

Contingency tables  - Contingency tables are used to tabulate the actual
number of subjects (or observations) that fall into the categories defined
by the rows and columns of a table.
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Survival tables  - Survival tables are used to enter information for each
subject. Prism then computes percent survival at each time, and plots a
Kaplan-Meier survival plot (and also compares survival with the log-rank
and Gehan-Wilcoxon tests).

Parts of whole tables  - A Parts of whole table is used when it makes
sense to ask: What fraction of the total is each value? This table is often
used to make a pie chart. The example below shows the number of
students who received grades of A, B, C, etc. The sum of the five values
in the table (61) is the total number of students.
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9.1.3 XY tables

In an XY table, every point is defined by both an X and a Y value.

Analyses performed with XY data

· Linear regression

· Nonlinear regression

· Correlation (Pearson or Spearman)

· Cubic spline & LOWESS

· Smooth curve

· Area under curve

Example of an XY table

§ The first optional column is for row titles  to label individual
subjects or samples.

§ The next column ("X") is for X value. There is only one X column per
table. If you choose to enter X error values, then there will be two
subcolumns (one for X, one for the error value). 

§ Each remaining column ("A", "B", ...) defines a treatment group.

§ Subcolumns  are for replicates in a treatment group. Prism uses
these to calculate error bars.
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§ Blank cells represent missing values.

§ Blue italics values are excluded  from graphs and analyses.

§ An XY data table can contain 256 data set columns and as many as
256 sub-columns.

§ XY tables can be configured to enter dates or times into the X
column, instead of numbers. Choose when you create table. 

Error bars

Prism will compute and graph error bars  from replicate values placed in
side by side subcolumns as shown (triplicate values) in the table above.
Specify the number of subcolumns when you create a new XY table.

You can also choose to create subcolumns formatted for entry of error
values computed elsewhere.

Prism can also plot horizontal X error bars . You must enter X error
values directly; Prism cannot compute them. You can only enter one
value for X errors, so X error bars are always symmetrical.

Entering multiple sets of data that don't share X values

Each data table has a single column for X and up to 104 sets of Y values.
What should you do if you have different X values for each set of Y
values? There are two ways to solve this problem.

The best approach is to stagger the data entry. You don't have to start
entering data in the first row. This example shows three data sets with
different X values.
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An alternative approach is to enter each data set on a different table. The
disadvantage with this method is that you lose some analysis choices.
You must enter all the data sets on one table in order for Prism to
compare linear regression lines, to compare best-fit values from nonlinear
regression, and to compare survival curves. Another minor disadvantage
is that Prism will automatically make a different graph for each table.
However, you can delete the unneeded graphs and include data from all
the data tables on a single graph.

9.1.4 Column tables (one grouping variable)

                                                                                                                                        
In a column data table, each column defines a group. These groups are
defined by one scheme, perhaps "control vs. treated." You can have more
than two groups in a one-way table, for example "placebo vs. low-dose vs.
high-dose.

Analyses performed with Column data

· t test (one-sample, paired and unpaired)

· Mann-Whitney

· Wilcoxon



GraphPad Prism7 User Guide168

© 1995-2016 GraphPad Software, Inc.

· Column statistics (including normality tests)

· One-way ANOVA (followed by Tukey, Dunnett, Newman-Keuls or
Bonferroni post tests)

· Kruskal-Wallis

· Friedman

· Bland-Altman

· ROC curves

Example of a column table

•

· Each column defines a treatment group.

· Prism does not use a separate column to enter the grouping variable.
Instead the groups are defined by columns.

· If data are not matched or paired, rows have no special meaning. Enter
data in any order you like.

· If data are from a before-after experiment with clear pairing or
matching, place each set of matched results on one row. Optionally, use
the row title to label it.

· Blue italics values are “excluded” (ignored by analyses and graphs). Use
Exclude Values.
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Error bars

For one-way tables, Prism will calculate error values and create error
bars automatically. Enter all the values for a data set in a single column.

9.1.5 Grouped tables (two grouping variables)

The idea of grouped variables is best understood by example. One
grouping variable might be "male vs. female"; the other grouping variable
is "control vs. treated." Every data point you collect is categorized by
both grouping variables: "male vs. female," AND "control vs. treated." A
two-grouping variable table and graph is used to tabulate outcomes that
are measurements such as weight or blood pressure, often with error
bars.

Analyses performed with Grouped data

· Two-way ANOVA

· Repeated-measures two-way ANOVA (mixed-model)

· Bonferroni multiple comparisons test

· Fisher's LSD multiple comparisons test

· Holm-Sidak multiple comparisons test

· Three-way ANOVA
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Example of a grouped table

Notes:

· Unlike other programs, Prism does not use separate columns to enter
grouping variables. Instead, groups are defined by rows and columns.

· The rows categorize the data by one grouping variable (men vs.
women).

· The columns (datasets) categorize the data by the other grouping
variable (control vs. treated).

· Blank cells represent missing values, which Prism handles properly. If
you are doing repeated-measures ANOVA, however, you can't have any
missing data values unless an entire subcolumn is empty.

· Blue italics values are “excluded” (ignored by analyses and graphs). Use
Edit… Exclude values.

· A grouped data table can contain 256 data set columns and as many as
256 sub-columns

Error bars

Prism will compute and graph error bars from replicate values placed in
side by side subcolumns as shown (duplicate values) in the table above.
Specify the number of subcolumns when you create a new table.

You can also choose to create subcolumns formatted for entry of error
values computed elsewhere.
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9.1.6 Contingency tables

What is a contingency table?

Contingency tables are used to tabulate the actual number of subjects
(or observations) that fall into the categories defined by the rows and
columns of a table.

The rows and columns can be defined in different ways, based on
experimental design.

· Prospective: You choose subjects based on exposure, from which you
define the rows. Each column represents a different outcome.

· Retrospective (case-control): Each column represents a different group
of subjects, identified based on presence or absence of disease. Each
row represents a different exposure they have had in the past.

· Experiment: Each row represents a different treatment group. Each
column represents a different outcome.

· Cross-sectional: You select a group of subjects, and then categorize
them by exposure (different rows) and disease (different columns).

Analyses performed from a contingency table

· Fisher’s exact test

· Chi-square test

· Odds ratios and relative risk
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Example of a contingency table

The three rows represent three different treatments. The two columns
represent two alternative outcomes. Each value is the actual number of
subjects (in this case; in other cases, the values may represent number
of objects or events). 

It is essential that you enter the actual number of subjects (objects,
events...) that you counted. Do not enter normalized values or
percentages. Since the values are counts, they cannot be negative and
must be integers. Prism won't let you enter a minus sign or decimal point
or create subcolumns. If you need to enter fractions or negative numbers,
or create a table with subcolumns, use a Grouped table  instead. 

9.1.7 Survival tables

On a survival table, you enter information for each subject. Prism then
computes percent survival at each time, and plots a Kaplan-Meier
survival plot (and also compares survival with the log-rank and Gehan-
Wilcoxon tests).

Analyses performed with survival data

· Kaplan-Meier

· Log-rank

· Wilcoxon-Gehan
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Example of a survival table

Each row represents a distinct subject. (You can optionally use row titles
to identify the subjects.) Each column represents a treatment.

Notes:

· Enter elapsed time (usually in days) as X (Prism does not let you enter
dates).

· For each subject, enter a code for Y:

· Enter ‘1’ for a subject if the event (death) occurred at the time entered
into X.

· Enter ‘0’ if the data are censored. Data are censored when you simply
don’t know what happened to the subject after that time, or do know
but can’t use the information.

· You'll find a more complete discussion of entering survival data and
interpreting the results in the statistics guide. 

Error bars

http://www.graphpad.com/guides/prism/7/statistics/index.htm
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When Prism plots a survival curve, it can include SE or 95% CI error bars.
These are computed as part of the Kaplan-Meier method for creating the
survival curve. You can't enter error values directly -- they are computed
from all the data.

9.1.8 Parts of whole tables

A Parts of whole table is used when it makes sense to ask: What fraction
of the total is each value? This table is often used to make a pie chart.

Analyses performed on parts of whole data

· Fraction of total

· Chi-square goodness of fit

Example of a Parts of whole table

The example below shows the number of students who received grades of
A, B, C, etc. The sum of the five values in the table (61) is the total
number of students.

You can enter data onto as many columns as you want. But note that only
the values entered into column A will be automatically graphed. Use
New...Graph to plot other columns.
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9.2 Creating data tables

How to create data tables.

9.2.1 How to create a new data table

A Prism project  can contain many data tables.

Click the new button from the Sheet section of the Prism toolbar (or
drop the Insert menu) and choose New Data Table and Graph. 

86
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The New Data Table and Graph dialog looks a lot like the Welcome dialog
(with fewer choices). Choose which of six kinds of data tables  you
want, and whether to start with an empty table or use sample data. If
you choose to create an XY or Grouped table and are not using sample
data, you'll also need to decide about subcolumn format. 

9.2.2 Creating a table to create a bar graph

Prism offers six distinct types of data tables. Four of these can be used to
create bar graphs, as detailed below. If you want to create a bar graph, it
is important to choose the kind of data table that matches your data.

Column graphs

Enter data for each group into its own column, stacking replicates (if
any). Each column then becomes a bar, and you'll be able to control the
appearance of each bar individually.
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Note: If you want to create a graph like the one above, but you've already
calculated your mean and error values, start instead with a Grouped table
(see below) and use only the top row.

Grouped graphs

Each column represents a different kind of bar. Each row is a different
instance of that bar. Enter replicates (if any) in side-by-side subcolumns.
So if you have three Y columns and four rows, you will have three kinds of
bars, and you can choose the color, fill, and border of each. You will have
four different bars of each type. You can choose whether you want the
bars interleaved, stacked, or separated on the Welcome dialog or by
clicking Change and then Type of graph.
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Contingency tables

A contingency table is like a grouped table but doesn't have subcolumns
for replicate values.

XY Bar graphs

Both the kinds of bar graphs mentioned above place the bars on the
graph in order, with equal spacing. In some cases, you want to position
each bar along the X axis with the position determined by an X coordinate
you enter. To make this graph, choose the Spikes graph in the New Graph
dialog.
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Settings in the Format Graph dialog also let you make this graph.
Uncheck the option to "Show Symbols" and check the option to "Show
bars/spikes." 

9.2.3 Creating a table to create a scatter plot

Prism offers six distinct types of data tables. Three of these can be used
to create scatter graphs.

XY scatter graphs

With an XY data  table, each X value can have several replicates for
every data set. When you make your graph, you can choose to show all
the replicates on your graph instead of error bars. Start with an XY table
if you want to show all your replicates for each X value.
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Here is the data table for the graph above.

To format an XY graph to show each data point as in the graph above,
click on the Format Graph button on the toolbar, select Global to choose
all data sets, and choose to Show each Replicate. To show mean and
error instead, choose Mean and Error from this drop-down menu instead.
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Column scatter graphs

If you want to compare groups and show every data point along with lines
for mean and error for each group, start with a column table. All the data
values for each group should be entered in a single column.

To make the graph above, start with a Column table  and enter all the
data points for each data set in a column. Prism will create error bars
from all the data points in each column.

If you instead want a graph that shows only the mean and error for each
data set, double click on any data point to open the Format Graph dialog
and choose "One symbol per column" and the type of error you want to
show.
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Grouped scatter graphs

If you want to create a scatter plot comparing groups by more than one variable, enter data on a
Grouped data table with side by side replicates.

Here are the data plotted as an interleaved graph:

You can also choose to superimpose the groups:
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9.2.4 Creating a table to combine bars and points

Prism offers three ways to create graphs that combine points and bars.

XY

Create an XY graph and then tell Prism to plot a data set (or several) as
spikes or bars. Detailed instructions to create the graph below. 

http://www.graphpad.com/support/faqid/1469/
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Grouped

Create a grouped bar graph, then tell Prism to plot one data set (or
several) as points. Detailed instructions for creating the graph below. 

Create two graphs and superimpose them on a layout

A third approach to getting bars and points on what appears to be one
graph is to create one XY graph and one column graph, and then tell
Prism to superimpose them on a page layout. Detailed instructions to
create the graph below. 

http://www.graphpad.com/support/faqid/1661/
http://www.graphpad.com/support/faqid/1646/
http://www.graphpad.com/support/faqid/1646/
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9.2.5 Inserting a series

Often you'll want your X column of an XY table to be a regular series of
values. Prism offers two ways to do this.

Using the Insert Series command

Follow these steps to insert an arithmetic or geometric series:

1. Place your insertion point in the first cell of the series. Alternatively
select the entire range that you want to contain the series. 

2. Drop the Insert menu and choose Create Series... Or click the
corresponding button in the Change portion of the toolbar.

   

3. Enter the number of values you intend the series to have. If you
preselected a range of values, Prism will default to the number of rows
in that range. Also enter the first value, and the rule to increment other
values. 
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Notes:

· You'll usually want to create a series in the X column of any XY table,
but you can insert a series in any column of any table. 

· If you select an entire column before bringing up this dialog, the dialog
will default to creating a series with 500,000 values. This can take a
while. Adjust the value a reasonable number. 

Turn the X column into a series

This option is a carryover from prior versions of Prism, and we suggest
you use the Insert Series command instead. 

To turn the X column into a series:

1. Create a new XY table.

2. Enter at least one Y value or column titles so the table is not
completely empty. 

3. Click the Table Format button at the upper left of the table, or drop
Change and choose Format Data Table.

4. Choose to generate X values, and enter the starting value and
increment.
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Notes:

· On older versions of Prism, you were able to define this series at the
time you created the table. With Prism 6, you can no longer do this. You
must first create the table, and then use Format Data Table to define
the series.

· When you define the X axis to be a series, Prism will delete any X value
you had entered into the X column without asking for confirmation.

· With this method, the entire X column becomes a nearly infinite series.
You cannot tell Prism where to stop the series.

· With this method, the series is always arithmetic -- each value is
computed by adding a constant increment to the prior one. Use the
Insert Series dialog to create a geometrical series — each value is
computed by multiplying a constant factor times the prior one.

9.2.6 Data table limits

You can have up to 500 data tables in your project. Each data table can
contain:
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· Any number of rows (limited by RAM and hard disk space). We've tested
hundreds of thousands of rows.

· Up to 256 data set columns. Prism 5 only allowed 104.

· Up to 256 subcolumns. Prism 5 only allowed 52.

If your table has more columns or subcolumns that Prism 5 can handle,
the table will simply not be included when you open the file in Prism 5. 
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9.3 Editing data tables

How to edit data tables.

9.3.1 Changing a data table format

The choice you make about how to format your data table is important.
If you don't choose the appropriate kind of data table, you won't be able
to make the kind of graph you want or perform the analyses you have in
mind.
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For XY tables Prism uses subcolumns replicate data. If your table needs
more subcolumns you can always change the number of subcolumns
(replicates) in a data table. Or, if you entered already-calculated error
values but your table is labeled wrong (say you actually entered SD, but
the table is formatted for SEM, you can make the switch.

To change the format of a data table, Click on the Table format area in
the upper left of a data table.

Alternatively, click on the Table Format button  on the Change
toolbar.
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If you want to change the type of error bars displayed on your graph,
you don't need to change the data table. Instead, double-click on any
data point on your graph to open the Format Graph  dialog and use the
drop-down menu to change the error-bar format.

 

9.3.2 Entering dates or elapsed times as X

Formatting the table to enter dates or times as X values

From the Welcome or New Table dialogs, you can choose to format the X
column for entry of dates or elapsed time instead of X values. 

351
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If you forgot to format the table when you created it, use Change..Format
data table to format the X values for dates or times.

Entering times or dates

If you choose elapsed time, enter time as hh:mm or hh:mm:ss. For
example, enter 1:12:30.2 to enter an elapsed time of 1 hour, 12 minutes,
30.2 seconds. 
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If you chose to enter dates, you can enter dates in almost any format.
Prism will figure out what you meant and display the date on the table in
a standard format (that you cannot change). The only ambiguity is if you
enter a date like 1/2/2014 or 1-2-2014. Is that January 2 or February 1?
The convention depends on where in the world you live. Make your choice
on the bottom of the View tab of the Preference dialog. 

If you enter a year with two digits, Prism Windows follows the choices
made in the Date tab of the Additional Settings dialog, accessed from the
Format Tab of the Regional settings control panel. 

When Prism shows a ? in the data table

If Prism doesn't understand the date or time you entered, it will show ? in
the data table. This is treated as a missing or blank value for graphing
and analyses. When you click on the cell to edit, Prism will show you
exactly what you entered for editing. 

Converting dates or times to values for analyses

When you analyze these data and make some kinds of graph, Prism
converts the dates or elapsed times to values. Choose the units and (for
dates) starting date on the Format Data Table dialog . Note that the
choice of months is not offered, because months have different lengths.
Years also have different lengths, so if you choose years, Prism does the
conversion based on 365.25 days per year.
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Formatting dates and times on the graph

The Format Axes dialog will present several choices for numbering
format. 

 

9.3.3 Column titles

Why use column titles?

Column titles are used to:

· Identify data sets on a data table.

· Identify data sets when choosing analyses and viewing results.

· Labeling the X axis of Column (and sometimes) grouped graphs. 

· Creating legends for XY and Grouped graphs.

How to edit column titles
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Click on the column title and edit. You can  bold, italicize, and underline
text in titles and can insert superscripts, subscripts and Greek letters.

Enter two or three line row titles and column titles

You may enter two or more lines of text for each column title. 

To add an additional line of text to the title click the Line Break symbol or
press the key combination Shift-Enter to move to the next line.

View and edit all the column titles at once

To view and edit multiple column titles at once, click on the Format Data
table button in the upper left corner of the data table and choose the tab
for column titles. If your table has many subcolumns, this is the best way
to edit column titles. Shortcut: Bring up this dialog by double-clicking in a
one of the column titles on the data table.
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Autocomplete

Prism uses autocomplete to help you. It tries to guess what you are
typing, and let's you choose from a list of titles you've used before. If you
find this more annoying than helpful, turn it off in the View tab of the
Preferences dialog.

9.3.4 Subcolumn titles

XY and Grouped tables can be formatted to have side-by-side
subcolumns. These subcolumns can be created to hold preaveraged data,
perhaps entering mean, SD and n. In these cases, the subcolumns are
labeled. In other cases, you create side by side subcolumns for entry of
replicate values. By default these are labeled "Y1", "Y2", etc. 

Prism 7 lets you you change these labels. Use Change... Format data
table and go to the third tab. You'll see the subcolumn tab of the Format
Data Table dialog.

Shortcut: Double click on any subcolumn tiltle (A:Y1 or B:Y2..).
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If you check the option on top of the dialog, the titles you enter will
appear on the data table. 

Notes:

· Choose between entering one title for every subcolumn for every data
set column (as above) or just a single set of subcolumn titles that apply
to all data sets. If you chose the latter choice with the example above,
you'd enter only three subcolumn titles and these would be repeated for
each data set. 

· Controls are provided in the toolbar of the dialog to enter greek letters
and math symbols (etc.) and to enter super and subscripts.
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· If the titles you enter are very long, you may wish to uncheck the top
option. This will leave the table labels as "Y1", "Y2", etc. 

9.3.5 Row titles

Why use row titles?

Row titles have four purposes:

· Label unknowns in standard curves -- the labels will propagate through
to the standard curve (interpolated values) results.

· Label individual points on an XY graph.

· Label groups in a grouped data table.

· Label subjects on a column table plotted as a before-and-after graph.

Show or hide the row title column 

If you don't see a column for row titles, click on the Table format area in
the upper left of a data table to open the Format table dialog. Choose to
"Show row titles."

To hide the row title column, click the X at the top of the Row title
column.

Enter two or three line row titles and column titles
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You may enter two or more lines of text for each row title. This is new to
Prism 6. You may also now bold, italicize and underline text in titles (you
could always use superscript, subscripts and Greek).

To add an additional line of text to the title click the Line Break symbol
or press the key combination Shift-Enter to move to the next line.

Autocomplete

Prism uses autocomplete to help you. It tries to guess what you are
typing, and let's you choose from a list of titles you've used before. If
you find this more annoying than helpful, turn it off in the View tab of
the Preferences dialog.

Showing row titles on a graph

Double click on any symbol to open the Format Graph dialog and choose
"Label each point with its row title". Double click on any row label to
change the font of all the labels. You can also delete individual labels or
drag them to a new location.
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9.3.6 Sorting data

Reordering XY data

If you choose connecting lines on an XY graph, Prism connects the points
in the order they appear on the data table. If the data are not sorted on
the data table, the connecting lines will jump back and forth across the
graph. If you want the connecting lines to go from left to right across the
graph, first sort the data table by X values. Click on the Sort Rows
button on the Change toolbar, and sort by X value.

Reordering Grouped data

Distinguish two ways to reverse order on a Grouped graph.

Reverse the order of rows

Click on the Sort Rows button on the Change toolbar, and reverse the
order.
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This example shows the effect of reversing the order of the rows in the
data table.

Reverse the plotting order of data set columns

Grouped tables are defined by two grouping variables. If you want to
reverse the order of how the columns are graphed, you don't need to
change the data table. Instead, go to the graph and click the Change
data set order button. One of the choices on its menu reverses the order
of data sets.

This example shows the effect of reversing the plotting order of data
sets. Note that this example starts with the same graph as the prior
example.
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9.3.7 Changing data table column widths

To adjust the width of a column, click anywhere on a column border and
drag. If you first select several columns, dragging the border of one
column will change the width of all selected columns. Prism determines
the width of subcolumns (replicates) automatically, and you cannot
change these widths individually. To make all larger or smaller, resize
the main column.

9.3.8 Specifying decimal places in a data table

Decimal format

Prism automatically chooses the number of decimal points to display in a
data table automatically.

To change the number of decimal points displayed, Select the column or
columns you wish to change (click at the top of the column to highlight),
and click on the Change decimal format button of the Change toolbar. 

Notes:
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· When you place the insertion point (click the mouse cursor) in a
particular cell in a data table, Prism expands that value to show all
digits. When you move to another cell, the value reverts back to the
selected numerical format.

· It is not possible to change decimal format of a contingency table or
the Y values in survival tables, since all values must be integers.

· You can only change numerical format for an entire column (or
several columns). It is not possible to change the numerical format
of individual cells.

Decimal separator

In some parts of the world, a period (point) is used as the decimal
separator. In other parts of the world, a comma is used.

When entering data into Prism, you can use either a period or a comma
to mark the decimal point.

When exporting data, Prism uses the separator you choose in the Export
dialog. When pasting data, Prism uses the separator set in 
Preferences .

When importing data , you can specify how a comma is interpreted (as
a decimal separator, as a thousands separator, or to separate columns
of data).

9.3.9 Excluding or highlighting values

Excluding values from data tables

If a value is too high or too low to be believable, you can exclude it.
Excluded values are shown in blue italics on the data table, but are not
included in analyses and are not shown on graphs. From the point of
view of analyses and graphs, it is the same as if you had deleted the
value, but the number remains on the data table to document its value.

To exclude selected values, Click the Exclude button from the Change
toolbar.
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The excluded values appear in blue italics, followed by an asterisk.

Choose on the File & Printer tab of the Preferences dialog how excluded
values should appear when copied to the clipboard. Your choices are to
copy a blank value (as if missing), a regular number (ignoring the fact
that the value is excluded) or a value followed by an asterisk (to match
what you see). Prism offers the same choices on the Export dialog to
control how excluded values are exported to .TXT or .CSV files. 

Instead of manually choosing points to exclude, you can ask Prism to
perform outlier elimination.

Highlighting values

Select a cell or a range of cells. Then click the paint bucket icon in the
Change part of the toolbar, or drop Change and choose Cell Background
Color. You can choose from eight colors to mark values that you want to
double check, or to color code different aspects of an experiment.

Don't confuse highlighting cells in a data (or results) table from 
highlighting sheet names in the navigator . 151
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9.3.10 Deleting or removing entire data sets

Deleting values only

To remove values from the data table, select then and then press the
Delete key. 

Removing entire data sets

To remove a data set from a Graph, click on the Add/Remove data sets
button from the Change toolbar. Alternatively, double click on a graph to
bring up Format Graph, and then go to the second tab. Select the data
set to remove.  

To remove a data set from a Results sheet, click on the Analyze different
data sets button from the Change toolbar, and uncheck the data sets you
do not wish to include in the analysis.
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9.3.11 Missing values

When entering data, simply leave a blank spot for any value that is
missing. Excluded values  are treated exactly the same as missing
values.  

Prism never ever treats an empty cell as if you had entered zero -- it
always knows that is a missing value. It will analyze the data if it can, and
leave analysis results blank when it cannot.

The details of how Prism handles missing values differs for various
statistical tests. 

Unpaired t test; Mann-Whitney test; Ordinary one-way ANOVA; Kruskal
Wallis test

These tests work fine with unequal sample size. Missing values are not
a problem.

Paired t or Wilcoxon matched pairs test; repeated measures one-way
ANOVA

Prism only analyzes rows where there are data for all conditions. If one
value is missing, that subject (row) is ignored.

  Ordinary two-way (not repeated measures) ANOVA -- Enter raw data

If some values are missing, two-way ANOVA calculations are
challenging. If any row/column combinations have no values at all,
Prism cannot compute ANOVA. If some row/column combinations have
fewer replicates than others (some replicates are missing),  Prism uses
the method detailed in SA Glantz and BK Slinker. This method converts
the ANOVA problem to a multiple regression problem and then displays
the results as ANOVA. Prism performs multiple regression three times
— each time presenting columns, rows, and interaction to the multiple
regression procedure in a different order. Although it calculates each
sum-of-squares three times, Prism only displays the sum-of-squares
for the factor entered last into the multiple regression equation. These
are called Type III sum-of-squares.
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Ordinary two-way (not repeated measures) ANOVA -- Enter mean, SD
(or SEM) and N

If your data are balanced (same sample size for each condition),
entering data as mean, SD (or SEM) and N is not a problem -- you'll
get the same results as if you had entered raw data. However, this not
the case if your data are unbalanced, it is impossible to calculate
precise results from unbalanced data entered as mean, SD (or SEM),
and N. Instead, Prism uses a simpler method called analysis of
“unweighted means”. This method is detailed in LD Fisher and G
vanBelle (details below). If sample size is the same in all groups, and in
some other special cases, this simpler method gives exactly the same
results as obtained by analysis of the raw data. In other cases,
however, the results will only be approximately correct. If your data are
almost balanced (just one or a few missing values), the approximation
is a good one. When data are unbalanced, you should enter individual
replicates whenever possible.

  Repeated measures two-way ANOVA

Prism cannot perform repeated-measures two-way ANOVA if any values
are missing. Prism  (beginning with Prism 5) works fine if there are
different numbers of numbers of subjects in each group, so long as you
have complete data (at each time point or dose) for each subject. Say
you are comparing two groups (control and treated) measured at four
time points. It would be fine if there were more treated subjects than
control subjects, so long as each subject has data at all four time
points. But Prism can not analyze repeated measures two-way ANOVA
if one of the subjects only had data for three time points, with the
fourth time point missing. .

  Linear and nonlinear regression

Fitting lines and curves works fine with missing values. You can choose
whether Prism fits the individual replicates or fits the means. If you
choose to fit the means, each mean gets the same weight regardless of
how many values were used to compute it. If you fit the individual
replicates, then X values with more Y replicates get more weight than X
values with fewer replicates.

Survival curves

Comparison of survival curves does not require equal sample size. If
data are completely missing for any subject, simply don't enter data for
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that subject. But before deciding to leave data out, read about
censoring which happens when you know the subject survived up until
a certain time, but don't know what happened after that (or you know,
but can't use the data because the experimental protocol wasn't
followed). Prism handles censored data fine. Don't omit those subjects,
enter the duration that they survived on the experimental protocol and
mark that duration as censored. 

9.3.12 Keyboard shortcuts

· The Tab key moves to the right. Shift-tab moves to the left.

· The Enter key moves to the right to the next subcolumn, if there is one;
otherwise it moves down a row and to the first subcolumn. Shift-Enter
does the opposite.

· The DEL key erases all selected values, but the data set will still be
linked to analyses and graphs. When you enter new data, Prism will
update the analyses and graphs. To delete a block of data completely,
select Delete from the Edit menu. Other data on the table will move to
fill the gap.

· Shift-space selects the entire row (Windows)

· Control-space selects the entire data set (Windows).

· Control-A selects the entire table (Windows).

· Shift-Control-Space selects the entire row (Mac).

· Shift-Option-Space selects the entire data set (Mac).

· Command-A selects the entire table (Mac).
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9.3.13 Rounding

How many digits can Prism store?

Prior to Prism 7, Prism stored only seven digits (actually it is binary, so it
is 'about' seven decimal digits) so did not always store the exact value
you entered. For example, if you enter the value 99.2492427 into a data
table, Prism rounded it to 99.249250. 

Prism 7 now stores numbers with double precision, so it can store about
fourteen significant figures.  If you enter the value 99.2492427 into a
data table, Prism 7 stores it as 99.2492427

How to show fewer digits than you entered

By default, Prism tries to show all the digits you entered, and increases
the number of digits after the decimal place to accommodate the extra
digits. But you can use the Format Numbers dialog  to show fewer
digits. And the results of analyses can be rounded as well. 

What you see on the Prism data table matters only when you look at that
table. Notes:

· Choosing to show fewer digits on the data table won't affect how Prism
analyzes or graphs your data. Analyses are always based on all the
digits you entered (up to the number Prism can store).

· When you save the Prism file (as .PZF or .PZFX), Prism saves all the
digits you entered (up to fourteen), so the values are not truncated
when you save.

· When you copy data from a Prism data table to the clipboard, Prism
copies the values you entered, not only the digits you see on the table.

· When you export a data table as a .TXT or .CSV file, Prism exports the
digits you entered, and not only those that appear on the table. 

 
Rounding

There are two issues that can make rounding seem erratic.

202
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· When the next digit is a 5. Rounding values is straightforward unless
the next digit is 5. Should 2.5 be rounded up to 3 or rounded down to 2?
Both are equally accurate, and many strategies have been proposed to
deal with this issue. The Wikipedia article on rounding explains the
many possibilities. Prism rounds values that end with 5 somewhat
unpredictably. For example,  0.25 gets rounded up to 0.3, but 0.45 gets
rounded down to 0.4.  These are both correct, since rounding a 5 up or
down is an arbitrary decision. Prism Windows uses the C function
sprintf() to display real numbers.  A Microsoft knowledgebase article
explains how this function rounds. The function used by the Mac Xcode
compiler is similar but not identical. Note that Microsoft Excel is
different. It uses two methods, one when the calculation is done within a
worksheet and another when done by a macro. 

·  Decimal to binary to decimal. Computers store the number as binary
digits, so need to convert to and from decimal. For many values, this
requires rounding as well. For example, let's say you type in the number
0.055, and ask Prism to display the value to only two decimal places.
The next, third, digit is 5. One common rule to always round up when
the next digit is 5, so you'd expect Prism to display 0.06. But the
computer can't store the value 0.055. Instead, all values are converted
to binary, and the binary value is close to 0.05499996 when converted
back to decimal. When rounding this value to two decimal places, the
next (third) digit is a 4. So Prism Windows rounds down in this case and
displays 0.05. Prism Mac rounds up, in this case, and displays 0.06. 

Really rounding!

The Format Decimal Format dialog rounds down what you see on the
table. But when you go to edit the data, all the digits you entered (or
imported or pasted) are still present. Prism doesn't yet offer a way to
truly round the data you see on the data table. But you can create a user-
defined function that will create a results table that is rounded. 

Click Analyze and choose Transform . Then choose User-defined Y
transform. Then click "Add..." to add a new function. Here is  a transform
that rounds numbers to only include two digits after the decimal:

Y = Floor(Y*10^2 + 0.5)/10^2

The transform multiplies the Y value by 10^2 or 100, adds 0.5, and then
rounds down to the lower integer (that is what the Floor function does).
Then divide by 100. 

Replace "2" in two places by "3" to round to three places, etc. 
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The results will appear on a results page. They will actually show one
more digit than you want and that last digit will always be zero. You can
use Format Decimal format to show one fewer decimal place.

These guided examples of common analyses will get you off to a great
start! CLICK HERE >

 

9.3.14 Data objects

Data objects are blocks of data imported or paste-linked from elsewhere.
You can't edit these data on that table either because the data are linked
to an external text file or to another table in the same Prism project .
Data blocks appear with thick borders. 

The example above has a red border, because the data were copied and
then paste-linked from a red results table. If the values were pasted from
a green results table, the border would be green. Green results tables are
organized like data tables and (unlike red results tables) can be graphed
or further analyzed. If the data were paste linked from another data
table, the border is blue. If the data are linked to an external file, the
border is black. 

9.3.15 Transforming and normalizing?

It is common to want to transform data to perhaps change units or
convert to logarithms. On a spreadsheet you can transform right on the
same table. Not with Prism.  To transform you choose the Transform
analysis  which puts the results on a new Results table and leaves the
data alone. 

Similarly, choose a specialized analysis to Normalize , Transpose , or
Remove a baseline . 
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10 Error bars and replicates

Prism lets you enter error values directly in a data

table and plot them on a graph, or it will calculate

them from raw data. You can choose what you

want error bars to show and how you want them

formatted.

Key concept -- Replicates and error bars

Replicates and error bars on XY graphs

Replicates and error bars on Column graphs

Replicates and error bars on Grouped graphs

Stacked vs. side-by-side replicates

Error bars and confidence bands on Survival graphs

Confidence and prediction bands from regression

Graphing error bars calculated elsewhere

Graphing each replicate

Horizontal error bars

10.1 Key concept -- Replicates and error bars

When you collect scientific data, you almost always collect replicate data
and plot the individual replicates or an error bar showing the variability of

212 212

213

215

216

217

218

219

219

221

223



Error bars and replicates 213

© 1995-2016 GraphPad Software, Inc.

the data. One of Prism's strengths is its ability to handle replicates and
error bars.

· You can enter replicates directly into a Prism data table.

· If you enter replicate values, Prism can plot either individual replicates
or error bars.

· You do not need to enter SD or SEM values in order to plot them. Prism
can plot error bars from raw data.

· You do not need to run a Row Means analysis to plot error bars. Prism
can plot error bars directly from raw data.

See also:

Graphing each replicate

Key concepts: SD

Key concepts: SEM

SD and SEM are not the same

When to plot the SD vs. SEM

10.2 Replicates and error bars on XY graphs

Entering Y replicates or error values

When you create an XY table, choices on the Welcome or New Table
dialog let you specify side-by-side subcolumns for entry of replicates or
error values computed elsewhere. Learn more about XY tables .

The example below is set for entry of two replicate values (duplicates) but
you can choose any number from 2 to 256.

221
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http://www.graphpad.com/guides/prism/6/statistics/index.htm?standard_deviation_(sd).htm
http://www.graphpad.com/guides/prism/6/statistics/index.htm?stat)keyconcepts_sem.htm
http://www.graphpad.com/guides/prism/6/statistics/index.htm?stat_semandsdnotsame.htm
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This next example is set up to enter mean, SD and N for each point.

Entering X error values

From the Welcome (or New Table) dialog, you can choose to enter X error
values.

Note that you cannot enter replicate X values and ask Prism to compute
error bars, nor can you separately define the right and left error values.
You only can enter an error value (which could be a SD or SEM) and Prism
will use that value to plot symmetrical horizontal error bars. 
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Error bars on graph

If you enter error values computed elsewhere, these are plotted on the
graph. 

If you entered replicate values in side-by-side subcolumns, Prism will plot
SD or SEM error bars depending on a setting in the New Graphs tab of the
Preferences  dialog. You can change the choice in the Format Graph
dialog . 

10.3 Replicates and error bars on Column graphs

Column tables offer no choices for data entry

A Column table has no subcolumns. Replicate values are stacked into
each column. Note the distinction between this arrangement of data and
the arrangement used in XY and Grouped tables, where replicates are
placed in side-by-side subcolumns.

When creating a Column table, you have no choices for data entry. Learn
more about Column tables.

If you want to create a column graph but enter error values computed
elsewhere, you can't do so on a Column data table. Instead, create a 
Grouped  table, but enter data only into the first row. A Grouped graph
from data entered on one row looks like a Column graph.

Choosing how to plot error bars and/or replicates

The Welcome dialog not only lets you choose the basic type of graph (via
thumbnails on buttons), it also lets you choose how to plot replicates or
error values (via the drop down list). The choices in the drop down list
change depending on which kind of graph you choose.

Changing how replicates or error bars are plotted

To plot the replicates or error bars differently, you don't have to remake a
graph. Instead, click the Change graph type button.
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The changes you make on the Change Type of Graph dialog apply to all
data sets on the graph.

An alternative approach is to double-click anywhere on the graph to bring
up the Format Graph dialog. Then click the "All' button if you want all
changes to apply to all data sets. If you don't do this, changes apply only
to one data set, so you can plot some data sets one way and other data
sets another way.

10.4 Replicates and error bars on Grouped graphs

Choosing error bars for a grouped graph

When you create a Grouped table, choices on the Welcome or New Table
dialog let you specify side-by-side subcolumns for entry of replicates, or
subcolumns for entry of error values computed elsewhere. Learn more
about Grouped tables . 

Note an important distinction: With XY and Grouped tables, replicates are
entered into side-by-side subcolumns; with Column data, replicates are
stacked into columns.

When you create a grouped graph, the Plot drop down menu gives you
many choices for error bars. Return to this dialog using Change..Graph
Type.

169
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 If you choose to enter error values directly, Prism will plot the values you
entered (except that when you enter %CV, Prism plots the SD). If you
entered Mean, SD (or SEM) and N, you can choose (on the graph) to plot
the error bars as SD, SEM or 95% CI.

 

10.5 Stacked vs. side-by-side replicates

Note that replicates are arranged differently on different kinds of data
tables.

· With XY and Grouped tables, replicates are entered into side-by-side
subcolumns.
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· With Column tablees, replicates are stacked into columns

· When entering data on Contingency, Parts-of-whole, or Survival tables,
you never enter replicate values so this distinction is irrelevant. 

10.6 Error bars and confidence bands on Survival graphs

Survival tables offer no choices for data entry

When you create a survival table, you have no choices for data entry. You
don't enter error values. Instead, Prism computes the SE or 95% CI of
survival when it creates the survival curves from raw survival data. Learn
more about entering survival data .

If you want to enter survival fractions with SE values computed
elsewhere, create an XY graph. In this case, Prism will not be able to
compare survival curves.

Choosing how to plot error bars

The Welcome dialog not only lets you choose the basic type of graph (via
thumbnails on buttons), it also lets you choose how to plot error values.
At each time point, choose to plot the standard error, the 95% confidence
interval, or no error bar.

Changing how error bars are plotted

To plot the replicates or error bars differently, you don't have to remake a
graph. Instead, click the Change graph type button.

The changes you make on the Change Type of Graph dialog apply to all
data sets on the graph.
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An alternative approach is to double-click anywhere on the graph to bring
up the Format Graph dialog. Then click the "All' button so changes you
make apply to all data sets. If you don't do this, you are able to plot some
data sets one way and other data sets another way.

If you plot the 95% confidence interval as confidence bands, you can fill
or color the area between the bands.

10.7 Confidence and prediction bands from regression

When you fit a line with linear regression, or a curve with nonlinear
regression, you can choose to plot confidence or prediction bands.
Confidence bands tell you how precisely you have determined the line or
curve. Prediction bands tell you about the scatter of the data.

Learn more about choosing and graphing prediction and confidence bands
from linear regression and nonlinear regression.

Prediction and scatter bands are computed using complicated calculations
that are part of the regression procedures. You don't enter these values
directly. All you do is check an option when choosing analysis options.

10.8 Graphing error bars calculated elsewhere

Choosing to enter precalculated error values

When creating (or reformatting) a Grouped or XY table, you can choose to
format the table for entry of preaveraged data.

Here is the list of choices:
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If you enter mean and SD or SEM, why also enter n?

If you only want to make a graph showing mean and SD or SEM, you only
need to enter those values into the data table. It is ok to omit the "n"
values, or to format the table for entry of Mean with SD or SEM, but
without n.

It is necessary to enter n in these situations:

· You want to be able to switch between graphing SD, SEM and CI error
bars. If you enter SD or SEM with n, Prism can switch between plotting
whatever form of error value you want to show. 

· You want to do statistical analysis. t tests, ANOVA and more require
knowing sample size. 

· You want accurate nonlinear regression. If you enter the data as mean
and SD or SEM, Prism will fit the means, and ignore the values you
enter as SD or SEM. If you also enter n, Prism can account for scatter
and sample size, and the curve fit will be the same as if you had entered
raw data.

What is the %CV?

The %CV is the coefficient of variation as a percentage, so is defined as
100*SD/Mean.  Since the SD and Mean are in the same units, the %CV is
a unitless percentage. This is only useful for ratio variables, where zero
means none of that value. Weight is a ratio variable, because a weight of
0.0 means no weight. Temperature in C or F is not a ratio variable,
because a temperature of 0.0 doesn't mean no heat.

The difference between entering +/- errors and upper/lower limit errors 

It is easy to confuse the +/- and upper/lower choices for entry of
preaveraged data. But the two are distinct.
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· When you format the subcolumns for entry of +/- error values,  the
values you enter are interpreted as distances. These are added to (or
subtracted from) the value you enter as the mean to compute the end
point of the error bars. 

· When you format subcolumns for entry of upper/lower Limit error
values, the values you enter are interpreted as the end points of the
error bars. The error bars will end at the Y values you enter. 

What if I want to enter the median and quartiles, or some other kind of
error bars?

If you choose to enter the mean, with sample size (n) and SD, SEM or %
CV, you really ought to enter those exact values. Otherwise, analyses
might be incorrect.

If you choose to format the data table with subcolumns for Mean and SD
or SEM or %CV without sample size, or for mean with +- error values or
upper and lower limits, no analyses will be possible. Or rather Prism will
only analyze/fit the means and ignore the error values. If you choose to
format the table so the subcolumns are labeled mean, upper limit, and
lower limit, you are welcome to enter into those subcolumns the median
plus the 25th and 75th percentiles, or whatever values you want. Prism
will plot the error values you enter, and it is up to you to keep track of
how these values were actually calculated, and to label your graphs
accordingly.

10.9 Graphing each replicate

The advantage of showing every replicate instead of error bars

When making a XY graph, Column graph or Grouped graph, you don’t
have to plot error bars. Instead you can graph each data point (replicate).
This is often the best way to display variation, as it shows your data
exactly. Don't plot mean or median with error bars too quickly. Stop to
think about whether a graph of the actual data would be more
informative.
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XY graphs

Choose Individual Replicates when you pick the error format for your
graph.

Column graphs

Choose to make a scatter plot.
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Grouped graphs

Choose the Plot individual values tab. Then choose any of the graph
types.   

10.10 Horizontal error bars

There are three approaches to having horizontal error bars in Prism. 

XY graphs with X error values
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In the Welcome dialog, or using Format Data Table, you can ask Prism to
create a subcolumn for X error bars. 

Prism will then plot each point with horizontal X error bars sticking in
each direction a distance defined by the X error value you entered. 

Rotate Column or Grouped graphs so the Y axis is horizontal

A choice on the third tab of Format Graph, lets you flip any Column or
Grouped graph  so the Y axis is horizontal. If you plot symbols or bars
with error bars, those error bars will now be horizontal, but that
horizontal axis is now the Y axis. 

Depth charts

When you place an XY graph on a layout, you can choose to have it
rotated 90 degrees to create a depth chart . Error bars that are vertical
on the graph will now be horizontal on the layout.
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11 Importing and exporting data

Prism gives you several options to get data from

other applications. You can copy and paste, or

import.
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11.1 Linking and embedding data

When you copy and paste from an Excel file or text file into a Prism data
table, you have the option to paste only the values or to keep a live link
to the original file so that whenever the original file is changed and saved,
your Prism graphs and analyses will update. A third option is to embed
(keep a copy) of the original file inside your Prism file.

When you link, you keep a connection to the original file. When you
embed, you make a new copy.

Linking and embedding works differently with Prism for Windows and
Prism for Mac:

· With Prism for Windows you can link or embed to Excel and text files.

· With Prism for Mac, you can't embed files or link directly to Excel
spreadsheets. You can, however, link to text files.

11.1.1 Changing linked and embedded data

Blocks of Prism data linked to a text file or linked to an embedded spreadsheet
(Windows only) appear with a border around them. These are called data objects. You
cannot edit these values within Prism. When you click on any cell within a block, you
select the entire data object. The figure below shows a data object.
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To edit the data:

Double-click anywhere on a block of linked data to bring up the Import
and Paste Special  dialog. Then click Open File to Edit Data. This will
open your original Excel file. After editing and saving the spreadsheet,
return to Prism and press Update to close the dialog.

To unlink a data object:

Double-click anywhere within the object to bring up the Import and
Paste Special  dialog. Click the Unlink button on the bottom of that
dialog. The values will remain on Prism’s data table, but will no longer
be linked to an external file or to an embedded spreadsheet.

To move a data object to a different location on the same table:

Double-click anywhere on the data object to open the Import and Paste
Special Choices dialog. Go to the Placement tab. Find the spot where you
can change the top-left corner of the object. Enter a row number and
choose a column for the new location. 

To move a data object to a different data table:

It is not possible to move a data object to a different data table. You can
delete it from the table where it doesn't belong. Then go back to the
source data, and copy-paste special to the correct location. 

To update values in Prism after editing a linked file:

Double-click on the data object in Prism to bring up the Import and
Paste Special  dialog. Press the Update button on that dialog. This is
only necessary if you didn't check the option to automatically update on
the Source  tab.

To change the region of a spreadsheet file linked to Prism. (Windows only):

If you accidentally linked to the wrong part of a linked spreadsheet, the
simplest approach is to unlink the data object, then start over.

An alternative approach is to change the region linked within Prism.
Click on the linked data object, then pull down the Edit menu and choose
Links.
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You will see a list of each linked data range on the current Prism table,
with the region you selected already highlighted. Press Change Source,
to bring up a second dialog.

At the bottom of that dialog, you'll see the current linked range in the
field labeled Item Name. With Excel, this range is formatted in an
unfamiliar way. R1C3:R100C4 goes from the first row of column 3 to the
100th row of column 4.

Note that you can also use this dialog to link to a different Excel file. 

To change the region of a spreadsheet embedded within Prism: (Windows
only.)

If you accidentally embedded the wrong part of a spreadsheet, you'll
need to copy and paste again. You can't simply delete the data object
and start again, because the object contains the embedded Excel table.
If you don't have the original spreadsheet file, you need to save it from
Prism. To do this, open the embedded spreadsheet from Prism, and then
use Excel's File..Save Copy As command to save the spreadsheet as a
file. Then you can delete the data object, and start over.

To select a single cell within a Data Object to copy to the clipboard:

It is difficult to select a single cell within a data object. If you click on a
cell in a data object, you will select the entire object. To select one cell
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within an object, click on a cell near the object, but outside of it. Then
use the arrow keys to move the selection inside the object to the desired
cell.

If a linked file has moved:

If the linked text or Excel file is in a folder different than the Prism file:
Prism stores the absolute location of the linked file. If the file no longer
exists at that location, Prism won't be able to find it, so will not be able
to update the data table. However, the imported values remain in the
Prism file. You won’t lose any data if the link is broken.

If the linked text or Exel file is in the same folder as the Prism file: It
matters whether the Prism file is stored in the .PZF or .PZFX format. If
.PZFX, the link is absolute. If the folder has a new name, or has been
moved to a new location, the link is lost. If the Prism file is in the .PZF
format, then Prism will maintain the link to the Excel or text file that is
in the same folder as the Prism file. It doesn't matter if the folder has
been renamed or has been moved to a new location. 

 

11.1.2 Paste linking data from Prism

You can copy data (or results), and paste link the data to the same or
different data table. You can either use the Paste...Link command on the
Edit menu (and the right-click shortcut menu), or choose to link in the
dialog that comes up when you choose Paste Special.

The pasted results are linked, which means if the original data are edited
or replaced, the linked values will update too.

Example 1

You use nonlinear regression to fit a dose response curve to six data sets.
The first three (A-C) are for one drug; the other three are for another (D-
F).  The logIC50 values are all on one row. You know tha the first three
are for one drug, and the next three for another. But Prism doesn't "know"
this. The results look like this:
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You want to put the logIC50 values into a new data table. The first three
should go into column A, and the next three into column B. Follow these
steps:

1.  Select the six values.

2.  Copy them to the clipboard.

3.  Use New...Data table and graph to make a new Column table.

4.  Put the insertion point into Column A and Row 1 of that new table.

5.  Choose Paste Special from the Edit (or right-click shortcut) menu.

6.  On the first (Source) tab of the Import and Paste Special dialog,
choose to insert and maintain link.

7.  On the fourth (Placement) tab of that dialog, choose to paste by
columns, stacking 3 values in each column. That way the six values
that you copied as one row, will paste into two columns.

8.  Click OK.

9.  Note that the values pasted into the data table are surrounded by a
red box. You cannot edit these values on the data table. If you double
click within that box, you'll return to the Import and Paste Special
dialog (where you can unlink the values, if you want to).
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10. Prove to yourself that the values are linked. Change the data being
analyzed, and notice that the summary values that you paste-linked
automatically update.

11. Create a graph of these values using New...Graph of existing data.

12. Compare the groups of values with a test.

13. Download the Prism file. 

 

Example 2

You have two sets of column data that you wish to plot both as a bar
graph showing the mean and SD, and also has a scatter graph showing
individual values.

One approach is to superimpose the bars and individual symbols. Prism 6
makes this simple, as it offers this as one of the choices for column
graphs. This can look good if you omit the error bar, but looks cluttered
when you include error bars. I used light colors for the symbols in the
graph below, which helped a bit.
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Another approach is to put the bars and symbols side by side. Follow
these steps.

1. Enter the two columns of data into columns B and C.

2. Select the values in Column B and copy to the clipboard.

3. Put the insertion point at the top of column A, and choose Paste...Link

from the Edit menu (or the right-click shortcut menu).

4. Select the values in Column C and copy to the clipboard.

5. Put the insertion point at the top of Column D, and choose Paste..Link

from the Edit menu.

6. Note that the pasted values in Columns A and D are surrounded by a

box and cannot be edited.

7. Edit a value in Column B or C. Note that Column A and D are instantly

updated when you move the insertion point. 

8. Polish the graph by double clicking on it, and choosing graphing options

for each data set.
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11.1.3 Unlinking data objects

When a block of data on a Prism data table is linked to another file (or to
embedded data), the data in Prism is included in a box. The box is black if
the linked data came from outside of Prism, red or green if the data were
paste linked from a Prism results table, and blue if the data were paste
linked from a Prism data table. 

You cannot edit these values in the data table because they are linked to
another source. 

To unlink the data block, and allow editing, right click anywhere within
the block of data, choose the Data Object command and then choose
Unlink.

11.2 Pasting data from Excel (Windows)

Select a range of Excel data and copy it to the clipboard. Switch to Prism,
move the insertion point to the cell of a data table that will become the
upper-left corner of the pasted data.

Pasting Excel data

Then click on the Paste  or Paste Special   button in the Prism
Clipboard toolbar.

If you use the Paste button or the keyboard shortcut (Ctrl+V), you will
only paste the values that have been copied to the clipboard. If you
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choose Paste Special , you have several options about how you want to
insert your data into Prism's data table. These options are only available
with Windows. If you use a Mac, skip to this page . 

· Paste Data -- Prism retains no link back to the Excel spreadsheet. The
values will be pasted and nothing else. The only advantage to using this
method is that it is conceptually simpler.

· Paste Embed -- You paste the selected data into the data table and also
paste a copy of the entire spreadsheet file into your Prism project, even
if it has several worksheets (tabs). This means you don’t need to worry
about keeping track of multiple files. You don't need to save the
spreadsheet file separately (except as a backup). You can open Excel
from within Prism, edit the data, and instantly update the analyses and
graphs in Prism. A potential disadvantage of embedding is that you will
end up with multiple copies of the same data. Another disadvantage is
that your Prism files will be larger.

· Paste Link -- Paste the values into the data table but also create a link
back to the Excel file. The link has two functions. It lets you trace (and
document) the source of the data so you stay organized. It also is a live
link. If you edit or replace the data within Excel, Prism will update the
analyses and graphs. The Paste Link command is available only if you
paste from an Excel workbook that has a name. If you are working with
a new Excel file, you must first save it (thus giving it a name) before
you can link its data into Prism. When in doubt, use Paste Link.

· Paste Data Transposed -- Converts data in Excel rows into columns in
Prism, and vice versa.
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· Paste Embed Transposed -- Converts data in Excel rows into columns in
Prism, and vice versa. You can choose to paste data only, and embeds a
copy of the Excel sheet in Prism.

· Paste Link Transposed -- Converts data in Excel rows into columns in
Prism, and vice versa. Retains a link to the original Excel sheet

· Paste Special -- Opens dialog to let you choose whether to embed or
link to the original file (Windows only), and also choose to filter and
rearrange the data as you paste it into Prism. The Paste Special dialog is
identical to the Import dialog .

Pasting an Excel table as a picture

You can copy a portion of an Excel spreadsheet and paste it onto a Prism 
graph  or layout . This pastes a picture only, and Prism cannot analyze
or graph the values since the values are not in any Prism data tables.

Importing Excel files

There are some limitations, and we don't recommend it, but you can 
import  Excel files directly into Prism for Windows.

11.3 Pasting data from Excel (Mac)

Pasting data from Excel
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Select a range of Excel data and copy it to the clipboard. Switch to Prism
and move the insertion point to the cell of the data table that will become
the upper-left corner of the pasted data.

Then click on the Paste or Paste Special   button in the Clipboard
toolbar.

· Paste -- You will only paste the values that have been copied to the
clipboard.

· Paste Transpose -- Converts data in Excel rows into columns in Prism,
and vice versa.

· Paste Special -- You'll then see the Import and Paste Special  dialog,
where you can choose whether to filter and rearrange the data (such as
transposing).

Note that it is not possible to Paste Embed or Paste Link to Excel files on
the Macintosh. Those features only work on Windows.

Pasting an Excel table as a picture

You can copy a portion of an Excel spreadsheet and paste it onto a Prism 
graph  or layout . This pastes a picture only, and Prism cannot analyze
or graph the values since the values are not in any Prism data tables.
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Importing Excel files

Prism Mac cannot import Excel files. Either copy and paste, or save from Excel in CSV

format and import that text file  into Prism.

11.4 Options when pasting data from Excel (win or mac)

What Excel puts on the clipboard

Excel Windows 2003 and later, and Excel Mac 2008 and later, copy data
to the clipboard in two formats: Plain text, and HTML.

By default, Prism (starting with 5.0c and 5.03)  pastes the HTML format.
This will allow much better pasting of Greek letters, superscripts and
subscripts, titles with punctuation, numbers with nonstandard thousands
or decimal separators, and more.

There is one change. If the Excel cell contains a mixture of numbers and
letters (or punctuation), prior versions tried to extract and paste just the
numbers. Prism Mac still works that way, but Prism Windows won't paste
anything into numerical parts of a Prism table if the corresponding Excel
cell mixes numbers and text. 

This new style of pasting only applies when pasting values. Paste-
embedding and paste-linking (Windows only) are not changed.

Changing back to the old style

238
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Pasting from the HTML rendition is the default. If it causes any problems,
use Edit..Paste Special and check the new option on the first tab:

    [ x]Paste older text-based clipboard format. Not recommended.

With this option selected, pasting will work just as it did with earlier
releases of Prism (before 5.03 and 5.0c). We don't anticipate any
situations where this will be helpful, but are providing this option just in
case. The option is available when you insert data only, and will be
unavailable if you choose to paste link or paste embed. 

Numbers, a Mac spreadsheet that is part of iWork, does not copy the
HTML so pasting from Numbers always uses the older style.

Two ways to paste from the HTML (older Excel versions only)

It gets even more complicated.

The HTML clipboard version from some versions of Excel contains each
number twice. One copy shows exactly what you see in Excel. The other
copy shows the value with more decimal places (ignoring formatting or
rounding within Excel). By default, Prism pastes the values as they are
shown in Excel. But the Paste Special dialog lets you use the other
version if you prefer:

 [x ]Paste as many digits as possible. If Excel rounds to 1.23, paste
1.23456

This option is not available if you copy from Excel Windows 2007 or later,
as the necessary information is not copied to the clipboard.

11.5 Importing data from text files

Importing a file vs. opening a file

From the Welcome dialog (or the File Open command), you can only open
Prism project files. 

To import data from a file, you must first create a new Prism project (or
open an existing one), go to a data table, position the insertion point, and
then choose the Import command or click the Import button.
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Prism will show you the Import and Paste Special  dialog, which will let
you choose whether to embed or link to the original file (Windows only),
and also will let you filter and rearrange the data as you bring it into
Prism.

Formats Prism can import

Prism can import text files delimited with tabs (.txt files) or commas (.csv
files).

When thinking about whether Prism can import your files, distinguish the
format of the file from the arrangement of the data. Prism arranges data
differently than do most programs that can export .csv or .txt files. 

To create a text file from an Excel spreadsheet:

Go to the worksheet (tab) you want to export, then pull down Excel's File
menu and choose Save as. Select either Text (tab delimited) or CSV
(comma delimited) format.

11.6 Importing text and Excel files directly

Importing Excel files

To import data into Prism (Windows only) directly from an Excel XLS file:

Start from a data table and move insertion point to the cell that will
become the upper-left corner of the imported data. Click on the Import
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button on the Prism toolbar. Whenever possible, transfer data from Excel
using copy and paste.

Prism will show you the Import and Paste Special  dialog, which will let
you choose whether to embed or link to the original file, and also will let
you filter and rearrange the data as you bring it into Prism.

Limitations to importing Excel files directly

If your Excel workbook (spreadsheet file) has several worksheets (tabs),
Prism only reads one – the one that was selected when the file was
saved. Any other worksheets are invisible to Prism.

When importing data from an Excel file, Prism launches Excel invisibly,
and asks Excel to send the data to Prism. So Prism can only import an
Excel file if Excel is available on the same computer as Prism. Because
Excel has to be launched in the background, importing an Excel file can
take much longer than importing a text file.

Importing an Excel file requires an OLE (Object Linking and Embedding)
connection between Prism and Excel. This is a complicated process,
requiring the coordination of Excel, Prism, and various Windows
components. While it works fine on most computers, it simply doesn't
work on some computers. Because Macintosh computers don't support
OLE, importing Excel files directly isn't possible with Prism Mac.

You'll rarely want to import an entire Excel spreadsheet into Prism. While
you can restrict rows and columns to import on Prism's Import dialog, in
most cases it is easier to simply copy and paste the appropriate range.

Importing text files

All spreadsheet and statistics programs can export blocks of data as a
text file, separating adjacent columns with commas, semicolons, or tabs.
Text files commonly have extensions such as .TXT, .DAT, .CSV (comma
separated value), or .PRN (printer). Some programs refer to these files as
ASCII files rather than text files.

To import data into Prism from a text (ASCII) file:
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Start from a data table and move insertion point to the cell in the data
table that will become the upper-left corner of the imported data. Click on
the Import button on the Prism toolbar.

Prism will show you the Import and Paste Special  dialog, which will let
you choose whether to embed or link to the original file (Windows only),
and also will let you filter and rearrange the data as you bring it into
Prism.

Note that it is not sufficient that a file have an extension (file type) such
as txt or dat. The file has to be a plain text file. If a file is not a text file,
renaming it to have a different extension won’t help.

11.7 Importing and pasting choices

The Import and Paste Special Choices dialog comes up when you import
a file into a Prism data table, or use the Paste Special command. It has
five tabs:

Source  - The Source tab lets you choose between importing or pasting just the
values, linking to a file, or embedding a data object.

View  - The View tab lets you see the contents of the imported or pasted file,
divided into columns.

Filter  - The Filter tab let you choose which portions of the data file to import.

Placement  - The Placement tab lets you rearrange your data as you
import/paste it into Prism.

Info & Notes  - The Info & Notes tab gives you tools to import
sections of a text file directly into a Prism Info sheet .
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11.7.1 Source tab

Linking and embedding

Insert Data only

Prism retains no link back to the Excel spreadsheet or text file. The values
will be pasted and nothing else. The only advantage to using this method
is that it is conceptually simpler.

Insert and Maintain Link

Paste or Import the values into the data table but also create a link back
to the original file. The link has two functions. It lets you trace (and
document) the source of the data so you stay organized. It also is a live
link. If you edit or replace the data in the original data file, Prism will
update the analyses and graphs. With Prism for Windows, you can link
directly to a text or Excel file. Prism for Mac will link only to text files.
With Prism Windows, the Link option is available only if you paste from an
Excel workbook that has a name. If you are working with a new Excel file,
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you must first save it (thus giving it a name) before you can link its data
into Prism.

Embed as OLE object (Windows only)

Paste or Import the selected data into the data table and also paste a
copy of the entire original spreadsheet or text file into your Prism project,
even if it has several worksheets (tabs). This means you don’t need to
worry about keeping track of multiple files. You don't need to save the
spreadsheet file separately (except as a backup). You can open Excel
from within Prism, edit the data, and instantly update the analyses and
graphs in Prism. A potential disadvantage of embedding is that you will
end up with multiple copies of the same data. Another disadvantage is
that your Prism files will be larger.

Automatically update Prism when the data file is changed

If you check this option, whenever you look at a Prism data table, graph,
results sheet, or layout, Prism will update the sheet if the linked Excel file
has been changed.

Excel options

What Excel puts on the clipboard

Excel Windows 2003  and Excel Mac 2008, copy data to the clipboard in
two formats: Plain text, and HTML. Numbers, a Mac spreadsheet that is
part of iWork, only copies in plan text format.

When there is a choice, Prism (starting with 5.0c and 5.03) pastes the
HTML format by default. This allows much better pasting of Greek letters,
superscripts and subscripts, titles with punctuation, numbers with
nonstandard thousands or decimal separators, and more. You can specify
that the text format be used by checking the option:

  [x]Paste older text-based clipboard format. Not recommended.

Two ways to paste from the HTML

It gets even more complicated. With Excel 2003, the HTML clipboard
version contains each number twice. One copy shows exactly what you
see in Excel. The other copy shows the value with more decimal places
(ignoring formatting or rounding within Excel). By default, Prism pastes
the values as they are shown in Excel. But the Paste Special dialog lets
you use the other version if you prefer:

   [x]Paste as many digits as possible. If Excel rounds to 1.23, paste 1.23456
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This option is not available if you copy from Excel 2007 or Excel 2010, as
the necessary information is not copied to the clipboard. It is also not
available when importing from Excel.

Note a bug in Excel Mac 2008. In very rare cases, using that option will
result in the wrong values being pasted into Prism. 

How to interpret spaces and commas

The choices are self-explanatory, but important.

11.7.2 View tab

The View tab of the Import and Paste Special dialog lets you see the
contents of the imported or pasted file, divided into columns. This can be
especially helpful if you are importing from a comma- or tab-delimited
text file. A quick look can let you know if your columns are formatted
correctly.

http://www.graphpad.com/faq/viewfaq.cfm?faq=1607
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Once you've pasted linked data into a Prism data table, click Open File to
open and edit the data file. If it is an Excel file, you'll open Excel. If it is a
text file, you will open a text editor.

11.7.3 Filter tab

Choices on the Filter tab of the Import and Paste Special dialog let you
choose which portions of the data file to import.
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Unknown and excluded values

When entering data, you can leave any parts of the data table empty.
Prism automatically figures out what to do with missing values. When
Prism imports a text file, it handles missing values automatically. Some
other programs use a code, say 99, to denote missing values. If you
import data from such a program, enter that code value into the Filter
tab.

To denote an excluded value in a text file (or within Excel), put an
asterisk immediately after the value. Then check the option on the Filter
tab to exclude values followed by asterisks.

Pick which Rows you wish to import or skip

First, select the range of rows to import, by specifying a first and last
row. If the file you are importing includes <notes>, <info>, or <title>
information (see Paste Special Notes ), start counting rows at the first
row after this structured information. Row “1” is the first row with data,
not the first row in the file.
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Then, select rows you want to skip. The filters work by checking whether
a designated column meets a criterion you specify. You can apply any
combination of three kinds of filters:

· Skip all rows until a criterion is met

· Skip all rows after a criterion is met

· Skip every row that meets your criterion.

When defining the criterion, you can use any column in the original file.
You are not restricted to using columns you choose to import. Compare
by checking whether the value of each row in the column is less than or
equal to (<=), less than (<), equal to (=), greater than (>), greater than
or equal to (>=) or not equal (<>) to the value you enter. It is not
possible to define criteria that compare values in two columns, only to
compare the value in one column with a value you enter in the dialog.

Decimate

If your data file is huge, you can decimate the data as you import.
"Decimate" literally means to keep one of every ten rows of data, but you
can tell Prism to skip any number of rows between the rows it imports. It
imports a row, skips the number of rows you specify, and then reads
another row. This is useful with any large file as a way to make Prism files
smaller and accelerate analyses and graphing.

Columns

Choose a range of columns you wish to copy by specifying a first and last
column. Or choose to read a column, skip one or more columns, and then
read another column.

Unstack

Some statistics programs save data in an indexed format (sometimes
called a stacked format). Each row is for a case, and each column is for a
variable. Different groups or experimental conditions are not defined by
different columns (as Prism is organized), but rather by a grouping
variable. Prism can unstack indexed data. Specify which column contains
the data and which column contains the group identifier. The group
identifiers must be integers (not text), but do not have to start at 1 and
do not have to be sequential.
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Example: In this sample of an indexed data file, you may want to import
only the data in column 2 and use the values in column 3 to define the
two groups.

Row # Col. 1 Col. 2 Col. 3

1 12 123 5

2 14 142 6

3 13 152 5

4 12 116 6

5 11 125 6

6 15 134 5

Check the box to unstack data only from column 2 using column 3 to
identify the groups. Prism will automatically rearrange the data, so they
look this like:

Row # First Col. Second Col.

1 123 142

2 152 116

3 134 125

The column that identifies the groups must contain integers. The lowest
integer defines the group whose values will be placed in the column
containing the insertion point in Prism. If there are gaps in group
numbers, Prism will leave blank columns.

If you use Paste Special to paste data from the
clipboard, the column numbers in the Filter tab
are relative to the range of data you copied to
the clipboard. For example, if you copied cells
C13-F45 from Excel to the clipboard, then
column 1 in Prism’s Filter tab refers to the data
in Column C in Excel, the first column of the
copied range.
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11.7.4 Placement tab

The Placement tab of the Import and Paste Special dialog lets you
rearrange your data as you import/paste into Prism.

Names

The Placement tab lets you choose whether you want to rename the Prism data
table and/or the Prism column titles with the name of the imported file, or with text
imported from a specified row in that file.

Top-left position of inserted data within Prism

Specify the top-left corner of the data object in Prism. Normally, this will be the
position of the insertion point when you choose the Import or Paste Special
command, but you can change it.

Row and column arrangement

Prism can rearrange the data as it imports. If you choose Transpose, the first row
in the source will become the first column in Prism, the second row in the source
becomes the second column in Prism, and so on.

If the data source has one column (or row) and you want to organize the data
according to your experimental design, choose By rows or By columns.

Example: Your data source has thirty values in a single column, and you wish to
import into a Prism data table formatted for entry of triplicate Y values. The first
three values in the source data are the first three replicates. The next three values
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in the source are the next set of replicates, so they belong in row 2 of data set A.
After filling five rows, you want to start inserting data into data set B. Choose to
import by rows, placing three values on each row and starting a new column after
five rows.

If the data source has the values from 1 to 30 in order, Prism will organize the data
as shown below. When placing values side-by-side, Prism does not pay attention to
the difference between subcolumns and data sets. It just puts values in the next
cell to the right, and it doesn't care whether that cell is another replicate, a SD, or
the beginning of a new data set. In the example above, Prism placed three values
side-by-side because you entered 3 into the dialog. The data table was formatted
separately for triplicate values.

If you choose to arrange the data “By rows” or
“by columns”, Prism reads the values row-by-
row from your source file, but ignores all line
breaks. It treats the data as though it came
from one column or one row.

11.7.5 Info & Notes tab

Prism's Info Sheets are a place to store details about a project or
experiment. If you are importing data from a text file (or pasting), you
can import ranges of information from a text file directly into a linked Info
sheet  in your Prism file.147



Importing and exporting data 251

© 1995-2016 GraphPad Software, Inc.

You can import this information at the same time you import your data.
Use the Info and Notes tab of the Import and Paste dialog to specify the
rows you want to import and which Info sheet you want them to flow into.

If you can control the format of your text file, you can include info
constants and notes in structured sections at the beginning of the text
file. Mark the sections in the text file with <> variable names as below.

· Mark any values that you want to import to Info Sheets for use as
constants as:

<Info>

· Mark sections you want to go into the freeform Notes areas of an Info
Sheet as:

<Notes>

· Mark a section to use as a title for your Info sheet as <Title>

Example:

<Info>
Experimenter, “Dave Jones”
”Lot number”,   564A
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”Specific radioactivity”,   345.6
</Info>
<Notes>
The experiment went smoothly, but we noticed a large bubble in the third replicate at 10 micro molar.
</Notes>
<Title>
Experiment of June 32, 2098
</Title>

Enter a tab after the <Info> variable name to separate it from its value.
If the variable name is two words, use quotation marks around the name.

The three blocks (info, notes, and title) can appear in any order,  but they
must appear at the beginning of the file. You can include one, two or all
three of the blocks,

If the info variable already exists, its value will be updated. If the variable
doesn’t exist, it will be appended to the Info table. 

Notes will be appended to the notes (right) portion of the Info sheet. It is
not possible to include Greek letters or super or subscripts when
importing.

The title you enter, if you include a <title> section, will replace the data
table sheet title.

When you use the View  tab to preview your data, the preview will not
include the structured information enclosed in notes, info, or title tags.
When you enter information on the Filter tab about which rows to include,
start counting with the first row following the structured information.

11.8 Troubleshooting: Negative numbers become positive; fractional
numbers become integers?

Situations where negative values become positive when pasted or
imported into a Prism table:

· In a contingency table. the rows denote treatment or exposure and the
columns denote alternative outcomes. Each value is the actual number
of subjects, objects or events. Thus all values must be positive integers
or zero. If the data you are importing has any negative values, the
minus signs are simply ignored, so the value will become positive. If you
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want to include negative numbers, you are not really creating a
contingency table. Drop the Change menu, choose Format Data Table,
and choose a different kind of table. You probably want a Grouped table.

· Excel can be configure to show negative values in red, without the
negative sign. When you copy and paste this to Prism, the color is lost
but the negative sign is not restored. 

· Some financial programs show negative numbers within parentheses.
Prism does not understand this syntax, and the numbers will not be
pasted as negative values.

· In a survival table, the Y values are a code. One value (usually 1)
indicates that the event (often death) occurred. The other value (usually
0) indicates that the data are censored after the specified X (time)
value. Negative values are impossible. 

Situations where fractional values can become integers when imported
or pasted into a Prism table:

· In a contingency table. the rows denote treatment or exposure and the
columns denote alternative outcomes. Each value is the actual number
of subjects, objects or events. Thus all values must be positive integers
or zero. If the data you are importing or pasting has a decimal point,
this will be ignored, so "1.23" will paste or import as "123".  If you want
to include numbers of fractions, you are not really creating a
contingency table. Drop the Change menu, choose Format Data Table,
and choose a different kind of table. You probably want a Grouped table.

· The Y columns of survival tables hold simple code values. Usually, 1
means death (or some other event happened) and 0 means the data
were censored. You can change the code, but Prism can only accept
integers into the Y columns of survival tables.

· Number format can depend on where you (or whoever made the text
file) lives. A comma sometimes denotes thousands, but sometimes is a
decimal separator. If you have trouble, use Edit..Paste Special (instead
of plain Paste). The first tab of Paste Special dialog  (which is identical
to the Import dialog) lets you define what commas mean. 
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11.9 Exporting from data tables

Copy and paste

The best way to take Prism data or results and place into Word or
PowerPoint is via copy and paste. If you do this, you'll find that Prism's
tables remain tables when they are pasted. In contrast, if you export then
import a text file, Word or PowerPoint won't format it as a table.

When pasting into Excel, or some other spreadsheet or statistical
program, note the options at the bottom of the File & Printer tab of the
Preferences dialog. Choose whether you want excluded values copied, and
whether you want the decimal separator to be a period or comma.

Exporting Prism data

From any data or results table, click on the Export button on the toolbar
and choose the format you want to use.



Importing and exporting data 255

© 1995-2016 GraphPad Software, Inc.

Exporting format

You also can specify how to handle excluded values, how to format the
decimal separator, and whether or not to include column titles.

CSV

CSV stands for "comma-delimited values", but the name is a bit
misleading. In the Preferences dialog , you can choose to export values
using a period (point) or a comma as the decimal separator. If you choose
a period (the US standard), then adjacent columns are indeed separated
by commas. If you choose a comma, then adjacent columns or
subcolumns are separated by semicolons.

This is a very standard format useful for moving blocks of data into
spreadsheet or word processing programs like Excel and Word.

When Prism exports into CSV, it doesn't distinguish row titles, X columns,
Y columns, and subcolumns. All the values are simply exported. Special
characters (Greek, subscripts, etc.) are lost from column and row titles.

TXT

This format is very similar to CSV, except that adjacent columns are
separated with tabs. These are common formats and can be used to
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easily move blocks of data into spreadsheet or word processing programs
like Excel and Word.

This is a very standard format useful for moving blocks of data into
spreadsheet or word processing programs like Excel and Word.

When Prism exports into TXT, it doesn't distinguish row titles, X columns,
Y columns, and subcolumns. All the values are simply exported. Special
characters (Greek, subscripts, etc.) are lost from column and row titles

XML

When you export in XML format, the exported file includes all special
formatting, including Greek characters, subscript, superscript, subcolumn
formats, etc. When you later import an XML file, everything should just
work. There is no ambiguity about whether commas are for decimals,
thousands, or used to separate columns.

If your goal is to export a data table from Prism on one computer and
import it into Prism on another computer, you should choose XML format.

While Prism follows standard XML conventions, the way Prism denotes
unique features such as subcolumn, excluded values, floating notes, etc.
is unique, so files can't be directly imported into other programs without
some extra work.

An XML style sheet is appended to every XML file exported. That means
you can view the file in a web browser, and see your data tables as
tables. But don't be fooled by this. You are not viewing the XML file, you
are viewing a rendition of the file as specified in a style sheet that is
appended to every XML file Prism exports. To see what the file actually
looks like, use a text editor.

We provide the XML schema in the Prism program folder
(prism6xmlschema.xml). Using that (and by exporting sample files from
Prism) a programmer could enable other programs to export data in
Prism XML format.

In addition to exporting data tables as XML, Prism can save an entire
project in a new XML based file format (PZFX ).

More choices when exporting or copying data

How should excluded values be handled?
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The idea of excluding values is unique to Prism, so there is no standard
way to denote exclusion when exporting data. Prism 6 offers three
choices. Excluded values can appear:

· Just like all other values, ignoring the fact that they are excluded.

· Followed by an asterisk. 

· As missing values, blanks.

What should the decimal separator be?

You have three choices:

· A period or point (1.23).  

· A comma (1,23).  

· Let Prism decide, based on your Windows or Mac control panel.

These choices are set in the export dialog when you export to a file. When
you copy the data to paste somewhere, these choices are set in the File &
Printer tab of Preferences dialog.
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12 Analyzing data with Prism

This section explains how to analyze data with

Prism. For help with statistical principles, and with

particular analyses, go to the Statistics Guide.
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12.1 Analyzing data: The basics

 .

12.1.1 What 'analyze' means in Prism

Prism uses the term analyze to include not only statistics and regression,
but also for data manipulations such as transforming, removing baselines,
and normalizing. In all cases, the results of each analysis appears on new
results pages and the data table does not change. For example, if you
transform data, the transformed values do not replace the data. Instead
they appear in a new results page. 

Data and analyses are linked. If you change the data, the analysis results
will update automatically as will any linked graphs. This works even if you
have chained several analyses . You can stop the automatic updating by
freezing  the results sheet. 

12.1.2 How to analyze data with Prism

Start from any data table or graph, and click the Analyze button. There is
no need to first select a range of data to analyze.  Prism completely
ignores any selection you made before clicking the Analyze button. 

Step 1. Analyze dialog

The analyze dialog appears. Make sure the drop down on the upper left is
set to 'Built-in analysis', and choose an analysis.The right half lets you
choose to only analyze selected data sets. It is not possible to choose a
subset of rows to analyze -- Prism always analyzes them all.
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Step 2. Analysis parameters dialog

Each analysis dialog has its own parameters dialog. Read about individual
analyses to learn about the choices.

If you are unsure about an analysis choice, click the Learn button in the
dialog to go to the appropriate help topic.

Step 3. View the results

Prism places the results into new sheets in the Results section of your
project. These results sheets are saved with the project. At any time in
the future, you can view the results, review the analysis choices, and
change those choice to update the results.
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Some results are presented on several sub-pages. Choose a sub-page to
view using the navigator (on the left) or the navigation toolbar (at the
bottom).

      

Step 4. Analysis checklist

Click the Analysis checklist button in the Interpret section of the Prism
toolbar to review a list of questions that will help you interpret the
results..

12.1.3 Statistical analyses and linear or nonlinear regression

Prism comes with three on-line guides (help). The details of statistics and
regressions are explained in the other guides.

· View the Statistics Guide

· View the Curve Fitting (Regression) Guide

12.2 Working with results of analyses

 .
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12.2.1 Creating chains of analyses

Results tables that can be analyzed further have green grids (in contrast,
tables with red grids cannot be analyzed further). There is no limit to how
many analyses can be chained together in this way. When you edit or
update the data table, Prism will update the entire analysis chain
automatically.

At the top of the Navigator, you'll then see The Data with Results folder,
which shows results nested underneath the corresponding data tables.
Analysis chains appear as a series of indented sheet names. In this
example, data are first transformed, then normalized, and then fit with
nonlinear regression.

You can choose to hide the Data and Results folder or to show it always,
even when you haven't created any analysis chains.  These choices are in
the View tab of the Preferences dialog.
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12.2.2 Changing an analysis

After reviewing the results of an analysis, you may want to change your
choices. Click on the Results button in the upper left corner of any
analysis results sheet to open the Analysis Parameters dialog.

Two buttons in the toolbar let you change an analysis:

 -- Change the analysis parameters (choices).

 -- Change which data table and data sets are analyzed.

12.2.3 Repeating an analysis

If you have already entered data on a new data table, and want to
analyze it exactly like you have already analyzed an existing table, use
the Wand  (Wizard to ANalyze Data).136



GraphPad Prism7 User Guide264

© 1995-2016 GraphPad Software, Inc.

If you haven't yet entered the new data, consider duplicating the current
data table with its family . Then edit or replace the data on the new
table and the analyses will update. 

If you have placed parts of the analysis on the graph (regression lines or
curves, or copy and paste a results table), then you can clone that
graph . 

12.2.4 Graphing results

If the results table has a green grid (but not a red grid), you can make a
graph of the results. To do so, click the New button and choose Graph of
existing data.  Then choose the graph you want to make. 

12.2.5 Frozen and orphaned analysis results

Frozen results

When you edit or replace data, Prism automatically recomputes all linked
analyses. If you don't want a particular results sheet to automatically
update when the data are changed, click the freeze button in the Sheet
section of the toolbar. 

For example, you might want to freeze the results before excluding some
outliers from the data, then repeat the analysis and have both copies of
the results in the project. Click again to unfreeze. When a sheet is frozen,
you'll see the word "frozen" in the status bar at the bottom of the
window, as well as a floating note that explains.

 

Note the distinction between deleting a data table and deleting all the
values. If you erase all values from a data set using the DEL key, Prism
still maintains the links between the data and the results. Since there are
no data, the results become blank. If you delete the entire data table, the
results remain and the sheet becomes orphaned.
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 Orphaned results

 Prism hot links data to analysis results. If you change the data, Prism will
automatically recalculate the analyses and update the results. It will also
update any result tables that have been embedded  onto graphs, or any
result values that have been hooked  to dialogs.

If you delete a data table, any linked results become orphaned, and you'll
see the word 'orphaned' in the bar at the bottom of the Prism window.
When the data table is gone you can view and graph the orphaned
results, but you cannot change the analysis parameters.

12.2.6 Excluding data points from an analysis

Excluding data sets

If you want to only analyze selected data sets, you can do so. Don't
exclude all the other points as explained above. And don't expect your
selection of data sets to matter when you click the Analyze dialog.
Instead, you choose which data sets to analyze on the right side of the
Analyze dialog. You can change your mind later via Change..Data
analyzed.

Empty data sets

How does Prism deal with empty data sets (or data sets with all values
excluded) when analyzing data. If you selected to analyze all the data
sets (the default), then Prism leaves empty data sets in results if there
are empty data sets in the data table. That way the data set letter is
always the same for data tables and results. In other words, the results
for data set E are always in results data set E. But if you selected to only
analyze selected data sets, Prism only analyzes selected data sets that
are not empty. If you choose to analyze data sets C, D and E, but data
set D is empty, then the results for data set C will appear in column A of
the results table, and the results for data set E will appear in column B in
the results table.

12.2.7 Embedding results on a graph

You can copy any part of a results table and paste it onto a Prism graph
or layout. The link will be 'live' so will be updated if you edit the data or
change the analysis parameters.
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Double-click on the embedded table to bring up a dialog that will let you
adjust its font, borders, etc.

When you copy a single cell of a table, you have two choices when
pasting:

· Paste as text -- First use Prism's Text tool to create a text box, then paste a
results sheet value into it. In this case, the value you copied will be pasted as text,
with no link back to the analysis.

· Paste as link -- If you paste directly onto the graph or layout (not while entering
text), you will paste an embedded table (with one cell) that will automatically
update when the results are recomputed.
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12.2.8 Hooking to analysis and info constants

What is hooking?

Prism lets you 'hook' the results of some analyses into the parameters
dialog of other analyses, and graphing dialogs. The value you hooked is
then used in that analysis, or graphing choice. The link is live, so will be
updated if the data are edited or (in some cases) if the analysis
parameters changed.

You can also hook constants entered on an Info sheet.

Which analysis results can be hooked?

Here is the list of all analysis results that can be hooked.

Analysis Values that can be hooked

Nonlinear
regression

· Best-fit value of each parameter

· Lower confidence limit of each parameter

· Upper confidence limit of each parameter

Survival
analysis

· Median survival

Bland-Altman · Bias

· Lower 95% confidence limit of bias

· Upper 95% confidence limit of bias

Column
statistics

· Mean with lower and upper confidence limits

· Geometric mean with lower and upper
confidence limits

· 25th and 75th percentile

· Median

· Lowest value

· Highest value

· QC control lines (Mean plus or minus 1, 2 or 3
SD)

· SD

· SEM

· N

· Sum

You cannot add to this list (but we can, so send us suggestions).
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How to hook?

You'll see hook icons  on many dialogs next to fields requiring you to
enter a value. Click, and then choose an analysis constant (or info
constant) on the Hook dialog.
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Example 1. QC plot

The graph shows repeated quality control measurements. The column
statistics analysis was run to compute the mean and SD (and more) of
the values. The lines at the mean and plus or minus two standard
deviations were drawn by hooking these values. This means that the grid
lines will move as more data are entered into the data table.

First double click on the Y axis to bring up the Format Axes dialog on the
Y axis tab. The bottom of the dialog lets you add additional ticks and grid
lines. To hook the grid line to an analysis constant requires drilling down
to the details dialog, so click the '...' button.
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You don't want to enter a Y coordinate on the Format Additional Ticks and
Grids dialog. Instead you want to hook an analysis constant. Click on the
hook button, and then choose the value you want to hook (first the mean,
later the two QC control lines). Back on the Format Additional Ticks and
Grids dialog, choose the kind of line (solid or dotted) and its color. You
can also choose to fill between the two QC lines
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Example 2. Confidence interval of EC50

This example shows grid lines at the EC50 along with its 95% confidence
interval. All three values were 'hooked' from the nonlinear regression
using Additional ticks and grid lines , so will move if data are edited or
replaced.
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12.2.9 Color coding key results

It is easy to color code selected cells a results tables. This would be useful
to highlight the key results, or to mark surprising results you wish to
review further. To do so:

1. Place the insertion point in the single cell you wish to color code. Or
drag to select a range of cells. 

2. Click the paint bucket icon in the Change area and choose a color. Or
drop the Change menu and choose "Cell Background Color".
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Note the distinction between the feature explained here with a related
feature that lets you highlight (color code) sheet names in the navigator. 
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12.3 Simulating data and Monte Carlo simulations

Simulating data is a powerful way to understand

statistical analyses and plan experiments. Monte

Carlo analysis lets you simulate many data sets,

analyze each, and then look at the distribution of

parameters (results) of those analyses. This can let
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you "experiment" with alternative experimental

designs via computer before you collect any data.

Prism makes it easy, without requiring any

programming or scripting.

12.3.1 Simulating a XY data table

To simulate a family of XY data sets with random error, start from any
data table or graph, click Analyze, open the Simulate data category, and



Analyzing data with Prism 279

© 1995-2016 GraphPad Software, Inc.

then select Simulate XY Data. 

X values tab. Generate a regular series (arithmetic or geometric) of X
values or use the X values from the data table you are analyzing. 

Equation tab. You can choose to use Y values from the data table you
are analyzing, and then add random scatter. More often, you will choose
an equation on this tab. 

Parameter values tab. On top of the tab, choose how many data sets
you wish to simulate, and how many replicates each data set will have.
The main part of the tab is where you enter the values of each parameter.
If you choose to simulate more than one data set, then you can choose to
enter a parameter value just for one data set, or to enter a parameter
that applies to several, or all, curves. Choose the data sets on the top
part of the dialog, and enter the parameter values for that data set (or
that group of data sets) below. 

Random error tab. Choose among several methods for generating
random scatter and also adding outliers. 

12.3.2 Simulating a Column data table

To simulate a set of Column data sets with random error, start from any
data table or graph, click Analyze, open the Simulate data category, and
then select Simulate Column Data. 

Experimental design tab

Choose the number of data sets. In most cases you will want to specify
the population mean of each column. But you can instead enter the mean
and SD of a set of means, and have each column mean chosen randomly.

For each column you wish to simulate, specify how many rows it will
have, its column mean, and its title. Note you can hook the column mean
to a results computed in another analysis. 

Random error tab

Choose among several methods for generating random scatter and also
adding outliers. 
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12.3.3 Simulating a Contingency data table

Experimental design

Choose the total sample size, the grand total of all four cells in the
contingency table. 

Also choose the experimental design:

· Cross-sectional. You sample subjects without regard to their exposure
or disease. 

· Prospective. You choose subjects based on exposure defined by the
rows, and then inquire about outcome defined by the columns.

· Experimental. You assign treatments that define the row, and then
tabulate outcome that defines the columns.

· Case-control-retrospective. You choose cases (with disease) and
controls and these define the columns. You then look back at exposure
and tabulate these results into rows. 

Rows and columns

Enter titles for both rows and both columns. 

Enter various probabilities as asked. The details depend on the
experimental method you chose. 

12.3.4 How to: Monte Carlo analyses

How to begin a Monte Carlo analysis

1. Simulate a data table using  one of Prism's simulation analyses.. Note
that these simulations include random scatter, so will produce new
results when they are updated.

2. Analyze that simulated data set as appropriate.
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3. From that results page, click Analyze and choose Monte-Carlo analysis.
This analysis will repeat the simulations many times, and tabulate
selected results. The Monte Carlo analysis will only be available for
analyses that create analysis constants. Note that linear regression
does not, but you can fit a straight line with the nonlinear regression
analysis. 

The explanations below explain the basic ideas of the Monte Carlo
analysis. Follow the example to learn the details.

Simulations tab

How many simulations?

How many simulations should you run?  If you make only a few
simulations, the results will be affected too much by chance. Running
more simulations will give you more precise results, but you'll have to
wait longer for the calculations to repeat. When just playing around, it
might make sense to use as few as 100 simulations so you can see the
results instantly. When trying to polish simulation results, it can make
sense to use as many as 10,000 or 100,000 simulations. A good
compromise is 1000.

Append?

If you go back to run more simulations, check an option box to append
the new simulations to the existing results, rather than start fresh.

Random seed

The choice of random numbers used in a series of simulations depends on
the random number seed used to generate the first set of results. By
default, Prism picks this seed automatically (based on the time of day),
and presents this seed in a floating note superimposed on Monte Carlo
results. 

If you want two or more Monte Carlo analyses to use precisely the same
data sets (so you can compare two ways of analyzing those data), enter
that random seed on the Simulation tab.

Parameters to tabulate tab

Prism lists all of the analysis constants generated by the analysis. Check
the ones whose values you want to tabulate. 
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You cannot change the set of values included in this list. Let us know if
there are parameters missing, and we can add them in a future version.

Hits tab (optional)

If you skip this Hits tab, Prism will tabulate the selected parameters
(different columns) for each simulation (rows). 

Prism can also reduce the results down to a single number -- the fraction
of the simulations that are "hits". Define a hit to be when a value
tabulated by the analysis equals a certain value, or is within a specified
range. Click New...Graph of existing data from this table, and choose a
parts-of-whole graph to create a pie graph of the fraction of hits vs. not
hits.

Prism can also tabulate the selected parameters only for simulations that
are hits, and/or for only the simulations that are not hits. Choose any or
all of these options (Hits, Not hits, All simulations) at the bottom of the
Hits tab. Each option you check will create its own results table.  

12.3.5 Monte Carlo example: Accuracy of confidence intervals

Overview

When you fit a curve with nonlinear regression, one of the most important
set of results are the 95% confidence intervals of the parameters. These
intervals are computed from the standard errors which are based on
some mathematical simplifications. They are called "asymptotic" or
"approximate" standard errors. They are calculated assuming that the
equation is linear, but are applied to nonlinear equations. This
simplification means that the intervals can be too optimistic, too narrow,
so your true confidence level may be less than 95%.

How can you know whether the intervals really do have 95% confidence?
There is no general way to answer this. But for any particular situation,
you can get an answer using simulations. This page explains how to do
this with Prism using the Monte Carlo feature new to Prism 6. We will
simulate a dose-response curve and ask how accurate the 95%
confidence intervals are for the Hill Slope. Christopolous suggested that
the distribution of HillSlope can be asymmetrical, and suggested fitting
the logarithm of the HillSlope instead (1).
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Step 1. Simulating the first experiment

From anywhere, click New..Analysis and choose Simulate XY Data. To
follow this example exactly, make these choices:

· X values tab. Start at X=-9, increment each X value by 0.5, and stop
when X equals or exceeds -3.0.

· Equation tab. Choose the folder "Dose-response - Stimulation", and
choose the equation: log(agonist) vs. response --Variable slope.

· Parameter values tab. Choose to simulate one data set, with 3 replicate
values. Set Bottom=250, Top=5000, logEC50=-6, and HillSlope=0.5.

· Random error tab. Random error is Gaussian (absolute) with SD=200. 

Step 2. Fit the first experiment

1. From the graph, click Analyze and choose Nonlinear regression. Or click
the nonlinear regression shortcut button in the Analysis part of the
toolbar. 

2. On the first (Fit) tab, choose the folder: Dose-response - Stimulation.
Then choose the equation: log(agonist) vs. response --Variable slope.
You can accept all the defaults for the other tabs. 

3. Click OK, and Prism will fit the model to the data and graph the curve
on the graphs.

Step 3. Simulate a few more data sets

Note the Hill Slope, the parameter we wish to investigate in this
simulation. To simulate new data with different random numbers, click
the red die icon, or drop the Change menu and choose Simulate Again.
Note that the Hill slope changes.

Step 4. Simulate many data sets

Start from the nonlinear regression results, click Analyze and choose
Monte Carlo simulation. 
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On the first (Simulations) tab, choose how many simulations you want
Prism to perform. For this example, enter 1000.

On the second (Parameters to tabulate) tab, choose which parameters
you want to tabulate. The choice is the list of analysis constants that
Prism creates when it analyzes the data. For this example, we only want
to tabulate the two confidence limits for the Hill Slope.

On the third (Hits) tab, define a criterion which makes a given simulated
results a "hit". For this example, we'll define a hit to mean that the
confidence interval brackets the true value of 0.5 (set in the simulation).
So a hit is defined when the lower limit is less than or equal to 0.5 and
the upper limit is greater than or equal to 0.5.

 Click OK and Prism will run the simulations. Depending on the speed of
your computer, it will take a few or a few dozen seconds. 

Step 5. Monte-Carlo results

The results of the simulations are shown on only one page (since we
unchecked all the options for reporting individual simulations in the Hits
tab above.
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The fraction of hits is 0954. For this example, we defined "hit" to mean
that the confidence interval included the true parameter value. In other
words, the confidence interval for HillSlope included the true value (used
in the simulation) in 95.4% of the 1000 simulated data sets. (Since these
results depend on which random numbers Prism generates, you'll get
somewhat different results when you try to follow this example).  This is
what you'd expect for 95% confidence intervals, and means that you can
trust the confidence intervals in experiment of this design. There is no
need to consider fitting the logarithm of the Hill Slope instead, for this
experimental design

Step 6. Try variations

If the confidence interval for this result is too wide for your tastes (it
ranges from 93.9% to 96.6%), go back and run this Monte Carlo
simulation with many more iterations (perhaps 10,000).

The conclusion is specific to the experimental design and parameter
values you chose. Go back to the simulation, and change the HillSlope to
4.0. Then change the Monte Carlo dialog to redefine a "hit" to mean that
the confidence interval brackets the true value of 4.0. A hit is defined
when the lower limit is less than or equal to 4.0 and the upper limit is
greater than or equal to 4.0. With such a steep HillSlope, the confidence
intervals really are not accurate at all. The "95%" confidence intervals
only include the true value (4.0) in 83.1% of the simulations. Doubling
the number of concentrations (changing the increment of X values from
0.5 down to 0.25 in the X values tab of the Simulate XY data dialog)
solves this problem. With so many data points, the 95% confidence
intervals contain the true value in 95.3% of the simulations. 

By varying the choices in the simulation dialog, and seeing the effect via
Monte Carlo simulations, you can design better experiments.

Another example
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Here is another detailed example, using simulations to find the power of a
t test. 

Reference

1. Arthur Christopoulos, Assessing the distribution of parameters in
models of ligand-receptor interaction: to log or not to log, Trends in
Pharmacological Sciences, Volume 19, Issue 9, 1 September 1998, Pages
351-357

Prism file for this example

12.3.6 Using a script to simulate many data sets

This page will help people who set up these scripts in earlier versions of
Prism, or people for whom the Monte-Carlo analysis doesn't provide
enough versatility. But for most people, the Monte Carlo analysis  will
be much easier. 

Follow these steps:

1. Create a Prism project that simulates  a data set with random scatter
(the first results sheet), and then fits a curve through these data with
nonlinear regression (second results sheet).

2. Make sure that the first data table is empty and formatted for column
data (no X column; no Y subcolumns). The script will write the results
into this table. You can click in the upper left corner of the data table to
change its format, if needed.

3. Click the Prism button at the left of the toolbar, and choose Run Script.
Then choose New Script, and start with a blank page.

4. Enter this script:

Table Prism 1 Clear

Foreach 100
 Goto R 1
 Regenerate
 Goto R 2
 WTable "logEC50",5,1
Next

5. Click the Run button on the Script dialog.
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6. After the script is complete, go to the first data table and view the
results.

7. Click analyze, and choose to do Column statistics (with normality test)
or perhaps create a Frequency Distribution.

The first line of the script specifies which data table will hold the results.
Then the script loops 100 times. With each loop, it goes to the first
results page (with the simulation) and regenerates with new random
scatter. It then goes to the second results page (with curve fit results)
and writes the value in the fifth row of the first column into the data
table, and labels that column "logEC50". You will want to adjust the row
number, and perhaps add additional lines to output additional results. You
may also want to loop more than 100 times.

12.3.7 How Prism generates random numbers

Random or pseudo-random?

The only way to generate truly random numbers is through a random
physical process, such as tossing dice or measuring intervals between
radioactive decays. Prism, like all computer programs, generates
“random” numbers from defined calculations. Since the sequence of
numbers is reproducible, mathematicians say that the numbers are
“pseudo-random”. 

The difference between truly random and pseudo-random numbers rarely
creates a problem. For most purposes, computer-generated random
numbers are random enough to simulate data and test analytical
methods.

Prism uses the time of day when calculating the first random number, so
you will get a different series of random numbers every time you run the
program. 

Random numbers from a Gaussian distribution

Prism generates random values from a Gaussian distribution using
routines adapted from ideas presented in Numerical Recipes in C, (W. H.
Press et al, second edition, Cambridge Press, 1992). The function RAN3
(defined in Numerical Recipes) generates uniformly distributed random

http://www.nr.com
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numbers and the function GASDEV transforms them to a Gaussian
distribution with a mean of zero and a standard deviation you enter. 

If you choose relative error, Prism first calculates a random number from
a Gaussian distribution with a mean of zero and with a SD equal to the
percent error you enter. It then multiplies that percentage times the ideal
Y value to yield the actual random value that is added to the Y value.

Prism also can generate random numbers from a t distribution with any
number of degrees of freedom (df). This lets you simulate wider scatter
than Gaussian. If df is low, this distribution is very wide. If df is high
(more than 20 or so), it is almost indistinguishable from a Gaussian
distribution. If df=1, the distribution is extremely wide (lots of outliers)
and is identical to a Lorentzian distribution, also known as the Cauchy
distribution. Prism uses this equation to generate random numbers from
the t distribution with df degrees of freedom:

In this equation, Rand is a random number drawn from a Gaussian
distribution with mean=0 and SD=1. To compute a random number from
a t distribution with df degrees of freedom, Prism generates df+1
different random numbers drawn from a Gaussian distribution.

Random numbers from a Poisson or Binomial distribution

We adapted ideas from pages 372-377 of Numerical Recipes, third
edition, by  WH Press and colleagues. 

Note an important difference between Poisson random values and
Gaussian. 

· With Gaussian rand values, the simulated values equals the calculated
ideal value plus a random error drawn from the Gaussian distribution
(with a mean of zero and a SD you specify). We say "plus" the random
value, but this random value will be negative half the time (on average),
so the simulated value will be less than the idea value half the time.  

· With Poisson, the simulated value is a  random value drawn from a
Poisson distribution, using the ideal value computed in the simulation as
the population value of the Poisson distribution. With Gaussian errors,
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you specify a standard deviation in the simulate dialog. Not so with
Poisson error.  The simulated Poisson value is always an integer. 

Random numbers with Excel

If you want to do simulations not possible with Prism, it might be possible
with Excel. The methods listed below work well with Excel 2003 and later,
but should not be used with earlier versions of Excel. 

Excel offers two random number functions. 

· The RANDBETWEEN(low, high) formula chooses a random integer
randomly from the range between (and including) the low and high
values entered. The result is always an integer, so this function is not
very useful.

· The RAND() function generates a random value between 0.0 and 1.0. It
is an Excel function, at least in name, so it needs to be followed by
parentheses, but the function has no inputs so there is nothing between
the parentheses.

If you want to generate random numbers from a Gaussian distribution,
you'll need to transform the values generated with the RAND() function.
This Excel formula computes a random number from a Gaussian
distribution with a mean of 0.0 and a SD of 1.0.

=NORMSINV(RAND())

The RAND() function calculates a random number from 0 to 1. the
NORMSINV() function takes a fraction between 0 and 1 and tells you how
many standard deviations you need to go above or below the mean for a
cumulative Gaussian distribution to contain that fraction of the entire
population.

Multiple by the standard deviation and add a mean, and you'll have
random numbers drawn from a Gaussian distribution with that mean and
SD. For example, use this formula to sample from a Gaussian distribution
with a mean of 100 and a SD of 15:

=(NORMSINV(RAND())*15)+100

12.4 Transforming, normalizing, etc.

 

http://www.exceluser.com/explore/statsnormal.htm


GraphPad Prism7 User Guide290

© 1995-2016 GraphPad Software, Inc.

Before graphing or analyzing your data, you may

first need to do some calculations to get your data

into proper form. While Prism is not as versatile

as Excel, Prism can do many data manipulations.
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12.4.1 Key concept -- Manipulating data

Before graphing or analyzing your data, you may first need to do some
calculations to get your data into proper form. While Prism is not as
versatile as Excel, Prism can do many data manipulations. From the data

table, click  on the toolbar, and choose transform  , normalize
, transpose , prune  or remove baseline .

Results will appear on a new results page with a green grid. While you
cannot edit these results, you can create a new graph (use the New...
button) and do further analyses (click the Analyze button). To help keep
track of chains of analyses, use the Data+Results folder  in the
Navigator.

What if Prism doesn't offer the tools you need to manipulate your data? In
that case, you should enter and manipulate your data in Excel, and then
copy and paste the results into Prism for further analysis and graphing.
Note that you can paste a link to the Excel file or you can paste embed
the entire Excel workbook within Prism. Learn more about linking and
embedding data from Excel .

292 299
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12.4.2 Transform data

When you transform data with Prism, the data table isn't changed.
Instead, Prism creates a new results table with the transformed values.

Standard functions

Choose a function

Choose from one of these functions for transforming Y values (analogous
functions are available for X):

Function Comments

Y= Y * K
Y = Y + K
Y = Y – K
Y = Y / K
Y = Y squared
Y = Y ^ K
Y = log(Y)
Y = -1*log(Y)
Y = ln(Y)
Y = 10 ^ Y
Y = exp(Y)
Y = 1/Y
Y = sqrt(Y)
Y = logit(y)
Y = probit(Y)
Y = rank(Y)
Y = zscore(Y)
Y = sin(Y)
Y = cos(Y)
Y = tan(Y)
Y = arcsin(Y)
Y = ABS(Y)
Y = Y + Random
Y = X / Y
Y = Y / X
Y = Y – X
Y = Y + X
Y = Y * X
Y = X – Y
Y = K - Y

Enter K in the box provided.
“
“
“
Enter K in the box provided.

Log base 10 
Natural logarithm (base e)

Ten to the Yth power (inverse of log).

eY (inverse of ln)
 
Square root.
ln(Y/1-Y)
Y must be between 0.0 and 1.0. See notes below.
Column rank. Smallest Y value gets rank of 1.
Number of SDs from the column mean.
Y is in radians.
“
“
Result is in radians.
Absolute value.
Gaussian. Mean=0. SD=K (you enter).

Enter K in the box provided.
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Y = K/Y
Y = log2(Y)
Y = 2^Y

“
Logarithm base 2
2.0 to the power of Y

Many of the functions include the variable “K”. Enter a value for K on the
dialog. When transforming Y values, you can enter one value of K for all
data sets or a separate value of K for each data set. To enter different K
values for each data set, choose a data set, enter K, choose another data
set, enter its K, and so on. Rather than entering the value of K, you can
hook an analysis or info constant .

Notes about the probit() function. Prism uses an older definition of probit
that adds 5 to all results, to avoid use of negative numbers. No, it doesn't
really make sense, but this was once a common standard. So
probit(0.025) = 3.04 (which is -1.96 + 5.00),  probit (.975) = 6.96 (1.96
+ 5.00), and probit(0.5) = 5.00 (0.00 + 5.00).

Interchanging X and Y

When you choose a standard function, you can choose to interchange X
and Y values and also choose transforms of X or Y or both.

Some notes on interchanging X and Y values:

· Prism can interchange data on tables with more than one data set (more
than one Y column), even though the results sheet has only a single X
column. It does this by creating additional rows. The results will be
staggered down the page with only one data set in any particular row.

· If you entered replicate Y values (or mean with SD or SEM) Prism
interchanges X and Y by putting the mean Y value into the X column.
Information about the scatter of Y is ignored.

· If you selected X or Y transforms (in addition to interchanging), Prism
applies the transform to the data after interchanging X and Y. This
means that the X transform is applied to data that were originally in the
Y column, and the Y transform is applied to data originally in the X
column.

Transforming error values

If you entered replicate Y values, Prism can transform each replicate or
the mean of the replicates.

147
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If you entered data as mean, SD (or SEM), and N, Prism tries to
transform the error bar as well as the mean. When a transform is
intrinsically asymmetrical (i. e. logarithms), it is mathematically
impossible to transform a SD and end up with a SD. You have two
choices. You may either transform the mean only or erase the error bars.
Or you may convert the error bars to 95% confidence intervals, and then
transform both ends of the confidence interval. The resulting 95% CI will
be asymmetrical.

Transforms for pharmacology and biochemistry

Eadie-Hofstee, Hanes-Woolf, and Lineweaver-Burk transforms are used to
plot enzyme-kinetic results. Scatchard transforms are used to display
radioligand binding, and Hill plots are used to plot dose-response data.

Important:. Use these transforms only as a way to display data, not as a
first step in analyzing data. You'll get better results by using nonlinear
regression on the actual data.

Here is the mathematical definition of each transform:

Function X becomes Y becomes

Eadie-
Hofstee

Y/X No change

Hanes-Woolf No change X/Y

Hill No change if
you entered
your data as
log(conc.).
Log10(X) if you
entered your
data as
concentration.

log10(Y/(Ymax-Y))
(Prism prompts for
Ymax)

Lineweaver-
Burk

1/X 1/Y

Log-log Log10(X) Log10(Y)

Scatchard Y Y/X
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Prism can also create Bland-Altman plots, which require a simple
transform of the data. However, this is not done via a transform, but
rather via a separate analysis. 

User-defined transforms

When writing your transform, you may use any of these functions when
writing your equation. Mostly functions are pretty standard.  Beware of
the sqr() function, which has different meanings in different
environments. In Prism, sqr() squares the value, and the sqrt()
function takes the square root.

If you are transforming X values, you may use Y in the function. If the
data table contains several data sets (so has several Y values for a
single X value), Prism will stagger the results down the page, repeating
X values as needed. The results for column A will appear on top of the
results table. Below that Prism will place the results for column B. For
these rows, column A will be empty. 

Usually, the same function is applied to all data sets. But you can write
a transform to apply different transforms to different data sets. To do 
this, precede the lines that apply to only some data sets with column
designators. For example, put <B> in front of a line in your transform
that only applies to data set B. Put <~A> in front of a line that applies
to all data sets except data set A.

Prism allows you to introduce some branching logic through use of the
IF function. The syntax is:

IF (conditional expression, value if true, value if false)

You can precede a conditional expression with NOT, and can connect
two conditional expressions with AND or OR. Examples of conditional
expressions:

MAX>100
Ymax=Constraint
(A<B or A<C)
NOT(A<B AND A<C)
FRACTION<>1.0
X<=A and X>=B 

Note: “<>” means not equal to, “<=” means less than or equal to, and
“>=” means greater than or equal to. Here is an example:

Y= IF (Y<Y0, Y, Y*Y)

If Y is less than Y0, then Y is unchanged. Otherwise Y is transformed to
Y squared.
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Y = IF (Y<0, Y/0, Y)

This function  returns Y if Y is positive or zero, but otherwise leaves the
results blank. In other words, it removes all negative values. The way
to leave a result blank is to do an impossible mathematical transform
such as dividing by zero.

12.4.3 Transforming concentrations

This analysis is new to Prism 7. Its purpose is to make it easier to
transform X values that are concentrations.

Special handling of X=0

Why handle X=0 specially? Because it is common to transform X values to
their logarithms, which is required before fitting some models to your
data. Since the logarithm of zero is undefined, if you enter X=0 that value
will be empty (missing) after transformation. This analysis  lets you
substitute some other value (a tiny concentration) for zero before taking
the logarithm. For example if your data go from 10-9 to 10-3 molar and you
plan to take the logarithm, consider changing the 0 value to 10-11. 

Change units

Multiply or divide all X values by a constant you select to change units.

Transform to logarithms
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Choose whether you want to use natural logarithms or base10 common
logarithms. Unless you are a mathematician, you may only know about
common logarithms and "natural logarithms" will seem very unnatural. 

12.4.4 Remove baseline

Many kinds of data combine a measurement (signal) you care about with
a baseline or background (noise) you don't care about. You can analyze
these data using two approaches. One approach is to perform analysis on
the total signal. The other approach is to subtract or divide by a baseline
or nonspecific value and then analyze and graph the results.

To access this analysis, start from the data table, click Analyze, then
chose the analysis Remove Baseline and Column Math. 

Definition of baseline

Depending on the experimental details, the baseline can be defined in (at
least) three ways. Think this through before choosing this analysis in
Prism. The baseline value for a particular value can be:
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· A value, or the mean of several replicate values, in specified rows of the
same column as the total value. Choose to define the baseline as the
value in the first row, the last row, or the mean of a specified number of
values in the first and/or last rows. 

· A value (or mean of replicate values) in the baseline column of the same
row of the table as the value from which the baseline will be subtracted
(or divided) . So the baseline value for a value in row 13 of column B
would be the value in row 13 of column A, or the mean of replicate
values in row 13 of column A. Choose between a single column being
the baseline values for all other values, or of having every other column
be baseline vs. total. 

If you check the option to assume a linear baseline, Prism performs
linear regression using the X values as X and the background
(nonspecific) values as Y. It computes a  predicted Y value (from the
line) at each value of X. Finally, it subtracts (or divides) this predicted
baseline Y value. This method is appropriate when you know that the
nonspecific or background values must be linear with the X values (for
example nonspecific binding is often linear with ligand concentration),
and is particularly useful when you have not collected baseline or
nonspecific measurements at every value of X (Prism will fill in the
missing nonspecific values from linear regression). When Prism fits
linear regression, it does not assume that the line goes through the
origin and does not display the regression results.

· The mean of all the values in (say) column A. You need to approach the
calculation differently if you wish to define the mean (or median) of one
column to be the baseline to subtract from (or divide into) all the other
values,. You cannot accomplish this goal using Prism's Remove Baseline
analysis. Instead, do two analyses of your data table. First do a Column
Statistics analysis to compute the column means. Then do a Transform
analysis, and choose the transform Y = Y-K (or Y = Y/K). Hook  the
value of K to the mean of the column you wish to use as the baseline
(usually the first column) as computed by the column statistics
analysis. 

Calculation

The choices are self-explanatory. You can ask Prism to subtract the
baseline, divide by the baseline, compute the fractional or percentage
difference, etc.  Note that you can also use this analysis to add or
multiply two columns.
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12.4.5 Normalize

Normalize the data to convert Y values from different data sets to a
common scale. 

One example of where normalizing can be useful: Investigators who
analyze dose-response curves commonly normalize the data so all curves
begin at 0% and plateau at 100%. If you then fit a sigmoidal dose-
response curve to the normalized data, be sure to set the top and bottom
plateaus to constant values. If you've defined the top and bottom of the
curves by normalizing, you shouldn't ask Prism to fit those parameters.

To normalize, click Analyze and choose Built-in analyses. Then select
Normalize from the list of data manipulations to bring up this dialog.

To normalize between 0 and 100%, you must define these baselines.
Define zero as the smallest value in each data set, the value in the first
row in each data set, or to a value you enter. Define one hundred as the
largest value in each data set, the value in the last row in each data set, a
value you enter, or the sum of all values in the column. Prism can express
the results as fractions or percentages.

Notes:
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· If you have entered replicate values, zero and one hundred percent are
defined by the mean of the replicates. It is not possible to normalize
each sub column separately.

· The X values are copied to the results table. They are not normalized.

· Each SD or SEM is normalized appropriately.

· If you normalize to the smallest and largest value in the data set, you
can remove those values (which would become 0.000 and 1.000) from
the results.

· If your data are entered into subcolumns, you can normalize the means
or separately normalize each subcolumn (new to Prism 7).

12.4.6 Transpose rows and columns

Each row of Y values becomes one column (data set) in the results table.
The first row becomes the first data set, the second row becomes the
second data set, etc. You may not transpose a data table with more than
104 rows, because Prism cannot create a table with more than 104
columns.

The column and row titles in the results table are determined by your
choices in the dialog.

Don't forget to check the option box if you want to create a new graph
from the transposed data.
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An alternative way to transpose is to copy selected data, and then paste
transpose .

Don't confuse transposing a data table (making each row become a
column) with swapping X and Y columns (so X becomes Y, and Y becomes
X). If you want to swap (interchange) X and Y columns, this is possible
via a checkbox on the Transform  dialog.

12.4.7 Prune rows

This analysis takes a large table, and creates as output a smaller table,
which can be easier to work with. But note that your original data are still
part of the file, which means the project file gets larger not smaller. But it
can be useful to have a smaller data set for quicker analyses and
graphing.

To prune, click Analyze and choose Built-in analyses. Then choose Prune
from the list of data manipulations to bring up this dialog.
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Note that Prism can also decimate while importing data  – import a row,
skip K rows (you enter K), then import another row.

241
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12.4.8 Fraction of total

The fraction of total analysis divides each value by its column or row total,
or by the grand total.

This analysis is most often used for parts-of-whole data or for contingency
tables, but it can be used for column data and for XY or Grouped data
tables, so long as they have no subcolumns.

The calculation of confidence intervals only makes sense when each value
entered into the table is an integer that represents the actual number of
objects or events counted. In this situation, computing a confidence
interval based on the binomial distribution makes sense. Don't check the
option to compute confidence intervals if the data are measured values, or
percentages, or normalized. 

With the first three choices, the results are presented on a results table
with green grid lines, so those results can be plotted. With the last choice
(presenting fraction of all three totals), the results are on a table with red
grid lines so cannot be plotted. With this last option, the option to report
confidence intervals is not available.
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Prism can compute the confidence intervals of proportions using three
different algorithms. We recommend the Wilson/Brown method. Prior
versions of Prism used the Clopper-Pearson method.

13 Graphs

For many, the whole point of Prism is to make and

polish graphs. Learn how.

http://www.graphpad.com/guides/prism/7/statistics/index.htm?stat_three_methods_for_computing_th.htm
http://www.graphpad.com/guides/prism/7/statistics/index.htm?stat_three_methods_for_computing_th.htm
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13.1 Creating graphs

Automatically created graphs

New graph of existing data

Duplicating a graph

Graphs created by analyses

13.1.1 New graph of new data

When you create a new data table, Prism automatically creates a linked
graph.

You'll create your first data table from the Welcome dialog, and a graph
will be automatically created. When you first go the the graph, a dialog
will pop up  where you can choose exactly the kind of graph you want. 

To make additional data tables with linked graphs, click on the New
button in the Sheet section of the Prism toolbar and choose New Data
Table With Graph. Choose the kind of data table on the New Data Table
dialog.  

13.1.2 New graph of existing data

There are two ways to create an additional graph from an existing table. 

· Duplicate the graph using New...Duplicate Sheet. Then edit one of the
copies. 

· Create a new graph of existing data. To do this:
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1. From the data table, click the New button and choose New Graph
of Existing Data.

  

2. Check that the correct table is chosen in the drop-down list. 

3. Check "Plot selected data sets only" if you don't want to plot all
the data on the graph. Then click Select and choose the data sets
to plot. You can only choose data set columns. You cannot choose
a range of rows. All rows are always plotted. 

4. If it is an XY table and you have fit a line or curve, check the
option if you want the curve or line to also appear (as well as the
data) on the new graph. 

5. Usually Prism creates one graph from the entire data set. If you
want one graph for each data set, check that option.

6. Choose the kind of the graph you want. The drop down lets you
choose between XY, Column, Grouped, etc. graphs, but you'll
almost always want the kind of graph that matches the data
table. 

7. Choose one of the thumbnails and make other choices to
customize the graph. 
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To bring back this dialog, drop the Change menu and choose Graph Type,
or click the button shown below. 

    

13.1.3 Duplicating a graph

Duplicate a graph, and plot the same data

There are two reasons you might want to do duplicate a graph:

· You want two graphs of the same data. Maybe one in color and one in
black and white. Or one plotting raw replicates and another with mean
and error bar. 

· You are experimenting with different ways to graph your data. You can
keep one graph while editing a copy, so exploring new ideas won't
delete a graph you sort of like. 

To duplicate a graph, go to it, click the New button, and choose Duplicate
Current Sheet. Prism will create a duplicate of the graph, and both copies
will plot the same data. Now you can change the properties of the new 
graph without affecting the original. In some cases, you may want to later
delete one of the copies . 

Duplicate a graph, and plot new data

Prism offers two ways to duplicate a graph with its data table (and
analyses).

· Duplicate family . Go to the graph you want to duplicate, click the New
button, and choose Duplicate Family. The duplicated graph will look
identical to the one you started with, but it will be graphing a duplicated
data table and perhaps duplicated analyses. Edit the data on that table,
and the new graph will update.
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· Clone a graph . Click the New button and choose New Data Table (+
Graph). On the New Data Table and Graph dialog, choose the Clone tab,
and choose which graph to clone. Use tabs at the top to clone from a
current project, a recent project or a saved example file . 

When you clone a graph, you'll be asked if you want to delete the data (or
part of the data) on the new data table. When you duplicate a family,
you'll need to select and delete the data manually. 

13.1.4 Graphs created by analyses

Some analyses automatically create new graphs. For example, if you
choose to make a residual plot as part of linear  or nonlinear regression, a
new graph will be made. Another example: With most multiple
comparisons after ANOVA, you can choose to make a new graph showing
the confidence intervals of the differences between group means. 

13.1.5 Portfolio graphs

One tab on the Welcome dialog that comes up when you start a new
Prism project is portfolio. Choose that tab and view dozens of graphs
made by Prism. Open any of these to explore how they were made. You
can also edit the data and graph to make your own graph using the
portfolio graph as, essentially, a template. 
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13.2 Prism Graphs: the basics

A picture is worth a thousand words -- Prism

makes it easy to create the graphs you want.

Choose a type of graph, enter your data and Prism

automatically creates a graph. Because graphs

and data are linked, if your data changes your
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graph will automatically be updated. Once you've

made your graph, you can customize any part of

it. This section contains the key things you need

to know to get started with graphs.
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13.2.1 Eight ways to change a graph

Direct manipulation

Click on an axis to select it. Knobs appear on both ends. Move the mouse
over the right knob of the X-axis or the top knob of the Y-axis. Drag the
axis to make it longer or shorter. Or grab the middle of the axis and move
the entire graph around the page. 

Shortcut menus

Move the mouse over a symbol, title, axis, etc, and right click (control
click with Macs). The shortcut menu will give you many choices to format
the object.  

Change Graph Type dialog

You can bring back the Change Graph Type dialog  (the same one you
used to create the graph) any time. This is useful for making large
changes in how the graph looks. 

Format Graph dialog

Use the Format Graph dialog  to change symbols, bars, error bars, area
fills, legends, etc. Double click anywhere on the graph (except the axes)
to bring it up. Be sure to look at all the tabs.

Format Axes Dialog

Use the Format Axes dialog  to change the range, interval, scale,
numbering, etc. of the axes. Double-click on an axis to bring it up. Be
sure to look at all the tabs.

Select a range of points on a data table, and change how corresponding
points are graphed

Select a cell or a block of cells, right (control) click, and choose Format
Points. You'll be able to change the color, size, symbol, border, etc. of the
points or bars that correspond to the selected cells. 

Color schemes

Choose a color scheme  to change all colors at once. 
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Magic -- Make Graphs Consistent

The Prism Magic  tool makes one (or more) graph look like another. It is
a huge time saver.

13.2.2 Change Graph Type dialog

Click to open the Change Graph Type dialog. Choose one of the
thumbnails showing the various kinds of graphs, and inspect the preview
below to make sure it is the graph you want.

This dialog is really designed to let you change graph type within a
family. For example, change from column chart with error bars to a
scatter plot. It also lets you change to a graph in a different family, but
this rarely makes sense. If you need to change to a different family of
graphs, there is a good chance you also need to change the format of
the data table .

You can also change graph type within the Format Graph  dialog. Click
Global (upper right corner of dialog), then change all data sets, so the
changes you make apply  to all the data sets and not just one. 

Note that there are three ways to create bar graphs in Prism, as a
Column, Grouped, or XY graph. Don't think "make a bar graph". Instead
think about how the data are organized.

13.2.3 Changing which data are plotted

Key points about plotting data sets

Once you understand these key points, it will be easy to control which
data sets are graphed.

· A graph can include many data sets from many tables. By default, Prism
makes one graph per table. But you can plot the same data table on
multiple graphs, and a single graph can have data from multiple tables.
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· When you fit a curve by nonlinear regression (or a line by linear
regression) the best-fit line or curve is essentially a data set. Prism
automatically plots the line or curve on a graph, but you can remove the
curve from one graph, or plot it on other graphs. Treat the curves just
as you would treat any other data sets.

· When you transform or normalize data, the results appear on green
data tables. You can't edit these tables, but the data sets on green data
tables can be graphed like any other.

Data Sets on Graph tab of the Format Graph dialog

The second tab of the Format Graph dialog lets you add, remove and
replace data sets on the graph (and also change the front-to-back or left-
to right order of data sets).

Bring up the dialog by double clicking on the graph, or using a shortcut
button.
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Shortcuts for adding, replacing and removing data sets

You don't need to use the dialog to add or remove data sets. 

Add data to a graph by dragging a data or results table from the 
Navigator  and dropping it onto the graph.

Remove or replace a data set by right clicking on any point or bar, and
choosing Remove Data Set or Replace Data Set.

13.2.4 The Format Graph dialog

Overview

Double click anywhere on a graph (except the axis) and the Format Graph
dialog will appear. Or click the Format Graph button. 

The choices on this dialog  depend on whether you are editing a XY ,
Column , Grouped , Contingency , Survival  or Parts-of-whole
graph. 

Click “Apply” to see the effect of changes

The Format Graph dialog gives you a huge number of options to change
the appearance of your graph.  Click “Apply” to see the effect of the
changes you made without closing the dialog. This saves you time over
clicking OK to see the changes, then bringing back the dialog to make
more changes. Once you click Apply, the changes are made even if you
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then cancel the dialog. To reverse those changes, use the Edit..Undo
command. 

13.2.5 The Format Axes dialog

Overview

Double click on an axis, or drop the Change menu and chose the X-axis or
Y-axis command, and the Format Graph dialog will appear. Or click the
Format Axis button.

The dialog has five tabs:

· Frame and Origin

· X axis

· Left Y axis

· Right Y axis

· Titles and fonts

Click “Apply” to see the effect of changes

The Format Axes dialog gives you a many options to change the
appearance of your graph.  Click “Apply” to see the effect of the changes
you made without closing the dialog. This saves you time over clicking OK
to see the changes, then bringing back the dialog to make more changes.

468

426

426

327

443



Graphs 317

© 1995-2016 GraphPad Software, Inc.

13.2.6 Prism Magic - Make Graphs Consistent

The Prism Magic tool makes one (or more) graph look like another. It is a
huge time saver.

Start from a graph, or several graphs selected in the Prism Gallery .
Click on the Prism Magic tool in the Change section of the Prism toolbar.

Select the graph whose appearance you'd like to match. You can choose
from any graph in the current project or any open project, any graph 
saved as an example , or any graph recently (two months) printed,
exported, copied to clipboard, or used as a Magic example (so long as it
had been saved, so the file has a name). 
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Click Next, and then select the properties of the example graph you would
like to apply to your current graph or graphs. 

 

If you check the option "Range and ticks of axis", what Prism does
depends on whether you have checked the option to use an automatic
range for the axes. If that is checked (on the example graph, then Prism
will check that option on the graphs you are changing. Depending on the
range of the axes, they may or may not end up with the same range. If
that option is not checked on the example graph, then all of the graphs
you are changing will be changed to have the range and interval of the
example graphs. 

13.2.7 Rotating, flipping, reversing
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The Rotate/Flip button in the Change section of the Prism toolbar drops a menu with
three choices. You can reverse the order of data sets on a graph, flip the page settings
between landscape or portrait orientation, or rotate column graphs from vertical to
horizontal

Reverse order of data sets

For XY and Survival graphs, this reverses the front to back order of data
sets. This only matters when data points overlap. You can fine tune that
order  in the Format Graph dialog.The two graphs in this example are
identical except that the plotting order was reversed.

 On Column, Grouped and Contingency graphs, this reverses the left-to-
right order. You can also fine-tune that order .

Flip between portrait and landscape orientation

You choice of portrait or landscape only matters when you print the graph
from the Graphs section. This choice does not change the aspect ratio
of the graph.

Rotate entire graphs

Rotate between vertical and horizontal presentation of Column, Grouped
and Contingency graphs.
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13.2.8 Formatting individual symbols and bars

Change the look of a single point or column

Right-mouse click on the point and choose Format this Point. You can
change the symbol shape, size, color and the format, color and direction
of the error bars.

For example, on the graph below, each data point is formatted to show
different symbols and error bars directions for alternating data points.

Format a range of data from the data table

Select a block of data, right click, and choose Format Points.
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Revert individual formatting back to data set format

Open the Format Graph dialog by double clicking on the graph. Go to the
Graph Settings tab, and check the option to "Remove all individual
formatting."
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13.2.9 Changing a graph's shape and size

Stretch an axis

Click on the axis to select it. Knobs appear on both ends. Move the mouse
over the right knob of the X-axis or the top knob of the Y-axis. Drag the
axis to make it longer or shorter.
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Enter the exact length of the axes

Double-click on the origin to bring up the Frame and Origin tab of the
Format Axes dialog. Select a custom shape, and enter both width and
height. Or select a standard (tall, square, or wide) shape, enter either
height or width, and Prism will automatically change the other value. On a
wide or tall graph, the long axis is 1.5 times the length of the short axis.

Set the default size and shape for new graphs

Pull down the Edit/Preferences menu and from the Graph tab choose Wide, Tall, or
Square. On a wide or tall graph, the long axis is 1.5 times the length of the short axis.
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Make a graph larger or smaller, including fonts

Click the Resize Graph button in the Change section of the Prism toolbar.
This button enlarges or shrinks both the graph and also the graph's
symbols and fonts. In contrast, resizing by stretching an axis doesn't
change symbol or font size.

If you click More Choices, a dialog lets you pick the exact size you want
and lets you resize the graph without changing font size. This can be
useful when the journal specifies both the exact graph size it wants and
the point size of fonts.

Point of confusions 

Changing the size of a graph vs. changing the zoom

The Zoom buttons at the right end of the bottom toolbar let you zoom in
or out as you work on a graph. These controls only change the
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magnification you see on screen, and do not change its size when printed
or exported.

Changing the length of the axes vs. changing the size of the graph

The first tab of the Format Axes dialog lets you choose exactly how long
the X and Y axes will be. The graph itself will be larger, depending on
what you choose for numbering and titles. The graph object will also be
larger if you place tables, text, drawings or images on the page. 

Click the Resize Graph button in the Change section of the Prism toolbar
to change the size of the entire graph object (including everything placed
on the graph page). You can tell Prism to make the graph have a specified
width. Or you can tell Prism how long you want the X axis to be.

You can also resize a graph when exporting . Specify the width of the
graph (with all the other objects on the page) in the export dialog. Prism
won't change the graph in Prism, but will create the exported graph file to
match your choices. 

 

13.2.10 Legends

When are legends  created automatically?

When your graph includes more than one data set. If it plots only one
data set, no legend is created automatically. The legend is a symbol or
bar followed by the data set name. (Legends for heat maps are
different .)

When does the legend simply say "legend"?

When you have not entered a column title. Enter a column title on the
data table, and the graph legend will update.

How to edit the legend
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You can edit the column titles of the data table, or you can edit the
legend directly on the graph. If you edit on the graph itself, you will
lose the linkage between the column title and the legend.

When is the column title hot-linked to the legend, so edits to the
column title appear on the graph?

The two are hot linked so long as you only edit the column titles. When
you edit the legend itself, the link is broken. Restore it by double-
clicking on the graph to bring up Format Graph dialog, go to the
appropriate data set, and then check the option "Revert legend to
column title".

 
How to delete a legend

Select it and press Delete. Or hold the Control key while selecting
several legends (or lasso them all) and press the Delete key to delete
them all. 

You can also delete legends by unchecking the "Show legend" option at
the bottom of the first tab of the Format Graph dialog.

Moving legends
Select one or more legend, and drag it around. You can also use the
commands on the Arrange menu to align and equally space legends.

Reversing the order
New to Prism 7 is a command on the Change menu, Reverse Legend
Order. This is distinct from the command that changes the front-to-
back or left-to-right order of data sets on the graph. You can also
change the order of data sets by dragging them on the page one by
one. 

Master legends
Learn how to make one legend be a master legend  for several graphs
on a layout. 

XY: When does Prism give me a choice of plotting  a symbol, a line
or both?

When you have chosen to connect points with point-to-point connecting
lines. If you plot the points from one data set and also a fit curve from
another results data set, Prism won't give you the choice of having one
legend with both symbol and line.

Bar graphs: How to change from square to rectangular legends for
bar graphs. 
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Double click on the graph to bring up Format Graph. Go to the third
tab, and you'll see this choice at the bottom.

13.2.11 Graphs with a right Y-axis

When you plot several kinds of data on one graph, it is often useful to plot
some data using a Y-axis on the left side of the graph and other data
using a Y-axis on the right side of the graph.  Note that you never can
have more than one X-axis.

To create a second Y axis

Double-click on an axis to open the Frame and Origin tab of the Format
Axes dialog. Or click on the Format Axis tool in the Prism toolbar.

Select the tab for "Right Y axis" and choose how you want the axis to be
formatted.



GraphPad Prism7 User Guide328

© 1995-2016 GraphPad Software, Inc.

All data sets are initially graphed using the left Y-axis. Depending on the
scale of the axis, the data points may or may not all be visible.

To plot data using the right Y-axis

Double-click on a data point or click on the Format Graph button on the
Prism toolbar. At the bottom of the Appearance tab, select “Right Y axis”.
Repeat for each data set to be plotted on the right Y-axis.

 If you assign a data set to the right Y-axis, and there is no Y axis. Prism
will automatically create the axis.

To create a graph with ONLY a right Y axis

Turn off the left Y axis, and create a right Y axis to which you assign data
set.
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To use different colors for the two Y axes

It is possible to give the two Y axes different colors. Select one axis, drop
the Change menu, choose Selected Object(s), and set the color (and
thickness) on the Format Object dialog that appears.

To create a graph with three Y-axes

Prism does not allow three Y-axes. You can, however, create that effect
with a bit of a workaround. Create a graph with no data. Hide the X-axis
(one of the choices for axis frame). Delete all the titles, You are left with
just a Y-axis. You can make that whatever scale makes sense. Now make
a layout and put your real graph next to this bogus graph with only a Y
axis. With some fussing to get the sizes to match, and the data scaled
right, you can give the illusion you want. You'll need to tell Prism to plot
all the data sets on either the right or left axis, so may need to transform
your values to make this work well.

Limitations

Prism always draws the right X axis, if there is one, the same length as
the left axis and starting and stopping at the same position on the page. 
If you want one of the axes to be shorter, the only way to get that effect
is to cover up part of one of the axes with a drawn rectangle that you
then make white (or whatever your page background color is).

13.2.12 Changing fonts  on graphs

You can change the font and point size of all the text that appears on
Prism graphs:
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· Set the default for fonts used in new graphs on the New Graphs tab of 
Preferences .

· The font of the graph title and axis titles can be changed by selecting
the title, then changing the font using the toolbar or Change..Selected
text. You can also change these fonts on the last tab of the Format Axes
dialog .

· The font of legends is changed by selecting and changing using the
toolbar or Change..selected text. 

· To change the font of the axis numbering or labeling: Click once to
select the axis. Then use the toolbar or change selected text to change
the font of all the numbers or labels on that axis. You can also do this on
the last tab of the Format Axes dialog . 

13.2.13 Bar graphs

"Bar graph" describes how the data are plotted, but not how the data are
organized. Prism can make bar graphs  from XY, Column, Grouped and
Parts-of-whole data. 

With XY data, you can combine bar graphs and XY on one graph .

13.2.14 Colors

 .

13.2.14.1Color schemes

Color schemes change all of a graph's colors at once. They are very
useful, but underused. 

Go to the graph you want to change, or select several graphs in the 
gallery . Then click on the Color Scheme button in the Change section of
the Prism toolbar. You can choose the Black and White or Colors schemes
right from the menu, or click More Color Schemes to have more choices. 
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In the color schemes dialog, you can choose a color scheme by name
using the drop down menu, or use the arrow buttons to browse the
schemes. 

 

You are not limited to the color schemes we provide. To create a new
color scheme, start from a graph with the colors you like. Click the Color
Scheme toolbar button and choose Define Color Scheme. The new color
scheme will default to the colors of the current graph, so this makes it
easy to transfer a color scheme from one computer to another: Apply the
color scheme to a graph on one computer, open the file on another, and
create a new scheme based on that graph. 
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After you click the "Define Color Scheme" button shown in the screenshot
above, you can also delete any user-defined color scheme you no longer
use. 

 

13.2.14.2Selecting colors (Mac)

To change colors individually, without dealing with color schemes:

· Change the color of a data set in the Format Graph dialog. Double-click
on the graph to open it.

· To change the color of just one data point,  right-click on that point or
bar and choose Format this data point

· Change the color of axes in the first tab of the Format Axes dialog.
Double click on an axis to open it.

When you choose any color in Prism mac, you use the standard OSX color
picker.

320
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· The toolbar at the top lets you choose one of five different approaches
to choosing a color. The example above shows choosing from a list of
colors, but the buttons above let you also use a color wheel, color
sliders (to enter RGB or CMYK), crayons, or choosing from a color
palette.

· The  magnifying glass icon gives you a sixth way to choose colors, by
matching  a color elsewhere on your screen. Click on the icon, then click
on any color showing on your screen (ok if it is a different application). 

· The custom colors at the very bottom of the dialog offer a seventh way
to choose a color. Simply click on the desired color. See below for
adding colors to this palette.

· Once you choose a color in the color picker, you'll also see it in the
Prism dialog. You don't need to click OK or close the Color Picker dialog. 

· To add new colors to the custom color palette at the bottom of the
dialog, drag a color down from the large swatch on top of the dialog
(white in the example) and drop onto one of the custom color boxes. To
choose a custom color, click on it.  
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· To make a color semitransparent  (opaque), use the slider at the
bottom of the color picker. 

Troubleshooting the Mac color picker

13.2.14.3Selecting colors (Windows)

Using the color picker

Within Prism, there are color drop downs on many dialogs (Format Graph,
Format Axis...) and on some right-click shortcut menus. Choose a color
shown and you are done. Or click the bottom choice, More Colors. for
more choices.  This brings up the custom color dialog, which is part of
Windows and was not created by GraphPad. This offers three ways to
choose a color:

· Basic colors. 

· Custom colors. See below for how to define a color to be custom. 

· Use the large color picker on the upper right of the dialog. To use this,
you need to make two choices. First, choose a color in the large box.
Then use the vertical slider to choose the shade of the color, basically
how much black is added.  The slider often defaultsall the way down to
maximum blackness. In this position, all the colors look black! You'll
need to move that slider up. 

· Enter a color by entering three numbers representing HSL or RGB. With
Windows, it is not possible to choose a color by entering CMYK values.
But all colors can also be encoded as RGB.
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Custom colors

There is room at the bottom left of the dialog for 16 custom colors you
create. To define and save a custom color, follow these steps:

1. Make sure that "Use these custom colors in new projects" is checked.

2. Check on one of the 16 custom color boxes in the bottom left of the
dialog, an empty one if there is one empty.

3. Choose a color by clicking on the large box of colors at the upper right,
or by entering RGB (or HSL) values. (See the note below about the
intensity slider.)

4. Click the button Add to Custom Colors. The color will appear in one of
the 16 custom color boxes at the lower left, and wil stay there.

Notes:

· The checkbox "Use these custom colors in new projects" only applies to
custom colors you choose after you checked that option. It won't apply
to colors you chose before checking the option. 

· The colors you assign to the Custom Color slots at the bottom of the
dialog cannot be transparent. The transparency of all custom colors is
set to 0% (because this standard Windows dialog cannot store
transparency). 
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· If you want to create a custom color by entering RGB (or HSL) values,
you need to add a first step: click on a basic color. You'll see the RGB
values of that color. Change them to enter your RGB values. Finally click
"Add to Custom Colors". If you don't do that first step, you won't be
successful at creating a new custom color. 

Transparency

Optionally choose to make any color semitransparent  by sliding the
control between 0 and 100%. At 0%, the color is completely opaque. No
matter how light the color, objects that are underneath this object won't
show through. At 100%, it doesn't matter what color you picked, because
the color is invisible. In between, the color is semitransparent.

13.2.14.4Semitransparent colors

Why use transparent colors?

The main reason is shown below. When points on a graph overlap, you
usually won't see some of them. If you choose a semitransparent color,
the overlapping points will get darker. 

Transparent colors can also be useful when shading the area under a
curve (or between error bands) so you don't hide other objects on the
page.
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Terminology

To be compatible with other programs, we use different terms for
Windows and Mac.

· Prism Windows uses the term transparency. At 0% transparency, the
color is completely opaque. No matter how light the color, objects that
are underneath this object won't show through. At 100% transparency,
the object is completely clear so it doesn't matter what color you
picked. With values in between, you'll see the color you chose, but
objects underneath will show through. 

· Prism Mac uses the Mac term opacity, which is the complement of
transparency. At 100% opacity, the color is completely opaque. No
matter how light the color, objects that are underneath this object won't
show through. At 0% opacity, the object is completely clear so it doesn't
matter what color you picked. With values in between, you'll see the
color you chose, but objects underneath will show through. 

A transparency of 75% equals an opacity of 25%. A transparency of 40%
equals an opacity of 60%.

Choosing semitransparent colors

Prism Windows lets you choose a few semitransparent colors in the color
drop down menu. 
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Or press "More colors & transparency" to bring up the full Choose Color
dialog where you can choose any color and apply any degree of
transparency. 

Prism Mac doesn't have the color drop down menu, so you choose opacity
at the bottom of the color picker. 

 A semitransparent color is not the same as a light color
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You can make any color with a light shade, with lots of white mixed in.
But a light color is not semitransparent. Light colors are opaque. To get a
color that looks light but is semitransparent, start with a darker color and
choose transparency. 

Semitransparent colors in exported images

When you export your graph or layout, the transparent (opaque) colors
may or may not look transparent (opaque) in the exported image. It
depends on what format you export in and on whether you use Prism
Windows or Mac. In the table below, "Yes" means that semitransparent
colors will be encoded in the exported file, and No means they will not be.

Format Windows Mac
EMF, EMF+ or WMF Yes n/a
EPS No No
PDF No Yes
TIFF Yes Yes
PNG Yes No
JPG No No
BMP No No

Note that the EPS, JPG and BMP formats simply cannot encode
transparency. 

13.3 The Format Graph Dialog
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Prism lets you customize every feature of a graph.

Change the shape, color, and size of graph

symbols; change the fill pattern and color of graph

columns; change the order that data sets are

plotted.
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13.3.1 Overview of Format Graph

 .

13.3.1.1 Different Format Graph dialogs for different kinds of graphs

Each kind of graph has a different Format Graph dialog. 

XY graphs

Column graphs

Grouped and Contingency graphs

Heat maps

Survival graphs

Parts of whole graphs

13.3.1.2 Changing one, some or all data sets

Parts of whole and heat maps are distinct, but for XY, Survival, Column,
Grouped and Contingency table graphs, the first tab of the Format Graph
dialog controls the appearance of symbols, bars, lines, etc. 

Change the appearance of one, several, or all data sets.

· One data set. Choose a data set from the drop  down on the top of the
dialog, then change the settings for that data set.

· All data sets. Drop the Global menu at the top right of the dialog,
choose to change all data sets, and then make the changes. Any
changes you make after choosing the change all data sets will apply to
all the data sets. Changes you made before making that choice only
apply to the data set selected then. Shortcut: Hold the Control key
down while you make changes. Any changes made while holding Control
down will apply to all data sets on the graph. When you are in global
mode (change all data sets), the cursor changes to include a globe:
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· Several data sets. Drop the Global menu at the top right of the dialog.
Choose some data sets, and then change the settings for those data
sets. For example, you could select data sets A, C, E, and G and change
all of those data sets to use a dotted line. Then choose B, D, F and H,
and make those lines solid. Any changes you make after choosing a set
of data sets to change will apply to those data sets. 

13.3.1.3 Style

The Style selections at the top of the Format Graph dialog is where you
make the most important choice about your graph. Graph points or bars?
Error bars? If so, showing what error value (SD, SEM, Range, ...)? 

The choices available here depend on what kind of graph you have chosen
(XY, Column, Grouped, etc.) and how you entered your data. 

13.3.1.4 Symbol shape and border

You can plot symbols on Column, Grouped, Contingency, and XY graphs. 
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Notes:

· You will only have choices of border color and thickness when you
choose an open symbol (as shown above). 

· The standard set of symbols will probably have what you want:

          

· If you click "More", you can choose any character from any font to use
instead of a symbol. 

13.3.1.5 Bar borders and fills

You can plot bars on Column, Grouped, Contingency, and XY graphs. 

Formatting bars works a bit different than it did in prior Prism versions. 
By default, the bars are solidly filled with a color you choose, and have a
border whose thickness and color you choose. 

If you want a fill pattern, check the option box, then choose the design
(the fill pattern) and color. 

13.3.1.6 Distinguishing the X axis from the bar baseline

If you make a Column or Grouped bar graph with some bars having
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positive values and others having negative values, Prism will by default
make a graph like this:

Distinguish the X axis from the bar baseline. 

· The X axis in the graph above is at the bottom of the graph. Set the
location of the X axis (and move it to Y=0) if you want in the first tab of
the Format Axis dialog. Bring up this dialog by double clicking on any
axis.

· The bar baseline is set in the third tab of the Format Graph dialog. In
the graph above, the setting is at its default value of "automatic" which
means Prism draws the baseline at Y=0. Bring up this dialog by double
clicking on the main part of the graph.
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The default graph, as above, is usually what you'll want. But if you want
something different, knowing how the X axis and the bar baselines are set
will let you make the kind of graph you want. 

13.3.1.7 Box and whiskers graphs

Creating a box and whiskers plot

Prism lets you create box-and-whisker plots from stacks of values entered
into a Column table, or side-by-side replicates entered into an XY or
Grouped table. 

The box
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The box always extends from the 25th to 75th percentiles. These limits
are sometimes called the hinges of the plot. Surprisingly, there are
multiple ways to compute these percentile values. Prism uses a standard
method, but a different method than Excel uses. 

The line in the middle of the box is plotted at the median. You can not
choose a different value, but Prism also lets you put a "+" at the mean. 

The location of the whiskers

Prism offers six ways to create whiskers in box-and-whiskers plots: 

§ Min to max. The whiskers go down to the smallest value and up to
the largest. 

§ Tukey. See details below. 

§ 10 to 90 percentiles. The whiskers are drawn down to the 10th
percentile and up to the 90th. Points below and above the whiskers
are drawn as individual points.

§ 5 and 95 percentiles

§ 2.5 and 97.5 percentiles

§ 1 and 99 percentiles

§ Min to max, show all points. This method plots whiskers down to the
minimum and up to the maximum value, but also plots each
individual value as a point superimposed on the graph.

Other options

§ Choose the border color and thickness, and fill the box with color. 

§ Plot the mean as a "+". 

§ Choose a fill pattern for the box, and choose the design (pattern)
and color. 

More about box and whisker plots

How the Tukey method plots  whiskers and outliers

1. Calculate the inter-quartile distance (the difference between the 25th
and 75th percentiles). Call this the IQR.
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2. Add the 75th percentile plus 1.5 times IQR.  If this value is greater
than (or equal to) the largest value in the data set, draw the upper
whisker to the largest value. Otherwise stop the upper whisker at the
the largest value less than the sum of the 75th percentile plus 1.5IQR,
and plot any values that are greater than this as individual points.

3. Calculate the 25th percentile minus 1.5IQR.  If this value is less than
the smallest value in the data set, draw the lower whisker to the
smallest value. Otherwise stop the lower whisker at the lowest value
greater than the 25th percentile minues 1.5IQR, and plot any values
that are greater than this as individual points.

Notes on Tukey boxplots

§ Why 1.5IQR? There is no statistical rationale; it is simply how Tukey
decided to do it, and he invented the idea of box-and-whisker plots.

§ When the Tukey method is used to create the whiskers, the ends of
the whiskers are sometimes called the inner fences. 

§ The values that are plotted individually are sometimes called
outliers, but "outlier" is defined differently by Grubbs test or some
other outlier test. The chance of finding one or more "outlier" by
Tukey's rule in data sampled from a Gaussian distribution depends
on sample size. 

§ If you only enter three values per group (n=3), Prism will plot the
median and range. It will not plot the percentiles and will ignore your
choice for how to plot the whiskers.

§ With Tukey's method, the whiskers always end at a value matching
one of the values in the sample. So the two whiskers are often not
the same length.

§ The terms boxplot and box-and-whiskers plot are often used
interchangeably, although originally the boxplot was used to describe
a plot with Tukey whiskers (fences) and the box-and-whisker plot
was used to describe a plot where the whiskers extend down to the
minimum value and up to the maximum value.

Five number summary

The term five-number summary is used to describe a list of five values: the
minimum, the 25th percentile, the median, the 75th percentile, and the
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maximum. These are the same values plotted in a box-and-whiskers plot when
the whiskers extend to the minimum and maximum.

The term outlier

The term outlier has many definitions. The individual points that are plotted
beyond the whiskers of a box-and-whiskers plot are sometimes called outliers,
but this definition does not match the definition used by the Grubbs' or other
outlier tests. 

How to create a box-and-whiskers graph by entering the minimum,
maximum, median and 25th and 75th percentiles rather than entering the
raw data 

Usually, Prism creates a box-and-whiskers graph from raw data. You
enter a stack of values, and Prism computes the range and percentiles to
make the box-and-whiskers graph. 

You need to be just a tiny bit sneaky if you want to enter the minimum,
25th percentile, median, 75th percentile, and maximum values directly.
Prism won't know that you entered those values, but will make the graph
as if you entered raw data. If you just enter those five values, Prism will
correctly compute the minimum, maximum, and median, but  the 25th
and 75th percentile values Prism computes will be incorrect. 

Here is a trick: Enter the median value three times, rather than once, and
also enter the minimum, maximum, and 25th and 7th percentile values.
For each group, enter seven values on separate rows of one column (the
order doesn't matter. )

§ Minimum

§ 25th percentile

§ Median

§ Median

§ Median

§ 75th percentile

§ Maximum
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 You can't "tell" Prism that these values are not the raw data, so it
"thinks" they are raw data and so computes the minimum, maximum,
median and quartiles from those seven values, and plots those computed
values, which exactly match the values you entered.  

13.3.1.8 Graphping error bars

You'll be able to choose error bars for XY, Column and Grouped graphs.
Choose the color of the error bars, the direction (up, down or both), the
style (capped or not) and thickness. 

Notes on error bars:

· Prism can plot several kinds of error bars: SD, SEM, interquartile range,
etc. Choose this at the top of the Format Graph dialog in the style
section. 

· In XY graphs, the Style drop down has two choices that look like
horizontal lines (solid or dotted). These create error envelopes, rather
than error bars. You can use the Area Fill settings at the bottom of the
Format Graph dialog to choose to add color within the error envelope.

       

· Survival graphs  deal with error bars differently.

· Learn more about error bars . 

13.3.2 XY graphs

Format graph: XY

Prism lets you customize every feature of a graph. Change the shape, color, and size
of graph symbols; change the fill pattern and color of graph columns; change the
order that data sets are plotted.

415

212
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Double-click on any symbol (or the background of the graph) to bring up the Format
Graph dialog.

See also

Appearance of XY graphs

Front-to-back order of data sets

Use row titles to label data points

Nudging XY data sets

Additional XY settings

Replicates and error bars on XY graphs
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13.3.2.1 Format Graph -- XY

Format Graph dialog - XY graphs

Use this dialog to change the look of all the symbols in a data set. If you
want to change the look of a single data point , use the right-click
menu. You can also change all the symbols in selected data sets .

Double-click on any graph symbol or bar to open the Format Graph
dialog.

To change the settings for one data set:

Select a data set from the list, and choose the symbols, lines, and error
bars for that data set. Then select another data set and choose settings
for that data set. Click OK to redraw the graph with all the changes. Note
that a fitted curve is treated as a separate data set.

To change all data sets on the graph for example to make all symbols larger:

320

320
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Click the Global button at the top right of the Format Axis dialog. Then
choose to change all data sets, or a subset  of data sets. Changes you
make after that will then apply to all selected data sets.

There is a shortcut for changing all -- Hold down the control key. (Note
the 'globe' cursor since you are making global changes.)

Style

Choose how to plot error bars. Select SD, SEM, 95% CI, or range. If you
created a data table with no Y subcolumns, you won't have any choices
here. But, if you entered data into subcolumns, the choices here
determine how the replicates or error bars will appear. The Appearance
drop-down on the left determines the basic look, with further choices in
the Plot drop-down to the right (the choices will depend on what you
select in Appearance).

 

Since it rarely makes sense to choose different error bar (or replicate)
choices for different data sets, you will probably want to click Global and
then All before changing error bar format.
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If you have four or more subcolumns for replicates, Prism will also give
you the opportunity (at the bottom of the appearance drop down menu)
to plot  box-and-whiskers at each X value.

Show symbols

Choose symbol type, size, and color. If you pick an open symbol, also
select a border thickness. Check the Clear option if you want point-to-
point lines and overlapping points to show through the open symbol. Use
the Shape drop-down menu to select one of Prism's symbols. Use the
More option on this drop-down to use any character from any font on your
computer as a symbol.

Show bars/spikes/drop lines

Use this setting if you want to drop vertical bars from your data points.
The bar will start at the X-axis or whatever Y value you choose and go up
(or down) to the Y position of the point. This is useful when you want to
create a bar graph where each bar’s position is determined by its X value.
It is also useful when you want to combine points and bars on one graph
as shown below. If you pick the narrowest width for the bars, the bars will
actually be spikes suitable for graphing mass spectra.
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Show error bars

Choose the format and color of error bars. Choose dotted or solid lines to
show an error envelope as in the graph on the right below. Use the Show
Area Fill button to add fill between the limits of the error envelope. Learn
more about error bars on XY graphs .

Connecting line/curve

Choose the line's color, style (straight vs. staircase), thickness, and
pattern (solid, dotted, dashed, etc.). This section includes choices to have
your connecting start either at the first data point or the graph origin,
whether to leave gaps in the connecting line next to the symbols, and
whether to plot lines connecting each replicate for repeated measures in
corresponding data sets as in the graph on the bottom row below.

If you choose arrows as connecting lines, it looks best to not also show symbols.

213
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Don't confuse the connecting line – which always goes from point to point – with a
best-fit curve or line created by regression. If you have fit a curve through the data,
Prism sees the curve as a separate data set. Select the data set for the values, and
choose symbols but no connecting line. Then choose the data set for the curve, and
choose a connecting line (curve) with no symbols.

Area fill

Fill below (or above) the point-to-point line that connects your points with a fill. Specify

fill color and pattern, and background color. You may need to adjust the front-to-
back order  of the data sets to get the effect you want.

Plot on which Y axis

Specify which axis to use for each data set. If you choose to plot on the right Y-axis,
Prism will create that axis if it doesn’t already exist.

Legend

Select Show legend to create a legend for this data set. Select Label each point with its
row title to link the legend to the column title entered on the data table. Uncheck this
box if you don’t want the legend to change when you edit the column title. You can
also edit the labels in the legend. Double-click on the legend text and type whatever
you like. Use the checkbox Revert Legend to Column Titles in the Legend to change the

356



GraphPad Prism7 User Guide356

© 1995-2016 GraphPad Software, Inc.

labels back to match the column titles. (This checkbox is only available if you have
edited a legend.)

Label each point with its row title

Check this box to include row titles  on graph near each data point. You can
move each label by selecting it and dragging. Even if you move a label,
however, it remembers its position relative to the data point -- so when
you change your data, or the size and shape of your graph, the labels will
adjust accordingly. Click on any label on the graph and use the Text
section of the Prism toolbar to change the size, font, and color of all the
labels.

         

13.3.2.2 Front-to-back order of data sets

When data points overlap (or are superimposed) on an XY graph, the
plotting order determines which will show on top.

The two graphs in this example are identical except that the plotting
order was reversed. Note the green symbols are behind the clear ones in
the graph on the left, and in front on the graph on the right.

198
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To change the front-to-back order of the data sets on a graph:

Click the Rotate/Flip button in the Change section of the Prism toolbar to
reverse the front-to-back order of data sets on a graph.

To fine tune the front-to-back order, go to the Data Sets on Graph tab of
the Format Graph dialog.
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Changing the order of the data sets on this dialog changes the font-to-
back order of the data sets on the graph. It does not change the order
of the legends . 

 Front to back order within a data set

Within a data set, the front-to-back order of plotting is determined by the
order of rows in the data table. The first row is furthest back and the data
entered in the last (bottom) row is plotting in front. If you need to control
which point is on top, change the order of the rows.

See also:

Nudging data sets on a graph.

 

325
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13.3.2.3 Use row titles to label data points

Enter row titles  in a special column on the XY data table.

Click on the Format graph button on the Prism toolbar or double-click on any data point
to open the Format Graph dialog. Check the "Label each point with its row title" box to

include row titles  on graph near each data point.

You can move each label by selecting it and dragging. Even if you move a
label, however, Prism remembers its position relative to the data point --
so when you change your data, or the size and shape of your graph, the
labels will adjust accordingly.

Click on any label on the graph and use the Text section of the Prism
toolbar to change the size, font, and color of all the labels. You cannot
adjust the font individually. All the row labels always share the same font,
size and color.

198

198
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13.3.2.4 Nudging XY data sets

Nudge overlapping data sets to make a graph easier to understand.

Double-click on any data point to open the Format Graph dialog. Use the
bottom of the Data sets on Graph tab to nudge a data set.

Nudging adds a specified value to each X and Y coordinate before
graphing. Use this feature cautiously, as it means that the position of the
symbol on the graph will not match the actual X and Y values of the data
point.

The values you enter are the actual increments of X and Y. Each data set
is incremented as much as you specify. The nudging is not cumulative

Nudging can be helpful to differentiate datasets that otherwise overlap a
lot. For example, the data in the following graph overlap so much it is
impossible to tell which tracing is which.

The graph below is an alternative way to plot the same data. The second
data set is nudged by 25 units in the Y direction (and not at all in the X
direction).

The third data set is nudged 50 units in the Y direction (with zero in the X
direction).
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Now you can see the individual tracings.

All three tracings still have about the same baseline Y coordinates. But
nudging the data in the Y direction separated them. Because the Y values
were nudged, it would be misleading to plot the data on a full Y axis as in
the graph above. So instead, the Y axis is hidden (Frame and Origin  tab
of the Format Axes dialog) and replaced with a scale bar.

Waterfall graphs

Nudging can also help you create a waterfall graph. All the data sets in
the following graph cover the same range of wavelengths, and all have a
baseline of zero optical density. Each data set was nudged in both X and Y
directions, each data set nudged a bit more than the previous data set.
This creates a pseudo 3D look that is sometimes called a “waterfall”.

13.3.2.5 Skip over some points to speed graphing

Plotting XY graphs with tens or hundreds of thousands of points can be
slow. If you are impatient, Prism lets you specify that a graph only show
one out of every K points (you specify K), to speed up screen redrawing.
Choose at the bottom of the second tab of the Format Graph dialog.

471
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13.3.2.6 Additional XY settings

The Graph Settings tab of the Format Graph dialog

Gaps at missing points.

Leave a gap when you have missing data points, or connect the existing
data points on each side.

Reset any individual formatting of points or bars

If you have changed the format of individual data points (by right clicking
on them ) , check an option here to reset everything back to the format
set in the dialog. 

 

320



Graphs 363

© 1995-2016 GraphPad Software, Inc.

13.3.2.7 Adding a line of identity

The regression guide explains how to fit a line or curve to your data. But
sometimes you just want to add a line of identity --  a line where every
point has equal X and Y coordinates. Prism offers three ways to do this:

· Enter a data set on your data table with only two points defining the two
ends of the line you want to draw. In both cases X and Y will have the
same value. You can put these points on the same data table as your
data. Just put the Y values into a new Y column. Place the X values
below the X for your main data set, and make sure the Y values are in
the same row (many rows above that will be blank). When you look at
the graph, that new data set will first show as only two data points.
Double click on one to bring up the Format Graph dialog. Uncheck the
option to show symbols, and check the option to show a connecting
line. 

· Use the analysis to plot a function. From the graph, click Analyze, and at
the bottom of the analyze dialog go to the Generate a Curve folder and
choose the Plot a function analysis. Choose a straight line (from the
Lines folder of equations), enter the first and last X values you want to
plot the line between, and then go to the third tab of that dialog and
enter values for the Y intercept (probably 0.0) and slope (probably
1.0). 

· Use the line drawing tool to draw the line manually. 

The first method is probably the most straightforward. The second
method is great in that it can be extended to other functions besides
straight lines. We don't recommend the third method, but it is a quick
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and easy way to produce the line for someone who doesn't want to think
about math.

13.3.2.8 Point to point lines

Check on option in the Format Graph dialog to connect the XY points with
point to point lines. 

Notes:

· You can choose to have the line begin at the origin by checking an
option. Otherwise, the line starts with the first point.

· The lines are drawn point to point in the order the data are in the data
table, which may not be in the order of the X values. But note that there
is a Sort-by-X-Value command on the Edit menu you see when looking
at an XY data table. 

· The graphs below show four ways to draw these lines. The bottom
choice is one you probably want to avoid. That graph uses open symbols
with clear (transparent) fill so the point-to-point lines will be visible
going through (or under) the points. You want to use white (or whatever
the background color is) fill color which covers up the point-to-point
lines. 
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13.3.2.9 Spaghetti plot

Spaghetti graphs plot longitudinal data, showing individual tracings for
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each subject (or other experimental unit). 

1. Enter data into an XY data table, formatted with subcolumns for
replicates.

2. At the top of the Format Graph dialog, choose to plot each replicate.

3. Uncheck "Show symbols"

4. Lower on that dialog for connecting lines, choose to connect "Each
replicate, Spaghetti plot".
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13.3.3 Column graphs

Format graph: Column

Prism lets you change every feature of a graph. Change the shape, color, and size of
graph symbols; change the fill pattern and color of graph columns; change the order
that data sets are plotted.

Double-click on any symbol or bar (or the background of the graph) to bring up the
Format Graph dialog.

See also:

Appearance of Column graphs

Data set spacing on Column graphs

Plotting order of Column graphs

Additional Column graph settings

Replicates and error bars on Column graphs
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13.3.3.1 Format Graph --Column

Format Graph dialog - Column graphs

Use this dialog to change the look of all the columns in a data set. If you
want to change the look of a single column , use the right-click menu.
You can also change all the symbols in selected data sets .

Double-click on any graph symbol or bar to open the Format Graph
dialog.

320

320



Graphs 369

© 1995-2016 GraphPad Software, Inc.

To change the settings for one data set:

Select a data set from the list, and choose the bar format and fill, lines,
and error bars for that data set. Then select another data set and choose
settings for that data set. Click OK to redraw the graph with all the
changes. Note that a fitted curve is treated as a separate data set.

To change all or some data sets on the graph (for example to make all
symbols larger):

Drop the list of data set names and choose --Change ALL data sets--. Or
click the Global button just to the right. Changes you make after that will
then apply to all data sets, or to data sets you select from the Global
button.
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Style

Choose how you want to display your data for each data set. Choose from
a simple bar (with or without error bars), a scatter plot, an aligned dot
plot, box and whiskers, before and after plot, or floating bars. Also choose
how to plot error bars. Select SD, SEM, 95% CI, or range.

Note that your choice applies to only one data set column unless you used
the global button to choose all or a subset of columns.

It can also be useful to use different styles for each bar of a graph, as
below:

Or connect data sets A and B as before-and-after and data sets C and D,
but not B and C.
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To do this, choose Before-and-after as the style for data sets A and C,
and Aligned dot plot as the style for data sets B and D.

There are seven ways to plot box-and-whisker graphs. Traditional Tukey
whiskers go 1.5 times the interquartile distance or to the highest or
lowest point, whichever is shorter. Other choices show specified
percentiles, which seems more logical. Any data beyond these whiskers
are shown as points. Or you can choose to superimpose each individual
point on the box and whisker plot. You need to have at least four values
in order to create a box-and-whiskers graph.

Because whiskers can be done in various ways, it is essential to mention
in a graph's figure legend which way they were made.

Bars and boxes

Set the format of bars and the box part of box-whisker plots. Note that if
you choose the first selection in pattern, the bar will have a solid color
(chosen in fill). 

Symbols

Choice here apply to symbols used for column scatter and before-after
graphs, as well as the symbols shown (if any) on box-and-whisker plots. 

If you check the option to plot a symbols on a bar graph, every value will
be plotted. If you check the option top plot symbols on a box-and-
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whiskers plot, the number of symbols is chosen in the drop-down in the
Style section (see above). You can choose to plot all points (last choice in
the list) or only to plot "outliers" defined in various ways.

Error bars

Choose the format and color of error bars. Learn more about error bars on
Column graphs.

Lines

Choose the color and thickness of lines for means on scatter plots and the
connecting lines on before and after plot.

Plot on which Y axis

Specify which axis to use for each data set. This is useful if you want to
show different type of data on the same graph. If you choose to plot on
the right Y-axis, Prism will create that axis if it doesn’t already exist.

Legend

Select Show legend to create a legend for this data set. You can edit the
labels in the legend. Double-click on the legend text and type whatever
you like. Use the Revert Legend to Column Titles checkbox in the Legend
section of the Format Graph dialog to change the labels back to match the
column titles. (This checkbox is only available if you have edited a
legend.)

215
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Label each point with its row title

On before and after plots and scatter plots, you can choose to have X
labels show on the graph to identify individual data points. Check this box
to include X titles on graph near each data point. Select each label on the
graph and drag it to move it where you want.

13.3.3.2 Data set spacing on Column graphs

Set the standard spacing between columns

To change the standard spacing between individual bars (or array of
column scatter points), go to the Graph Settings tab. If you enter a larger
value, the gaps between bars will be wider so the bars will be narrower.
You can also set the gap before the first and after the last column.
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Changing the spacing between selected columns

To change the space between two adjacent bars, go to the Data Sets on
Graph tab. Select a data set and enter (at the bottom of the dialog) the
percentage of normal spacing you want between that data set and the
prior one. If you enter 200, that bar will be twice as far from its left
neighbor as the others. If you enter 50, it will be half as far. If you enter
0, this bar will touch the neighbor on the left.
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Note one possible source of confusion. 

When you enter a value here as the space between a selected data set
and the prior one, you enter the percentage of the gap set in the Graph
Settings tab. If you enter 200%, you are setting the gap between the
selected data set and the prior one to be twice as large as the usual
gap.  

When you enter a value on the graph settings tab as space between
columns, enter the percentage of the width of the bar (or plotting area for
the set of scatter symbols). A value of 50%, means the gaps between
bars are half as wide as the width of the bars. 
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Adding a line between adjacent columns

To add a line between two adjacent bars, go to the Data Sets on Graph
tab. Select a data set and enter (at the bottom of the dialog) the
specifications of the line you desire.
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Empty columns

An alternative way to leave a gap is to create an additional data set
column on the data table, enter only a single number (usually 0), and
include it on the graph. If the baseline of the graph is 0.0, and that value
is 0.0, then Prism will draw a zero height bar, which is essentially a gap.

13.3.3.3 Plotting order of Column graphs

The two graphs in this example are identical except that the plotting order
was reversed.

To reverse the plotting order of the data sets on a graph, click the Rotate/Flip button in the Change section of the Prism toolbar.

To fine tune the left-to-right order, go to the Data Sets on Graph tab of
the Format Graph dialog.
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Changing the order of the data sets on this dialog changes the left-to-
right order of the data sets on the graph. It does not change the order
of the legends . 

13.3.3.4 Additional Column graph settings

Graph Settings tab of Format Graph dialog

Use the Graph Settings tab of the Format Graph dialog to change the
direction of bars on a graph from vertical to horizontal, to set the baseline
for graph columns, and to adjust the space between columns. Double-
click on any bar to open the dialog.

325
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Rotate columns from vertical to horizontal

You also can use the Rotate button.

Baseline

Fill in this box to change the baseline for bars on a graph. The default is
for the bars to begin at the X axis.
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Check the box for "Hide Baseline" if you want your bars to float as in the
example below.

Dimensions

Prism automatically adjusts the width of columns based on the size of the
graph, the number of data sets, and the gap between bars which you set
here. To make the columns wider, make the spacing smaller.
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Discontinuous axis

When you have a gap in a Y axis, choose whether or not you also want a
gap in any columns that span the gap.

Reset any individual bar formatting

If you have changed the format of individual bars (by right clicking on
them ) , check an option here to reset everything back to the format set
in the dialog. 

13.3.3.5 Forest plots

This graph below is a Forest plot, also known as an odds ratio plot or a
meta-analysis plot. It graphs odds ratios (with 95% confidence intervals)
from several studies.

320
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There are a few tricks to making this graph:

1. Enter the data into a Column table. Keep the default choice to enter the
"replicates" into columns. (In this case, they are not replicates, but
Prism thinks they are).

2.  Enter the results for each study into a separate data set column. Enter
in each column the Odds ratio itself, as well as the high and low
confidence limits (computed elsewhere).  The order of those three
values doesn't matter. Label the studies by entering column titles. You
may use Greek symbols, super and subscript, etc.

2. Go to the graph.

3. When you first go to look at the graph, Prism will prompt for the kind of
graph you want. Choose "Column Mean with error bars". 
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4. Note that Prism's doesn't (can't) know that each column contains a
computed odds ratio along with the low and high confidence limits. It
just sees three values. So choose to plot the median and range. The
median and range of the three values you entered are the odds ratio
and its confidence limits computed elsewhere. If you choose to plot a
confidence interval instead, Prism will compute a confidence interval
from the three values you enter and the results will be nonsense.

5. The default graph is vertical. To make the graph horizontal (as below),
double click on the graph to bring up Format Graph, and go to the third
tab.

6. Double-click on the X axis to bring up Format Axis. Choose to make the
axis scale logarithmic with log spaced minor ticks, and to create a grid
line at X=1.0.
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13.3.3.6 Color coding column scatter graphs

When you make a column scatter graph with Prism, all symbols in each
column have the same shape and color. This page explains how to make
some points have a different color. 

Choose selected points in the table

1. Select a range of data, perhaps one row or one subcolumn.

2. Right click, choose Format Points, and then Symbol color

Notes:
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· If you have more than one graph from the same data, Prism will ask
whether you wish to change one or all graphs.

· If you have an XY table and the X column is  entirely blank, then the
Format Points command will be gray. The workaround is to change your
table to a Column table. 

· There is no way to create a new legend using this method to explain
what the colors mean.

Change selected points on the graph

1. Make a column scatter graph as usual.

2. Right click on a point, choose Format This Point, and choose a different
color.

3. Repeat for each point you want to change.

Make a Grouped graph instead (to get a legend)

1. Create a Grouped data table, and choose a Grouped Column Scatter
graph.

2. Enter data on a Grouped data table, rather than a Column table. Put
the values you want to have different colors into different data set
columns. Put the values you want to appear in different columns of the
graph into different rows. 

Example:
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13.3.4 Grouped and Contingency graphs

Format graph: Grouped and contingency

Prism lets you change every feature of a graph. Change the shape, color, and size of
graph symbols; change the fill pattern and color of graph columns; change the order
that data sets are plotted.

Double-click on any symbol or bar (or the background of the graph) to bring up the
Format Graph dialog.

See also:

Appearance of Grouped and Contingency graphs

Data set grouping and spacing on Grouped graphs

Plotting order of Grouped graphs

Additional Grouped graph settings

Replicates and error bars on Grouped graphs
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13.3.4.1 Appearance of Grouped and Contingency graphs

Format Graph dialog - Grouped graphs

Use this dialog to change the look of all the columns in a data set. If you
want to change the look of a single column , use the right-click menu.
You can also change all the symbols in selected data sets .

Double-click on any graph symbol or bar to open the Format Graph
dialog.

320
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To change the settings for one data set:

Select a data set from the list, and choose the symbols, lines, and error
bars for that data set. Then select another data set and choose settings
for that data set. Click OK to redraw the graph with all the changes. Note
that a fitted curve is treated as a separate data set.

To change all data sets on the graph (for example to make all symbols
larger):

Click the Global button and choose, Change all data sets. Changes you
make after that will then apply to all data sets.

Style

With two-grouping variable graphs, replicates are placed in side-by-side
columns on the data table. One grouping variable is the main column
heading, the other is the row title.
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Choose how to display a data set on the graph. Choose between a scatter
dot plot, an aligned dot plot, a before-and-after plot, a column or bar, a
box-and whiskers plot, or a floating bar showing the minimum and
maximum.

Choose how to plot error bars. Select SD, SEM, 95% CI, or range. Your
style choice will determine which options below you can use. Since it
rarely makes sense to choose different error bar (or replicate) choices for
different data sets, you will probably want to click "All" before changing
error bar format.

Format Symbols or bars

If you choose to plot data as a scatter dot plot or a before-and-after
graph, select the symbol type, size, and color. If you pick an open
symbol, also select a border thickness. Check the Clear option if you want
point-to-point lines and overlapping points to show through the open
symbol.

Click More to use any character from any font as a symbol.
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If you choose to plot your data sets as bars, columns, box-and-whiskers,
or floating min/max boxes, choose the color, outline and fill of the bars
and boxes.

Use the Data Sets on Graph tab  to adjust the spacing between bars,
and whether you want the bars stacked, interleave, grouped, or
superimposed.

Prism labels bars with the row titles from the data table. You may not edit
the bar titles directly, but if you edit the row titles, the graph will update.
Use the Format Axes  dialog, not the Format Graph dialog, to turn off
the labels or to change to vertical or angled labels.

If your data table has only one row, Prism will place the column titles,
rather than row titles, under each bar.

Format error bars

Choose the format and color of error bars. Learn more about error bars on
Grouped graphs .

Lines

Choose the format of lines connecting data points for a before-and-after
plot. Consider using arrows.

Plot on which Y axis

Specify which axis to use for each data set. If you choose to plot on the
right Y-axis, Prism will create that axis if it doesn’t already exist.

393
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Legend

Select Show legend to create a legend for this data set. Prism
automatically uses the column titles in your data table as legend labels.
You can also edit the labels in the legend. Double-click on the legend text
and type whatever you like. Use the "Revert Legend to Column Titles"
checkbox in the Legend section of the Format Graph dialog to change the
labels back to match the column titles. (This checkbox is only available if
you have edited a legend.)

13.3.4.2 Grouped graphs with XY data

If you entered XY data, with values in the X column, you can make a
Grouped graph. But note:

The whole point of a grouped graph, is that the X axis is spaced by row
number. The X value does not determine the position of the points on the
graph. This can be useful in some situations, but very misleading in
others. As shown below, the X values may not even be plotted in order of
their value. On a grouped graph, position is determined by row number
only.
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The graph above has the X axis labeled with the X values. On the Format
Axes dialog, you can choose to use Row titles (if you entered any), row
numbers or column titles instead.
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13.3.4.3 Data set grouping and spacing on Grouped graphs

How do you change the grouping and spacing of bars on Grouped
graphs?

Click on the Format graph button on the Prism toolbar or double-click on
any data point to open the Format Graph dialog.

Set the standard spacing between bars

To change the standard spacing between individual bars and groups of
bars, go to the Graph Settings tab.
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Set how you want the bars to be grouped

You can change the overall grouping scheme of a graph or make hybrid
graphs types using the order tab of the Format Graph dialog. For each
data set, choose whether it should be interleaved with, stacked on top of,
placed apart from the (starting a new group of bars, hence the name
“grouped”) or superimposed on the preceding data set.

Add lines between groups

 Check the box to Separate a data set from another with a line.
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Stacked and superimposed bars

Note the difference between Stacked and Superimposed below. When the
bars are superimposed, each extends from the X axis to the value. When
bars are stacked, each bar starts at the top of the one below.

Notes:

· If bars are stacked, it can help to use semitransparent colors. That way
you can see the smaller bar that is hidden behind a taller one. 
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· Use the middle tab of Format Graph to change the order of data sets,
which controls which data set is on top. 

· With stacked bars, each row in the data table becomes one stack of
bars. If you want to leave a gap between stacks (to create a natural
grouping of sets of stacked bars), leave a blank row in your data table. 

· It sometimes is helpful to combine both stacked and interleaved bars on
the same graph as below. This is done by checking the option to stack
the "dogs" data set on top of hippos, and to make the "cats" data set
grouped.

 

13.3.4.4 Plotting order of Grouped graphs

Data set order

The two graphs in this example are identical except that the plotting
order was reversed.

Click the Rotate/Flip button in the Change section of the Prism toolbar to
reverse the order of data sets on a graph.
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To fine tune the left-to-right order, go to the Data Sets on Graph tab of
the Format Graph dialog.

The two graphs in this example are identical except that the plotting order
was reversed.

To reverse the plotting order of the data sets on a graph, click the Rotate/Flip button in the Change section of the Prism toolbar.
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To fine tune the left-to-right order, go to the Data Sets on Graph tab of
the Format Graph dialog.

Changing the order of the data sets on this dialog changes the font-to-
back (if you plot symbols) or left-to-right (if you plot bars) order of the
data sets on the graph. It does not change the order of the legends
. 

Order of bars within a data set

The previous section explained how to adjust the order of the data sets.
The order of the individual columns within a particular data set is
determined by the order they are entered in the data table.

325
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To reverse the row order on a data table, go to the data table. From the
Change menu, click the Sort button, and choose "Reverse row order".

See another example of changing plotting order for Grouped graphs.

13.3.4.5 Additional Grouped graph settings

Graph Settings tab of Format Graph dialog

200
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Use the Graph Settings tab of the Format Graph dialog to change the
direction of bars on a graph from vertical to horizontal, to set the baseline
for graph columns, and to adjust the space between columns. Double-
click on any bar to open the dialog.

Direction

Rotate columns from vertical to horizontal

You also can use the Rotate button.
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Baseline

Fill in this box to change the baseline for bars on a graph. The default is
for the bars to begin at the X axis. Check the box for "Hide Baseline" if
you want your bars to float as in the example below.

Spacing

Use these settings to set adjust the spacing between columns on a graph,
between groups of columns, and before the first column and after the last
one. If you make the spacing smaller, the columns will become wider.

Choose how much if any space to leave for the bar where no value was
entered (the cell is blank).  In the example below, no data was entered
for black dogs. You can choose to leave no space, normal 100% space, or
something in between.
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Discontinuous axis

When you have a gap in a Y axis, choose whether or not you also want a
gap in any columns that span the gap. Not leaving a gap may make your
graph misleading.

Shape of the legend key

For bar graphs, choose between square or rectangular (wider) boxes
before the legend text.

13.3.4.6 Row or column titles under bars?

You can change how the bars are labeled. Double-click on the axis to
bring up Format Axis, then choose to use Row numbers, Row titles, or
Column titles. If you choose Column titles, you'll want to use the text tool
to add text to the graph to explain the grouping.
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13.3.4.7 Plotting the grand mean or grand median

To plot the grand mean or grand median, plot grouped data (with
individual replicates) on a Grouped graph, choose "Plot individual values"
and then choose to plot a superimposed scatter plot. The last two choices
on the Plot drop down menu will be to plot the Grand mean or Grand
median. It is not possible to plot the grand mean or median with error
bars, and it isn't totally clear even how those error bars would be
defined. 



Graphs 405

© 1995-2016 GraphPad Software, Inc.

  



GraphPad Prism7 User Guide406

© 1995-2016 GraphPad Software, Inc.

13.3.4.8 Three way graphs

A three way graphs is a Grouped graph set up to show data entered into
Prism for analysis by three-way ANOVA. The entered data look like this.
Note the two line column titles. These are essential both to properly label
the data, but also to properly label the graph.

From the Change Graph Type dialog, choose the Three-way tab and one
of the thumbnails.

The graph looks like this. 
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Note that the first line of the column titles in the data table become labels
for the two halves of the graph, and the second line of the column title
becomes the graph legend. The row titles become labels under the bars. 

13.3.5 Heat maps

 .

13.3.5.1 Creating a heat map

New to Prism 7, Heat maps are a standard way to plot grouped data. The
basic idea of a heat map is that the graph is divided into rectangles or
squares, each representing one cell on the data table, one row and one
data set. The rectangle or square is color coded according to the value of
that cell in the table. Prism offers lots of options to make Heat maps
useful. 

Enter data on a Grouped table. Most often you'll want to format this with
no subcolumns. In this case, each number you enter maps to one
rectangle on the heat map. Unless you choose to reverse or transpose
axes, the arrangement of the colors on the heat map will correspond to
the numbers in the table. If your table as three rows and four columns,
the heat map will also have three rows and four columns. 

If you enter replicate values in side by side subcolumns, you can later
choose if you want the heat map to be based on the mean, median or
geometric mean of the replicates. You can even choose to make a heat
make of variation, and use the SD, %CV or SEM as the basis of the
heatmap. 

When you go to the automatic graph (or choose New..Graph of existing
data), the New Graph dialog opens. Choose the Heat Map tab and make
basic choices about the kind of heat map you wish to make.
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Once you see the graph, double click on it to bring up the Format Graph
dialog with many more choices. 

Color mapping

Graph settings

Titles and labels

Gaps

Legends
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13.3.5.2 Color mapping

Mapping replicates

 If you entered replicate values (side by side), you can later choose if you
want the heat map to be based on the mean, median or geometric mean.
You can even choose to make a heat make of variation, and base the heat
map on the SD, %CV or SEM of replicate values. 

Color map and range

There are four choices of color maps:

· Single gradient. Choose the range of values to convert to colors and the
range of colors. 

· Grayscale. You can choose whether black or white is for the lower value,
and what the range of values is. 

· Rainbow. You choose the range of data values. Prism chooses the range
of colors by fixing the saturation and brightness to 100% and varying
the hue from 0° to 300°.
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· Double gradient. You choose the baseline value (almost always 0.0) and
color (usually white or black). Then separately enter the maximum
value (almost always positive) and color, and also enter the minimum
value (almost always negative) and color. 

· Categorical. Enter a value or range of values, and what color you want it
to show as. Repeat as needed. Ranges cannot overlap. You can't have
one range "1-2" and another "2-3" because that would leave it
ambiguous how to encode 2.0000. Instead do something like this -- one
rage for "1.0-1.99" and another for "2.0-2.99". 

·

Off the map

Choose a color to use if the value is too large or too small to be part of
the map you defined, or if the value is blank or excluded. Of course, these
choices are irrelevant if no values are off scale, blank or excluded. To
make blank and excluded values more apparent,  check an option to place
a black X through those cells. Since the X is always black, use a light
color to encode these cells. 
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13.3.5.3 Graph settings

Borders and background

Choose the page background color and the color and thickness of the
borders around each cell (box) and around the entire heat map. 

Size and shape

You can set the size of the entire heat map, in which case the size and
shape of each cell will be determined by that size and how many rows and
columns there are. Or set the size and shape of each cell, and the overall
size is determined from that. 

Order

Optionally reverse the order of columns and/or rows. Or transpose rows
and columns. 
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13.3.5.4 Titles and labels

Choose whether to show an overall title over the graph, whether to write
the numerical value (or the mean, median, etc) of each cell in that cell,
and how to label the two axes. 
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13.3.5.5 Gaps

There are two reasons to use gaps. 

· You can put gaps next to and under all the cells just because you think
the heat map is more attractive that way. The gaps server as borders. 

· Use gaps to group sets of rows and columns to give some structure to
the heatmap. Maybe the left half is for one cell line, and the right half
for another. Put a gap in between to distinguish them. 
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13.3.5.6 Legend for heat maps

The legend is the key that maps colors to value. 

Choose if the legend will be horizontal or vertical and whether it has a
border, then choose the interval for labeling it, and the location and
formatting of each label.

13.3.6 Survival graphs

Format graph: Survival

Prism lets you change every feature of a graph. Change the shape, color, and size of
graph symbols; change the fill pattern and color of graph columns; change the order
that data sets are plotted.

Double-click on any symbol or bar (or the background of the graph) to bring up the
Format Graph dialog.

See also:

Survival graphs: formatting options 414
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Appearance of Survival graphs

Changing the plotting order of data sets

Nudging survival data sets

Error bars and confidence bands on Survival graphs

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

13.3.6.1 Appearance of Survival graphs

Format Graph dialog - survival plots

Use this dialog to change the look of all the points in a data set. If you
want to change the look of a single data point , use the right-click
menu. You can also change all the symbols in selected data sets .

Double-click on any graph symbol or bar to open the Format Graph
dialog.

415

419

420

218

320

320



GraphPad Prism7 User Guide416

© 1995-2016 GraphPad Software, Inc.

To change the settings for one data set:

Select a data set from the list, and choose the symbols, lines, and error
bars for that data set. Then select another data set and choose settings
for that data set. Click OK to redraw the graph with all the changes. Note
that a fitted curve is treated as a separate data set.

To change all data sets on the graph (for example to make all symbols
larger):

Drop the list of data set names and choose --Change ALL data sets--. Or
click the ALL button just to the right. Changes you make after that will
then apply to all data sets.

Show Symbols

Choose symbol type, size, and color. If you pick an open symbol, also
select a border thickness. Check the Clear option if you want point-to-
point lines and overlapping points to show through the open symbol. Use
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Shape the drop-down menu to select one of Prism's symbols. Use the
More option on this drop-down to use any character from any font on your
computer as a symbol.

In survival plots, you can choose to show symbols only for censored data
points, or for all data points. Make this selection on the Graph Settings
tab of the Format graph dialog.

Error bars

Choose how you want error bars to be formatted. Error bars can go above
or below a data point or in both directions. Learn more about error bars
on survival graphs .

Depending on the choices you made when you created a survival plot, the
option for error bars may or may not be available. You can change this
setting in the Graph Settings tab of the Format Graph dialog.

218
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Connecting lines

Choose the format of lines connecting data points for a survival plot.
Consider using arrows.

Show Area fill

Choose to show area fills below or above the plot lines. Click the All
button to turn on this feature for all the data sets on a graph.

Plot on which Y axis

Specify which axis to use for each data set. If you choose to plot on the
right Y-axis, Prism will create that axis if it doesn’t already exist.

Legend

See the page on Legends for XY graphs.  325
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13.3.6.2 Changing the plotting order of data sets

Change the order to determine plot lines are in front. Plotting area
matters the most when you use area fills. The graphs below are the
same, but with the plotting order reversed. Note that on the graph on the
left the area fill from the one data set hides the other.

To change the plotting order of the data sets on a graph:

Click the Rotate/Flip button in the Change section of the Prism toolbar to
reverse the front-to-back order of data sets on a graph.

To fine tune the front-to-back order, go to the Data Sets on Graph
tab of the Format Graph dialog.
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13.3.6.3 Nudging survival data sets

Nudging can be helpful to differentiate datasets that otherwise overlap a
lot. The "Treatment B" data set in the graph on the right has been nudged
up a bit to separate it from the "Treatment A" data set.
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13.3.7 Parts of whole graphs

 .

13.3.7.1 Changing the look of parts of whole graphs

Format Graph dialog - Parts of whole plots

Use this dialog to change the look of a Parts of whole graph If you want to
only change the look of a single segment, it is simpler to use the right-
click menu on the graph. You can also change all the symbols in selected
data sets .

Double-click on any graph section to open the Format Graph dialog.

To change the general appearance of the graph:

 Click on the thumbnail image in the Graph type section of the dialog. You
can change from a pie chart to a donut, slice or dot plot. Prism will
preview how your graph will look after the change.

320
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To change the settings for one data set:

Select a data set from the Colors and legend list, and choose the color of
the graph segment, and what information you want the legend to show.

To change all data sets on the graph:

Click the Global button to select all data sets on the graph. Or, select the
data sets from the drop-down menu that you want to change.

If your graph only has one data set (one slice):

The graph is generated from values entered into a single column in the
data table. If you enter data into a row, you'll only get one value on the
graph.

Color and Legends

You can set the color of each graph segment. Use the roll-down to choose
if you want a particular segment of a pie or donut graph exploded from
the main graph and how far away you want it to be. Or choose to hide a
segment.
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Choose the information you want the legend to show and how you want it
formatted.

If one of the rows of data is zero, then Prism will not create a legend for
it. If you want a legend, even though the value is zero, enter some tiny
nonzero value like 0.000001. The slice will be invisible on the graph, but
Prism will create a legend for it. 

Borders

Choose the color and thickness of the segment borders. You can have
different settings for the inner and outer borders. These setting are for all
the segments of the graph.

Titles

Click to show or hide the graph title, or to show or hide the total of all
values, The graph shows each category as the fraction of the total, so it
can be very useful to show the total  near the graph. With donut graphs,
it is common to put the total in the center of the graph as shown below.
Optionally add a prefix or suffix, for example: 1,000 Applicants, or Total:
1,000. 



Graphs 425

© 1995-2016 GraphPad Software, Inc.

Order

Reverse the order of the data sets to change the orientation of the graph.

Size

Use the Size portion of the dialog to change the size of the whole of a
donut graph.

13.3.7.2 Changing which data set is plotted

A parts-of-whole graph can only plot one data set. To plot a different data
set, double click on the graph to bring up the Format Graph dialog, go to
the second tab, and choose the table and data set to plot. 
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Note that the values that comprise a parts-of-whole graph are always
entered into one data set column. If your values are in a row, you'll need
to select them, copy to the clipboard, go to an empty row and paste.

13.4 Format Axes dialog

Scientists often individualize the axis range, numbering and ticks.

Axis range

Axis numbering

Major and minor ticks

Graphs with two Y-axes

Hide an axis and show scale bars

Put a gap in an axis

Additional ticks and grids

 Axis titles
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13.4.1 Axis range, numbering & titles

 .

13.4.1.1 Axis range

Double-click on an axis to open the Format Axes dialog. Or click on the
Format Axis tool in the Prism toolbar.

Prism chooses the range of each axis automatically. To override this,
uncheck the "Automatically determine the range and interval" box and
enter the minimum and maximum value you want plotted on the axis. You
can also hook  a range limit to an info constant.

You can only set the range on numerical axes, not the categorical axis
of Column and Grouped graphs.

267
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13.4.1.2 Axis numbering or titles

Double-click on an axis to open the Frame and Origin tab of the Format
Axes dialog. Or click on the Format Axis tool in the Prism toolbar.

What values or labels show on the X axis?

XY graphs

Normally, of course, the X axis of an XY graph plots the X values you
enter into the  X column. The X axis, in this case, is numerical. If the X
values are not evenly spaced, then the points won't be equally spaced. 

If you enter row titles for each row, then you can choose to label the X
axis with row titles rather than X values. Choose in the Number format
drop down in the Regularly spaced ticks part of the Format Axes dialog. 
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When you choose to label the X axis with row titles, the spacing of the
points may change. Essentially, Prism uses the row number as the X
value, so the points will be equally spaced along the X axis, even if the X
values are not evenly spaced. By default, each row label will appear. If
you have many rows, this will be cluttered. You can ask Prism to plot,
say, every fifth row label by changing the major tick interval to 5, starting
at 0. Keep in mind that Prism uses the row number (first row is 1) rather
than the values entered into the X column, to position the data and
determine which labels to show. Prism also uses this coordinate system
(row numbers) when positioning additional ticks and grid lines. If you ask
for a grid line at X=5, Prism will draw it to correspond with the point in
the fifth row, whatever its X value.

If you entered elapsed times or dates instead of X values, Prism presents
a different set of choices for Number format. 

Grouped and contingency table graphs

With Grouped graphs (and graphs of contingency tables), you can have a
choice of labeling the X axis with row titles, column titles, or row number.
You may or may not see all three choices, depending on how you
configured your graph.
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Other types of graphs

Survival graphs always use survival time as the X values. Column graphs
always label the X axis with column titles. Parts-of-whole graphs don't
have axes.

Appearance of axis numbers or labels

To change the font, size, and color of the numbering for one axis:

Go to the Titles and Fonts tab of the Format Axes dialog. Click the Font button in
the Numbering or labeling section. Or select an axis by clicking on it, and use the
Font settings in the toolbar.

To change the default font used for new graphs:

Set on the New Graphs tab of the Preferences dialog .

To move the numbers above/below the X-axis or to the right/left of the Y-
axis:

Select the position of the axis numbering in the Axis Titles section on the Titles and
Fonts tab of the Format Axes dialog. Or select the axis numbering by clicking once;
then drag the numbering with the mouse or nudge it by clicking the arrow keys:

To put a prefix in front of all axis numbers, or a suffix after:

Enter the prefix (i. e. “$”) or suffix (i. e. “%”) in the Format Axes dialog.

To rotate the numbering 90 degrees:

Set the number orientation In the All Ticks section in the Format Axes dialog.

To label axes with row titles instead of X values:

If you entered both X values and row titles on an XY data table, you can choose to
label the axes with Row Titles instead of Decimal numbers via the Format setting in
the Regularly spaced ticks section of the Format Axis dialog. If you do this, Prism
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will ignore the X values entirely, and use the row number (top row is 1) as the X
values when plotting values.

13.4.1.3 Major and minor ticks

Prism lets you show both major and minor ticks on an axis. By default,
Prism automatically sets the minimum and maximum range for an axis as
well as the major tick interval.

To change the major or tick interval:

Double click on an axis to open the Format Axes dialog. Uncheck the Auto
box in the Range section and set the major tick interval in the Regularly
Spaced Ticks section.

To show minor ticks:

Double-click on an axis to open the Format Axes dialog. Select an interval
for minor ticks in the Regularly Spaced Ticks section. Choose the interval
for minor ticks between major ticks and whether you want regular or log
spacing . Select the number of intervals you want between major ticks,
not the number of ticks. (For example, choosing four intervals creates
three minor ticks.)

To hide ticks:

Double-click on an axis to open the Format Axes dialog. In the All Ticks
section, choose None for Direction in the All Ticks section.

To change the direction and length of ticks:

Double-click on an axis to open the Format Axes dialog. Set the direction
and length of ticks in the All Ticks section.

To place additional custom ticks or grid lines on a graph:

See: Additional ticks and grid lines .
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13.4.1.4 Hide an axis and show scale bars

Hiding the X or Y axis. Or both. 

Prism lets you hide either the X- or the Y-axis and show scale bars
instead.

To hide and axis and show a scale bar instead:

 

Double-click on an axis to open the Frame and Origin tab of the Format
Axes dialog. Or click on the Format Axis tool in the Prism toolbar.

Choose to hide one or both axes in the Frame & Origin section. You can
also choose to Show Scale Bars.
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Scale bars

To show or hide the scale bar:

If you choose to hide either axis, a new option will appear in the Frames and axes
section of the Format Axes dialog: Show Scale Bar. Check this option to see scale
bars; uncheck to hide scale bars.The length of the scale bar equals one axis
interval, set in the Regularly Spaced Ticks section of the Format Axes dialog.

To delete a scale bar:

Click on a scale bar to select it, and then press DEL to delete it.

To change the color or thickness of a scale bar:

Double-click the scale bar to bring up the Format Object dialog. Choose color and
thickness in this dialog.

To remove the caps on the end of the scale bar:

By default the scale bars are capped. These are actually "arrowhead" styles. To
change, double-click the scale bar to bring up the Format Object dialog. Then
change the arrowhead settings.

To move a scale bar:



GraphPad Prism7 User Guide434

© 1995-2016 GraphPad Software, Inc.

Drag with the mouse. Or click to select, and then nudge by clicking the arrow keys.

To label a scale bar:

Scale bars don't include any numbering. To create a label for a scale bar, click the
text tool ("T" button), click near the scale bar, and type.

To change the length of the scale bar:

You can’t change the length of a scale bar by stretching it. Instead, bring up the
Format Axes dialog and change the tick interval in the Regularly Spaced Ticks
section.

13.4.1.5 Discontinuous axes

Creating a gap in an axis

When plotting scientific data, you will often want to create a
discontinuous axis - and axis with one or two gaps. Double-click on the
axis to open the Format Axes dialog. In the Gaps and Directions section,
you can choose either a two-segment (one gap) or three-segment (two
gaps) axis.

Set the range of each segment and its length as a percent of the total
length of the axis. 
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Finally,  choose the spacing and properties of minor and major ticks
separately for each axis segment.

Limitations:

· You cannot make one segment have a logarithmic or probability scale
without making all the segments have such a scale. 

· You cannot make one segment go in reverse while the other segment(s)
go in the usual direction. 

· You can only create discontinuities in the X axis of XY and Survival
graphs, not Column and Grouped graphs. 

Adjusting the position of the gap on the graph

To move the gap along the axis, or make the graph wider or narrower,
click on ab axis segment to select it and then:

· Drag the knob just to the left of (or below) the gap to change the
position of the gap along the axis (make one segment larger, and
another smaller). 

· Drag the knob to the right of (or above) the gap to widen or narrow the
gap itself

Example 1

455
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· Left segment range: 0 to 15

· Left segment length: 67% of the total

· Right segment range: 15 to 50

· Right segment length: 33% of the total.

Because of the change in scale, the linear regression line appears to have
two slopes. In fact the mathematical slope is identical everywhere, and
the line was created by a single analysis of all the data. The slope just
appears steeper in the right half of the graph because the time scale is
more compressed.

Example 2

· Left segment range:  -9.5 to -8.5

· Left segment length: 12% of the total

· Right segment range: -8.5 to -2.5

· Right segment length: 88% of the total

To place "0" on the left segment, create an additional tick label at X=-9
and enter the text "0". 



Graphs 437

© 1995-2016 GraphPad Software, Inc.

Example 3

· Left segment range:  0 to 24

· Left segment length: 50% of the total

· Right segment range: 48 to 72

· Right segment length: 50% of the total

The line was drawn by linear regression, which automatically skips over
the axis gap.

 

13.4.1.6 Additional ticks and grids

Prism let's you add up to 30 additional ticks or grid lines at defined
positions along the axis. A discontinuous axis has two or three segments,
and the limit of 30 additional ticks or grid lines applies to each segment
separately. 

To create additional ticks or grid lines:

Double-click on an axis to open the Format Axes dialog. In the Additional
Ticks and Grid Lines section, set the coordinate on the axis where the tick
or line should appear. Check the box to show either a tick or a grid line. If
the coordinate is at a location where there already is a regular number or
label, the label you enter in the Additional ticks section is shown and the
regular label will be hidden. 
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To format an additional tick:

 Click on the Details button of the Additional Ticks and Grid Lines
section of the Format Axes dialog. This appears as a gear on Prism
Window, and as "..." on Prism Windows. This lets you format how the tick
or grid line will look and add text to the label.
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Choose whether you want each tick in line with or across from the regular
ticks.

You also can Hook  the text of the label to an analysis or Info Sheet
constant .

To add a fill between additional ticks or grid lines

Check the option to fill between two ticks, and choose the fill color and
pattern.

267
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To create adjoining fills

Prism can only fill the space between an Additional Grid line and one of its
neighbors. To create fills on both sides of a grid line, place two additional
grid lines at the same position and fill backward from one and forward
from the other.

To remove or change an additional tick:

Double-click on the axis to bring up the Format Axes dialog. Locate the
tick you want to change in the Additional Ticks and Grid Lines section.

Click the Details button to open the Format Additional Ticks and
Grid lines section and click on the Delete Tick button.
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To create an additional tick or grid line by hooking an info or analysis
constant:

The coordinate, or text, of an additional tick can be hooked to an analysis
constant  or info constant . Click on the Details button in the
Additional Ticks and Grid lines section and then on the Hook icon in the
Format Additional Ticks and Grids section and select the constant you
wish to link to.

267 147
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In this example, the dashed line for Kd and BMax were hooked to the Kd
and BMax values in fit by nonlinear regression. If the raw data are
subsequently changed, both the results information and this grid lines will
update.

13.4.1.7 Axis titles

By default, Prism puts generic titles on top of the graph and on the X-
and Y-axes.

To edit a title:

Click in the title to select it. If you are editing a Y-axis title, it will be
temporarily displayed horizontally for editing. Edit (or replace) the text.
To enter more than one line, press Enter between lines. When you are
done, click in the background of the graph. While editing the title, you can
use controls in the text toolbar.

To delete a title:

Drag over the title to select it. If you are editing a Y-axis vertical title, it
will be temporarily displayed horizontally for editing. Then press the DEL
key.

To bring back a deleted title:

Double-click an axis to open the Format Axes dialog. Check "Show title" in
the Titles and Fonts tab of Format Axes dialog.

To change the font of a title:

Select the title, or a portion of it, and use Font tools on the toolbar. Or
double-click on the axis to open the Format Axes dialog, go to the
Titles&Fonts tab,  and click the Font button.

To make a title a bit smaller or bigger.

Select the title, Then press the  or  buttons on the toolbar to change
the point size.

To justify a title:
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Usually a title is centered over the graph or axis. To justify the title with
the right or left edge of the axis, select the title and click on the text
justify button on the Text toolbar.

To move a title:

Move the mouse near the title until the cursor turns into a two-headed

arrow . Then hold down the primary mouse button and drag the title
into position. Alternatively, go to the Titles and Fonts tab of the the
Format Axes dialog, where you can position the title by entering the
desired distance between the axis and the title. 

A graph title is always centered over the graph, and an axis title is always
centered on the axis. If you want noncentered titles, delete the title and
then create a separate text object which can be positioned anywhere.

To hide a title, or rotate a title:

Double-click an axis to open the Format Axes dialog. Uncheck options to
hide any of the titles.  For both Y axes you have the choice to make the
title vertical or horizontal.
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To change the default font and size used for new graphs:

Pull down the Edit menu (the Prism menu in Mac OS X), and choose
Preferences, then go to the New Graphs tab.

Why you want to put titles on axes!

 

From XKCD. 

https://xkcd.com/833/
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13.4.2 Labeling axes with dates and times

 .

13.4.2.1 Elapsed time

New to Prism 7 is the ability to enter elapsed times instead of X values .
This page explains how to make graphs when you entered data this way. 
Another page  explains how prior versions of Prism dealt with dates and
times. 

The Format Axis dialog offers two new choices when you entered elapsed
times instead of X values. '

Elapsed time scale

At the top of the dialog, choose to use a Elapsed Time scale. 

If you choose an Elapsed time scale, you can choose to display just hours,
hours:minutes, hours:minutes:seconds or
hours:minutes:seconds.milliseconds. To avoid overlap, you'll probably
want the dates to be displayed vertically or at an angle (not horizontal).

191
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Linear scale for X values entered as elapsed time

If you choose a linear (numerical) scale, Prism tells you what the units
will be. These units are set on the data table.  

To change those units, go back to the data table, drop the Change menu,
choose Format Data Table , then uncheck "Choose automatically" and
select the units you want to use.
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What values are used when you fit a curve or line to the data?

When you analyze an XY table with X values entered as elapsed times,
Prism converts the elapsed times to numbers. To change the units
(seconds, minutes,...), go back to the data table, drop the change menu,
and choose Format Data Table.

Note that the choice of months is not offered, because months have
different lengths. Years also have different lengths, so if you choose
years, Prism does the conversion based on 365.25 days per year. 

13.4.2.2 Dates (New Prism 7 method)

New to Prism 7 is the ability to enter dates instead of X values . This
page explains how to make graphs when you entered data this way. 
Another page  explains how prior versions of Prism dealt with dates. 

The Format Axis dialog offers two new choices when you entered dates
instead of X values. 

191
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Date scale

At the top of the dialog, choose to use a Date scale. 

If you choose a Dates scale, you can choose many ways to display the
dates. To avoid overlap, you'll probably want the dates to be displayed
vertically or at an angle (not horizontal).

When you choose a Dates axis scale, Prism is smart about how far to
space the dates. Jan 3 is much closer to Jan 1 than is Feb 3...

Linear scale for X values entered as dates

If you choose a linear (numerical) scale for X values entered as dates,
Prism tells you what the units will be.
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 To change those units, go back to the data table, drop the Change menu
and choose Format Data Table. 

What values are used when you fit a curve or line to the data?

When you analyze XY data where X values are entered as dates, Prism
converts the dates to numbers using a starting date and a date unit
(days, weeks, etc.). To change this, go back to the data table, drop the
change menu, and choose Format Data Table.

13.4.2.3 Dates (Method used with prior versions)

Prism does not understand the concept of dates or times, so you cannot
enter times or dates as X values. But you can get Prism to plot dates or
times as row titles. 
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Note that Prism does not try to interpret the meaning of row titles. To
Prism, you just entered labels. The data will always appear equally
spaced on the graph, even if the dates are not equally spaced
chronologically. Most of the time, your dates will be equally spaced so this
approach works well. But sometimes, your dates are not equally spaced
on the calendar and the graph is misleading:

You'll need to use a different approach to plot a series of dates that are
not equally spaced. Enter the data onto an XY table. Enter the dates as
row titles. Into the X column, enter the number of days since some
starting point. 

To make this graph, you'll need to make some changes on the Format
Axis dialog. Leave the Number Format set to Decimal. Don't choose Row
Titles, or you'll end up with an equally spaced graph. Use the Additional
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Ticks section to specify each label and its location (X coordinate). Check
the option to plot only these additional ticks (instead of regular ticks). 

13.4.3 Logarithmic axes

If your data span a wide range of values, it can be easier to visualize the results
when you make one of the axes logarithmic. Distinguish between transforming
your data to logarithms (which creates a new results table) from choosing a
logarithmic axis (which only stretches the axis, without altering your data).

  

What is a logarithmic axis?

How to: Create a log axis

Logarithmic axes cannot contain zero or negative numbers

Regression fits the data, not the graph
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When to use a logarithmic axis

Advice: Bar graphs with log axes rarely make sense

Graphing logarithms - different than using a log axis

A review of logarithms

 

 

 

 

 

 

13.4.3.1 What is a logarithmic axis?

A logarithmic axis changes the scale of an axis

The two graphs below show the same two data sets, plotted on different
axes.
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The graph on the left has a linear (ordinary) axis. The difference between
every pair of ticks is consistent (2000 in this example).

The graph on the right has a logarithmic axis. The difference between
every pair of ticks is not consistent. From the bottom tick (0.1) to the
next tick is a difference of 0.9. From the top tick (100,000) down to the
next highest tick (10,000) is a difference of 90,000). What is consistent is
the ratio. Each axis tick represents a value ten fold higher than the
previous tick.

The red dots plot a data set with equally spaced values. Each dot
represents a value with a Y value 500 higher than the dot below. The dots
are equally spaced on the graph on the left, but far from equally spaced
on the graph on the right. To prevent overlap, the points are jittered to
the right and left so they don't overlap. The horizontal position of the red
dots has no other meaning.

The blue dots represent a data set where each value represents a Y value
1.5 times higher than the one below. On the graph on the left, the lower
values are almost superimposed, making it very hard to see the
distribution of values (even with horizontal jittering). On the graph on the
right with a logarithmic axis, the points appear equally spaced.

Why “logarithmic”?

In the example above, the ticks at 1, 10, 100, 1000 are equally spaced on
the graph. The logarithms of 1, 10, 100 and 1000 are 0, 1, 2, 3, which are
equally spaced values. Since values that are equally spaced on the graph
have logarithms that are equally spaced numerically, this kind of axis is
called a “logarithmic axis”.

Interpolating between log ticks

What value is halfway between the tick for 10 and the one for 100 on a
logarithmic axis? Your first guess might be the average of those two
values, 55. But that is wrong. Values are not equally spaced on a
logarithmic axis. The logarithm of 10 is 1.0, and the logarithm of 100 is
2.0, so the logarithm of the midpoint is 1.5. What value has a logarithm
of 1.5? The answer is 101.5, which is 31.62. So the value half way
between 10 and 100 on a logarithmic axis is 31.62. Similarly, the value
halfway between 100 and 1000 on a logarithmic axis is 316.2.

Lingo
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The term semilog is used to refer to a graph where one axis is logarithmic
and the other isn’t. When both axes are logarithmic, the graph is called a 
log-log plot.

Advantages of a logarithmic axis

One advantage, as shown above, is that a lognormal distribution is easier
to see on a logarithmic axis. Another reason to prefer a logarithmic axis is
when the values span a large (many orders of magnitude) range of values
and otherwise wouldn't really fit on a linear graph. At least not without a
lot of creativity (from xkcd)!

13.4.3.2 How to: Create a log axis

 This page shows how to stretch the axis to a logarithmic scale (which
doesn't alter your data). Distinguish this from transforming your data to
logarithms, which you can plot .

To create a log axis:

Double-click on the axis to open the Format Axes dialog. In the Scale
section, set the axis to Log10 or Log 2.

463
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This graph shows log spaced minor ticks. The minor ticks between the
major ticks at 10 and 100 show the position of 20, 30, 40, 50, 60, 70, 80
and 90. Since the minor ticks are not equally spaced on the graph, we
call these log spaced minor ticks. Note that there are eight ticks, so nine
intervals (many people mistakenly think there ought to be ten).

To set the numbering for a log axis:

Double-click on the axis to open the Format Axes dialog and set the
number format in the Numbering or Labeling section. Prism offers three
numbering format choices for log axes.

Antilog: 10, 100, 1000, 10000, etc.

Scientific: 1x101, 1x102, 1x103, 1x104,etc.

Power of 10: 101, 102, 103, 104,etc.

Log: 1, 2, 3, 4, etc.

To set the minor tick intervals for a log axis:

Double-click on the axis to open the Format Axes dialog and set the
number format in the Numbering or Labeling section. Choose Equal or
Log spacing, and the number of intervals you want between major ticks,
not the number of ticks.
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13.4.3.3 Logarithmic axes cannot contain zero or negative numbers

The logarithms of negative numbers and zero are simply not defined

Let’s start with the fundamental definition of a logarithm. If 10L = Z, then
L is the logarithm (base 10) of Z. If L is a negative value, then Z is a
positive fraction less than 1.0. If L is zero, then Z equals 1.0. If L is
greater than 0, then Z is greater than 1.0. Note that there no value of L
will result in a value of Z that is zero or negative. Logarithms are simply
not defined for zero or negative numbers.

Bottom line: A logarithmic axis can only plot positive values. There simply
is no way to put negative values or zero on a logarithmic axis.
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A trick to plot zero on a logarithmic axis in Prism

If you really want to include zero on a logarithmic axis, you’ll need to be
clever. Don’t enter 0, instead enter as a small number. For example, if
the smallest value in your data is 0.01, enter the zero value as 0.001.
Then use the Format Axis dialog to create a discontinuous axis, and use
the Additional ticks feature of Prism to label that spot on the axis as 0.0.

13.4.3.4 Regression fits the data, not the graph

Choosing a log scale changes the way the graph looks, but does not
change the data values. Linear or nonlinear regression fit an equation to
your data. Your choice of axis scaling does not affect any calculations.

The three graphs shown below represent the same data by linear
regression.

The graph below has linear X and Y axes, so the linear regression line
appears straight.

The graph below has a logarithmic X axis. The curve you see is the
results of linear regression. It is the best fit to the equation Y=intercept
+ slope*X. The X values used by the linear regression are the X values
you entered. Graphing this linear regression line on a log axis results in
a curve.
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The graph below has a logarithmic Y axis. Again, the best-fit linear
regression line appears curved when plotted on a logarithmic axis.

13.4.3.5 When to use a logarithmic axis

A logarithmic X axis is useful when the X values are logarithmically
spaced

The X axis usually plots the independent variable – the variable you
control. If you chose X values that are constant ratios, rather than
constant differences, the graph will be easier to view on a logarithmic
axis.

The two graphs below show the same data. X is dose, and Y is response.
The doses were chosen so each dose is twice the previous dose. When
plotted with a linear axis (left) many of the values are superimposed and
it is hard to see what’s going on. With a logarithmic axis (right), the
values are equally spaced horizontally, making the graph easier to
understand.
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A logarithmic axis is useful for plotting ratios

Ratios are intrinsically asymmetrical. A ratio of 1.0 means no change. All
decreases are expressed as ratios between 0.0 and 1.0, while all
increases are expressed as ratios greater than 1.0 (with no upper limit).

On a log scale, in contrast, ratios are symmetrical. A ratio of 1.0 (no
change) is halfway between a ratio of 0.5 (half the risk) and a ratio of 2.0
(twice the risk). Thus, plotting ratios on a log scale (as shown below)
makes them easier to interpret. The graph below plots odds ratios from
three case control retrospective studies, but any ratio can benefit from
being plotted on a log axis.
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The graph above was created with the outcome (the odds ratio) plotted
horizontally. Since these values are something that was determined (not
something set by the experimenter), the horizontal axis is the Y axis even
though it is horizontal.

A logarithmic axis linearizes compound interest and exponential growth

The graphs below plot exponential growth, which is equivalent to
compound interest. At time = 0.0, the Y value equals 100. For each
increment of 1.0 on the X axis, the value plotted on the Y axis equals 1.1
times the prior value. This is the pattern of cell growth (with plenty of
space and nutrients), and is also the pattern by which an investment (or
debt) grows over time with a constant interest rate.

The graph on the right is identical to the one on the left, except that the Y
axis has a logarithmic scale. On this scale, exponential growth appears as
a straight line. Exponential growth has a constant doubling time. For this
example, the Y value (cell count, value of investment) doubles for every
time increment of 7.2657.

Exponential decay is also linearized on a logarithmic axis, but only when
the decay eventually decays to zero.

13.4.3.6 Advice: Bar graphs with log axes rarely make sense

Prism can create bar graphs with a logarithmic Y axis, but think twice
before deciding to make this kind of graph. The point of a bar graph is to
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let people compare heights or areas of the bars. In most cases, you
should try to avoid using a log axis when creating a bar graph.

The treated bar in the graph below (with a linear axis) is four times as
tall (and has four times the area) as the control bar. This tells you that
the treatment increased the response fourfold. This is very
straightforward since the Y axis is linear.

Beware of bar graphs with a logarithmic axis. Since zero can’t be shown
on a log axis, you need to decide where to begin the axis. A log scale
has no logical starting place, so the choice is arbitrary. The graphs below
show the same data as the graph above, but with the Y axis beginning at
0.001, 10 or 100.
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The relative height of the bars appears to be almost the same in the
graph on the right and very different on the graph on the left. The
relative heights (or areas) of the bars on a log scale is not informative. 

If the goal is to create propaganda, a bar graph using a logarithmic axis
is a great tool, as it lets you either exaggerate differences between
groups or minimize them. All you have to do is carefully choose the
range of your axis to give the impression you want to project.  If your
goal is to honestly show the data, don’t create bar graphs using a
logarithmic axis 

The only case that I know of where it makes sense to plot bars on a
logarithmic axis is when the Y axis is plotting the fold change in
something. Then the baseline of 1.0 is logical (no change), as is a
logarithmic scale.

13.4.3.7 Graphing logarithms - different than using a log axis

Transforming data to logs

If you need log data for your analysis, you can either enter logs directly
or transform your data. For example, you should fit a sigmoidal dose-
response equation to data expressed with X as logarithm of dose. If you
enter concentrations, you'll need to convert them to logarithms before
using nonlinear regression.

To transform your data to logs:

Click the Analyze button, choose built-in analyses, and then select
Transforms from the list of data manipulations. Choose X = log(X).

Also check the box at the bottom of the dialog to Create a New Graph of
the results. Prism will create a results table of the transformed data, and
a new graph. To perform nonlinear regression on the transformed data,
click Analyze from either the results table or the new graph.

Plot data already entered as logarithms



GraphPad Prism7 User Guide464

© 1995-2016 GraphPad Software, Inc.

If you enter data as logarithms, or graph the results of a log transform,
you should graph the data with a linear axis. Don't choose a log scale!
Your data are already logarithms. If your data represent logarithms, you
can format the axis numbering to make this clear.

The figure below compares the appearance of decimal (the default),
powers of ten, and antilog formatting.
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In the graph below, the X values represent the logarithm of
concentration. The logs were entered directly into the X column of the
data table. The graph of these data has a linear (not log) X axis. The
axis was formatted with a numbering format of powers of 10, and with
nine minor tick intervals with log spacing (see dialog settings below the
graph).

In the graph below, An alternative way to indicate that the data are
logarithms is to choose the antilog numbering format (this choice is only
available when the interval is 1, the minimum is –9 or greater, and the
maximum is 9 or less).
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13.4.3.8 A review of logarithms

Common (base ten) logarithms

The best way to understand logarithms is through an example. If you take
10 to the third power (10 x 10 x 10) the result is 1000. The logarithm is
the inverse of that power function. The logarithm (base 10) of 1000 is the
power of 10 that gives the answer 1000. So the logarithm of 1000 is 3. If
you multiply 10 by itself 3 times, you get 1000.

You can take 10 to a negative power. For example, taking 10 to the -3
power is the same as taking the reciprocal of 103. So 10-3 equals 1/103, or
0.001. The logarithm of 0.001 is the power of 10 that equals 0.001, which
is -3.

You can take 10 to a fractional power. Ten to the 1/2 power equals the
square root of 10, which is 3.163. So the logarithm of 3.163 is 0.5.

Ten to the zero power equals 1, so the logarithm of 1.0 is 0.0.

You can take the logarithm of any positive number. The logarithm of
values between zero and one are negative; the logarithms of values
greater than one are positive. The logarithms of zero and all negative
numbers are undefined; there is no power of 10 that gives a negative
number or zero.

Logarithms to other bases

The logarithms shown in the previous section are called base 10
logarithms, because the computations take 10 to some power. These are
also called common logarithms.
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You can compute logarithms for any power. Mathematicians prefer natural
logarithms, using base e (2.7183…).  Despite that name, use of
logarithms with base e does not seem natural to most scientists who tend
to be far more comfortable with base 10 logarithms.

Biologists sometimes use base 2 logarithms, often without realizing it.
The base 2 logarithm is the number of doublings it takes to reach a value.
So the log base 2 of 16 is 4 because if you start with 1 and double it four
times (2, 4, 8, and 16) the result is 16. Immunologists often serially
dilute antibodies by factors of 2, so often graph data on a log2 scale. Cell
biologists use base 2 logarithms to convert cell counts to number of
doublings.

Logarithms using different bases are proportional to each other. So
converting from natural logs to common logs is sort of like changing
units. Divide a natural logarithm by 2.303 to compute the common log of
the same value. Multiply a common log by 2.303 to obtain the
corresponding natural log.

Mathematical properties of logarithms

Logarithms convert multiplication into addition and division into
subtraction, and exponentiation into multiplication:

log(A.B) = log(A) + log(B)

log(A/B) = log(A) - log(B)

log(An) = n.log(A)

Antilogarithms

The antilogarithm (also called an antilog) is the inverse of the logarithm
transform. Since the logarithm (base 10) of 1000 equals 3, the
antilogarithm of 3 is 1000. To compute the antilogarithm of a base 10
logarithm, take ten to that power.

To compute the antilogarithm of a natural logarithm, take e to that
power. The natural logarithm of 1000 is 6.980. So the antilogarithm of
6.908 is e6.908, which is 1000. Spreadsheets and computer languages use
the notation exp(6.908).

Terms that sound similar to logarithm:  logit and logistic
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The term logistic sounds like it is related to logarithms. In fact, the term
logistic has three distinct meanings, which don't all involve logarithms.  

The logit function, used in logistic regression, is the natural logarithm of a
probability (P, with a value between 0.0 and 1.0) divided by 1-P:   

Logit(P) = ln[P/(1-P)]

The lognormal distribution is a distribution of values whose logarithms
follow a Gaussian distribution. The lognormal distribution itself is
asymmetrical with a heavy tail to the right. It is easy to be mislead by the
asymmetry, and  mistakenly eliminate values in the tail of the distribution
as outliers. 

The notation “log(x)” can be ambiguous

Within Prism transforms and equations, the log() function computes the
common (base 10) logarithm.

With some computer languages (for example, Javascript) log(x) denotes
a natural logarithm, not a common logarithm. Excel is especially
confusing. In an Excel worksheet function, log(X) is the common
logarithm, but in an Excel VBA macro, log(X) is the natural log.

The notation “ln(X)” is the natural logarithm in Prism.

Don't mix up logarithms with scientific notation

Consider the value 0.000000001. It can be written as 10-9. Since computer
programs can't deal with subscripts, this is entered into most computer programs
(including GraphPad Prism and Excel) as 1e-9. The 'e' here means "times ten to the
power of". Don't mix up that scientific notation with a logarithm. The logarithm of 

0.000000001 is -9.

13.4.4 Frame and origin

The frame determines the basic look of a graph, and its position on the page.

http://www.graphpad.com/faq/viewfaq.cfm?faq=1465
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Positioning a graph on the page

Customizing a graph's frame and axes appearance

Showing grid lines

Setting the graph origin

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

13.4.4.1 Positioning a graph on the page

If you plan to copy and paste the graph to another program, or place the
graph on a Prism layout, you won't really care where it is on the page.
But if you plan to print that page, you might care to position a graph
precisely. 

To see the position of a graph on the page:  Drop the View menu,
choose Zoom, and choose To Fit Page. This lets you see the entire page
at once, so you can see the position of the graph relative to the entire
page. 
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To center the graph on the page: Click on the Center on page button
in the Arrange section of the Prism toolbar.

To drag a graph on the page: Grab either axis and drag the graph.

To  specify an exact position on the page: Click on the Format Axis
tool in the Prism toolbar and enter the exact distance of the graph from
the top and left edge of the page in the Frame and Origin tab of the
Format Axes dialog.
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13.4.4.2 Customizing a graph's frame and axes appearance

Double-click on the graph origin to open the Frame and Origin tab of the Format Axes
dialog.
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Use this dialog to set the origin of your graph and to format the color
and shape of the axes or surrounding frame.

To change the gap of an offset axis, click and drag the end of the axis.

To draw a box around a graph , including titles and numbering, use the
drawing tool. Or wait until you assign a graph to a layout, and choose
the border on the second tab of that dialog . 
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13.4.4.3 Showing grid lines

Regular  grid lines

Double-click on the graph origin to open the Frame and Origin tab of the
Format Axes dialog. Or click on the Format Axis tool in the Prism toolbar.
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Note that grid lines from the Y axis always come from the left Y axis.
Even if you turned off that axis, its major tick interval controls the grid
lines. It is not possible to create automatic grid lines from the right Y
axis. But you can  place additional ticks or lines  one at a time to give
the same effect.

Special grid lines

Double-click an axis and use the Format Axis tab to place additional ticks
or lines  (formerly called Custom Ticks) on your graph. You can create
as many grid lines anywhere on an axis.

Using a grid to align objects

Right-click anywhere on the Prism toolbar and choose Show Grids, or
drop the View menu and choose Show Grids. This grids will not show in
printouts or exported images.

437

437



Graphs 475

© 1995-2016 GraphPad Software, Inc.

13.4.4.4 Setting the graph origin

The position where the X and Y axes intersect is called the "origin." To
change the position of a graph's origin, double-click on the origin of a
graph to open the Frame and Origin tab of the Format Axes dialog). Or
click on the Format Axis tool in the Prism toolbar.
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13.4.4.5 Graphs: Frame and axes

The choices on the Format Axis dialog are self-explanatory. Don't
overlook the Additional Ticks and Grid lines section  which lets you
place any numbers or labels anywhere on any axis. And don't overlook
the Frame and Origin  tab.

Here is a list of shortcuts to change the axis directly, without using the
Format Axes dialog:

· To change the shape and size of a graph by stretching: Click once on
an axis to select it. Then drag on either end to stretch.

437
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· To make a graph proportionately larger or smaller: Click Resize Graph
button on the Change section of the Prism toolbar.

· To change the thickness or color of one axis: Click once to select that
axis. Then click Change and choose Selected Object(s). If you change
the X axis, the top part of the axis frame will also change accordingly.
If you change the left Y axis, the right part of the axis frame will also
change accordingly (unless you created a right Y axis).

· To move the graph and axis titles closer to, or further from, the
graph: Position the mouse near the title until the cursor becomes a
two-headed arrow. Then drag.

· To move the axis numbering (or labeling) closer to, or further from,
the axis: Move the mouse over the numbering until the cursor
becomes a two-headed arrow. Then drag. Or click once on the
numbering to select. Then nudge one pixel at a time by clicking the
arrow keys.

· Double-click on the origin of a graph to bring up the Frame and Origin
tab of this dialog.

· To format the size, font, color, etc. of the numbering of an axis, click
to select the axis and then use the controls in the Text toolbar.
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14 Page layouts

Page layouts let you combine several graphs on a

single page, along with data or results tables, text,

drawings, and imported images. Graphs can be

from one or several Prism projects.
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14.1 Creating a layout

Click the New button on the toolbar, or drop the Insert menu, and choose
New Layout

1.  Choose whether you want portrait or landscape orientation for the
overall page, and choose its background color. 
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2.  Choose the number of placeholders you want on the page, and their
arrangement.

3.  Decide either to start with a layout page with placeholders only, or
(new to Prism 7) to automatically place graphs onto the layout. In the
latter case, you specify the first graph and Prism places the other
graphs automatically working in the order the graphs appear in the
Graphs section of the navigator.

14.2 Assigning a graph to a placeholder

Choose a graph
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Note that you can not only choose a graph from the current project, but a
graph from any project. It is especially easy to choose a graph from
another open project. If you choose to Pick a graph from another project
that is not open, after you choose that project file, Prism will open it. 

Linking within a project

By default, Prism the graph on the layout automatically updates when the
graph itself updates. You can choose to place the graph on the layout as
an unlinked picture with no link to the original data.You might prefer this
option if you are sure the graph is 100% done, and you don’t want to
allow any possibility of it being changed. It can also be useful if you want
to keep "snapshots" of a graph as a project continues and additional data
are collected and graphed. 

Linking between projects

If you choose or paste a graph from another project, you'll have three
choices:

· Merge a copy of the graph, along with its data tables and analyses, into
the project you are working on now. The advantage of this approach is
that everything will be in one project. The disadvantage (which some
consider to be an advantage) is that the data will now exist in two files.
Another advantage is that your file is self-contained. Even if you move it
to a different computer, everything will work. 

· Live link. The data and graph are not in the project with the layout. To
edit a linked graph, go to the original project. Then resave that file and
the changes will appear in the layout. Prism can maintain the link only if
the name and location of the linked file doesn't change. If you change
computers, you'll almost certainly break the link. The advantage of
linking (which some will consider to be a disadvantage) is that the data
and graph only exist in one place. 

· Unlinked picture. As the name suggests, this is just a picture that is not
linked to any data or any editable graph. 

Cropping  

The first tab of the Assign Graph graph dialog lets you crop a graph to get
rid of white space or portions of the graph you don't want to see on the
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layout. If you enter a negative value for any of the cropping values, you'll
make the graph placeholder larger, adding white space in that direction.

The second tab (Size and Location) lets you add a border around the
graph and change its size and position.

14.3 Adding another graph to the layout

When you first create a layout page, Prism asks you to choose an
arrangement of placeholders. But you are not stuck with this
arrangement. You can always go back to the Format Layout dialog by
clicking its toolbar button, or dropping Change and choosing Arrangement
of graphs. 

If you assign the wrong graph to the layout, it is easy to replace. Just
double-click on that graph (in the layout) and choose its replacement. Or
drag the name of the replacement graph from the Navigator and drop on
to the graph you want to replace. 

It is easy to add a new graph to the layout. First resize and move graphs
to make space for a new one. Then do any of the following (the first two
choices are the simplest). 

· Drag a graph from the Navigator  and drop onto a blank spot on the
layout page. Don't drop too close to an existing graph or you might end
up replacing that graph rather than adding a new one. 

· Go to the Graphs section of this project or any other, and copy a graph
to the clipboard. Then go to the layout, and paste.  

· From the layout, drop the Insert menu and choose Prism Graph. Then
choose the graph you want to add to the layout. 

· From the layout, bring up the Format Layout dialog (by clicking its
toolbar button, or dropping Change and choosing Arrangement of
graphs) and choosing to add another graph to the layout. 

100
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14.4 The size of graphs on layouts

What is the scaling factor?

The scaling factor is defined as the ratio of the size of the graph on the
layout compared to its size on the graph. 

If the graph and layout are zoomed  differently, it will be hard to
understand the scaling factor. Set the zoom to be the same for  the graph
and layout (using controls in the lower right of the Prism Window). 

Changing the scaling factor of one graph

The easiest way to change the scaling factor is to select a graph on a
layout page, grab a corner knob and drag. 

If you want to set the scaling factor to a particular value, double click on
the graph (on the layout) to bring up the Place Graph on Layout dialog.
Go to the second (Size and Location) tab, and set the Scaling Factor.

Note that this tab also lets you specify a border to go around the graph.

103
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Equalize the scaling factor of several graphs

1. Select the graphs to equalize (not necessary if you want to equalize all
graphs on the layout).

2. Choose Equalize Scaling Factor from the Arrange menu, or press the

button in the Change section of the toolbar.  

3. Choose to reduce the scaling factor of graphs that are larger than the
others, or to increase the scaling factor of those that are too small. If
graphs were originally made the same size, with same size fonts, this
command will get things the same again on layout. If graphs started off
with different sizes, however, this command won't be very helpful.

Increase or decrease the scaling factor of all graphs

1. Choose Resize Layout from the Change menu, or click the Resize

button. 

2. You'll see a menu with choices: Smaller, Larger, To Fill Page, or More
Choices (which brings up the dialog shown below). 
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14.5 Creating a depth chart

A depth chart is an XY plot rotated so the independent X variable is
shown on the vertical axis, and the dependent Y variable is shown on the
horizontal axis. This makes sense when the X variable is depth. Follow
these steps:

1. Enter data on an XY table. Enter the depth values into the X column.

2. Prism will create an XY graph with X on the horizontal axis. 

3. Use the Format Axis dialog to change the direction of the numbering on
both axes. Set the X axis numbering to: Below, vertical. Set the Y axis
numbering to: Left vertical.

4. Delete the automatic X axis title (because it cannot be rotated).

5. Create an independent text object with the depth title. Select it, and
rotate 180 degrees by clicking the rotate button in the lower right of
the Text area in the toolbar several times.Your graph will now look like
this:
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6. Assign that graph to a layout. 

7. Double click on the graph to bring up the "Place graph on layout"
dialog. Go to the second (Size and Location) tab, and choose to rotate
90 degrees clockwise.
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The result, on the layout, is a depth chart, with the X variable on the
vertical axis and the Y variable (and its error bars) plotted on the
horizontal axis. 
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14.6 Master legends (one legend for several graphs)

If you place several graphs on a layout, you can create a master legend
that applies to all the graphs as shown below.

A master legend is one legend on a layout that is for several graphs. To
create a master legend, create an extra graph (not on the layout) with
the legend you want. Then select and copy that legend and paste to the
layout. Then add other graphs without legends to the layout.

It took four graphs to make the figure above. The first three graphs show
data, and the fourth (not shown) was used only to create the master
legend. Follow these steps:
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1. Duplicate one of the graphs to create another graph that won't be
shown in the layout, but will be used to create a legend. To create a
legend on this graph, double-click on a symbol to bring up the Format
Graph dialog. Click the ‘Global’ button, select ‘Change all data sets’ in
drop-down. You can also select ‘Change ALL data sets’ from ‘Data set’
drop-down.

2. Create a layout and assign the graphs (three in this example).

3. Select and copy the legends from the extra graph and paste onto the
layout (Paste Drawing). That is a simple copy and paste operation and
does not use a placeholder.

Notes:

· The master legend is linked to the graph from which it was copied. If
you change the symbols in that graph, Prism will update the master
legend.

· Master legends on a layout have exactly the same size as the legend on
the graph from which you copied the legends. When you place graphs
on layouts, you can shrink or expand it to fill a placeholder. You can't do
this with master legends. The only way to change the size of the symbol
in the master legend is to change the font size and symbol size on the
graph used to create the master legend. This is done in the graphs
section, not the page layout section.

· You can edit the text of the legend,  change the size of the text in the
master legend, and make it bold or italics. These changes will be lost if
you make any changes to the graph from to which the master legend is
linked. 

· After copying a legend, you can only paste it into a layout. It is not
possible to paste a legend onto another graph.
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14.7 Duplicating a layout

If you have a page layout whose arrangement you like, duplicate it (just
the sheet). Then double-click on each graph to bring up a dialog where
you can choose a different graph for that slot.

Prism offers a direct way to clone a graph from the Welcome dialog, but
does not allow cloning of layouts. However, you can accomplish the same
goal by going to a layout, dropping the New button, and choosing to
Duplicate Family. This will duplicate not only the layout, but all graphs on
the layout and all results and data sheets linked to those graphs. Edit all
the data tables, and you are done. The analyses and graphs will
automatically update.
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15 Adding text, drawings, results and pictures to graphs or
layouts

This section explains how to add text, drawings and

pictures to a graph or layout.
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15.1 Adding text

Adding text to a Prism graph or layout

To enter new text anywhere on a graph or layout:

Click one of the text 'T' tool buttons (the one on the right makes a text
box with a border).

Click on the graph or layout at the spot where you want to enter text and
type. If you want to enter several lines, press Enter between lines. When
you are finished, click to select another tool or somewhere else on the
page.

To enter a paragraph with automatic word wrapping:

Enter the first line or two using one of the text tool buttons and then click
anywhere else on the page to create the text object. Go back and click on
your text. You'll see knobs on the corners. Drag the knobs to make the
text object the correct width. Don't worry about the height, as it will grow
automatically as you enter text. Now, double-click inside the text object
to bring back the insertion point and type your text. Don't push Enter at
the end of each line, as Prism will automatically wrap the text as you
type.

To add Greek letters, European characters, math symbols or Wingdings:

First be sure you have a text insertion point. Then press the Greek button
and choose a character from the menus provided.

To add a constant from an Info table:

You can add a constant from an Info sheet  in a text box. Use the Insert
Info Constant button on the Write section of the Prism toolbar. Once
you've added an Info constant to your graph or layout, double click to
open the text box and add a label. If you edit the Info constant, the linked
text-box on your graph will be updated.
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To enter en or em dashses:

An en-dash is wider than a hyphen or minus sign. An em-dash is even
wider. Learn how to enter these in Prism. 

Changing text

To change font and size of text:

Standard toolbar buttons let you make text bold, italicized, underlined,
subscripted, or superscripted, and let you change font, color, and size.

Select a block of text or an entire text object and use the right-click
menu. Or pull down the Change menu and choose Selected Text to bring
up the font dialog.

GraphPad does not provide any fonts with Prism, but lets you choose any
TrueType font already installed in your system. If you want a font that is
not in the list, you'll need to find or buy the TrueType font and then install
it into Windows or Mac OS X. 

To rotate text:

You can rotate text objects to any angle you want. Click on one of the
text-rotation buttons in the Text section of the Prism toolbar. The buttons
will rotate your text in 15 degree increments.

Or double-click on the object boundary to bring up the Format Text
dialog. Then set a standard rotation (horizontal, vertical up, vertical
down) or choose angled and enter the rotation angle in degrees.

To change the alignment of a text block:

http://www.graphpad.com/support/faqid/1328/
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Click on the Justify button on the Font toolbar. From the drop-down
menu, you can choose, right-justified, left-justified, or centered.
Whichever you choose will be the default the next time you enter text.

To add or change a border or background:

Right click on a text block, and you'll see choices to change the border
thickness and color, and the background. Or double-click on the border of
the text object to bring up the Format Text dialog. Then click the Border
and Fill button to bring up a dialog where you can change border and
background.

To move text:

Move a text object by dragging. You can also stretch the object to change
its shape. This will change how text wraps, but will not change the point
size of the lettering.

You can only move axis and graph titles closer to, or further from, the
graph. They always remain centered. To move a title closer to or further
from the graph, point the mouse near the title until the cursor changes to
a two-headed arrow. Then drag the title.

You can also move axis numbering (or labeling for bar or category
graphs) closer to, or further from, the axis. Click on the numbering to
select. Then use the arrow keys to nudge its position. Or set the distance
between numbers and axis within the Format Axis  dialog.

To prevent text from snapping into alignment:

When you drag a text object around the page, it will automatically snap
into alignment with other text objects, with the center of bars (etc.) on
graphs, or with the center of a graph. You can keep dragging, so are not
trapped by the snapping. If the snapping gets in the way of moving the
text object where you want it, hold down the ALT key while dragging and
there will be no snapping.

428
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15.2 Using Word to add text (Windows only)

You can use Microsoft Word® to add text to a Prism graph or layout.
Word gives you more formatting options than are possible with Prism text
tools. You can create bulleted lists, add tables -- anything you can do
with Word. It's a bit more cumbersome, however, because you must open
Word in a separate window to edit your text, rather than editing it directly
on your Prism sheet. This is most often helpful when you have large text
boxes that require a lot of formatting.

To add text to a graph or layout using Word, click the Word button in the
Write section of the Prism toolbar. This will open Word so you can create
your text box. To finish, click on Update in Word File menu, or simply
close Word.

To edit a Word text box in Prism, double click on the text in Prism. This
will open Word. To finish, click on Update in Word File menu, or simply
close Word. 

 

 

 

 

 

 

15.3 Drawing lines, arrows, and shapes

Drawing lines, arrows, and other shapes on a graph
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1. Click on the drawing tool in the Drawing toolbar. If you want to draw
several objects, hold Shift while selecting the drawing tool. Then you'll
be able to use it repeatedly without selecting it again. Click any other
Toolbar button to unselect the drawing tool. The tool you used most
recently will show as the default drawing button on the main Prism
toolbar.

2. Position the mouse pointer (now a pencil) at one end of the line or
arrow (or one corner of the box or oval). 

3. Hold down the primary mouse button and drag to the other end (or to
the diagonally opposite corner). Hold the control key if you want to
draw a perfect circle or square.

Changing the appearance of a drawing object (line, arrow, square, etc.)

Select any object and double-click on it to bring up the Format Object
dialog. Choose the thickness, color, and style of lines or borders; the fill
color and shading of shapes; and arrowhead direction, size, and style.

For a line, for example, you can choose to have no arrowheads, or
arrowheads on one or both ends. You can also choose to caps on the ends
of a line instead or arrows.
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You also can right-click on any drawing object to change individual
properties like color and line thickness.

Changing the default line color or thickness

Draw a line, then double click to bring up the dialog above. Change the
thickness, color and style to what you want the default to be for future
lines and arrows. Check the option "Set as default" and OK from the
dialog. Now those settings will be used when you draw new lines or
arrows.

15.4 Including pictures and other objects

Pasting or importing images

You can paste or import picture onto a Prism graph or layout. 

OLE

Windows only: When you paste an object created by a program that is an
OLE server, Prism will embed the object. This means that Prism contains
a separate copy of the object, so you can double click to edit in the
original program. This is great, for example, with equations.  In some
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cases, you may prefer to paste link to the original file. To do that, copy
the object and then choose Paste Special from the Edit menu. Then
choose Paste Link. To learn more about the pros and cons of linking and
embedding, see Object linking and embedding . You can also use the
Insert Object command to create a new OLE object. 

Formats Prism can paste or import

 Prism Windows can import:

Windows Enhanced Metafile (*.emf)
Windows Metafile (*.wmf)
TIFF (*.tif;*.tiff)
JPEG (*.jpg;*.jp2;*.j2k;*.jpx)
Portable Network Graphics (*.png;*.mng)
Windows Bitmap (*.bmp)
Graphics Interchange Format (*.gif)
Scalable Vector Graphics Format (*.svg)
PC PaintBrush (*.pcx)
TruvisionTarga Format (*.tga)
Microsoft Paint Format (*.msp)
PhotoShop 3.0 Format (*.psd)
Windows Icon and Cursor Formats (*.ico)

Prism Mac can import:

TIFF (*.tif;*.tiff)
Windows Bitmap (*.bmp)
JPEG (*.jpg;*.jp2;*.j2k;*.jpx)
Macintosh Pict (*.pct;*.pict)
Portable Network Graphics (*.png)

If your image uses a 16 bit color model (millions of colors), Prism
(Windows and Mac) stores the image as such and does not simplify it. 

Editing the picture in Prism

To add a border: Click once to select the image or object in Prism. Then
drop the Change menu and choose Selected Object.
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To resize: Grab a corner and drag larger or smaller. 

Problems with windows/mac compatibility

We try to keep Windows and Mac completely compatible, but this is not
possible with images placed on a graph or layout. 

If you paste (or import) a WMF or EMF or EMF+ image into Prism 7
Windows, save the file, and open in Prism 7 Mac, that image is gone. We
will try to solve this issue in a future release. 

15.5 Tips for moving or rotating objects

Selecting objects on the page

When you work in the Graphs  section of your project, the graph itself
as well as text, legends, drawings, and imported images are all referred
to as “objects”. When you are working in the Layout section  of your
project, each graph with all of its objects is grouped into a single object.
Images imported onto a page layout are also objects. Images imported
onto a graph are objects in the graph section, but are part of the graph
object in the page layout section.

To select one object:

Point to the object and click the left mouse button. To select a rectangle or oval,
click on its edge. Prism displays knobs on the selected object.

To select several objects:

Hold down the Shift key while selecting the objects one at a time. Or… drag an
imaginary rectangle around all the objects. You've selected all objects entirely
contained within the rectangle.

Moving objects

To move an object with the mouse:

Point to an edge. Press the left mouse button and drag.

To move an object vertically or horizontally only:

With Prism Windows:

Hold the Shift key while dragging to allow only vertical movement. (Remember
this because the Shift key is marked with a vertical arrow.)

Hold the Ctrl key while dragging to allow only horizontal movement. 
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With Prism Mac:

Hold the Shift key. Prism will let you drag vertically or horizontally, but not at
an angle.

To prevent automatic snapping:

Hold the ALT key down while dragging an object to prevent Prism from trying to
automatically snap it into place.

To nudge an object a tiny distance:

Select one or more objects. Press the up, down, right or left arrow keys. Each
press of an arrow key moves the object(s) one pixel.

To nudge an object in larger steps:

 Hold down the Control key (Windows) or Command key (Mac) and each click of an
arrow key will move the objects in larger steps.

To group two or more objects so they move together:

Select Group from the Arrange menu or toolbar.

The set of objects now acts as a single object. If you want to work with the
individual objects again, drop the Arrange menu and choose Ungroup.

To rotate an object:

Grab the rotation knob and move your mouse.

15.6 Aligning objects on a graph

Automatic snapping

Prism will automatically try to snap objects to be in alignment with graph
axes and other objects. For instance, you can drag a text box over a bar
or group of bars and Prism will try to snap the text box to align with the
centerline of the bar. Prism will also change the justification of the text to
"centered." If you don't like this, you can change the justification back
using the text justification button in the Text toolbar. 
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To overcome this automatic snapping, hold down the ALT (Windows) or
Command (Mac) key while dragging the object.

 
Using the Align or Group button in the Arrange section of the Prism
toolbar

For graphs, use the drop-down menu under the Arrange button

For layouts, each task has its own button in the Arrange toolbar.
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To align objects:

 - Select Align Objects from the Arrange menu or toolbar. Choose horizontal
and vertical orientation, or to align by the X or Y axes.

To position an object by entering distances:

Select Position Object from the Arrange menu or toolbar. Enter the distance
between the upper left corner and the top and left edge of the page.

To lock an object so you can’t accidentally move it:

 - Select Lock Object from the Arrange menu or toolbar. When you select a
locked object, the knobs will be gray rather than black, and you will not be able to
move the object or change its size. To unlock the object, select it, then select Lock
Object from the Arrange menu again.

To bring an object on top of overlapping objects.

 - Select it, drop the Arrange menu or toolbar and choose Bring to Front. Or use
the toolbar button.

To send an object behind overlapping objects.

 - Select the object. Drop the Arrange menu or toolbar and choose Send to
Back. Or use the toolbar button.

To space objects equally:

 - Select three or more objects. Choose Distribute Objects from the Arrange
menu or toolbar.

To duplicate one or more objects.

Select the object(s). Drop the Arrange menu or toolbar and choose Duplicate
Object.

To center everything on a page.

 - Click the Center button.

Zoom settings

To precisely align objects, zoom to a larger magnification. Select a zoom level in the
View menu or click the zoom buttons. Zooming changes the magnification on the
screen, but does not change the size of the graph or layout when printed. Hold Ctrl
and press M to zoom larger or J to zoom smaller.
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Rulers

Choose Rulers from the View menu. The rulers appear on top and to the left of the
graph and page layout screens. Show the rulers to align objects precisely. Hide the
rulers to leave more space for the graph.

Alignment guides

Alignment guides are temporary lines you can drop from the ruler to check on the
position and alignment of objects. Click the mouse in either ruler to drop a single
guide (down from the top ruler, or over from the left ruler). Click the corner where
the two rulers intersect to drop both alignment guides at once. The guides will
remain visible only as long as you hold down the mouse button.

Grids

Choose Grids from the View menu. Prism will show a grid that extends from the
minor ticks on the rulers, spaced every 0.1 inches, or 1 millimeter. This grid is
provided to help you align objects. It will not print. Select Grids from the View
menu again to turn it off. Note the distinction between showing this grid, and
choosing a frame with a grid (from the Format Axes dialog) to include a grid on a
graph.
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15.7 Adding analaysis results to a graph

You can put analysis results on the graph easily. 

1. Select a cell or a range of cells on a results table (or data table).

2. Copy to the clipboard.

3. Go to a graph and layout and paste. 

4. Double click to reformat.
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16 Exporting images from Prism

There are several ways to get your graphs and

layouts into other applications. You can export

them to PowerPoint or Word using one-click

export . You can export them in a variety of521
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image formats , or you can copy and paste your

graphs and layouts as bitmaps.

16.1 How to export one or more graphs or layouts

Are you sure you want to export?
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If your goal is to send graphs to a colleague who doesn't own Prism,
consider sending a Prism file. He or she can then open the file using Prism
itself, the free Prism trial (expires in 30 days), or the free Prism viewer
(never expires).   

If your goal is to place graphs into a Word document or PowerPoint
presentation, you can copy-and-paste or use the one-click send buttons
rather than exporting. There are some settings in the File & Printer tab of
the Edit/Preferences dialog that will affect the result and whether or not
you will paste your graph as a Prism object or a picture.

How to export

1. Start from one graph or a layout, or from several graphs or layouts
selected on the Gallery . 

2. Click the Export button on the Prism toolbar to bring up the Export
Graph dialog. Alternatively, drop the File menu and choose Export.

3. Choose the export format , and also choose the location and name of
the exported file. 

16.2 Exporting options

Export one graph or layout, or several or many?

To export several graphs at once, start from the graph gallery, select two
or more graphs, and then choose to export. With most formats, each
graph or layout will be exported to its own file. With PDF format, you can
choose to export each to its own file or all to one file. 
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File format

This is the most important choice. If you don't want to think about it, we
suggest using PDF if you can, and use TIFF as a second choice.

 Read about the pros and cons of the alternative formats .  

Clear (transparent) background?

Within Prism, there is no distinction between having a clear page
background  and a white background. When you paste or export a Prism
graph into another program, however, the two are distinct if the exported
graph is combined with other objects that are behind (in a front-to-back
sense) it. If the background is clear, you'll see other objects that are
behind it. If the background is white, you won't.  

The TIF, PNG, PDF, WMF (Windows only) and EMF (Windows only)
formats allow you to choose a transparent (clear) background. With Prism
Mac, but not Prism Windows, you can choose a clear background with EPS
export. If you choose to export as a TIF file with a clear background from
Prism Windows, it will be RGB 32 bits (with no choice of color model). The
.JPG, and BMP formats simply have no concept of a clear background, so
those file formats simply don't allow for the possibility of clear
backgrounds.   

Resolution 

The resolution is entered in dots per inch (dpi).  For perspective, most
computer screens have a resolution of about 100 dpi, and most
professional printing presses (used by journals) use a resolution of 1200
dpi. Laser printers range from 300 to 1200 dpi. 

The PDF, EPS, WMF (Windows only) and EMF (Windows only)  formats
encode vectors and fonts, so have essentially infinite resolution. If you
export in one of these formats, you will not be asked to enter a
resolution. The other formats offer choices of 100, 300, 600, and 1200
dpi.

If you double the dpi, note that you quadruple the number of pixels in the
image, and thus quadruple the file size. 

Color model

If you choose the PDF, EPS or TIF format, you'll need to choose between 
RGB and CMYK color models . We recommend that you choose RGB
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when possible, as there will be fewer surprises. RGB colors will closely
match what you see on the Prism screen (which internally uses RGB).
Select CMYK only when submitting images to a journal that insists on
CMYK. 

With some formats, you can also choose between being able to save
thousands (8 bit) or millions (24 bit) of distinct colors. When you choose
thousands of color, some colors may get changed a bit when saved. When
you save RGB, thousands of colors are stored in an indexed format, but
millions of colors are not. Some journals may specify whether they want
colors expressed in 8 or 24 bits, and whether they prefer indexed or
nonindexed colors. 

When exporting in jpg, tiff, pdf or eps formats, instead of exporting in
color, you can choose grayscale where colors are converted to various
shades of gray. 

Size

In most cases, you'll want to export without changing the size of the
graph or layout. But you can specify the width of the exported graph.
Don't enter the desired width of the graph's plotting area, but rather the
desired width of the entire graph object, including any legends or
drawings or objects. 

Embed fonts (EPS on Windows only)

When you export to EPS format using Prism Windows, choose whether to
convert the fonts to outlines. Learn the pros and cons of the two
approaches .

Prism Mac does not offer the choice of converting text to outlines. 

Defaults

Check an option at the bottom of the dialog to lock in your settings of
format and options to use as the default for future exports. To change the
default exporting location, use the File Locations tab of the Preferences
dialog. 

16.3 The differences between export formats

Setting the default export format and the default for copying to clipboard
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Set the default for how Prism copies graphs and layouts to the clipboard
in the File & Printer tab of the Preferences dialog. Choose the export
format in the Export dialog, and check an option at the bottom of that
dialog to set the default for future exports. 

PDF

Prism's PDF files encode vectors and fonts (not bitmaps), so the resulting
file can be stretched to any size with no loss of quality. Export in PDF
format when you can.  Unfortunately, few Windows programs import pdf
images, and few journals accept them. In contrast, PDF is the preferred
format for transferring images between mac programs.

Notes:

· If your graphs are in color, you will need to choose between RBG and
CMYK color model. . 

· You don't have to have Adobe Acrobat to export PDF files. Prism creates
PDF files on its own. 

· When exporting several graphs or layouts, you can choose to export all
of them to one PDF file. Or you can  ask Prism to create a separate PDF
file for each sheet. 

· Prism Mac and Windows (new to Prism 7) can encode transparent colors
in PDF export.  

TIFF

This is a bitmap format, which means that your graph or layout is turned
into a collection of dots.  TIFF files tend to be trouble-free when
submitted to journals. You need to choose resolution, color model, and
size.

The resolution is expressed as dots per inch (dpi). Computer screens
display images at about 100 dpi. Computer printers generally print at
300-600 dpi, and publications are generally printed at 1200 dpi. Journals
typically ask for a file at 1200 dots per inch (dpi), the highest resolution
that Prism offers.

Choose between two ways to express colors: RGB (designed for computer
monitors or projectors) or CMYK (designed for printing). If you are
submitting to a journal, follow their instructions. If in doubt, choose RGB.
You can also choose Monochrome files, which are pure black and white
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with no grays. If you choose RGB, choose between 256 colors (smaller
files) or millions of colors (larger file, but more accurate color rendition).

Typically, graphs and layouts in Prism projects are much larger than
publication size. If you ask for a graph at 1200 dpi at the actual size in
Prism, you will end up with either a huge file or an out-of-memory error
message. Avoid this problem by specifying the publication size. Let’s say
your graph is 6 inches wide, but you will publish it with a width of 2
inches. By checking the option to reduce the graph to a width of 2 inches,
you will create a file one-ninth as large (one-third the width times one-
third the height).

With TIF format, and no other, Prism lets you choose to compress the file.
The advantage of compressing, of course, is that the file is smaller. The
disadvantage is that compressed TIF files might be less compatible with
other programs. With Prism Windows (but not Mac), choose between two
compression methods. PackBits compression create the smallest file size,
but  LZW (Lempel-Ziv-Welch) compression might be more compatible.
Prism Mac does not offer you a choice of compression methods. It uses
LZW compression when you chose Grayscale, CMYK or RGB (millions of
colors, 16 bits), and PackBits compression when you choose Monochrome
or RGB (256 colors, 8 bits). 

Previous versions of Prism Mac included an "alpha channel" when
exporting in TIFF format, and this caused problems with some journal
production systems. Prism 6 and later do not include this alpha channel.

TIFF files exported by Prism 7 (Windows or Mac) encode transparent
colors. 

EMF+, EMF or WMF (Windows only)

Windows Metafile (.WMF) and Enhanced metafile (.EMF) files contain
vector and font instructions for how to draw the graph. This means you
can resize the image (in another program) with no loss of quality. These
formats are only used by Windows program, not Mac programs (and
Prism Mac cannot export in these formats).

WMF is an ancient format; EMF is old, and EMF+ is the newest. So
generally EMF+ is the best format. But not always. You may need to
experiment to see which format works best for your needs, but these
notes may help:
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· Don't use WMF when exporting or pasting bar graphs with fill  patterns
to PowerPoint. If you use WMF, the patterns on such a graphs do not
scale and appear of higher density.  

· If you paste an EMF image into PowerPoint, the colors may change when
you save then reopen the file. Not with WMF or EMF+.

· Choose EMF  instead of "EMF+" to workaround the problem with
somewhat corrupted graph when pasting EMF+ to older versions of
Adobe Illustrator (CS5) or Corel draw. The problem is how Adobe
Illustrator opens "EMF+" format that is generated by GDI+ in Prism 6.  

· Choose EMF instead of "EMF+" to when a graph is sent to PowerPoint
and then exported to PDF. WIth EMF+, the fonts can change. 

· Some very old programs do not support EMF. For these choose WMF.

· EMF and EMF+ files exported by Prism 7 encode transparent colors, but
WMF files do not encode transparency. If you choose a transparent color
for your graph, it won't look transparent in the exported file if you
choose WMF.

· EMF+ is a newer format than EMF but both kinds of files use the same
.EMF extension.

 
EPS

Like PDF, EPS files contain vectors and fonts. The resulting file isn't just
an EPS wrapper around a bitmap file. Prism Windows gives you the choice
of converting text to outlines. If you do that, the image will always look
right (no font files required), but you wont be able to edit text in other
programs. If you include text as text, it can be edited elsewhere but font
files are required. Prism Mac always converts text to outlines. 

In theory, the EPS format is the best (tied with PDF). It encodes
everything as vectors and fonts, so can be expanded or shrunk without
any loss of resolution. In fact, submitting EPS files to journals is often
problematic. Fonts and EPS files.

The EPS format is unable to encode transparency. If you choose any
transparent colors in Prism, they will look solid in the exported file.

JPEG
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The .JPG format is designed for photographs with gradients of similar
colors. It is not a particularly good format for exporting for line art and
graphs. Prism offers this choice because some journals insist on it, but we
recommend that you use the .TIF format when possible. The only
advantage of .JPG is that the files are smaller.

Most programs that export to the .JPG format give you a choice of
compression. If you compress more, the files will be smaller but the
resulting image won’t be as sharp. Prism gives you no choice. It only
exports to the .JPG format with the least possible compression, making
larger files but sharper images. Any compression would reduce the clarity
of your graphs noticeably.

The JPEG format is unable to encode transparency. If you choose any
transparent colors in Prism, they will look solid in the exported file

PNG 

The .PNG format is great for posting graphs on web sites. PNG files use
screen resolution, which is fine for displaying on screen but is too little
resolution for submission to printed journals. There are no options of color
depth.

Prism Windows can encode transparent colors in PNG export. Prism Mac
cannot, and any transparent colors in your graphs become solid in the
exported PNG file.

BMP

This is an older format that doesn’t offer any advantages.

 

16.4 Exporting for publishing in journals

When you submit figures to journals for publication, you have to decide
which format to use. Each journal has their own rules, and these
sometimes change. But here are some general notes on preparing Prism
graphs for publication.

Exporting as a TIFF file

Exporting as TIFF, our customers tell us, usually works well. Notes:
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· In most cases, you will want the page background in Prism to be white,
and to check the option in the Export dialog to include that color in the
file.Transparent backgrounds can sometimes cause problems.

· For resolution, try to follow your journal guidelines. It would seem to
make sense to choose the highest resolution (1200 dpi) but some
journals prefer 300 dpi. Definitely avoid the 100 dpi resolution, which is
way too low for publication. Some of our customers say they always
give the journal more resolution than requested, and this seems to work
well for them.

· Choose the color model  requested by your journal. Different journal
have different requirements.It seems that RGB is now more popular
than CMYK, so choose RGB if you don't know what your journal wants. If
your graph is entirely black on white, choose the monochrome or gray
scale color model. 

· For size, choose to make the exported file the exact width the journal
wants. More.  

· For compression, choose the LZW method, as it is standard and should
not pose any problems to the journal production process.

Exporting as an EPS file

EPS files (encapsulated postscript) files encode the graphs as vectors and
fonts, so have infinite resolution (except for any embedded pictures).
They are more compact and sharper than TIFF or other bitmap files. Even
if the journal you are submitting to doesn't list EPS as an acceptable
format, ask them, since their printed guidelines may be out of date.  

The problem of fonts in EPS files

Prism Windows (but not Mac) offers an option to convert fonts to
outlines  when exporting to an EPS file.

The default is to save the text as characters, with references to the font.
If you have used only standard fonts, this format lets the journal
producers edit the text, or change the font and size. The only drawback is
that if the file is opened on a computer that does not have the exact fonts
you used, another font will be used and the look of the graph (or layout)
will change. If you use standard fonts, we recommend this approach. 
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If you check the option  to convert all text to outlines or glyphs, the look
of your graph or layout will be preserved on any computer, even one that
does not have the fonts you used. The disadvantage is that the text no
longer is encoded as text, so the people processing your files at the
journal will not be able to edit the text, change the point size or switch to
a different font. We only recommend this approach if you use any unusual
fonts in your figure, and are not sure if the journal computers will contain
those fonts.

Prism Mac always converts fonts to outlines. 

Adobe products offer a third way to deal with fonts that combines the
best of the two approaches above, but Adobe has not provided the hooks
our programmers would need to implement this approach. If you have
access to Adobe Illustrator, here is an approach that is likely to work well.
Export the graphs from Prism Windows without converting the text to
outlines. Or try copy and paste.  Then export from Illustrator in EPS
format. We do not use Illustrator, so can't give you any detailed
information.

Beware of the term embedded font. If your journal asks for that, clarify
what they mean. Previous versions of Prism and some other programs 
used the term "embed" to describe converting fonts to outlines. Adobe,
and some journals, use the term "embed" to the describe the third
approach above, an approach that Prism does not offer.

Choosing a color model

If your graph is entirely black on white, choose the monochrome or
grayscale color model.

If your graph includes color, choose the color model  requested by your
journal. Different journal have different requirements. It seems that RGB
is now more popular than CMYK, so choose RGB if your journal has not
specified. 

Previewing EPS files

Once you've exported an EPS file from Prism, you'll probably want to see
it to make sure it is correct. With Macs, this is no problem. Just double-
click on the file and it will be opened in Preview, a program that is part of
the OSX system. What actually happens is that Preview converts from
EPS to PDF, and displays the pdf image. 

Windows, however, has no built-in program that can view EPS files.
Adobe Illustrator seems to be the standard that many journals use, so

516



GraphPad Prism7 User Guide516

© 1995-2016 GraphPad Software, Inc.

import the EPS files into Illustrator if you can. If you don't have access to
Illustrator, you'll have to find another program. Try double-clicking on the
file to see if you already have a program that can open EPS files. Also try
the free program GhostScript, which works OK. Another option is to
export from Prism as a pdf file, and view that. This works because eps
and pdf files contain mostly the same information, with a different
"wrapper". 

16.5 RGB vs. CMYK color models

The Export dialog requires you to choose between RGB and CMYK color
models when you choose to export a graph (or layout) in the PDF, EPS,
JPG or TIF format. 

RGB (Red, Green, Blue) is based on projecting. Red light plus Green light
plus Blue light all projected together create white.  Black is encoded as
the absence of any color. Colors encoded as RGB are sometimes called
spot colors. 

CMYK (Cyan, Magenta, Yellow, blacK) is based on ink.  Superimpose Cyan
ink plus Magenta ink plus Yellow ink, and you get black. White is encoded
by the absence of any color.  Colors encoded as CMYK are sometimes
called process colors. 

Even though it uses one more number to encode a color, the CMYK
scheme actually encodes a smaller "color space" than does RGB. That
means that the appearance of some colors will change when converted
from RGB to CMYK. Most noticeably, bright colors in RGB (left side of
figure below) will look duller and darker in CMYK as shown in the right
side of the figure below. 

http://pages.cs.wisc.edu/~ghost/
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We recommend that you choose RGB when possible, as there will be
fewer surprises. The colors will closely match what you see on the Prism
screen (which internally uses RGB). Many scientific journals now request
RGB. 

Select CMYK only when submitting images to a journal that insists on
CMYK. 

Learn more about the differences between RGB and CMYK  here and here.
 

16.6 Fonts and EPS files

Prism Windows (but not Mac) offers two choices about how to handle
fonts when exporting to EPS format.

The default choice is to choice saves the text into the EPS file as
characters, with references to the fonts you used. If you have used only
standard fonts, this format lets others edit the text, and change the font
and size. The only drawback is that if the file is opened on a computer
that does not have the exact fonts you used, another font will be used
and the appearance can change drastically.

http://www.printernational.org/rgb-versus-cmyk.php
http://www.articlesbase.com/printing-articles/difference-between-rgb-amp-cmyk-1916310.html
http://www.sketchpad.net/basics7.htm
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Prism Windows also offers an option to convert all text to outlines, so that
each letter is described as a set of graphic objects without reference to
any font file. Prism Mac always exports EPS in this format. The advantage
of this approach is that the look of your graph or layout will be preserved
on any computer, even one that does not have the fonts you used. The
disadvantage is that the text no longer is encoded as text. That means it
is impossible to opens the .eps file and edit the text, change the point
size or switch to a different font.

Adobe products offer a third way to deal with fonts that combines the
best of the two approaches above. The font definitions themselves are
included in the file, so the text remains as text, but will render perfectly
on any computer. As far as we can tell, this choice only works within
Adobe products and Adobe has not provided the hooks our programmers
would need to implement this approach. 

Beware of the phrase embedding fonts, as it is not used consistently.
Adobe uses it to describe the third approach listed above (including font
definitions in the file). Prism 5 and earlier (and some other programs) use
the phrase "embedding fonts" to mean the second choice above
(converting fonts to outlines or glyphs). 

16.7 The size of exported graphs and layouts

How to change the size of a graph in Prism

When exporting a graph to submit to a journal, you will often want to set
the exact width of the graph, and any other objects (text, legends,
drawing, pictures, results tables) on the graph page. There are two ways
to change the size of the graph in Prism:

· Set the width of the exported graph on the Export dialog.

· On the graph page. Drop the Change menu and choose Resize Graph. 

A third possibility is to change the length of the X and Y axes in the
Format Axis dialog. But just sets the axis length. The full graph will be
larger when you consider titles, numbering,  legends, drawing etc.).

We recommend the second approach above (change the size of the graph
in Prism), as you can then check that nothing is too small. One guideline
(from Cadmus, who handles production for many journals) is to make no
font be smaller than 6pt, and no line be thinner than 1/2 point.  
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What happens when you resize exported images?

EPS, PDF, WMF, EMF files

The EPS, PDF, WMF and EMF formats are all based on vectors and fonts.
These formats essentially store the instructions to draw the graph. You
can stretch them to any size, and they should still look great. The only
exception is if you pasted a picture onto your graph. Then that picture will
remain a bit map in your EPS (etc.) file, and may not look great if its size
is changed. 

Even though it shouldn't matter, it is not a good idea to create an
oversize graph, and expect the journal to reduce the graph size (and thus
increase its resolution for TIFF files). Journals prefer that you export the
graph at the size it will be published. 

TIF, PNG, BMP, JPG files

TIF, PNG, BMP and JPG files encode bitmaps. If you stretch or shrink
these images in another program, that program has to figure out how to
create extra pixels or remove existing ones. Often the image becomes a
bit blurry. It is much much better to resize in Prism (in the Graphs
section) and then export the bitmap image file at exactly the size you
want it to end up at.

If you want to know the size of an image, beware of viewing it after
importing  into another program. The size you will see in the other
program depends on how that program deals with the mismatch of dots-
per-inch (dpi) between the file and on screen, and also on what view
zoom setting you have in that program.

It is easy to find out how large an image is in pixels, and its dpi:

· Mac. Double-click to open in Preview and then drop the Tools menu and
choose Show Inspector. 

· Windows: Double-click to open in Photo Viewer, then drop the File menu
and choose Properties. (This works for Windows 7; other versions are
similar.)
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16.8 Clear (transparent) background

What is a clear background?

Within Prism, there is no distinction between having a clear background
and a white background. Both look identical on screen.

When you paste or export a Prism graph into another program, a clear
background will let colors and objects show through, so Clear is not the
same as White. 

The problem is that not all export formats support the concept of
transparency, and Prism doesn't support all formats. The JPG, and BMP
formats simply have no concept of a clear background, so those file
formats simply don't allow for the possibility of clear backgrounds.

Note that Prism lets you set two separate colors for the background of a
graph. What Prism calls the background is the color of the 'page'. The
plotting area color is the background color within the plotting area defined
by the axes. Both can be set by right clicking (control-click for mac) on
the graph, or by dropping the color wheel icon. Layouts, of course, only
have the page background property.

Which export formats allow you to choose a clear background?

With Prism Windows, you can choose a clear background when you export
in PDF, EMF or WMF formats. Prism Windows cannot export TIFF images
with clear backgrounds (but Prism Mac can).

With Prism Mac and Windows, you can choose a clear background when
you export to PDF, TIFF, and EPS format. 

This choice is in the Exporting options part of the Export Graph dialog,
where you can choose to include a background color or export with a clear
background.

Copying graphs and layouts to the clipboard

Choose on the File & Printer tab of Preferences whether you want Prism to
copy graphs and layouts to the clipboard with the background color you
specified in Prism or with a clear background.

Sending to PowerPoint

Rather than copy and paste, we urge you to use the Send-to-PowerPoint
command (a button at the right end of the toolbar, or a command in the
File menu. The choice you make for sending background color (vs.
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transparent) to the clipboard (see prior section) also applies when
sending a graph or layout to PowerPoint.

When you copy a graph or layout from Prism Mac, two versions are placed
onto the clipboard. The PDF version supports transparent background and
plotting area. Whether the background is clear or not depends on an
option you set in Prism's Preference dialog (bottom of File & Printer tab). 
The bitmap version does not support a clear background. If you copy and
paste, which version pastes depends on your version of PowerPoint and
on whether you use Paste Special. Avoid the uncertainty by using the
Send-to-PowerPoint command. 

 

16.9 One-click to Microsoft PowerPoint or Word

Send to PowerPoint or Keynote

The Send-to-PowerPoint command copies the current graph or layout),
creates a new slide in PowerPoint, and pastes.

When you send to PowerPoint, it matters what the background color is in
Prism. If the background is CLEAR in Prism, then Prism leaves the
background alone in PowerPoint. If the background is any color in Prism,
including white, then Prism changes the PowerPoint background to match.
If your PowerPoint slide master has a background gradient or image that
you want to keep, make your backgrounds in Prism clear, not white.

Send to Word (Windows only)

The Send-to-Word command copies the current graph or layout  (or a set
of graphs or layouts selected on the gallery ), and pastes it into Word.
Position your insertion point in Word before using this button.

This button is available on Prism Windows, but not Prism Mac.

Setting preferences for Send-to-Word or Send-to-PowerPoint (Windows only)
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Open the Send to MS Office tab of the Prism Preferences  dialog.

The most important choice (Windows only) is whether to embed, link, or
send a picture . Embedding is the most versatile, but makes your Word
or PowerPoint files larger.

When sending to Word, choose whether to display full colors, black and
white, or gray scale. The latter two options simply set a setting within
Word to display and print the graph in black and white or gray. If you
embed or link, and double-click to edit in Prism, you'll see the graph in its
original colors.

Problems sending to Word or PowerPoint? EMF(old) vs. EMF+ vs. WMF

Windows supports three similar formats for describing images using
vectors and fonts. The WMF (Windows Metafile) format is older. The
EMF+ (Enhanced metafile) format is newer, and in theory a bit better.
Prism can also use an older version of EMF. In fact, one format works

153

523



Exporting images from Prism 523

© 1995-2016 GraphPad Software, Inc.

better for some programs and the other format for others. It seems
impossible to predict.

Choose which format to place on the clipboard (and to use when sending
graphs to PowerPoint) at the bottom of the File & Printer tab of the
preferences dialog. If you're having problems with pasted graphs looking
funny, try another format.

16.10 Embedding or linking Prism graphs in other programs

This page applies only to Prism Windows. Object Linking and Embedding
is not possible on the Mac. We wish it were.

The difference between pasting an object, a link or a picture

There are three ways to copy a Prism graph or layout and paste it into
many Windows programs, including Word or PowerPoint.

Paste a graph or layout as a Prism object:

Prism will paste a picture of the graph, plus a copy of all the data,
analyses and graphical settings needed to create that graph (or layout).

Double-click the object in the other program to edit it within Prism, where
you can edit data, change analysis settings, and format the graph. When
you exit Prism, the revised graph will appear in Word.

The advantage of embedding is that the Word or PowerPoint file is
complete, containing the Prism data and settings. One disadvantage is
that this makes the Word file larger. Another disadvantage (for some) is
that it means your data can be stored in multiple places. If you realize the
data was entered incorrectly, you will need to edit all the copies. Others
see this as an advantage -- a way to backup your data.

A Prism object only includes the data tables and results that are linked to
the graph (or layout) that you pasted. Other parts of the Prism project
are not included.

This is Windows only, and is not possible with Prism Mac.
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Paste a graph or layout as a picture

A picture may be worth a thousand words, but it doesn't let you edit data,
change analysis choices or reformat the graph. When you double-click on
a pasted picture, you cannot edit it within Prism. Instead, you'll open up a
generic graphic or photo editor.

An advantage of this approach (for some) is that people you send the file
to won't be able see your data or edit your graphs. Because there is no
need to store the data and settings, this approach doesn't take up so
much disk space.

Paste a graph or layout as a link

Prism can paste a picture along with a link to the Prism file. When you
double-click, Prism will be launched and open the linked Prism project.
You can then edit the data, analysis settings, or graph in Prism. When
you exit, the revised graph will be updated in Word or PowerPoint.

One advantage of this method (over pasting an object) is that your Word
or PowerPoint files will be smaller. Another advantage (for some) is that it
keeps your data in one place for easy editing. The disadvantage is that
the link really is just a link to a file with a particular name in a particular
place. If the linked file has been deleted, renamed or moved, you won’t
be able to edit it. If you move the Word or PowerPoint to another
computer, you won't be able to open the linked file unless it too is moved.

This is Windows only, and is not possible with Prism Mac.

Insert object

If you insert a Prism object into Word or PowerPoint, you'll embed an
entire Prism project. In contrast when you paste a graph as an object,
you only embed the data and results linked to that graph.

Choose the Insert Object command from the other program's Insert menu
(or in Office 2007, the right side of the Insert tab). Choose to create
object from a file, and choose your Prism file.

The advantage of this method is that it includes the entire Prism project.
This might be useful if you send a document to a colleague and want to
include all supporting details.

This is Windows only, and is not possible with Prism Mac.

How to choose to paste an object, a link or a picture
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One-click buttons to send to PowerPoint or Word

Choices in the Send to MS Office tab of Prism's preference dialog
determine whether Prism's one-click Send buttons  send an object, a
link, or a picture.

Copy and paste

When you copy a graph (or layout), Prism put all the necessary
information on the clipboard so the pasting program can choose if it
wants to paste a picture, an object, or a linked picture. Microsoft Word
and Excel and older versions of PowerPoint paste an embedded object.
PowerPoint 2007 and 2010 are different. By default, they paste a picture.
To override this, drop the clipboard menu,  choose Paste Special, and
then choose to paste a Prism object. 

Copy and Paste Special

Instead of pasting (and letting the program choose), use the Paste
Special command, so you can choose which format is pasted. With most
programs, Paste Special is a choice on the Edit menu. With Office 2007
and 2010, it is a choice on the Paste menu which is on  the left side of the
Home tab of the ribbon.

The Paste Special dialog lets you choose to paste an object ("GraphPad
Prism 7 Project Object"), or a Picture ('Enhanced metafile"). You can also
paste a bitmap, which might be useful if you want this Word or
PowerPoint document to look nice on a Mac.

If you check this option to paste a link, the scrolling list gives you no
choices. This option will not be available if you copy a graph from an
unnamed Prism project, because linking requires that the Prism file has a
name.

EMF+, EMF(old) or WMF?

Windows supports three similar formats for describing images using
vectors and fonts. The WMF (Windows Metafile) format is older. The
EMF+ (Enhanced metafile) format is newer, and in theory a bit better.
Prism can also use an older version of EMF. In fact, one format works
better for some programs and the other format for others. It seems
impossible to predict.

Choose which format to place on the clipboard (and to use when sending
graphs to PowerPoint) at the bottom of the File & Printer tab of the
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preferences dialog. If you're having problems with pasted graphs looking
funny, try another format.

Editing a Prism object embedded in PowerPoint or Word

To edit a Prism object embedded in PowerPoint or Word, simply double
click on it. 

If you have multiple versions of Prism installed on your computer,
Windows will choose which version to launch (the one used to create that
object). But you can override that decision: Right click on the Prism
object in PowerPoint, choose the Prism Object command, and then choose
Convert from the submenu, and choose the Prism version you want to
open that object.

Opening Prism objects with different Prism versions

What happens when you double click on a Prism object embedded in
Word or PowerPoint (or elsewhere)? If the Prism version that created that
object is present on your computer, that version of Prism will open it. If
that version is not present, a newer version of Prism will open the file. But
if the object was created with Prism 7, but the computer only has Prism
6, the object will not open. Instead you'll see a message that explains.

16.11 Posting graphs to a Web site

If you actually use this feature, please write to support@graphpad.com
and let us know. We may remove it from future versions.

How to post

To post a graph or layout to an FTP server, drop the File menu and choose
Post to Web, and choose to send the current sheet, all graphs or all
layouts.

Prism will post the graphs (or layouts) on your FTP server and create an
index page. Immediately after posting the graphs, Prism will launch your
browser, and take you to that page. Copy the URL of the created page
and email it to others so they can view your graphs.

mailto:support@graphpad.com


Exporting images from Prism 527

© 1995-2016 GraphPad Software, Inc.

Note that Prism posts only pictures of your graphs or layouts for others to
view. It does not upload the Prism file itself.

Specifying the FTP server

Before you can post to a Web site or FTP server, you must configure
Prism to do so in the Internet tab of the Preferences dialog. This dialog
also will come up the first time you click on the Post to a Web site button
in the Send section of the Prism toolbar.

Enter the ftp URL and your account name and password (if required). You
must also enter the URL to use to view these files (Prism will append the
folder and file name). If your server is behind a firewall that prevents
incoming FTP connections, check the option to use passive mode so Prism
will initiate data connections rather than asking the server to connect
back to your computer. You may want to ask your webmaster for help in
configuring these FTP settings.

17 Printing

This section explains how to print graphs and

layouts, and how to change your printing options.

17.1 Two toolbar buttons for printing

The Print section of Prism’s toolbar has two buttons for printing.

 -Print the current sheet, or multiple sheets selected in the Gallery ,
using your default Print settings.

 -Bring up the Print dialog to choose a printer and which pages to print.
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17.2 Printing data and results tables

Choose font size

Change the font size to control the size of the print on the page, and thus
the number of pages needed to print a table. To do so, click the Zoom
buttons. Or use the keyboard shortcuts: Use Smaller Font (Ctrl-J), Use
Larger Font (Ctrl-M)

 

Note these buttons work differently in data and results tables than they
do in graphs and layouts. When you are working with a table, the zoom
buttons change the actual size of the font used, which will then change
the size of the printed table.  When working with a graph or layout, these
buttons simply zoom what you see on screen, but do not change the
actual size of the graph or layout when printed.

Portrait vs. landscape

Save paper, with some tables, by changing the Landscape/Portrait
orientation when printing data tables, results, and info sheets. Go to File…
Printer Setup for Windows (File… Page Setup for Mac). A single setting
applies to all data tables, results sheets, and info pages in the entire
project.

While you can change graphs and layouts from portrait to landscape
orientation, you cannot o so on data or results tables.

Change column widths

Reduce column widths by positioning the cursor between column
headings, and dragging to squeeze more onto each printed page.

Printing preferences

These options on the File & Printer tab of the Preferences dialog affect
printing of tables.

· Print grid lines on tables -- Check this box to include the horizontal and
vertical lines on data and results tables. Omit it for a cleaner look.
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· Print row and column labels -- When printing data tables, print the row
numbers on the left of every page and the column letters on top of
every page.

· Print the sheet name as header -- Print the sheet name, file name, and
date on each page as a header. You'll probably want this header on
pages placed in your notebook, but not on graphs submitted for
publication.

17.3 Printing graphs and layouts

Page orientation

Each graph or layout can be set to be portrait or landscape. Since the
page orientation setting in the portrait/landscape setting of the printer
setup dialog only allows one setting per file, Prism ignores this setting for
graphs and layouts.

Flipping the orientation of a graph

Click the rotate button in the Change toolbar and choose Flip. 

Flipping the page orientation does not change the aspect ratio of the
graph. You won't see the change on screen unless you zoom  down to
see the entire page.

Flipping the orientation of a layout

Use the Flip button in the Change section of the Prism toolbar to change
the orientation of a layout.
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Printing preferences

Two options shown on the File & Printer tab of the Preferences dialog
affect printing of graphs and layouts.

· Print the sheet name as header -- Print the sheet name, file name, and
date on each page as a header. You'll probably want this header on
pages placed in your notebook, but not on graphs submitted for
publication.

· Print no grays and no colors -- Convert all colors to black. Don’t print
colors as shades of gray.

Printing posters

Prism can print on very large pages (up to 1.5 by 2 meters) so can create
a poster directly. 

Choose the paper size by dropping the File menu and choosing Printer
setup (Windows) or Page Setup (Mac). The details vary with each printer
driver.

Since you can only set the page size once for the entire project, we
suggest that you create your graphs in one project (or several projects)
using a standard page size. Then make your poster in a separate project
created just for that purpose. Set a large page size and then go to the
layout section and create a layout sheet. Arrange the placeholders, and
assign graphs from your other projects.

 

17.4 Printing the gallery

Open a Gallery  page by clicking on the section title in the Navigator
(Data tables, Results, Graphs, etc.). You'll see thumbnails of all the
sheets in an array.

Distinguish two ways to print from the gallery. 
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Print selected sheets: Select the sheets you want to print. Then
select the Print command or click on one of the Print buttons on the
Prism toolbar.

Print the gallery page itself:  Click on the Print button in the Prism
toolbar and click the Gallery option in the Print dialog. Printing the
gallery might be useful to create a table of contents for a lab notebook,
or to see an overview of your work. 
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18 Scripts

Use a Prism script to automate the analysis of a

large number of files. Prism's scripting language

lets you open and close Prism files, import data,

and export or print results and graphs.
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18.1 Overview of Prism scripts

Because Prism links data to graphs and analyses, a great deal of
automation is built in. Simply edit or replace data or info constants, and
everything will be updated. Although this built-in automation suffices for
day-to-day lab work, it can be tedious when repeated over and over.

You can use a Prism script to automate the analysis of a large number of
files, or simulate many data sets for Monte Carlo analyses. Prism's
scripting language lets you open and close Prism files, import data, and
export or print results and graphs. You can run Prism scripts from within
Prism, or launch Prism from another program.

Note that Prism scripts do not tell Prism how to analyze or graph your
data. That is built-in to the Prism project (or template). Use a script to
import data into an existing project and to specify which results and
graphs you want to export or print.

Scripts are small computer programs. Creating a script is slightly more
difficult than using Prism. Experience with other scripting or macro
languages is helpful, but is certainly not necessary. If you want to launch
a Prism script from Excel, you will also need to learn a bit about Excel's
macro language, Visual Basic for Applications.

To learn about scripts, first look over the examples we present in the next
section. These examples show you the kinds of things that Prism scripts
can do and give you a feel for how easy it is. Then read on to learn the
details of Prism syntax. The final sections of this chapter explain how you
can launch a Prism script from another program.

Can a Prism script control how Prism analyzes and graphs data?

No. A Prism script can open a Prism project file (or template), import
data, and export results and graphs. But the details of how data are
analyzed and graphed are stored in the Prism file. Note that when you
change data, Prism updates the results and the graphs. This includes
updating analysis constants and paste-linked data. For this reason, Prism
scripts tend to be very short and easy to write.

Does Prism have an API that can be called from other programs?

No. But other programs can launch a Prism script. Read the details about
how this works with the Windows  and Mac  versions of Prism.

Can other programs create Prism files?
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Yes .

18.2 Alternatives to scripting

Prism can save its project files in two formats. The PZFX format
includes all the data and info tables in plain text XML that other programs
can view, edit or replace.

While other programs can't really create Prism files, they can start with a
Prism file you have created, and replace the data. When a user then
opens this file, the results and graphs will be updated.

To get an idea about how this approach works, follow these steps:

1. Create a Prism file, with data, analyses and graphs as you want them.

2. Save from Prism in the PZFX format.

3. Then open the file with a text editor (notepad). The analysis and
graphing stuff is all encrypted in a way you can't access. But the data
and info are in plain text, structured, XML.

4. Edit the data (and perhaps the info constants), and resave.

5. Double click on the file to open in Prism. You'll see that graphs and
analyses are updated to analyze and graph the new data.

Using this approach, you can effectively (from the user's point of view)
save a Prism  file from your application (or instrument). No scripts. No
need to use your software and Prism on the same computer at the same
time. No need to even use the same platform (Win vs. Mac) for Prism and
your program. All you have to do is replace the data portion of a .PZFX
file, and resave it.

18.3 Example scripts

The easiest way to learn Prism's scripting language is to follow some examples.

The examples are all for Prism Windows. The only difference on a
Macintosh is that you use a colon instead of a backslash to specify disk
names, folder names, and files. For example, the first line of the first
example would read:
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SetPath “Hard Drive:Prism 4:Data:June21”

 

Script example 1. Repeatedly import data

Script example 2. Monte Carlo analysis

Script example 3. Import several files onto one table

Script example 4. Open a template and import data

Script example 5. Import data and info constants from the script
file

Script example 6. Import data into several tables

18.3.1 Script example 1. Repeatedly import data

This script analyzes a folder full of dose-response data stored as text
files, perhaps from an instrument. It creates a single file that tabulates
the logEC50 values along with the standard error and the R square of the
fit.

Script command Comments

SetPath “c:\data\june21\” This sets the disk and directory
to be used for the rest of the file.

OpenOutput results.txt Create a file called results.txt to
contain the output.

Table Text Start a tab delimited text table in
that file.

Open dr.pzfx Open the Prism file dr.pzfx

  ForEach dr*.txt Loop for all files that begin with
dr, have the extension .txt, and
are located in the disk and
directory defined by the SetPath
command.

  Goto D Go to the data section, to the
data table last visited.
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  ClearTable Erase all data from the table.

  Import Import the file defined by the
ForEach statement into the first
empty columns.

  WTable “File name”  %F Write the file name into the 
output file.

  Wtable “logEC50”, 5, 1 Write to the output table the
value on the fifth row, first Y
column (A), and label that
column of the table “logEC50”.

  WTable “SE of logEC50”, 11,
1

Write the SE of the logEC50
(from the 11th row of results)
into the next column.

  Wtable “R2”, 21, 1 Write the R2 value into the next
column.

Next Loop back to the ForEach
statement and read the next file.
Exit loop if no more files.

Beep Signal completion.

 

18.3.2 Script example 2. Monte Carlo analysis

This is an example of Monte Carlo analysis. We'll simulate 500 data sets
with random variation and fit a dose-response curve to each. This script
creates a table containing the logEC50 and HillSlope from all 500 fits.
Before running this script, you must create a file that has the first data
table formatted for a one-grouping variable data set (no X, No Y
subcolumns). The first results sheet must be one that simulates data with
error. The second results sheet must be a nonlinear regression that fits a
dose-response curve to the data.

Script command Comments
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Table Prism 1 Clear Designate the first data table in your
file to contain the results of this script.
Delete all the contents of that table now
(clear). Note this script requires that
the first data table be formatted for one
grouping variable data, with no X
column.

ForEach 500 Loop 500 times.

  GoTo R 1 Go to the first results sheet, which is a
simulation.

  Regenerate Regenerate the simulation with new
random numbers.

  GoTo R 2 Go to the second results sheet. Since
this sheet contains nonlinear regression
results, Prism will automatically refit
the data for each loop.

  Wtable “logEC50”,
5,1

Write the value from the first Y column
in row 5 to the first column of the
output table, and label that column
“logEC50”.

  Wtable “Hill Slope”,
6,1

Write the value from the first Y column
in row 6 to the next (second) column of
the output table, and label that column
“Hill Slope”.

Next Loop back to the ForEach statement.

 

When the script is done, table 1 will have two columns and 500 rows.
Each row will have the logEC50 and Hill Slope from one of the simulated
experiments.

18.3.3 Script example 3. Import several files onto one table

This example uses the script to import several files onto one data table.
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Script command Comments

SetPath “c:
\Data\Oct2011\”

Define the disk and directory to be used
by the rest of the commands.

Open rapid.pzt Open the Prism template rapid.pzt that
was created to contain a formatted data
table.

GoTo D Go to the data section.

ForEach
Avge_*.dat

Loop through all files that start with
Avge_ and have the extension DAT.

    Import Import into the first empty column.

Next Go to the next file, which will be imported
into the next column of the same table.

18.3.4 Script example 4. Open a template and import data

This example uses a script to launch Prism.

Script command Comments

SetPath “c:\data\oct2011\” Define the disk and
directory to be used by
the rest of the
commands.

Open rapid.pzt Open the Prism
template file rapid.pzt

GoTo D Go to the data table.

    Import today.txt Imports the file
today.txt.

GoTo G Go to the graph
section.

Save today.pzfx Save the file with the
specified name
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While Example 4 would not be useful when run from Prism, it would be
useful as a way to launch Prism.

For 32 nbit (x86) Windows: Create a shortcut icon with a target
something like this:

"C:\Program Files\GraphPad\Prism 7\prism.exe” @”C:\Users\(current user)\Documents\”doit.pzc. 

For 64 bit Windows: Create a shortcut icon with a target something like
this:

 “C:\Program Files (x86)\GraphPad\Prism 7\prism.exe” @”C:\Users\(current user)\Documents\”doit.pzc. 

Double-click that icon to launch Prism and run the script doit.pzc.

For Mac: You cannot create an icon that launches Prism running a certain
script. All you need to do with Prism Mac is double-click on the script icon
and that will launch Prism and run the script. 

The script shown above instructs Prism to open a template (today.pzt)
and import today's data (today.txt, presumably changing daily) into the
file, and go to the graph. Once you have set this up (a few minutes) and
also have a mechanism so the data file is updated daily (outside the
scope of Prism), you simply double-click the saved file to see a new graph
of today’s data.

18.3.5 Script example 5. Import data and info constants from the script file

Script command Comments

GoTo D , 1 Go to the first data table.

InsertData 1,0 Insert data from the script file, starting
at row 1, column 0 (the X column).

<DATA>
1.000           564.1452
2.000           389.7727
3.000           138.9337

Data block within script file.
Adjacent values are separated by tabs.



GraphPad Prism7 User Guide540

© 1995-2016 GraphPad Software, Inc.

4.000           115.3119
</DATA>

GoTo I, 2 Go to second info sheet.

SetInfo "Experiment", 2,
0

Set the name of the second info
constant.

SetInfo "345", 2, 1 Set the value of the second info
constant.

SetInfo "Experimenter",
3, 0

Set the name of the third info constant.

SetInfo "Dan Brown",3,
1

Set the value of the third info constant.

SetInfo "[Potassium]",
4, 0

Set the name of the fourth info
constant.

SetInfo "3.45 mM", 4, 1 Set the value of the fourth info
constant.

 

It would not make sense to create this script by hand, but it would be
very useful if created by another program. 

18.3.6 Script example 6. Import data into several tables

Before running this script, create a Prism file with 9 data tables each
linked to a graph, and all the graphs placed on one layout.  

Script command Comments

GoTo D Go to the data section.

ForEach 9 Loop nine times.
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GoTo %N Go to the Nth data table, where N is the
loop number.

Import Data%
N.txt

Import the data file. Data2.txt goes into
the second table, Data3.txt goes into the
third table, and so on.

Next Loop.

GoTo L 1 Go to the first layout, which was setup to
show all nine graphs.

Print Print the layout.

18.3.7 Script example 7. Changing the X-axis title of all graphs

Script command Comments

GoTo G Go to the graphs section.

ForEachSheet Loop over all sheets in this
section.

   SetAxisTitle X, "Time (minutes)"
Change the X axis tite.

Next

18.4 Script syntax

Each script command begins with the command name. Most commands
then have one or several arguments. Separate the command name from
the arguments with a space, and separate the arguments from each
other with spaces or commas. You can use upper and lower case letters
interchangeably, and can add extra spaces to improve readability.

In the rest of this section, required arguments are shown in square
brackets [like this] and optional arguments are shown in angled
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brackets <like this>. When an argument is in lower case, it describes
the value you will enter. When an optional argument is in uppercase,
you enter that exact word if you want that option.

General commands

Adding comments to a script

Loops and simulations

Creating new sheets

Changing data tables

Changing graphs

Setting the default drive and folder

Opening and saving Prism Files

Importing data

Changing info constants

Including data and info constants in the script file

Exporting a graph or layout

Exporting data, results or info tables

Copy and paste

Writing to Prism, text, HTML, XML or SQL tables

Writing to text files

Send to Microsoft Office

Special purpose commands

18.4.1 Navigating a project

Commands

GoTo <section: D, I, R, G, or L >, <sheet#>, <view#>

GoTo +        
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Explanation

The GoTo command is used in almost every script, to navigate to a
different sheet in the project as these examples show:

Example: Description:

GoTo G Go to the graphs section, to
the most recently viewed
graph.

GoTo 3 Go to the third sheet of the
current section.

GoTo G, 3 Go to the third graph.

GoTo V2 Go to the second view
(subpage) of the current
results.

GoTo R, 3,
V2

Go to the second view of the
third results sheet.

GoTo + Go to the next sheet in the
current section.

GoTo - Go to the previous sheet in the
current section.

Notes:

· Prism numbers the sheets so the first sheet is #1. This seems normal to
everyone except computer programmers, who expect the first one to be
#0. 

· Don't forget to include a space (or comma) between the results and the
view. The command "GoTo R4V2" goes to the default (current view) of
results sheet 4, and the view part of the command is ignored. 
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18.4.2 How rows and columns are numbered

Many commands let you specify a particular row or column number. 

Column numbering

· The Row Title column, if there is one, is number -1. 

· The X Column, if there is one, is number 0. 

· Column A, is column 1.

· Column B, is column 2, etc. 

Row numbering

· The Column Title row, if there is one, can be referred to either as row 0
or -1 (to be consistent with column titles).

· The other rows follow the row number shown on the table. So the first
data row is #1. This seems obvious to most, but people familiar with
other computer languages may expect the first row to be #0.

· It is not possible to access subcolumn titles via script. 

18.4.3 Adding comments to a script

Add comments to your script following these examples:

Commands

//single comment line

/*

  Several lines

  of comments.

*/
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18.4.4 Loops and simulations

Commands

ForEach [# of loops]

ForEach [filespec, i. e. ”C:\data\DR*.txt”]        

ForEachSheet

Next

Regenerate

Explanation

The heart of many scripts is a loop. You can loop a certain number of
times (for simulations), over all matching files (repeated importing), or
over all sheets in a section (to print or export…). End the loop with a Next
statement. You cannot nest loops.

Starting and ending the loop

There are three ways to start a loop:

· Loop a specified number of times (example ):  ForEach 100. 

· Loop over a set of files (example ):  ForEach *.CSV

· Loop over all sheets in the current section:  ForEachSheet

For all three kinds of loops, the Next statement ends the loop.

Regenerate random numbers

One common use of a Prism script is to do Monte Carlo analyses. First
create a Prism file that uses the analysis ‘Simulate data with random
scatter” to generate data, and links those simulated data to another
analysis (say a nonlinear regression). Inside each loop, use the GoTo
command to go to the analysis page that generates the data, and use the
Regenerate command to create new ‘data’ (with different random
scatter). Then go to the results, write out selected results, and use the

536
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Next command to loop again. See script example 2  at the beginning of
this chapter.

18.4.5 Using variables when outputting text

The Prism scripting language lets you use these four variables in any
command that exports text. They are mostly useful inside of loops . 

· %F. The name of the file. This is useful in ForEach loops that import a
set of files. %F is the file name before the period. 

· %X. The file extension (without the preceding period).

· %S. The name of the current sheet. This is useful when looping over all
sheets in a file. Starting with Prism 7, you may also use this variable
outside of a loop.

· %N. The loop number. This is useful in simulations, which loop a set
number of times.

· %%. This outputs the percent symbol, %.  

These variables can be preceded and/or followed by other text. They can
only be used within a script loop. Note there are additional variables
you can use when writing text. 

18.4.6 Creating new sheets

Commands

DuplicateDataTable  <CLEAR>
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DuplicateFamily  [prepend_text] <CLEAR>

CreateLayout [#rows] [#columns] <orientation>
<#StartingGraphIndex> <#Graphs> 

Explanation

DuplicateDataTable

For the most part, script commands navigate among sheets you have
already created by hand. You can’t create new data tables, new analyses
or new graphs in a script except by duplicating existing ones. When you
duplicate a data table, all you get is a new data table. You can import
data into it, but not analyze or graph within the script. 

DuplicateFamily

Duplicates a sheet as well as all linked sheets. Import new data to replace
the existing data, and all analyses and graphs will update.

All new sheets include the prepended text in front of the sheet name.
Enter %F as the prepend text, to use the name of the most recently
imported file.

CreateLayout

Create a new layout with an array of placeholders with the specified
number of rows and columns on a page of the specified orientation
"portrait" or "landscape" (portrait is the default).  Assign graphs starting
with the specified one. Specify by rank order in the navigator, with "1" as
the first graph. If you specify GraphsCount, Prism will assign that many
graphs only. If you omit this parameter, Prism will stop when it has
reached either the last placeholder on your layout or the last graph in the
project
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18.4.7 Changing data tables

Commands

SetYReplicates  [#]

ClearTable <row>,<col>,<subcol>

DeleteAllDataSets <CLEAR>

Explanation

Using a script, you have limited ability to change a data table.

The SetYReplicates command changes the number of Y replicates
(subcolumns), but script commands can not make other changes to the
data table or number (decimal) format.

The DeleteAllDataSets command deletes all data and all links to
analyses and graphs.

The ClearTable command erases all data to the left and below of the
designated cell (including the cell itself) but maintains links to analyses
and graphs.

18.4.8 Changing graphs

Commands

ApplyColorScheme ["scheme name"]

SetAxisTitle [which axis: X, Y, or Y2] ["new title"]

SetGraphTitle [“new title”]

SetAxisLimits [which axis: X, Y, or Y2] <segment #>
[Top/Bottom/Interval]  [value]

Explanation

You must create graphs manually (or by duplicating). You can’t change
most graph properties via scripts, but you can apply a color scheme,
change the limits of an axis, and change the graph or axis titles.
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When entering the graph or axis title, you can only enter plain text, and
Prism does not provide tools to enter Greek letters, math symbols,
superscripts or subscripts. But note that Windows lets you enter some
special characters by holding Alt and typing its four digit code. For
example, alt-0181 enters the Greek letter mu.

To use the % symbol in an axis or graph title, enter it twice. The
command "SetAxisTitle Y %% Complete" changes the Y axis title to "%
Complete". This is because the % symbol is used to indicate a variable. 

Each use of the SetAxisLimits command lets you change the range
(minimum and maximum  values) or interval of an axis. Each use of the
command only lets you change one of those values. If you want to change
the Y axis (left Y) so it ranges from 100 to 200 with an interval of 10, you
need to use this command three times (in any order): 

SetAxisLimits Y top 200
SetAxisLimits Y bottom 100
SetAxisLimits Y interval 10

If the Y axis was split into two segments, you need to specify which
segment to change. The first (left or bottom) segment is '0', and the
second segment is '1'. If you wanted to change the bottom  segment, use
these commands. Note that it is not enough to specify the segment
number; you also need to include the word 'segment'.

SetAxisLimits Y segment 0 top 200
SetAxisLimits Y segment 0 bottom 100
SetAxisLimits Y segment 0 interval 10

After you change a graph using a script, linked layouts won't update
unless you write script commands to go to that layout. Here is a script
that flips through all the layouts, so ensures they are all up to date.

Goto L
ForEachSheet
Next

18.4.9 Setting the default drive and folder

Commands

SetPath [“drive and folder path”]

http://www.geoff-hart.com/resources/accents-windows.pdf
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Explanation

All the commands that read and write files use the path set in the
SetPath command unless you specify a different drive or folder in the
other commands. For Windows, use these examples:

SetPath “C:\Users\(current user)
\Documents\007\goldfinger\oddjob”

SetPath “(local drive):\DataFiles\August2005\”

SetPath “\\LabServer\DDrive\PrismFiles"

The last example opens a file on another computer named “LabServer”.
In this case you don’t use the “C:” notation for hard drives, but rather
refer to the name of the drive (“DDrive” in this example.)

On the Mac, use a format like this:

SetPath “Hard Drive:Prism 4:Data:June21”.

If you prefer to specify the path within each individual command, you can
still use the same formats as shown above.

18.4.10 Opening and saving Prism Files

Commands

Open [“filename”]

Close

Save <”filename”>
Explanation

Scripts can either be saved as part of a Prism file, or in a separate script
(.pzc) file. When the script is running from a separate file, the Open and
Close commands let you switch between Prism files. The script commands
work on the last opened file. You may open several files at once. To go
back to a file you already opened, simply reissue the open command
again.

If you don’t include a disk and directory, Prism will look in the directory
(folder) specified by the SetPath command. Include the file extension
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(.PZF, .PZFX, .PZT or .PZM). If no SetPath script command was used
Prism, Prism uses the temporary folder.

Unlike the Import command, the Open command by itself will not
automatically open the next file file in a ForEach loop. To do so, use this
syntax: Open %F.PZFX.  That opens the next file in the loop (%F) with
the extension .PZFX (which you may want to change to .PZF).

The Close command does not save the file, so issue the Save command
first if you want to keep the changes. Include a file name with the Save
command to create a new file. Omit the file name to save changes using
the same name.

The Save command saves to either .PZF or .PZFX format, depending on
the file name you enter.

18.4.11 Importing data from a text file

Commands

Import <”filename”>, <row>, <col>, <subcol>

ImportLink <”filename”>, <row>, <col>, <subcol>

Explanation

The Import command imports data from a text file into a data table. The
ImportLink command replaces data in a data object file using existing
choices for filtering and rearranging

If you omit the filename and are in a ForEach file loop, Prism will use the
current loop’s file. If you include a file name, don’t precede it with a path,
Prism will use the path defined in the SetPath statement if there is one.

If you want to import starting at a particular row or column, specify them.
Row 0 is the title row, and row 1 is the first row with data. Column 0 is
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the X column, and column 1 is the first Y column. Column -1 contains the
row titles. It is not possible to import subcolumn titles. 

The advantage of the ImportLink command is that it lets you specify
which parts of the file to import and how to rearrange the data. Before
creating the script, manually import a data file and choose the option to
maintain a link between Prism and the data (text) file. At this time,
choose options on the Filter and Placement tabs of the Import dialog to
select rows and columns to import and rearrangements (such as
transpose). These properties are stored with a data object. See Data
objects in Prism . The ImportLink command then replaces new data,
using the same properties.

If there is only one data object on the table, don’t specify row, column, or
subcolumn. Prism simply uses the only data object on the table.. If there
is more than one data object you need to specify the row, column, and
subcolumn of the upper-left corner of the data object you wish to import
into.

Note that the ImportLink command updates a Prism data object linked to
a text file. If you Paste Link data from Excel, you cannot update the link
using this command. You'd need to write VBA code in Excel to change the
data in Excel.

18.4.12 Importing data from the script file

Commands

InsertData <row>, <col>, <subcol>

InsertDataLink <row>, <col>, <subcol>

226
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Explanation

If you create the script file from within another program, you can include
data and info constants within the same file as the script commands.

The InsertData command imports data included within the script file, into
the current data table, starting at the specified position. The data are
included right in the script file enclosed between the tags <Data> and
</Data>. The rest of the script continues right after the </Data> tag.

InsertData

<Data>

1, 2, 4

5, 7, 9

</Data>

The InsertDataLink command imports data included within the script file,
into a data object whose upper left position is at the indicated position.
This works similarly to the ImportLink  command.

If you want to import starting at a particular row or column, specify them.
Row 0 is the title row, and row 1 is the first row with data. Column 0 is
the X column, and column 1 is the first Y column. Column -1 designates
the row titles.

18.4.13 Copy and paste

Commands

Copy

Copy [#rows] [#columns] [first row] [first col] <first subcol>

Paste  [first row] [first col] <first subcol>

Paste  

551
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Explanation

From a data, info, or results table, copy selected values to the clipboard.

If you use the Copy command with nothing else, Prism copies the entire
sheet to the clipboard.

You can also specify which range to copy. Note that #columns includes
subcolumns. So if you want to paste triplicate values into two adjacent
columns, you need to enter #columns as 6 (or 7 if you also paste an X
column).

If you use the Paste command with no arguments, Prism will paste the
entire table starting at the current position of the insertion point. 

Copy and paste use the Windows or Mac system clipboard, so will
overwrite any other information copied to the clipboard.

18.4.14 Changing info constants

Commands

SetInfo [”value”] [rownumber] <position: 0 (name) or 1 (value)
or 2 (notes)>

SetValueToInfo [infotable #] [inforow#] [datarow] [datacol]
<datasubcol>

Explanation

The SetInfo and SetValueToInfo commands inserts (or changes) a
value into an Info sheet.

With the SetInfo command, set position to 0 to change the name of the
constant, 1 to change its value (the default choice), or 2 to append to the
notes (in which case the row number is ignored).

Examples:
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SetInfo 5.3, 3 

Setinfo "Notebook 25, page 34", 5

Setinfo "Experimenter", 3, 0

Setinfo "Dennis", 3, 1

Setinfo "Notebook 2007H, page 304", 1, 2

The first example sets the third constant equal to 5.3. The second
example sets the fifth constant to “Notebook 25, page 34”. The third
example names (or renames) the third constant to “Experimenter”. The
fourth example assigns the value “Dennis” to that constant. The fifth
example adds some text to the notes portion of the info page.

With the SetValueToInfo command, the value comes from a data, results
or info table. You must first navigate to that table using the Goto script
command. Then specify the row and column (and perhaps subcolumn) of
the cell with the value you want to use, and which row of which info table
you want to ‘paste’ that value into. Example:

SetValueToInfo 2, 4, 14, 0

From the table that a prior Goto script command has taken it to, find the
X value (column 0) in row 14. Put a copy of that value in the fourth row of
the second info table. 

18.4.15 Exporting a graph or layout

Commands

ExportWMF [filename] <CLEAR> (Windows only)

ExportEMF [filename] <CLEAR> (Windows only)

ExportTIF [filename] <resolution> <mode> <compress or LZW>
<CLEAR>

ExportBMP [filename] <mode><resolution>

ExportPNG [filename] <resolution><CLEAR>

ExportJPG [filename] <mode> <resolution>

ExportEPS [filename] <mode> <CLEAR> <nofonts>

ExportPDF [filename]   <mode> <CLEAR>
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ExportAllPDF [filename]   <mode> <CLEAR>

Explanation

For the formats that let you set resolution (dots per inch), enter 100,
300, 600 or 1200. You cannot enter other values. The default is 300 dpi.

For EPS or PDF export, set the mode to “RGB” (256 colors, default),
“CMYK” or “Grayscale” 

For TIFF export, set the mode to “RGBlow” (256 colors, 8 bits),
“RGBhi” (millions of colors, 24 bits), “CMYK” (default), “GRAY” or “MONO”.
Note that “MONO” means black and white only, with no grays. CMYK and
RGB are two ways of denoting colors.

For TIF export, include the "compress" option to save the file using
"PackBits" compression, which will make the file smaller but perhaps less
compatible. Or use the "LZW" option (Windows only) to compress using
the Lempel-Ziv-Welch algorithm, which doesn't compress quite as well as
PackBits, but may be more compatible with some programs. 

For EPS export, choose nofonts to not include fonts. This makes the EPS
file smaller and more compatible, but requires that the same fonts be
present on the computer used to import the file. 

If your page has a colored background, you will see that background in
the exported file, unless you include the parameter "CLEAR" to export the
graph or layout with no background color (only allowed for some
formats).

For all export commands, Prism will use the SetPath location if you don't
specify disk and directory.

ExportPDF exports the current graph or layout. ExportAllPdf exports all
the graphs (or all the layouts) into one multipage file. 

If you use “%F” to export a file with the same name as
the imported data table, remember to append an
extension. For example “ExportWMF %F.WMF “.
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18.4.16 Exporting data, results or info tables

Commands

ExportTable [filename] <ALL>

Explanation

If used from a data or results table, this command exports the entire
table. The format will depend on the extension you give the file name.
Choose from tab-delimited text (.txt), comma-delimited text ( .csv), or
Prism XML ( .xml).

If used from an info table, and the filename is a .txt file, this command
exports only the notes (and not the info constants). If the file name is an
.xml file, then this command exports both info constants and notes. If you
want to export only info constants, use the WSheet command  instead.

If you choose the XML format, and include the ALL option, all data and
info tables will be exported.

You can also export the values in a data table or results sheet to a table
created by a script.

18.4.17 Writing to Prism, text, HTML, XML or SQL tables

Commands

Table Prism [datatable number] <CLEAR>

Table Text <&> <delimiter>   

Table CSV <’delimiter’>  

Table HTML <border #> <width #>

Table XML [filename]

Table SQL [datasource] <table > <login> <password> <CLEAR>
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WTable [column title] [row] [col] <subcol>

WTable [column title] [text or %F or %N]

NextRow

EndTable

OpenOutput [“filename”] ,<CLEAR>, <”delimiter”>      

  
Explanation

These commands make it easy to export Prism results into structured
tables. The first step is to define your table. Choose to place the results
into a data table within Prism, to a text file (delimited with tabs), to a
CSV (text file delimited with commas), to a HTML (web) table, to an XML
table, or directly to a ODBC connected database. If you choose to write
to a text, CSV or HTML file, create the file using the OpenOutput
command before creating the table. This lets you combine other
information (as explained in the next section) as well as the table. XML
output must be in its own table, so enter its file name as part of the
Table XML command.

Use the WTable command to write a value into the table. The first
argument will become the column title in the new table (or the variable
name when exporting to a database). The next three arguments define
the cell on the current results (or data) table that will be written to the
new table. Or enter text to just space columns apart, or %N to put in the
loop number or %F to put in the current file name.

Note that the Wtable command has a name that can be misleading. It
writes a single value (or text string) to a table. The command does not
write an entire table. If you want to write an entire results (or data)
table, use the WSheet command . 

In almost all cases, you’ll create a table as part of a loop. The Next
statement that ends the loop also starts the next row on the table. When
the loop is complete, so is the table. In rare circumstances, you might
not want the end of a row to correspond with the Next statement of a
loop. In this case, end a row with the NextRow statement, and close the
table before the loop ends with the EndTable statement.
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18.4.18 Writing to text files

Commands

OpenOutput [“filename”] ,<CLEAR>, <”delimiter”>        

WText <"text"> <;&>

WDate <;&>

WTitle  

WCell [row], [col], <subcol> <;&>

WRow [row], <col>, <subcol> <;&>

WCol [row], <col>, <subcol><;&>

WSheet <row, col, subcol><;&>        

WBlock [row(s)]  [column(s)] <row label> <;>

WTCol [row, col] <, subcolumn><;&>

WTRow [row] <,col, subcol> <;&>

WTSheet <row, col, subcol><;&>

WTBlock [row(s)]  [columns to include] <row label> <;>

WVersion

CloseOutput

Explanation

Prism offers two methods for writing results from a script. The previous
section explains how to write tables. A more general method, writing to a
text file, is explained here. Generally, you’ll find it easier to write to
tables (previous section) but may find uses for  the extra flexibility of
writing to text files.

The first step is to use the OpenOutput command to open (or create) a
file to contain the text the script will output. If you don't precede the file
with disk and directory, Prism will use the path defined in SetPath. If
there is no SetPath command, then Prism assumes that you want to use
the directory that contains the script. If you include a delimiter, say “,” it
will appear between entries. Otherwise the output file will be delimited
with tabs.
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If the output file already exists, Prism appends to that file unless you
have included CLEAR.

Results will be tab delimited unless you include an alternative delimiter in
the OpenOutput statement.

Examples: 

OpenOutput C:\gp25\output.txt, Clear

OpenOutput C:\data\july97, “,”

You can write (export) data and results to the text file using any of the
commands that begin with W (or by creating a text or CSV table as
described in the next section).

If you end any of the W commands with a semicolon, the next W
command will add text to the same line, following a tab. If you end with
an ampersand (&), the next W command will add text to the same line,
without a tab. If you omit the semicolon or ampersand, Prism inserts the
codes for carriage return and line feed so the next W command will write
to the next line in the file.

The most useful W command is WCell which writes out the contents of
one cell in a data or results table. You need to specify the row and
column of the cell to write. Row 0 refers to the row of column titles, and
row 1 is the first row of data. Column 0 refers to the X column, and
column 1 is the first Y column (column A).

You can also write out entire rows or columns, or the entire sheet, at
once. The commands that begin with WT transpose the data (so each
row becomes a column) before writing to the text file.        

WVersion writes the version of Prism you are using, to fully document
your results. 

Note that the WTable command is distinct  from the set of commands
described here, despite the fact that it begins with the letter W. 

Read more about WBlock and WTBlock . 

Variables

Use the following variables when writing text:

· %D   Date and time this file was last saved, e.g. "Tuesday, September
16, 2014 4:08:10 PM"
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· %P   File name of the Prism project

· %S   Sheet name

· %V   Prism version

18.4.19 The WBlock and WTBlock commands

These commands were introduced in GraphPad Prism 6.04 and 6.0e. The
idea is to specify a block (range) of cells to write to a text file already
specified in an OpenOutput command.

 WBlock script command

Syntax:   WBlock [row(s)]  [column(s)] <row label> <;>

Rows 

The parameter for rows can designate a single row, a row down to a blank
row, a range of rows , or a list of rows which can be in any order.  You
must have used the OpenOutput script command first to specify where
the results will be written.

What you
enter

How Prism interprets it

7
Only row 7. Of course, row 7 is the row labeled with a 7 in
front of it, so row 0 is the column titles.

“7” Only row 7

“7-“ Start at row 7 and keep going until you hit a blank row

“7-12”
Start at row 7 and end at row 12. Note that the second
number is the ending row, not the number of rows.

“7, 11, 9,
8”

Specified rows in that order.

 
Columns
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The parameter for columns can designate a single column, a column
across until an empty column, a range of columns, or a list of columns
which can be in any order.  You must have used the OpenOutput script
command first to specify where the results will be written.

What you
enter

How Prism interprets it

3
Only column 3. The column of row titles (if it exists) is column
0. Column 1 is column A, but for some results there are no A,
B, C column labels.

“3-3”
Only column 3. The column with titles is 0, so in the example
above, this is the “significant” column

“3” Only column 3. 

“3-“
Start at column 3 and keep going right until a column is empty
(or the end of the table).

“3, 4” Columns 3 and 4

“3-6” Columns 3, 4, 5 and 6. 

“3, 8, 4”
Columns 3, then 8 then 4. Note that the order in the results
will not match the order in the Prism table.  Also note that I
included spaces after the commas which are ignored.

“3,8,4” “

 
Row label

The parameter row label would must be quoted text. That text will appear
as the first item in every row output. If the WBlock command ends with a
semicolon, then there is no delimeter (no tab, no space, no comma) after
that text. If there is no semicolon, then the row label text is separated
from the next column just like all the columns are separated (tab unless
an alternative is specified in OpenOutput command).  If there is no row
label (as it is an optional parameter), then a semicolon at the end of the
command is ignored and has no impact. 

 

WTBlock script command

The WTBlock command has the same syntax as WBlock. Note that the
label is applied to each row as output (which is each column in the Prism
table)

    WTBlock [row(s)]  [columns to include] <row label> <;>
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Examples

Here are results of one way ANOVA followed by Dunnett's test from Prism
6.04 (the results show two new columns that were not in prior releases):

The results are shown here as tables. In fact, they will be tab-delimited
text (or comma delimeted, if that is set in the OpenOutput command).

Example 1

WBlock "7-", "6,4", "PSummary"
WBlock "7-", "6,3", "Significant?"

The results will be as shown below. Here it is a table. In fact it will be tab
delimited text. (The delimeter is set in the OpenOutput script command,
and defaults to tabs).

Psummary B ****
Psummary C ns
Psummary D *
Psummary E ns
Significant? B Yes
Significant? C No
Significant? D Yes
Significant? E No
 
Example 2

WBlock "7-", "6,4", "PSummary";
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WBlock "7-", "6,3", "Significant?";

The results will be as shown below. Note the semicolon after the labels,
so in both cases the label and the columnID column run together.         

PsummaryB ****
PsummaryC ns
PsummaryD *
PsummaryE ns
Significant?B Yes
Significant?C No
Significant?D Yes
Significant?E No

Example 3

WBlock "7-", "7,4", "PSummary"
WBlock "7-", "7,3", "Significant?"  

Here there is no semicolon, so the labels have their own column.

Psummary Treated
***
*

Psummary
Treated+Anta
gonist

ns

Psummary
Treated+Agon
ist

*

Psummary Solvent Blank ns
Significant? Treated Yes

Significant?
Treated+Anta
gonist

No

Significant?
Treated+Agon
ist

Yes

Significant? Solvent Blank No

Example 4

WTBlock "7-", “7,3,4”
 

Treated
Treated+Antagonis
t

Treated+Agonist Solvent Blanks

Yes No Yes No

*** Ns * ns

 



Scripts 565

© 1995-2016 GraphPad Software, Inc.

Example 5

WTBlock, “7-“, 3, “Significant?”
 

Significant?
Yes No Yes No

 
Prism file
 

18.4.20 Send to Microsoft Office

Commands

SendToWord

SendToPP

Explanation

These commands send the current graph or layout to Word or
PowerPoint.

18.4.21 Special purpose commands

Commands

SetProjectName [“new name”]

SetScriptDialogTitle [“dialog title”]

RecalcAll

Beep

Createlog

SetSheetTitle [new_name] <K>

http://cdn.graphpad.com/faq/1893/file/1893.pzf
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CloseScriptDialog

Print

Exit

Explanation

Use the SetProjectName command to change the name of the project
file (the name it will have when next saved) and the 
SetScriptDialogTitle command to change the wording of the dialog that
shows while the script is running (only useful if you are creating scripts
to be used by others).

If you are opening a file created by a prior version of Prism, and saved in
the large format (which includes analysis results) the RecalcAll
command will tell Prism to recalculate all the results.

If you script takes a long time to complete, you might want to use the 
Beep command to alert you when the script is complete.

If you run a script from the script dialog, every step is logged in the
second tab of the dialog. In this case, the CreateLog command is
ignored, as the log is always created. If you run a script from a file, the 
CreateLog command starts logging every step into a file with the same
name as the script file, but the extension .log.

SetSheetTitle renames the sheet. If you specify K, the first K characters
of the sheet name are retained, and the rest is renamed.

The Print command prints just the current sheet.

The Exit command closes all open files, without saving and without
prompting to save, and exits Prism. It works on Windows only.
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18.5 Running a Prism script

There are several ways to run a Prism script. While

testing and developing a Prism script, run it from

Prism. Once you perfect it, you may want to run it

from the command line or from another program as

explained in this section.
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18.5.1 Creating and running a script from Prism

Creating and running a Prism script within Prism

While testing and developing a Prism script, run it from Prism. Once you
perfect it, you may want to run it from the command line or from another
program as explained later.

Creating a script

To create a script within Prism:

1
.

Click the Prism button (or drop file menu) and choose Run Script

2
.

Choose to make a new script

3
.

Choose to start with a blank screen, or to start with a copy of an existing script.

4
.

Enter or edit the script on the left side of the GraphPad Prism Script dialog. Use
the right side to review script syntax.

5
.

Repeatedly click ‘1 step’ to step through the script. You can watch the result in
Prism, as well as observe the script log.

6
.

Click “12 steps’ if you are feeling lucky.
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7
.

Click ‘Run” when you are convinced the script will run without error. The Script
dialog will minimize, as will Prism, while the script runs.

Editing a script
1
.

Click the Prism button (or drop file menu) and choose Run Script

2
.

Choose one of the scripts listed in the menu. Or choose Open Script file to open a
script in an external file.

3
.

Follow steps 4 through 7 above.

18.5.2 Run a script  using Automator, MacScript, or AppleScript

Run a script using Automator

If you use OSX 10.4 (“Tiger”) or later, Prism installs an Automator Action
that lets you launch a Prism script. The inputs to this Action is either a file
containing a Prism script, or the text of the script itself. The output is
either the word “Done” or an error message.

Run a script from Microsoft Office using MacScript

MacScript commands let you launch Prism from Word or Excel. These
examples assume you are running Visual Basic for Applications (VBA)
from within Excel.

Launch Prism with this MacScript command.

MacScript “tell application “”HD:Prism4:Prism””” + Chr(13) +
_

“activate” + Chr(13) + _

“open file “”Macintosh HD:Prism4:Scripts:dr2””” + Chr(13) +
_

“end tell”

The MacScript command has to specify both the full location of Prism and
the script that Prism will launch. The MacScript command is a Visual Basic
statement that you will need to write in an Excel macro, perhaps one that
runs when the user clicks a button.
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As soon as Visual Basic has launched Prism, it will continue to the next
statement in the Visual Basic program or macro. It will NOT wait for Prism
to complete before continuing. If you don't take the extra steps described
below, your Visual Basic program will try to read a file containing Prism’s
results before Prism has finished creating that file. To avoid this, make
your Visual Basic program pause until Prism creates a file.

When you write the Prism script, include lines at the end of the script to
create a file that will tell Visual Basic you are done. The example below
creates done.txt.

OpenOutput "done.txt"

WText "done"

CloseOutput

Your Visual Basic code should first delete the file done.txt (if it exists from
a previous run) and then launch Prism. Immediately following, include
these lines that make your program loop until done.txt is created.

Do Until Dir$(“HD:prism 5:done.txt") > "" 

Application.Wait Now + TimeValue("00:00:1")

Loop

The first line in the example above checks whether the file done.txt
exists. Change the path and file name as needed. If the file exists (Prism
is done), Visual Basic continues beyond the loop with any code that
follows. If the file doesn't exist yet, Visual Basic waits 1 second, and then
loops back to test again whether the file exists.

MacScript “tell application “”HD:Prism4:Prism””” + Chr(13) +
_

“quit” + Chr(13) + _

“end tell”

 
Run a script from AppleScript

Here is a sample AppleScript that launches Prism and tells it to run the
script named DR2 located in the P4scripts folder on a disk named HD.

tell application "HD:Applications:Prism4 Folder:Prism"
   activate
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   open file “HD:P4scripts:DR2.pzc”
end tell

Note that are two ways to specify the path. The example above uses a
HFS path. Here is the same example using a POSIX path.

 tell application "HD:Applications:Prism4 Folder:Prism"

   activate

   open POSIX file “/P4scripts/DR2.pzc”
end tell

With the Posix style, you use slashes (not colons) and must have the
opening slash.

 

18.5.3 Launching a Prism script from outside Prism (Windows)

One way to launch a script is from within Prism (drop the File menu and
choose Run Script). You can also launch a Prism script from outside
Prism. When you launch Prism this way, if the script closes all open Prism
files, then Prism will shut down when the script ends. Otherwise Prism will
remain open.

Launching a Prism script from a desktop icon

To create an icon that launches a Prism script, point your mouse to an
empty spot on the desktop, click the right mouse button and select New…
Shortcut. Enter a command line that starts Prism and points to the Prism
script file to launch. Include the @ symbol in front of the path to the
script name. If either path includes spaces, include the entire path in
quotes as shown below:

“C:\PRISM5\PRISM.EXE” @”C:\PROGRAM FILES\PRISM 6\SCRIPTS\DOIT.PZC”
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Shelling to Prism from another program

To "shell" simply means to launch one program from another. Here is an
example of a shell command in an Excel VBA macro.

Shell ("C:\prism 5\prism.exe @C:\prism 6\dr2.pzc")

The shell command has to specify both the full location of prism.exe and
the script that Prism will launch. Include the @ symbol in front of the
script name.

Two important notes:

· Prism will run invisibly. Even when it is done, Prism will not show on
screen.

· As soon as Visual Basic has launched Prism, it will continue to the next
statement in the Visual Basic program or macro. It will NOT wait for
Prism to complete before continuing. If you don't take the extra steps
described below, your Visual Basic program will try to read a file
containing Prism’s results before Prism has finished creating that file. To
avoid this, make your Visual Basic program pause until Prism creates a
file, as explained below.

When you write the Prism script, include lines at the end of the script to
create a file that will tell Visual Basic you are done. The example below
creates done.txt.

OpenOutput  "done.txt"
WText "done"
CloseOutput

Your Visual Basic code should first delete the file done.txt (if it exists from
a previous run) and then launch Prism. Immediately following, include
these lines that make your program loop until done.txt is created.

Do Until Dir$(“C:\prism 6\done.txt") > ""  
Application.Wait Now + TimeValue("00:00:1")
Loop

The first line in the example above checks whether the file done.txt
exists. Change the path and file name as needed. If the file exists (Prism
is done), Visual Basic continues beyond the loop with any code that
follows. If the file doesn't exist yet, Visual Basic waits 1 second, and then
loops back to test again whether the file exists.
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Launching Prism from another program using OLE automation

An alternative to the Shell command is to launch Prism using OLE (or
Active X) automation. Here is an example.

Set Prism = CreateObject("Prism.command")
Prism.SetPath (”C:\data\july99”)
Prism.visible
Prism.runcommand (“c:\prism5\doseresp.pzc")
Prism.quit
Set Prism = Nothing

The first line creates a Prism command object. You may give the object
variable any name you like (on the left side of the = sign), but it is
convenient to name it Prism. You don’t have to tell the program the
location of prism.exe. Windows takes care of this automatically via the
registry.

The second line, which is optional, tells Prism which folder to use. This
replaces the need for a SetPath statement within the Prism script. When
running a script, Prism looks for data files and templates in this directory
(folder) first. Place the name of the folder in quotation marks or use a
text variable. 

The third line tells Prism to show its progress dialog. Once you have
tested your code, remove this line so Prism will run invisibly (show no
dialogs).

The fourth line launches the Prism script. You must include the full path of
the script file; the directory used in the SetPath message (above) is not
used automatically.

The final two lines cause Prism to exit, and free the memory used by the
Prism object.

Shell command vs. VBA automation

There are two advantages to using OLE automation, rather than the Shell
statement. First, with OLE automation Visual Basic and Prism run
sequentially, with no possibility of Visual Basic trying to obtain results
that haven't been created yet. Second, with OLE automation, your Visual
Basic program can direct Prism to import data from a particular folder
(Prism.SetPath command) without changing the Prism script.

Launching a script from an intranet web page (Windows)

You can launch Prism from a link on an intranet web site.
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First, create a batch file on your web server that calls (using the Call
command) the program and individual configuration files.

For example, create a file called StartPrism.bat containing a single line
something like this

Call “N:\Program Files\PRISM5\PRISM.EXE” -OC:\WINDOWS\prism5.cnf

Or this:
Call F:\Prism\Prism.exe @"F:\PRISM\PRISMSCRIPTS\DOIT.PZC"

Of course, you'll need to adjust this example depending on where you
have installed Prism. The drive letters are aliases for the server drive. In
the first example, the first part opens Prism and the second part tells
Prism where to find the configuration file. In the second example, the
second part launches a Prism script.

Next edit your web page to include a hyperlink to the batch file. For
example, HTML link the text "Prism" to the file StartPrism.bat

18.5.4 Using Prism scripts with Excel

Exporting data from Excel to Prism

Although Prism can open Excel files, this is slow. Instead, write a Visual
Basic macro to export selected values as a text file. The macro below,
run from Excel, exports the upper left corner of worksheet 1 (12 rows, 6
columns) to a comma-separated value (CSV) file, which Prism can
import.

Open  "C:\data\july97\dr2.csv" For Output As #1
For I = 1 To 12
For J= 1 to 6
   Print #1, Worksheets(1).Cells(I,J).Value; ",";
Next
Write #1,
Next
Close #1

Follow this with code to launch Prism, run the Prism script, and perhaps
import results from Prism back to Excel.
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Creating a PZC (Prism script) file from Excel

While creating a system to run Prism from Excel, you need to edit both
the Excel VBA statements and the Prism PZC script. One way to simplify
your work is to write Visual Basic code that exports the PZC file from
Excel. Then you only have to edit one file. For example, you could use
the following VBA code:

Open  "C:\Prism4\auto.pzc" For Output As #1

Print #1, “Shortlog”

Print #1, “SetPath C:\gp\prism25\”

Print #1, “Open generate.pzm”

Print #1, “openOutput fit.txt”

Print #1, “   ForEach 500”

Print #1, “    GoTo R 1”

Print #1, “    Regenerate”

Print #1, “    GoTo R 2”

Print #1, “    WCell 5,1”

Print #1, “ Next”

Close #1

Shell ("C:\program files\prism5\prism.exe  @C:
\prism5\auto.pzc")

The first line starts a new file called auto.pzc and designates it as file
number 1. The next 10 lines, export Prism script commands you have
written into that file. The next line closes the script file, which is
launched by the final line shown above. Further lines would import the
results exported by Prism.

Putting all the commands into one file doesn't help conceptually. You still
have to distinguish the VBA code within Excel from the script commands
of Prism. The advantage is that you can do all the editing within one file,
rather than two. The disadvantage is that writing the script is a bit
harder, as you have to place each line in quotations and precede it with
"Print #1,".
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Putting Prism graphs into Excel

In addition to importing the results of Prism analyses, you may want to
import a Prism graph into Excel. Exporting the graph is no problem, as a
Prism script can export a graph or layout as a WMF picture. The problem
is importing it into Excel, as there is no way to write Visual Basic
commands to import a picture. You can do it indirectly. Create a picture
object manually in Excel (display the control toolbar, click on the image
button, then drag to create the object). Then write Basic code to change
the contents of that picture object. For example,

Sheet2.DRGraph.Picture = LoadPicture(Path$ + "dr2.wmf")

18.5.5 How long can a script be?

The maximum size of a script is not limited by number of lines, but rather
by number of characters. The limit is 64,000 characters. If you hit this
limit, consider removing comments and blank lines. Also consider
removing any parts of the script that are not needed. For example, most
script commands have default parameters and if these are correct, you
don't need to hard code parameters. 
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19 Standardizing Prism use in a lab

If many people in your lab use GraphPad Prism,

you may want to standardize some preferences or

provide all with a set of templates or equations or

color schemes. This section explains how to do so.
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19.1 Locking the preference file

What is included within the preferences file?

Prism offers many choices on its Preference dialog. It allows you to set
defaults for color schemes, fonts, symbols sizes, graph units, and more.
Beyond that, the Prism Preferences file remembers which files you have
recently opened or closed, user-defined equations you have created, color
schemes you have created, autocomplete text, and more. All that is
saved in a preference file that customizes Prism for you. 

Where is the preference file located?

Windows XP:

[system disk]:\Documents and Settings\[user] \Application data\GraphPad Software\Prism\7.0\Prism7.cfg

Vista and Windows 7-10:

[system disk]:\Users\[user]\AppData\Roaming\GraphPad Software\Prism\7.0\Prism6.cfg

Mac:

 ~[local user]\Library\Preferences\ com.GraphPad.Prism.plist

With older versions of OSX, you can locate the file using Finder and drag
it to the trash. Since Lion, the file is invisible. To delete it, launch the
Terminal application, and enter this command:

             rm ~/Library/Preferences/com.GraphPad.Prism.plist

How to prevent saving changes to the preferences file: Windows

When Prism is used in a teaching lab, you want Prism to startup the same
way each time. When a student uses Prism, you don't want preferences
set by other students to be used, as that would make it seem that Prism
acts unpredictably. 

The first step is to create and write-protect the preference file. 

1. Delete the Prism preference file, Prism6.cfg from:

   [system disk]:\Users\[user]\AppData\Roaming\GraphPad
Software\Prism\7.0  
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2. Launch Prism so it creates a default preference file.

3. Set any preferences as you want them to appear for each user.

4. Create any color schemes you want everyone to have access to, as well
as user-defined equations you want everyone to access.

5. Quit Prism. Now the preference file is saved.

6. You might wish to write-protect the preference file to make sure it isn't
changed in the future.

The second step is to add /C to the Prism command line , to tell Prism
not to resave the preference file when it exits.

Individual users will still be able to make changes to the Preference file,
and these will be used during that session. But those changes won't get
saved and so won't be seen by the next user.   

How to prevent saving changes to the preferences file: Mac

When Prism is used in a teaching lab, you want Prism to startup the same
way each time. When a student uses Prism, you don't want preferences
set by other students to be used, as that would make it seem that Prism
acts unpredictably. 

The method explained above for Windows doesn't work, because there
are no command line switches in OSX. Instead, create and write-protect
the preference file. 

1. Delete the Prism preference file, com.GraphPad.Prism.plist, from:

        ~[local user]:Library:Preferences   

2. Launch Prism so it creates a default preference file.

3. Set any preferences as you want them to appear for each user. Also
create any color schemes or user defined equations you want everyone
to access.

4. Quit Prism.

587
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5. Write protect the preference file:

Open the folder that contains the preference file 

    : ~[local user]:Library:Preferences

Beware that Macs have multiple Library folders. Pick the one within the
local user that each student will log in as, not the overall Library folder. 

Right-click on the file "com.GraphPad.Prism.plist", and choose Get Info.
Check "Locked".  

Repeat for the file that contains the list of autocomplete text entries: 
com.GraphPad.Prism.autocomplete.plist

19.2 Individual preference files

Prism stores the list of user-defined equations, choices from the 
Preferences  dialogs, the list of recently used files, and more in a
configuration file.

Prism Windows stores preferences in the file Prism6.cfg. Prism Mac stores
preferences in a file named “Prism6 Preferences”. The location of these
files depends on which version of Windows or the Mac OS you use, so
search for them.

If several people use the same Windows computer, each may wish to
maintain their own preferences and equations. To do this, create a
different shortcut icon for each user. In the target portion of the
properties dialog for the shortcut, enter the full path name of the Prism
program followed by “-O” (letter O, not zero) and then the full name of
the configuration file you want to use. If the file doesn't exist, Prism will
create it. For example:

C:\Program Files\PRISM7\PRISM.EXE -OC:\JERRYS\JSPRISM.CNF

If you are running a network license, you may place the Prism6.cfg file
into the program folder on the shared (server) drive. When Prism is first
used on a new computer, it will use the settings in this shared
configuration file. Changes will be saved on the individual user’s hard
drive. This means that all users can begin with the same settings, but
then customize them..

153
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19.3 Shared templates, methods, and examples

You can ensure that everyone using Prism sees the same templates ,
methods  and examples . Create them on one computer, and then
move the files to the other computers you manage. To do that, you need
to know where the files are stored.

Templates

Templates  are complete Prism files that you'll see listed on the Open
File tab of the Welcome dialog. You can tell Prism where to save
templates in the File Locations tab of the Preferences dialog. The default
locations are listed below. 

Prism saves templates in:

[[system disk]:\ProgramData\GraphPad Software\Prism\7.0\Templates\[templates category folder]

Prism Mac saves these files in:

Users/[User]/Library/Application Support/GraphPad/prism/7/Templates/[templates category folder]

 Methods

A method file  contains a data table and linked analyses and graphs.
When you apply a method, using the Wand (Wizard to Analyze Data),
those analyses and graphs are attached to a new data table.

 Prism saves methods in:

[system disk]:\ProgramData\GraphPad Software\Prism\7.0\Methods\[methods category folder]

Prism Mac saves these files in:

/Library/Application Support/GraphPad/prism/7/Methods/[methods category folder]

Examples

An example file is a Prism graph with linked data and analyses. You 
clone  an example from the Clone A Graph tab of the Welcome dialog. 

Saved examples

Prism Windows XP saves examples in:

[system disk]:\Documents and Settings\[User]\Application Data\GraphPad Software\Prism\7.0\Examples\[examples category folder] 
 

138

136 135

138

136

135



GraphPad Prism7 User Guide582

© 1995-2016 GraphPad Software, Inc.

On Vista or Windows 7, Prism saves examples in:

[system disk]:\Users\[User]\AppData\Roaming\GraphPad Software\Prism\7.0\Examples\[examples category folder]

Prism Mac saves these files in:

/Users/[User]/Library/Application Support/GraphPad/prism/7/Examples/[examples category folder]

Shared examples

The Welcome dialog cloning tab offers a separate tab for shared
examples. These are intended to be examples created in a lab to be
shared with everyone in a lab. The only way to show graphs on this tab is
to manually move filed from the saved example folder to the shared
example folder. 

On Windows XP, Prism looks for shared examples in:

[system_disk]:\Documents and Settings\All Users\Application Data\GraphPad Software\Prism\7.0\Examples\

On Windows Vista or Windows 7, Prism looks for shared examples in:

[system_disk]:\Users\All Users\GraphPad Software\Prism\7.0\Examples\

Prism Mac looks for shared examples in:

Library/Application Support/GraphPad/prism/7/Examples

Prism Mac also looks for shared examples within the application bundle: 

[Prism.app]/Contents/SharedSupport/Examples

Providing online Help for methods and templates

When you save the template or method, enter a brief description. If you
want to provide more extensive help to your users, also create a web
(.htm) file that explains use of the template or method. Give it the same
name as the template or method, but with the extension .htm, and place
it in the same folder. For example, if your template is doseresponse.pzt,
create a help file named doseresponse.htm. When someone uses the
template or method, Prism will pop up the dialog with the brief
instructions. This dialog also has a button “Help for this template”. When
your uses click this button, Prism will launch a web browser to display the
.htm file you created.
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19.4 Adding your own built-in equations

Prism makes it easy to add your own equations, and these will appear in
the "User defined equations" group of equations. But if you want to share
a set of user-defined equations with others in your lab, you can create a
new group of equations that will appear underneath the ones we provide. 

How to create new Equation files:

1. Start a new Prism project. Go to preferences, file and printer tab, and
make sure that you are saving in .pzf format and that the "Save
compact" option is not checked.

2. For each equation, either fit a data set with nonlinear regression or
simulate a theoretical curve (plot a function). Reorder the results pages
to the order you want the equations displayed in the equation list.

3. If a user picks your equation and clicks 'Details' they will see a small
preview of the graph that is linked to the equation. Make sure this
graph is easy to comprehend at small sizes.

4. When entering each equation, also consider entering a description and
tip. The tip appears on the Fit tab of nonlinear regression. The
description appears on the Details page.

5. When saving your equation, use a name something like this: "[Smith
Lab] Flow cytometry equations", so it is very clear to anyone using
Prism that these equations did not come from GraphPad (we won't be
able to answer questions about them).

6. Note that each file you create will become a "folder" of equations in
Prism. You'll want each file, therefore, to include several equations. 

How to make those equations appear with the list of built-in
equations:

· Windows: Move (or save) the files to the Equations folder within the
Prism program folder.

· Mac: Find the Prism.app file. Right (or control) click and choose Show
Package Contents. You'll see the "folders" within the package. Drill down
to Contents: SharedSupport:Equations. Move your equation files there.
Note that by changing the prism.app file (bundle) you have changed its
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digital signatures. So you'll need to configure Gatekeeper to let Prism
run anyway.

· Both platforms:  Please do not delete any equation files that came with
Prism. They are "built in" so should always be available (to prevent
confusion later).

If Prism is running, quit (exit) it, then restart it. You'll now see your list of
equations in the Fit tab of nonlinear regression.

Editing those equations is a bit tricky. Quit Prism, and move the file out of
the Equations folder. Now restart Prism, open the file and edit it. When
done, save your changes and quit Prism. Finally, move the file back to the
Equations folder, and restart Prism.

Don't worry about .pze files

For every "built-in" equation file, Prism creates a .pze file. These files
contain, essentially, compiled equations and so let Prism load the
equations more quickly. With Windows, you'll find these deep in the
Application Data folder. With Mac, they are deep in the Application
Support folder and also in the Cache folder in the Equations folder in the
Prism bundle. 

You don't need to manage these files, and shouldn't try to. Prism will
automatically create  and update the needed file when necessary.

19.5 Using a local LabArchives server

LabArchives usually uses a server maintained by LabArchives.

If you want to use a local server to host LabArchives files, you can do so.
Details here. 

http://graphpad.com/support/faq/how-to-configure-prism-to-communicate-with-a-local-labarchives-server/


Support and license 585

© 1995-2016 GraphPad Software, Inc.

20 Support and license

Prism makes it easy to get the support you need.

This section tells you about the Prism license

agreement and how to contact our support

department.
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20.1 Installing Prism

Installing for one person

Installing Prism is standard and easy. On Windows, simply run our
installation program. On a Mac, drag the Prism application file to your
Applications folder.

Installing for many people

We offer some shortcuts to help IT people installing Prism for many. Read
the details in this document: 

Installing GraphPad Prism 7 for Many - A guide for IT staff

20.2 System Requirements

Prism 7 for Windows runs under either the 32- or 64-bit versions of
Windows Vista, 7, 8 or 10.  Prism will run in a screen as small as 800 x
540. While it runs fine on 64 bit versions of Windows, it is a 32 bit
program. 

Prism 7 for Macintosh requires OS X 10.9 (Mavericks) or later. If you use
OS X 10.7 or 10.8, Prism will launch and seems to run ok but we haven't
tested Prism thoroughly on these versions of OS X and can't provide
much support.

Prism windows requires 60 megabytes of space on the hard drive. Prism
Mac requires 80 megabytes space. 

 

20.3 Fire wall settings

Prism tries to connect to the internet with every launch, and must
succeed at least every 30 days or 20 launches (whichever comes first) to
conform the validity of the license. Once it hits those limits, it displays:

http://cdn.graphpad.com/docs/prism/How-to-Install-Prism-A-Guide-for-IT-people.pdf
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"You are currently offline. Prism must connect to the internet at least
once every 30 days to validate your license. Please connect to the
internet and launch Prism again."

If you are getting this message even though you computer is connected
to the internet, perhaps you have a firewall that prevents Prism from
communicating with the internet. Prism uses port 443, which is the same
port that web browsers use when browsing securely (https:), but it is
possible that your IT people configured your firewall so that web browsers
(and email programs...) but not Prism can use that port. If that is the
case, they will need to change the firewall settings. 

20.4 Command line switches (Windows only)

When Prism starts up, you can give it some special instructions in the
command line. In order to add command line instructions, edit the
Prism.exe start icon. Right click on the Prism desktop icon and In
Properties change the target to add the command after the last quote
mark. Leave a space between the quote mark and the slash, so the target
looks like this:

"C:\Program Files\GraphPad\Prism5\prism.exe" /U

You can use hyphens or slashes (-U and /U) interchangeaby. 

All of the options shown below also work if you use the Shell command to
launch Prism from another program using Visual Basic for Applications
(VBA).

These options only work on Windows. There is no similar mechanism for
sending startup commands to Mac applications.

Run prism script - @[some_prism_script_file_path]

To create an icon that launches a specific Prism script, point your mouse
to an empty spot on the desktop, click the right mouse button and select
New… Shortcut. Enter a command line that starts Prism and points to the
Prism script file to launch. Include the @ symbol in front of the path to
the script name. If either path includes spaces, include the entire path in
quotes as shown below:

"C:\Program Files\GraphPad\Prism5\prism.exe" @"c:\program files\GraphPad\Prism5\scripts\doit.PZC"

Turrning off check for update - /U
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When Prism (Windows) first starts, it tries to check for updates via the
web. If it can't connect, it normally just keeps going. But in very rare
cases, it tries to check for updates and then can't get past this step so
never gets to the Welcome dialog. This is quite rare, but easy to work
around. One way to get Prism to stop check for updates is to use the /U
switch when starting Prism.

Edit the Prism start icon so that the target looks something like this (with
quotes around the path, but not around the /U, and a space beteween the
quotation mark and the slash):

"C:\Program Files\GraphPad\Prism5\prism.exe" /U

Create startup log  - /L

If Prism will not start at all, it can help to create a start log. This will show
us which steps Prism completes successfully and which steps fail. To
create a start log, edit the Prism start icon to add the /L switch so the
target looks looks something like this (with quotes around the path, but
not around the /L, and a space between the quotation mark and the
slash):

"C:\Program Files\GraphPad\Prism5\prism.exe" /L

Regenerate PZE files (prism equations cache) - /E

The "built-in" equations are actually installed as a set of Prism files. You
can even add your own "built-in" equations. The first time Prism runs, it
compiles these equations to a form (.PZE files) that it can access and
compute very quickly. It should never be necessary, but you can force
Prism to compile all the equations again. To do so, edit the Prism start
icon to add the /E switch so the target looks something like this (with
quotes around the path, but not around the /E, and a space beteween the
quotation mark and the slash):

"C:\Program Files\GraphPad\Prism5\prism.exe" /E

Print file - /P [file_path]

You can create an icon that will open a Prism file and print all pages. Edit
the Prism start icon to add the /P switch so the target looks like this.
Please note space between /P and [file_path]. Prism prints silently,
without Prism appearing in the taskbar.

"C:\Program Files\GraphPad\Prism 6\prism.exe" /P c:\test.pzf
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Use custom option file  - /O [prism_cfg_file_path]

Prism stores many settings in a preference file (also called an options
file). This file contains all the settings in the Preferences dialog, a list of
recently used files, user-defined equations, color schemes and more. You
can use a startup option to force Prism to access the preferences file from
a different location. This might be useful if you use Prism for several very
distinct uses, and want a separate set of preferences for each. It would
also be useful if different people use Prism, and each wants unique
preferences, but they all want to log in to Windows as the same User. To
tell Prism to use a unique preference file, edit the Prism start icon to add
the /O switch so the target looks like this. Please note the space
between /O and [file_path].

"C:\Program Files\GraphPad\Prism 6\prism.exe"  /O c:\gsconfig.cfg

Don't save preferences - /C  

Prism stores many settings in a preference file (also called an options
file). This file contains all the settings in the Preferences dialog, a list of
recently used files, user-defined equations, color schemes and more. You
can use a startup option to tell Prism to not save any changes to the
preferences file. This is useful in a teaching lab, or a shared computer, so
Prism will always start with the same preferences.

"C:\Program Files\GraphPad\Prism 6\prism.exe" /C

 

20.5 Technical support

Check for program updates

Like all software companies, GraphPad occasionally issues minor updates
to Prism. The full version number is not on the CD. Instead, drop the Help
menu and choose ‘Check for updates’. 

Check for answers on graphpad.com

If you can’t find the answers in these help screens, please visit our 
support web site. We update the Quick Answers database almost every
week, and the answer to your question is very likely to be there.

Personal support

http://www.graphpad.com/support


GraphPad Prism7 User Guide590

© 1995-2016 GraphPad Software, Inc.

Drop the Help menu and choose Personal support command. Prism will
instruct your email program to create a new email, automatically
including your version and serial number, and attaching (if you choose)
the file you are working on.

If the Personal support command does not work on your computer (or you
use a Mac) email us at support@graphpad.com . 

Please send:

· The version of Prism you are running and if you are using Prism for
Windows or for Mac. To find the version number, drop the Help menu
(Windows) or Prism menu (Mac OS X) and choose About Prism.
Windows versions have two digits after the decimal point (i. e. 7.01).
Mac versions have a single digit after the decimal followed by a letter (i.
e. 7.0b). Send us the actual version number (which you can see on the
Welcome dialog when you start Prism. Don't say something ambiguous
like "Prism 7" or "the latest version". 

· In most cases, a problem is best demonstrated by attaching a particular
project (.pzf) file to your email. Please make the project small and
focussed. If you are having a problem with one graph, send us a project
with one graph, not 100. 

· If you saw an error message, send us a screen shot or the exact
wording you saw. 

· Send screen shots when that would help us understand the problem.

· Don't send raw data in the text of the email and expect us to paste this
into Prism, reproduce what we think you might have done, and then
comment on what we see which may or may not be what you see.
Similarly don't send data in Excel files. 

We provide support for Prism, not statistical consulting

Your Prism license does not include free statistical consulting. Since the
boundary between technical support and statistical consulting is often
unclear, we often will try to answer simple questions about data analysis.
But don't push your luck! While we are often willing to look over a
completed analysis to offer our thoughts, we won't analyze your data for
you.

mailto:support@graphpad.com
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No phone support

We've discovered that we can provide much better support by offering it
via email only. We know that some companies use "email only" as a way
to brush off customers and avoid providing support. We are not like that.
We really do provide individual, helpful answers to your email questions,
often within an hour or two.

GraphPad doesn't offer telephone support for several reasons.

· Our customers live all around the world, but we're only here during
business hours on the West coast.

· When we return your phone call, you might be at lunch, away from your
desk, or gone for the day. If we leave a message, it might start a round
of telephone tag that could last for days.

· We often consult with contract programmers in a different country
before answering questions.

· It is difficult to describe graphing and analysis problems on the
telephone. When you email us a question, you can attach your Prism
files, exported images, or screenshots of error messages. This helps us
figure out the problem and provide helpful solutions. 

· In many cases, our answers contain screen shots or links to pages on
our web site. Trying to relay a URL via telephone doesn't work very well.

· We keep a record of problems and solutions. When you receive a email
from us, you can always refer back to it -- even weeks or months later.
And we can keep a record of the questions you asked and whether or
not we solved your problems. We use these records to help others with
similar questions, and to help design new versions of our software.

· We often answer emails while traveling or from home. This lets us
answer much more promptly than we could by phone.
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20.6 How to cite GraphPad Prism

Citing Prism

When citing analyses performed by the program, include the name of the
analysis, and Prism version number (including the second number after
the decimal point). Use this example as a guide:

“One-way ANOVA followed by Dunnett’s multiple comparisons test was
performed using GraphPad Prism version 7.00 for Windows, GraphPad
Software, La Jolla California USA, www.graphpad.com”.

To find the full version number, pull down the Help menu (Windows) or
the Prism menu (Mac OS X). Then choose About Prism.

It is more important to explain which analysis choices you made than
which program you used. For example, it doesn’t really help to say you fit
a curve with Prism if you don’t say which equation you selected, how you
chose to weight data points, whether you fixed any parameters to
constant values, etc.

Citing a page in the user's guide or an FAQ

 Include the name of the page, the date you accessed it and the URL. Use
this example as a guide:

"What you can conclude when two error bars overlap (or don't)?"
GraphPad Software, Inc.  Accessed 5 November 2008.  
http://www.graphpad.com/faq/viewfaq.cfm?faq=1362

 Citing the QuickCalc free web calculator

Include the name of the calculator and the date you used it. Here is an
example:

Confidence intervals of proportions were calculated using the GraphPad
QuickCalcs Web site:
http://www.graphpad.com/quickcalcs/ConfInterval1.cfm (accessed
November 2015).
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20.7 GraphPad Prism license agreement

PLEASE READ CAREFULLY:  GRAPHPAD SOFTWARE, INC. ("GRAPHPAD") IS WILLING
TO LICENSE THE SOFTWARE IDENTIFIED ABOVE ONLY UPON THE CONDITION THAT
YOU ACCEPT ALL OF THE TERMS CONTAINED IN THIS SOFTWARE LICENSE
AGREEMENT (THE "AGREEMENT").  BY CHECKING  "I AGREE TO THE GRAPHPAD
LICENSE AGREEMENT" ON THE ACTIVATION DIALOG, OR BY INSTALLING, UPLOADING,
ACCESSING OR OTHERWISE USING ALL OR ANY PORTION OF THE SOFTWARE, YOU
AGREE TO BE LEGALLY BOUND BY THIS AGREEMENT.  IF YOU ARE AGREEING TO
THESE TERMS ON BEHALF OF A COMPANY OR OTHER LEGAL ENTITY, YOU REPRESENT
THAT YOU HAVE THE LEGAL AUTHORITY TO BIND SUCH ENTITY TO THESE TERMS,
AND ALL REFERENCES TO "YOU" SHALL APPLY TO SUCH ENTITY.  IF YOU DO NOT
HAVE SUCH AUTHORITY, OR IF YOU DO NOT WISH TO BE BOUND BY THE TERMS OF
THIS AGREEMENT, THEN DO NOT INSTALL, UPLOAD, ACCESS OR OTHERWISE USE THE
SOFTWARE.

DEFINITIONS.  "Software" means the computer program identified above, and in which
this Agreement is embedded, and any updates or error corrections thereto provided by
GraphPad.  "Computer" means computers, including desktop or laptop computers, or
file servers, used for general computing functions (such as, but not limited to, word
processing, e-mail, general purpose Internet browsing and office suite productivity
tools).  "Authorized Number of Computers" means the number of Computers that the
Software may be loaded as shown by the quantity of licenses purchased by you as
indicated on your invoice for the Software. "You" means you personally if you license
the Software for yourself, or the company or other legal entity for which you license the
Software (but not the affiliates, subsidiaries or other related legal entities of such
company or legal entity).

LICENSE AND TERM.  Subject to the terms and conditions of this Agreement, GraphPad
grants to you a nonexclusive, nontransferable, limited license to install and use the
Software. The term of the license depends on what you downloaded or purchased. 

(a) The free trial (demo) license may be used for a period of 30 days from the date that
you receive it. After that, it may be used to view (but not edit) Prism files. Any attempt
to defeat the time-control disabling function in the Software is a material breach of this
Agreement and a violation of intellectual property law.

(b) A perpetual license does not expire, and may only be terminated by GraphPad if you
violate the terms of this Agreement. Upgrades to newer versions are not included. Each
perpetual license may be installed on one computer. If that computer is used
exclusively by one person and not shared with others, then that person may also install
the Software on a second computer, also used exclusively by him or her.

(c) A personal subscription lasts for the period of time for which you subscribed as
indicated on your invoice for the Software, and may only be earlier terminated by
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GraphPad if you violate the terms of this Agreement. A personal subscription may be
installed and activated twice, on computers used solely by the subscriber.  Upgrades to
newer versions during the term of the license are included. You acknowledge that (i)
your right to install and use the Software is limited to the term of your subscription, (ii)
the Software is designed to cease to function upon expiration of the term of your
subscription if the subscription is not renewed, and (iii) you may generally renew your
subscription, but the terms upon which the Software may be licensed upon a renewal
are subject to change by GraphPad at its sole discretion.  Any attempt to defeat the
time-control disabling function in the Software is a material breach of this Agreement
and a violation of intellectual property law. 

(d) A group subscription license lasts for the period of time for which you subscribed as
indicated on your invoice for the Software, and may only be earlier terminated by
GraphPad if you violate the terms of this Agreement.  Your subscription is to activate
the software on an authorized number of computers. Upgrades to newer versions
during the term of the subscription are included. You acknowledge that (i) your right to
install and use the Software is limited to the term of your subscription, (ii) the Software
is designed to cease to function upon expiration of the term of your subscription if the
subscription is not renewed, and (iii) you may generally renew your subscription, but
the terms upon which the Software may be licensed upon a renewal are subject to
change by GraphPad at its sole discretion.  Any attempt to defeat the time-control
disabling function in the Software is a material breach of this Agreement and a violation
of intellectual property law.

USE OF PRIOR VERSIONS IF YOU UPGRADED. If you purchased your license as an
upgrade from a prior version, you not transfer your license for the prior version to
another computer or to anyone else. 

INSTALLATION AND USAGE.  You may install and use the Software on up to the
Authorized Number of Computers.  THIS IS NOT A CONCURRENT USER LICENSE.  The
Authorized Number of Computers includes each Computer that at any time is or has
been given access to the Software, regardless of whether such Computer is running the
Software at a particular point in time.

AUDITS.  To ensure compliance with this Agreement, you agree that upon reasonable
notice, GraphPad or GraphPad’s authorized representative shall have the right to
inspect and audit your use of the Software.  Any such inspection or audit shall be
conducted during regular business hours at your facilities or electronically, either by
GraphPad or by representatives authorized by GraphPad for this purpose. If such
inspections or audits disclose that you have installed or permitted access to the
Software in a manner that is not permitted under this Agreement, then (i) you are liable
to pay for any unpaid license fees as well as the reasonable costs of the audit; and (ii)
the license grant with respect to the Software will terminate immediately. Any
information obtained by GraphPad or GraphPad’s authorized representative during the
course of such inspection and audit will be used and disclosed by GraphPad solely for
purposes of such inspection and audit and for enforcement of GraphPad’s rights under
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this Agreement and applicable law, unless other uses or disclosures are required under
applicable law. Nothing in this Section shall be deemed to limit any legal or equitable
remedies available to GraphPad for violation of this Agreement or applicable law.

MANDATORY ACTIVATION AND LICENSE CONFIRMATION. Activation associates the
use of the software with a specific computer. You must activate Prism before using it
the first time. Prism will confirm the activation each time you launch it. During
activation (and activation confirmation), the software will send information about the
software and the device to GraphPad. This information includes the version, the serial
number, the Internet protocol address of the device, and information derived from the
hardware configuration of the device.  BY USING THE SOFTWARE, YOU CONSENT TO
THE TRANSMISSION OF THIS INFORMATION. UNLESS THE SOFTWARE IS ACTIVATED,
YOU HAVE NO RIGHT TO USE THE SOFTWARE. This is to prevent its unlicensed use.
YOU ARE NOT PERMITTED TO BYPASS OR CIRCUMVENT ACTIVATION. You must
activate every computer from which Prism is used.

GENERAL RESTRICTIONS.  You agree and acknowledge that, unless enforcement is
prohibited by applicable law (and then only to the extent prohibited by applicable law),
the following actions are expressly prohibited:

(a) You may not (and may not permit any third party to) decompile, disassemble or
reverse engineer the Software.

(b) You may not modify, translate, adapt, arrange or create derivative works of the
Software or the User Documentation.

(c) You may not sell, transfer, rent, lease, loan, or otherwise distribute all or any portion
of the Software, the User Documentation or any other rights granted to you in this
Agreement.

(d) Except as otherwise expressly provided in this Agreement, you may not allow access
to the Software or the User Documentation over the Internet, including, without
limitation, in connection with a web hosting, commercial time sharing, service bureau,
or similar service.

(e) You may not remove, alter or obscure any copyright or other proprietary notices,
labels or marks from the Software or the User Documentation.

(f) You may not otherwise install, access or otherwise use or copy the Software or the
User Documentation other than in strict compliance with the terms of this Agreement.

(g)You may not use the Software in medical diagnosis or treatment, or in applications
or systems where the Software's failure to perform can reasonably be expected to
result in significant physical injury, property damage, or loss of life.  

(h) You may not attempt to to reduce the number of licenses that you need by use
multiplexing or pooling (hardware or software to pool connections, reroute
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information, or reduce the number of devices or users that directly access or use the
software).

(i) You may not install the Software on network servers, and may not use any kind of
remote access software to control and view the software running on one computer from
another computer or terminal.

ALL RIGHTS RESERVED.  Title to and ownership of the Software, the User
Documentation and all related intellectual property are retained by GraphPad.  The
Software is confidential and the Software and the User Documentation are copyrighted.
 The Software and the User Documentation are licensed to you, not sold.  All rights of
every kind that are not expressly granted to you in this Agreement are entirely and
exclusively reserved to GraphPad.

LIMITED WARRANTY.  GraphPad warrants that, as of the date on which the Software is
delivered to you and for thirty (30) days thereafter, the Software will provide the
features and functions generally described in the User Documentation and that the
media on which the Software is furnished, if any, will be free from defects in materials
and workmanship under normal use.  Except for the foregoing, the Software and the
User Documentation are provided "AS IS."  All warranty claims must be made during
such thirty (30) day period.  GraphPad’s entire liability and your exclusive remedy will
be, at GraphPad’s option, to attempt to correct or work around errors, to replace the
defective media on which the Software is furnished, if any, or to refund the license fees,
if any, paid by you and terminate this Agreement.  

DISCLAIMER OF WARRANTY.  EXCEPT AS SPECIFIED IN THIS AGREEMENT, GRAPHPAD
MAKES, AND YOU RECEIVE, NO WARRANTIES, EXPRESS OR IMPLIED WITH RESPECT
TO THE SOFTWARE AND THE USER DOCUMENTATION.  ANY STATEMENTS OR
REPRESENTATIONS ABOUT THE SOFTWARE AND ITS FUNCTIONALITY IN THE USER
DOCUMENTATION OR ANY COMMUNICATION WITH YOU CONSTITUTE TECHNICAL
INFORMATION AND NOT AN EXPRESS WARRANTY OR GUARANTEE.  IN ADDITION,
GRAPHPAD SPECIFICALLY DISCLAIMS ANY OTHER WARRANTY INCLUDING, WITHOUT
LIMITATION, THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE, AND NONINFRINGEMENT.  WITHOUT LIMITING THE
FOREGOING, GRAPHPAD DOES NOT WARRANT THAT THE OPERATION OF THE
SOFTWARE WILL BE UNINTERRUPTED OR ERROR FREE.  SOME JURISDICTIONS DO
NOT ALLOW LIMITATIONS ON IMPLIED WARRANTIES, SO THE FOREGOING MAY NOT
APPLY TO YOU.  THIS LIMITED WARRANTY GIVES YOU SPECIFIC RIGHTS.  OTHER
RIGHTS, WHICH VARY FROM JURISDICTION TO JURISDICTION, MAY APPLY TO YOU. 

LIMITATION OF LIABILITY.  IN NO EVENT SHALL GRAPHPAD HAVE ANY LIABILITY FOR
ANY INCIDENTAL, SPECIAL, INDIRECT, OR CONSEQUENTIAL DAMAGES; LOSS OF
PROFITS, REVENUE, OR DATA; BUSINESS INTERRUPTION, OR COST OF COVER.  IN
ADDITION, IN NO EVENT SHALL THE LIABILITY OF GRAPHPAD FOR ANY DAMAGES
ARISING OUT OF OR IN CONNECTION WITH THE SOFTWARE, USER DOCUMENTATION,
OR THIS AGREEMENT EXCEED THE AMOUNT PAID OR PAYABLE BY YOU FOR THE
SOFTWARE.  THE LIMITATIONS OF LIABILITY IN THIS SECTION SHALL APPLY TO THE
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MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW TO ANY DAMAGES, HOWEVER
CAUSED AND REGARDLESS OF THE THEORY OF LIABILITY, WHETHER DERIVED FROM
CONTRACT, TORT (INCLUDING, BUT NOT LIMITED TO, NEGLIGENCE) OR OTHERWISE,
EVEN IF GRAPHPAD HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES AND
REGARDLESS OF WHETHER THE LIMITED REMEDIES AVAILABLE HEREUNDER FAIL OF
THEIR ESSENTIAL PURPOSE. 

EXPORT REGULATIONS.  All Software and User Documentation delivered under this
Agreement are subject to United State export control laws and may be subject to export
or import laws and regulations of other countries.  You agree not to export the Software
or the User Documentation in violation of United States or other applicable export
control laws.

U.S. GOVERNMENT RESTRICTED RIGHTS.  If the Software is being acquired by or on
behalf of the United States government or a United States government prime contractor
or subcontractor, the Software and the User Documentation are provided with the same
commercial license rights as are described elsewhere in this Agreement.

GOVERNING LAW.  This Agreement shall be governed by and construed and enforced in
accordance with the laws of the State of California, U.S.A. without giving effect to the
conflict of laws principles thereof, excluding the UN Convention on Contracts for the
International Sale of Goods.

ENTIRE AGREEMENT.  This Agreement sets forth the entire understanding of you and
GraphPad relating the subject matter hereof and supersedes any and all other previous
or contemporaneous communications, agreements, representations, warranties or
advertising with respect to the Software and User Documentation.

SEVERABILITY.  The invalidity or unenforceability of any provision of this Agreement
shall not affect the validity or enforceability of any other provision of this Agreement.  If
any provision of this Agreement shall be held invalid or unenforceable in part, the
remaining portion of such provision, together with all other provisions of this
Agreement, shall remain valid and enforceable and continue in full force and effect to
the fullest extent consistent with law.

NO WAIVER.  No term or provision hereof will be considered waived, and no breach
excused, unless such waiver is in writing signed on behalf of the party against whom
the waiver is asserted. No waiver (whether express or implied) will constitute a
consent to, waiver of, or excuse of any other, different, or subsequent breach.

LANGUAGE.  The English language version of this Agreement is legally binding in case
of any inconsistencies between the English version and any translations.

20.8 Training

If you would like an on-site course in using GraphPad Prism, we
recommend that you contact Star Training Service. Jimmy Walker has
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presented hundreds of courses in Prism to pharmaceutical companies
around the world, and receives rave reviews. His courses are informative
and fun, and appeal to both new and experienced users.

Email jimmy@startrain.com, or call 415-893-1835.

Star Training Service is completely independent of GraphPad Software.

mailto:jimmy@startrain.com
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Index
- 5 -
5 number summary     345

- A -
Adding a new data table     175

Adding comments to a script     544

Adding data to graph     313

Adding pictures     497

Adding text     492

Adding text with Word     495

Additional gridlines     437

Additional ticks     437

Aligning objects     500

Alignment guides     500

alpha channel     513

Analysis chains     154

Analysis constants, hooking     267

Analysis parameters     263

Analyze dialog     259

Analyzing data, analysis constants     267

Analyzing data, chaining analyses     262

Analyzing data, changing inputs and choices     263

Annotating graphs and layouts     150

Annotating graphs and layouts, highlighting     151

Annotating graphs and layouts, lines and boxes    
495

Annotating graphs and layouts, text     492

Antilog transform     292

AppleScript     569

Apply button     315, 316

ApplyColorScheme command     548

Arithmetic series, inserting     185

Arranging objects     500

Arrows     495

Assigning graphs to a layout     480

Audio notes     150

Autocomplete     194, 198

Automatic backups     121

Automating with scripts     541

Automating work     267

Automator     569

Autosave (Mac)     111

Axes origin     475

Axes, logarithmic     458

Axes, offsetting     471

Axis limits     427

Axis numbering     428

Axis of bar graph     343

Axis titles     443

Axis, hiding     432

- B -
Backing up Prism projects     121

Backup preferences     153

Backups     121

Bar graphs, don't use log Y axis     461

Bar graphs, which table?     176

Baseline of bar graph     343

Baseline, removing     297

Batch processing. Prism Magic.     317

Beep command     565

Blue italics -- outliers     203

BMP, importing     497

box and whisker plot     345

Box and whiskers     351

Box around graph     471

Boxes     495

boxplot     345

Bring to back     500

Bring to front     500

- C -
Cadmus     513

Center on page     469

Chained analyses     154

Chaining analyses     262

Change all data sets     315

Changing a data table format     189

Changing analyses     263

Changing decimal places on data table     202

Changing graph type     313

Changing subcolumns on data table     189

Changing X to Y     300

Characters     497

Choose colors     334

Circles     495
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Citing Prism     592

Clear     334

Clear background     520

ClearTable command     548

Clone a graph     135

Cloning a layout     479

Close command     550

CloseOutput  command     559

CMYK     334

CMYK vs. RGB     516

Color code cells     151

Color models     516

Color schemes     330

Colors, choosing     334

Column data tables     167

Column math     297

Column titles     194

Column wdiths     202

Combining projects     123

Command line switches     587

Commands, scripting     542

Comments, addiing to a script     544

Compatibility between Prism and other programs    
120

Compatibility between Prism versions     120

Compressed format     118

Constants, hooking analysis constants     267

Contingency data tables     171

Contract     593

Control space shortcut     208

Copy and paste     523

Copy command     553

Copying between projects     123

Copying problems     153

Courses in Prism     597

Create series     185

Createlog command     565

CSV files, importing     238

Ctrl key shortcut     208

Ctrl-space shortcut     208

Custom colors     334

Custom ticks     437

- D -
Data analysis     262, 263

Data objects, changing     226

Data objects, creating     242

Data sets on graph     313

Data table, decimal places     202

Data tables - changing the format     189

Data tables - Column     167

Data tables - Contingency     171

Data tables - Grouped     169

Data tables - Parts of whole     174

Data tables - starting or duplicating     175

Data tables - Survival     172

Data tables - Which one for a bar graph     176

Data tables - XY     165

Data tables vs. projects     175

Data tables, column titles     194

Data tables, excluding values     203

Data tables, key concepts     162

Data tables, printing     528

Data tables, row titles     198

Data tables, sorting     200

Data, pasting from Excel (Mac)     235

Data, pasting from Excel (Windows)     233

Data, pasting from text files     238

Data+results folder     154

Date axes     448

Decimal places     202

Decimals, rounding     209

Decimating rows     301

Default preferences     153

Del key shortcut     208

DeleteAllDataSets command     548

Deleting data from graph     313

Deleting sheets     143

Depth charts     485

Dictated notes     150

Directories  of templates, methods and example
files     581

Discontinuous axis     434

Displays, using two     105

donut charts     422

Dragging graph to layout     482

Drawing     495

Duplicate family     134

DuplicateDataTable command     546

DuplicateFamily command     546

Duplicating a data table     175

- E -
Elapsed time     446
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Electronic notebook     125

ELN     125

Emailing files     124

Embedding and linking data     226

Embedding and linking, data objects     242

Embedding fonts     517

Embedding results     265

Embellishing a graph     495

EMF or WMF format     523

EMF vs. WMF     153

EMF, exporting     506

EndTable command     557

Enter key shortcut     208

EPS files and fonts     517

EPS, exporting     506

Equations, adding to graph     497

Equations, adding your own set     583

Error bars on Column graphs     215

Error bars on Grouped graphs     216

Error bars on survival graphs     218

Error bars on XY graphs     213

Error bars, choosing     351

Error bars, horizontal     223

Example graphs     135

Examples, saving in a lab     581

Examples, scripting     534

Excel files, importing     239

Excel, working with (Mac)     235

Excel, working with (Windows)     233

Exchanging X and Y values     292, 300

Excluding outliers     203

Excluding values     203

Export graphs and layouts     506

ExportBMP command     555

ExportEPS command     555

Exporting files     126

Exporting graphs and layouts     521

Exporting multiple sheets     144

ExportJPG command     555

ExportPCX command     555

ExportPICT command     555

ExportPNG command     555

ExportTable command     557

ExportTIF command     555

ExportWMF command     555

- F -
Families of related sheets     154

Family folder     154

Family of sheets, duplicating     134

FAQ, tech support     589

Fence, inner     345

File formats     118

File locations     153

File locations, templates, methods, examples     581

Files, format compatibility     120

Files, sending     124

Fire wall     586

five number summary     345

Flipping - transposing - a data table     300

Flipping error bars to horizontal     223

Flipping pages. Landscape vs. portrait     318

Floating notes     150

Folders of templates, methods and example files    
581

Font, changing     492

Fonts in EPS files     517

Fonts on graphs     329

Fonts, embedding     517

ForEach command     545

Format Axes     471

Format Axis dialog     316

Format Graph dialog     315

Format graph, Column     368

Format graph, Grouped     387

Format graph, XY     351

Fraction of total     303

Frame of graph     471

Freezing a sheet     147

Freezing results     264

Freezing sheets     264

Front-to-back order of data sets     356

Frozen results     264

FTP     526

Full screen     109

- G -
Gallery, printing from     527

Gallery, view and choose sheets     101

Gallery, working with multiple sheets     144
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Gaps in axis     434

Generate a series of X values     185

Geometric series, inserting     185

Getting around     100

Getting started     11

Global changes     315

GoTo command     542

Grand mean     404

Grand median     404

Graph faster     361

Graph frame     471

Graph legends     488

Graph origin     475

Graph paper, making     473

Graph shape     322

Graph size     322

Graph tooltips     102

Graph type, changing     313

Graph, adding to layout     482

Graphics, importing     497

Graphing, use column titles     194

Graphing, use row titles     198

Graphs, cloning     135

Graphs, exporting to file     506

Graphs, exporting to Word or PowerPoint     521

Grid lines, equally spaced on axis     473

Grids, for alignment     500

Grouped data tables     169

Grouping     500

Guides, for alignment     500

- H -
Hardware requirements     586

hh:mm:ss     446

Hidden toolbars     104

Highlight cells     151

Highlighting sheets     151

Hooking analysis constants     267

Horizontal error bars     223

Horizontal vs. vertical graphs     318

- I -
Import command     551

Importing Excel files     239

Importing options, filter     245

Importing options, info & notes     250

Importing options, placement     249

Importing options, source     242

Importing options, view     244

Importing text files     239

ImportLink command     551

Individual replicates, plotting     221, 351

Info sheets     147

Inner fence     345

Insert and maintain link to data objects     242

Insert data only     242, 244

Insert object     523

InsertData command     552

InsertDataLink command     552

Inserting pictures and objects     497

Instances. Open multiple.     105

- J -
JPEG, exporting     506

JPG, importing     497

- K -
Key concept - data tables     162

Key concept - linking and embedding data     226

Keyboard shortcuts     208

- L -
Lab Archives     125

Lab notebook     125

LabArchives     125

LabArchives server     584

Landscape vs. portrait     318

Landscape vs. portrait. Graphs.     529

Landscape vs. portrait. Tables     528

Launching scripts Excel     574

Launching scripts from outside of Prism     571

Launching scripts using MacScript, Automator, or
AppleScript     569

Launching two instances     105

Layout legends     488

Layout tooltips     102

Layout, adding anther graph     482

Layouts     480

Layouts, creating     479
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Layouts, exporting     521

Layouts, exporting to file     506

Learning Prism     11

Left panel, navigator     100

Legends     488

License agreement     593

Limits of axis     427

Line of identity     363

Lines     495

Link     523

Linked analyses     154

Linking and embedding data     226

Linking and embedding, data objects     242

Locking a sheet     147

Locking a table, freezing     264

Locking in position     500

Log axes     458

Log transform     292

- M -
Mac differences, no OLE     523

Mac vs. Windows     97

Mac vs. Windows, compatibility     120

Macros, scripts     541

MacScript     569

Magic, Make graphs consistent     317

Magnifier     103

Major ticks     431

Make Graphs Consistent     317

Managing sheets     143

Master legends     488

Merging     123

Method file     136

Method vs. template     139

Methods, applying     136

Methods, saving in a lab     581

Microsoft Equation Editor     497

Microsoft Excel files, importing     239

Microsoft Excel, pasting data from (Mac)     235

Microsoft Excel, pasting data from (Windows)    
233

Microsoft Office     523

Microsoft Office, sending to     153

Minor ticks     431

Missing toolbars     104

Monitors, using two     105

Monte Carlo analysis     286

Monte Carlo simulations     278

Monte Carlo simulations with scripts     536

Moving between sheets     100

Moving graphs     123

Moving objects     500

Multiple graphs, exporting     506

Multiple graphs, on layout     480

Multiple sheet selection     144

- N -
Navigator     100

Navigator tooltips     154

Next     545

NextRow command     557

Nonspecific, subtracting     297

Normalizing     299

Notebook, LabArchives     125

Notes, floating     150

Nudging, XY graphs     360

Numbering of axis     428

Numbers, rounding     209

- O -
Object     523

Objects     500

Objects, importing     497

Office     523

Offset axes     471

Offsetting or nudging data sets     360

OLE     523

One-click export     521

One-grouping variable tables     167

Open command     550

OpenOutput command     557, 559

Options     153

Options, saving     118

Order of rows in data tables     200

Orientation of graphs     529

Orientation of tables when printed     528

Origin of graph     475

Orphaned results     264

Outliers     203

Outliers, generating     278

outliers, in box-and-whisker plots     345
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- P -
Page layouts     480

Page layouts, creating     479

Parameters dialog, returning to     263

parts of whole graphs     422

Parts of whole tables     174

Paste command     553

Paste link     523

Paste special     523

Paste special options, filter     245

Paste special options, info & notes     250

Paste special options, placement     249

Paste special options, source     242

Paste special options, view     244

Pasting data from Excel (Mac)     235

Pasting data from Excel (Windows)     233

Pasting data from files     238

PCX, importing     497

PDF, exporting     506

Percentage of total     303

Phone support, why we don't offer     589

PICT, exporting     506

PICT, importing     497

Pictures, importing     497

pie charts     422

Ping pong button     154

Placing a graph in a layout     480

PNG, exporting     506

PNG, importing     497

Pointers     89

Portrait vs. landscape     318

Portrait vs. landscape. Graphs.     529

Portrait vs. landscape. Tables.     528

Positioning     500

Posters     480

Posters, printing     529

PowerPoint     523

PowerPoint, sending to     153

PowerPoint. One-click export to.     521

Precision, rounding errors     209

Preference files, individual     580

Preferences     153

Print buttons     527

Print command     542

Print vs. Quick print     527

Printing data tables     528

Printing multiple sheets     144

Printing. Landscape vs. portrait. Graphs.     529

Printing. Landscape vs. portrait. Tables.     528

Prism 3, compatibility with     120

Prism 4, compatibility with     120

Prism gallery, view and choose sheets     101

Prism Gallery, working with multiple sheets     144

Prism Magic. Make graphs consistent     317

Prism Navigator     100

Problems with copying and pasting     153

Process colors     516

Projects vs. data tables     175

Projects, merging and splitting     123

Pruning rows     301

Publishing     506

Publishing to Web     526

PZF     118

PZFX     118

- Q -
QC lines     437

Questions, tech support     589

Quick print vs. Print     527

Quick start     11

- R -
Random numbers     278

Range of axis     427

Rapid Inspector     513

RecalcAll command     565

Reciprocal transform     292

Recording     150

Recovering     121

Reference     592

Regenerate     545

Related sheets     154

Removing a baseline     297

Removing data from graph     313

Renaming sheets     143

Replacing data on graph     313

Replicates, plotting     351

Replicates, plotting individual     221

Resize layout     483

Results, embedding     265

Results, freezing     264
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Results, orphaned     264

Reverse order of data sets     318

Reversing row order     200

Revert (Mac)     111

RGB     334

RGB vs. CMYK     516

Right Y axis     327

Rotating graphs. Horizontal vs. vertical     318

Rotating titles     443

Rotating -transposing - a data table     300

Rounding     209

Row titles     198

Row titles, XY     359

Running scripts from Excel     574

Running scripts from outside of Prism     571

Running scripts using MacScript, Automator, or
AppleScript     569

- S -
Save command     550

Saved examples     135

Saved method     136

Saving options     118

Saving templates, methods, and examples files in a
lab     581

Saving work     121

Scale bars, axis     432

Scaling factor     483

Scatter plots, which table?     179

Script syntax     541

Scripts, examples     534

Scripts, launching from other programs     571

Scripts, running from Excel     574

Scripts, running using MacScript, Automator, or
AppleScript     569

Scripts, running within Prism     568

Scripts, to simulate nonlinear regression     286

Search for sheets     154

Second  Y axis     327

Section tabs     154

Segmental axis     434

Selected sheets     144

Send to back     500

Send to front     500

Send to Word or PowerPoint     521

Sending files     124

Sending to office     153

SendToPP command     565

SendToWord command     565

Sequence of X values     185

Series, inserting     185

Set Sheet Title command     542

SetAxisLimits command     548

SetAxisTitle command     548

SetGraphTitle command     548

SetInfo command     554

SetPath command     549

SetProjectName command     565

SetScriptDialogTitle command     565

SetValueToInfo command     554

SetYReplicates command     548

Shape of graph     322

Shapes     495

Shared examples     135

Sharing Prism in a lab     577

Sheets     143

Sheets, freezing     264

Shift-enter shortcut     208

Shift-space shortcut     208

Shortcuts     208

Show sheets of one type     101

Show toolbars     104

Simulating data with random error     278

Size of graph     322

skip     313

Skipping rows     301

Slide sorter view -- Gallery     101

SmartDraw     497

Snapping, text     492

Software license agreement     593

Sorting data tables     200

Sorting sheets     143

speed graphing     313

Speed graphing mode     361

Splitting     123

Spot colors     516

Star Training     597

Starting a new data table     175

Sticky notes     150

Stretch an axis     322

Strikethough over numbers -- outliers     203

Subcolumn formats     189

Subcolumns, on Grouped tables     216

Subcolumns, on XY tables     213

Support     589
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Survival data tables     172

Survival graphs     415

Syntax, scripting     554

Syntax, scripts     541

System Preferences     111

System requirements     586

- T -
Tab key shortcut     208

Table CSV command     557

Table for a bar graph     176

Table for a scatter plot     179

Table HTML command     557

Table Prism command     557

Table SQL command     557

Table Text command     557

Table XML command     557

Tables, printing     528

Tables. Data tables in Prism     162

Tabs, move between sections     154

Technical support     589

Telephone support, why we don't offer     589

Template vs. method     139

Templates     138

Templates, saving in a lab     581

Text     492

Text boxes     492

Text files, importing     239

Text files, working with     238

Text on graphs     329

Text. Using Word to add formatted text.     495

Themes. Color schemes     330

Three segment axis     434

Ticks     431

TIF, exporting     506

TIF, importing     497

Time axes     446

Tips     89

Titles of columns     194

Titles of rows     198

Titles on axes     443

Tooltips     154

Tooltips, for navigation     102

Tours     11

Training     597

Transforming     292

Transparency     334

Transparent background     520

Transposing data as you paste (Mac)     235

Transposing data as you paste (Windows)     233

Transposing data tables     300

Tree on left, navigator     100

Tukey method for box and whisker plot     345

Turbo graphing mode     361

Two grouping variable tables     169

Two Prism windows     105

Two segment axis     434

TXT files, importing     238

Type of graph, changing     313

- U -
Uncompressed     118

Ungrouping     500

Units, transforming to change     292

Using different parameters     263

Using Prism in a lab     577

- V -
Versions (Mac)     111

Versions of Prism     120

Vertical vs. horizontal graphs     318

View importing option     244

View toolbars     104

Viewing Prism files     124

- W -
Walker, Jimmy     597

Wand, wizard to analyze data     136

WBlock command,WTBlock command     561

WCell command     559

WCol command     559

WDate command     559

Web publishing     526

Welcome dialog     84

What's new     14

What's new: heat maps     17

whiskers     345

Widths of columns     202

Windows differences, OLE     523

Windows menu     105

Windows vs. Mac     97
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Windows vs. Mac, compatibility     120

WMF or EMF format     523

WMF, exporting     506

WMF, importing     497

Word     523

Word, sending to     153

Word, using to add formatted text     495

Word. One-click export to.     521

Working with multiple projects     123

Working with multiple sheets     144

Working with sheets     143

Working with text files     238

WRow command     559

WSheet command     559

WTable command     557

WTCol command     559

WText command     559

WTitle  command     559

WTSheet command     559

- X -
X and Y, transposing     300

X values, regular sequence     185

XLS files, importing     239

XML     118

XY data tables     165

- Y -
Y axis, adding one on right     327

Yellow highlighter     151

- Z -
Zooming     103, 500
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